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1

Introduction to Hydro GeoAnalyst

Hydro GeoAnalyst (HGA) is the most comprehensive and customizable environmental
data management system available on the market. The easy-to-use HGA package
integrates a list of flexible and customizable database structures used around the world,
complimented by state-of-the-art tools for data interpretation, statistical analysis,
Geographical Information System (GIS) mapping, data charting, and two- and threedimensional visualizations.
For most environment-related projects, whether they are contaminated sites, mining
facilities, or municipal water supply projects, there is often an abundance of data that has
been collected over the years. How many times have you had to sift through several paper
reports for that one piece of information when compiling monthly summaries on a project?
Can you be sure that you have not misplaced a report or failed to mention an important piece
of data?
HGA addresses these and many other needs in the environmental industry. The system
enables you to create a project-specific database, or enhance and build upon your existing
database. It can collect all of your previous data and reports and consolidate them into a
powerful relational database system that can be queried and referenced with ease.
HGA operates as a desktop application based on Microsoft SQL Server technology.
Some typical applications for HGA include:
·
·
·
·
·
·

Regional water well management
Contaminant site inventory
Environmental regulatory compliance
Geologic cross-sections
Public access to information
Mine process/compliance
management

· Environmental site assessment
· Monitored natural attenuation
· Regional aquifer characterization and

management
· Cross-boundary data sharing
· Aquifer vulnerability mapping

HGA is implemented through a number of modules, each designed to perform a specific set
of tasks. This approach allows HGA to be memory efficient, flexible, and expandable. The
modules are organized into four groups as shown below:
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The following modules are for the purposes of Data Management:
· Template Manager
· Import Data
· Query Builder

· Lab Quality Control
· List Editor
· Material Specification Editor

Interpretation of geologic and hydrogeologic data is made easy with the visualization
modules that are provided in HGA. Using these tools, raw data can be transformed into
meaningful spatial data sets. HGA offers a collection of standard and custom modules for
interpreting vast amounts of spatial data. Some of these modules are briefly described in the
following sections.The following modules are for the purposes of Analysis and
Interpretation:
· Plot Collections
· Well Profile
· Map Viewer

· Cross Section Editor
· Scene Viewer
· AquiferTest (link)

Once the data have been analyzed and interpreted, they can be shared with project
stakeholders in meaningful ways using the reporting and collaborative tools available in
HGA. Using these tools, you can easily create and share data tables, reports, plots, maps in
various formats including direct publication to configured websites. The following modules
are for the purposes of Collaboration:
· User Manager
· Online Sharing

· Event Planning
· EDD Workflow

©2022 by Waterloo Hydrogeologic
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Hydro GeoAnalyst Plus (HGA+) is an extended Edition of HGA that includes additional data
management, analysis, and reporting modules, features, and functionality with a focus on
working with geochemical data:
·
·
·
·

Water Quality Standards
Parameter Editor
Parameter Group Editor
Map Viewer

· R-Console
· Calculations (Functions, Water Type,

Units, and Custom Expressions)
· Sample Report

Additionally, HGA and HGA+ have options for generating and publishing reports from the
various modules. A complete list of modules and their available by Edition is available in the
next section of this document.

1.1

HGA Editions
There are four editions of Hydro GeoAnalyst that are available with the following modules
and features:

Data Management Modules and Features

HGA
HGA+
(Standard)
Module/Feature
32- 64- 32- 64Bit Bit Bit Bit

Description

Template
Manager

Fully customize your environmental
database to your specific project
needs with options to add unlimited
tables and fields.

Data Import

Easily import and validate data from
Excel, Access, EDDs and Mobile
EDDs, Diver MON files or LAS files.
Also includes option to bulk load
images.

Data Viewers

Edit, manage, tabulate, search, and
filter your project data using
integrated data viewers and lists
specifically designed to work with
your data based on your projectspecific needs.

Query
Builder
/Viewer

Easily create, save, and recall data
queries to extract useful information

©2022 by Waterloo Hydrogeologic

4

Hydro GeoAnalyst 11.0

about your project. Only minimal
SQL syntax knowledge required!

Lab QA/QC

Verify the accuracy of laboratory
result through the analysis of blank,
duplicate, matrix spike samples,
dilution factors, detection limits and
holding times.

List Editor

Create lists of valid values for almost
any field in your database (e.g.
Station Type, Geologic Unit, etc.) for
consistent and reliable data entry.

Material
Specification
Editor

Create, edit, and manage material
specifications and patterns for use in
your project well profiles, cross
sections, and 3D scenes.

Analysis/Interpretation Modules and Features

HGA
HGA+
(Standard)
Module/Feature
32- 64- 32- 64Bit Bit Bit Bit

Description

Well Profile

Displays detailed well/station
information stored as depths or
intervals and includes support for
deviated (non vertical) wells by
automatically calculating true vertical
depth.

Plot
Collections

Create and organize plots based on
dynamic queries of your data.
Choose from 5 types of statistical
plots and 5 general plots.

Map Viewer

Create detailed maps based on a live
connection to your data. Visualize
stations, add detailed plots, and
interpolate contours of the water
table elevation, potentiometric heads,
or of the concentrations of
constituents of concern.

Map Manager

Create detailed maps of your site,
and visualize stations, contours of
water table or contaminant hot spots
and define cross section lines.

©2022 by Waterloo Hydrogeologic
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5

Produce detailed cross section
diagrams showing geologic,
hydrogeologic and model layers as
well as screen and water level data.

Scene Viewer

Displays and interpolates your
project data in 3D quicker and easier
than ever before and supports
visualization of fence diagrams,
plumes, deviated (non vertical) wells,
and more.

3D
Interpolation

Interpolate data in three dimensions,
plus time to estimate the spatial and
temporal distribution of d

Link to
AquiferTest

Easily send your pumping test data
to be analyzed, interpreted, and
visualized in AquiferTest.

Collaboration Modules and Features

HGA
HGA+
(Standard)
Module/Feature
32- 64- 32- 64Bit Bit Bit Bit
User
Management

Event
Planner

Online Share

Mobile EDD

Quick
Checker

©2022 by Waterloo Hydrogeologic

Description
Manage and control the different
levels of user access for each
member of your extended team.
Easily plan future sampling events
and other field activities, schedule
recurring sampling rounds and set
automatic reminders to ensure a
sampling round is never missed.
Publish project data to the web for
communicating and presenting data
to colleagues and stakeholders.
Quickly build reusable data collection
forms that streamline the data
collection process for field staff
improving the integrity and quality of
your data.
A stand-alone utility that can be
shared with project stakeholders to
streamline importing data from
external sources by validating it
against your data integrity rules.
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Print-ToOffice
Reporting

Report Editor

Quickly prepare client-ready reports,
figures, and graphics from data
views, plot collections, well profiles,
map views, and 3D scenes using
Microsoft Office template documents.
Create professional custom reports
containing data, 2D and 3D-views
you have generated for your
projects. (NOTE: this is a legacy
module that is only available in
existing project and will be retired in
a future version of HGA)

Hydro GeoAnalyst Plus (HGA+) Modules and Features

HGA
HGA+
(Standard)
Module/Feature
32- 64- 32- 64Bit Bit Bit Bit
Sample List

Description
Managing and view samples and
related results. Leverage the power
of the Query Builder to define lists of
samples for use throughout the
application

Parameter
Editor

Define how parameters are used
across your projects. Ensuring
consistency from collection through
analysis and allowing you to
dynamically switch measurement
units (e.g. ug/L to meq/L).

Water Quality
Standards

Import, manage and update any
number of Water Quality Standards
to compare against sample data.
Easily find and manage
exceedances.

Functions

Sample
Reports

Over 50 functions and converters
that allow you to perform quick, onthe-fly analyses on your water quality
data, including: dynamic unit
conversion, ionic functions, corrosion
and scaling indices, isotope
calculations and more.
Build customized analytical data
reports for any dynamic sample sets
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including statistics and comparisons
to one or more active standards.

R-Console

Allows you to run scripts in the R
scripting language and leverage the
thousands of available libraries that
facilitate data analyses, visualization,
categorization and much more.

(Extended)
Plot
Collections

Create interactive plots based on
dynamic data sets. Support for 9
geochemical specific plots in addition
to what is available in HGA’s
standard plot module.

(Extended)
Map Viewer

Create maps based on a live
connection to your data. Includes
support for all plot types and
interactive selection of sample data.

Bit Level (32-bit vs 64-bit) Editions
As of Version 11.0, Hydro GeoAnalyst is available as either a 32-bit application or as a 64-bit
application, both of which are included with your purchase of HGA or HGA+:

Memory and Performance
The bit-level installations have the following memory and performance attributes:
· The 32-bit editions are limited by Windows Operating Systems to a hard limit of

approximately 2GB of active RAM; exceeding this limit may cause errors and/or force
the application to close.
· The 64-bit editions do not have a memory limitation and have increased performance
Modules
The bit-level installations have the modules included/excluded, as described above. The
modules which are only available in 32-bit editions of HGA are "legacy" modules, which are
based on 32-bit technology. Updated or replacement versions of the legacy modules are
under development and will be available in a future release. In some cases, a near
equivalent module is already available. For example, the Map Viewer is a near equivalent to
the Map Manager, similarly, the Print-to-Office functionality effectively replaces the Report
Editor module.

Compatibility
Installation of the 32-bit and 64-bit application is mutually exclusive on the same machine;
that is, you may only install one Edition/Version of HGA on the same machine. However, you
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can connect to an HGA project of the same version using either bit level. This means that
depending on your needs, members of your HGA team can have the benefits of using the
64-bit version if the legacy modules are not needed; while others can still access these
features.

1.2

Installation and Licensing

Hardware Requirements
To run the latest version of Hydro GeoAnalyst, you will need the following minimum system
configuration:
Windows 10 Pro or Enterprise
Operating System
Processor
RAM

NOTE: Administrative rights are required to install
the software
32-bit or 64-bit (1 gigahertz (GHz) or faster)
16 GB or more recommended

Hard Disk

500 MB Free Space, plus extra space for your
projects

Networking
Hardware

Network Card (required for soft key licensing)

Software Requirements
To run the latest version of Hydro GeoAnalyst, the following software pre-requisites are
required:
Microsoft .NET Framework v.4.0 installed (provided with installation)
Microsoft Visual Studio C++ 2005 Redistributable (provided with
installation)
If you have any problems with your particular system configuration, please contact your
system administrator, or technical support: support@waterloohydrogeologic.com
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Additional Requirements
Due to recent updates to Windows 10, the following steps must also be taken to install Hydro
GeoAnalyst:
· HGA must be installed using Administrative rights and Windows 7 Compatibility

Mode. Once installed, HGA will run normally without the need for either.
· The .NET 2.0/3.5 framework must be enabled in Windows 10 settings.

SQL Server Requirements
Hydro GeoAnalyst works with SQL Server databases. HGA databases can be stored on
SQL Server 2012, 2014, 2016, 2017 or 2019 instances. Full SQL Server Editions as well as
Express or Local DB are supported.
An instance of SQL Server 2014 Local DB is automatically installed with HGA.
Starting Hydro GeoAnalyst
Once HGA has been installed on your computer, simply double-click on the Hydro
GeoAnalyst shortcut icon ( ) located on your computer’s desktop. Alternatively, you can
access the software via the Start Menu by clicking on the Windows button and looking under
the Waterloo Hydrogeologic folder.

Please Note: If you are using dongle-based hardware
licensing, please ensure that your dongle is connected to
your computer AFTER you have installed the software, and
that you have properly configured your installation.

Troubleshooting
If you have any problems with your particular system configuration, please make sure that
you followed the installation instructions precisely. If the problem is still unresolved, contact
your IT and/or hardware experts. Finally, if you are still having trouble, you may consider
contacting our Support team: support@waterloohydrogeologic.com.

1.3

Updating Old Projects
Hydro GeoAnalyst is backwards compatible, so that you can open and work with projects
created in earlier versions of the application. The first time you open a project from a
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previous version, you may be prompted to convert/update your database to the new format.
A dialog similar to the one shown below will display:

At this time, you will have the option to create a backup copy of your database, which is
highly recommended.
Click the Yes button to create a backup copy of your database. Otherwise, click No to
continue with the database upgrade without creating a backup (Not Recommended).
Selecting the Cancel button will cancel opening the project.
In addition, it is recommended that you create a backup of the "Projects" directory before
you open projects in the new version of Hydro GeoAnalyst. This can be done using the
options in "My Computer", or "Windows Explorer".

Please Note: Waterloo Hydrogeologic is not responsible for
any direct or indirect damages, however caused, if project
data has not been securely and independently backed up.
You are strongly encouraged to frequently back-up your
HGA project folder and the SQL Server database.

1.4

Installing R
Hydro GeoAnalyst Plus (HGA+) includes the R-Console module which supports advanced
statistical analysis, visualization, and much more using the R scripting language. In order to
make use of the R-Console, you must separately install R on your computer as described
below.

Please Note: The R-Console is only available in HGA+.
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R is a freely available scripting language and environment for statistical computing
developed by the R Foundation and an active user community which provides a vast variety
of statistical and graphical procedures.

Getting R
To get Started with R, please visit the R homepage: www.r-project.org. There you will be
able to download a copy from one of the members of the Comprehensive R Archive Network
(CRAN) and find many resources including the manual and answers to FAQs. HGA+ has
been tested with the base version of R for Windows, which is available from many mirror
websites, including: https://cloud.r-project.org/bin/windows/base/release.htm.
32-Bit vs. 64-Bit
HGA+ is available as either a 32-bit application or a streamlined 64-bit application (please
refer to the help on HGA Editions for more information). In order to use the R-Console, you
will need to install the same bit-level of R as the installed edition of HGA+. That is, if you
install the 32-bit edition of HGA+, you will need the 32-bit version of R and if you installed the
64-bit edition of HGA+, you will need to install the 64-bit version of R. Please note that you
can install both the 64-bit and 32-bit versions of R (in fact this is currently the default
installation setting):
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Package Libraries
The R scripting language is powerful in its own right; however, it is made significantly more
useful by facilitating the use of thousands of external package libraries developed by the
wider community; common examples include ggplot2 (which facilitates plotting) and leaflet
(which facilitates mapping).
In order to install package libraries from within Hydro GeoAnalyst, you will need to call at
least one library using a native R interface (e.g. RGui or RStudio). The following steps will
guide you through the process of installing your first package which also installs the
necessary files for installing more package libraries in HGA+.

1. Go to the folder where you installed R, by default, this will typically be:
§ C:\Program Files\R\R-[version number]\bin\i386 (for the 32-bit version of R) or
§ C:\Program Files\R\R-[version number]\bin\x64 (for the 64-bit version of R)
2. Double-click the file called: RGui.exe. This will open the graphical user interface (GUI)
which is distributed with R:
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3. At the prompt, install one package (that you will likely use). For example, you can
type:
> install.packages('ggplot2')
Please Note: if the package fails to install; a likely cause is that R is attempting to
install the library packages to a folder that requires administrative rights. If this
is the case, you can do one of the following:
a. close RGui and reopen it by right-clicking and selecting the "Run as Admin..."
option.
b. install R to a local folder that does not require administrative rights
c. set the libPaths option before installing packages in your script. For example if
you want to install libraries into "c:\users\user_name\documents\R\libraries", at
the beginning of each script you can add:
> .libPaths( c( "c:/users/user_name/documents/R/libraries" , .libPaths()
)
4. Press <ENTER> to execute the command. You will be prompted to select which of
the secure CRAN mirror sites from which you want to download the package:

Once you select a CRAN mirror site for the package, RGui will begin installing the
package library along with the prerequisites to install other packages, including in the
R-console module in Hydro GeoAnalyst. Note that you will be similarly prompted each
time you install a package using the install.packages() command in the R-console
module within Hydro GeoAnalyst.
5. Close RGui.
6. Open Hydro GeoAnalyst and select Project > Hydro GeoAnalyst Settings from the
main menu
7. Select the R-Console tab and set the R location to where the correct version of R.dll is
installed on your machine. The default location is:
©2022 by Waterloo Hydrogeologic
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C:\Program Files\R\R-3.6.1\bin\i386\R.dll or C:\Program Files\R\R-3.6.1\bin\x64\R.dll;
however, your installation location may be different.
8. Click Apply and OK
You should now be ready to start working with the R-Console module in HGA+.
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HGA Demo Project Tutorial
The Demo Project is a pre-loaded project that includes sample data and saved outputs like
queries, maps, cross sections, and more! This tutorial will show you how to install the Demo
Project and then guide you through it so you can become familiar with HGA and what you
can accomplish with the program!
Getting Started

q To explore the AquaChem demo project, first launch Hydro GeoAnalyst 11.0, which

will open on the Start Page by default.
q On the Start Page you should see a button to 'Install demo project...'. Alternatively,

you can click 'Project > Install demo project' from the main menu, as shown below:

Clicking either of these buttons will open the 'Install Demo Project' window, as shown
below:
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At this step, you must select a name for the project, a data source (where the project
database will be stored), and a project folder location (where supplemental project
information will be stored).
The simplest data source option is the Local Database which is installed on your machine
with HGA. If you prefer, you can install the Demo Project to other SQL Servers running on
your machine or network - but you must ensure you have appropriate permissions. In
general, the Local Database option is ideal if you will be working on the project alone and
only need access project information from your machine. Projects requiring remote access
or access by multiple users should be setup using a Microsoft SQL Server located on a
network that is accessible to the appropriate members of the project team.
By default, the Demo Project files will be installed to the folder location specified as the
"Default Project Location" in the General tab of the HGA Settings window, which can be
accessed by clicking Project > HGA Settings from the main menu. The default location is
"My Documents\Hydro GeoAnalyst".

q Select Local Database as the Data source type, MSSQLLocalDB as the Instance

Name and, HGADemo as the Database name (as shown above)
q Select

and

to install the Demo Project.

Once the Demo Project has finished installing, it will automatically open and you can see it is
populated with data.
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Now that you have loaded the demo project, you can proceed to the next section, where you
will learn to navigate within the Interface.

2.1

Navigating the Interface

General Program Layout
The HGA interface consists of several controls:
· Menu Bar: Contains menu commands with access to most features that are available

in Hydro GeoAnalyst.
· Module Toolbar: A toolbar that contains short-cut buttons for the most frequently used

features in Hydro GeoAnalyst.
· Project Explorer: Hosts controls to help you manage and access your data:

o Project Tree: Allows you to navigate to and interact with your subsets of your data
in various formats of interest
o Station Picker: Allows you to select one or more station(s) that are used to display
and work with data in other modules, tabs, and plots.
o Sample Picker [HGA+ only]: Allows you to select one or more sample(s) that are
used to display and work with data in other modules, tabs, and plots.
· Workspace Tabs: Provides access to the various views, modules, and components of

Hydro GeoAnalyst projects.
· Main Workspace: Contains the workspace for the current view.
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· Workspace Toolbars: Contain icons for the main options you can perform with the

current module displayed in the workspace.
· Status Bar: Displays the program status.

Several of the modules will also launch as separate workspace tabs when you open an HGA
project.

New Concept: The concept of Stations is used throughout
HGA: these are simply records that refer to a specific
location, often including an x and y coordinate and other
metadata. The Station Picker can be found below the Project
Tree.

When first opening HGA, the default window displays will appear. There are two tab groups:
· the Project Explorer on the left includes the Project Tree and Station Picker and
· the Main Workspace on the right which includes 4 tabs; the Station List, Station Data,

Query Results, and Data Filter. The tabs provide you with different ways of viewing the
data in the database. We will go through each of these in the Demo.
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The HGA interface is adjustable - you can change the layout to suit your needs. You can find
more information About the Interface in the Fundamental Concepts section.
All spatial data in the Demo Project is projected according to the NAD1983 UTM Zone 17N
coordinate system. This information is defined when creating new projects and can be
viewed by selecting Project > Properties, from the main menu.
The Project Tree can be easily expanded to see all the nodes and entities contained in the
Demo project. Take a moment to inspect the items under each node in the Project Tree.

Station Groups
In HGA, stations can be sorted into groups allowing for efficient management and quick
retrieval of data stored in the database. All station groups created for a project are listed in
the Project Tree under the Station Groups node. Double clicking on any of the branches
corresponding to a station group will load the Station List tab, and display the appropriate
stations belonging to that group.
In the Demo Project, there are several station groups (for example: All Stations, Boreholes,
Monitoring Wells, etc.).

There are three kinds of Station Groups in HGA:
All Stations: This station group is in all projects and all stations that are entered
(imported or manually) into the project will be found in this station group. You can not
delete or rename this station group.

Static: Select one or more stations directly in the Station List tab, right-mouse click,
and select the Add to Station Group option from the pop up menu.
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Dynamic: Using the query builder, define a more advanced search criteria, and build
a station group with those stations that satisfy the query criteria.
Once the stations in a group are displayed, a number of operations can be applied based on
the selection. To find out more about Station Groups please refer to Station Groups.

Sorting & Filtering Records
Using the sorting and filtering options, you can also select different views for the data. For
example, it may be helpful to view just the stations at specific elevation.
To do this:
q Double click the All Stations from the Station Groups branch of the tree
q Select the Elevation column in the Station List

This will sort the values in the elevation column from lowest to highest (arrow is displayed in
the column header) and you can see station GB-34 has the lowest elevation at 321.09m.

q Select the Elevation column again to sort the values from highest to lowest. And now

you will see that the highest elevation is 340.49m and this occurs at station GB-33.
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Additionally you will find the first row in the data grids is a filter row. You may want to find all
the stations in your project that begin with GB.
q Enter "GB" in the filter row of the Station Name column.

You will see that only the stations which name begin with GB are in the station list.
q Clear the filter by selecting the

button in the Station name column.

q Return the stations back into the original sort order by clicking on the ID field.

List Editor
For some fields - like Station Type - you will find there is a drop down menu you can select
from. This list is generated by the List Editor.

©2022 by Waterloo Hydrogeologic

22

Hydro GeoAnalyst 11.0

The List Editor provides the ability to create and customize lists for just about any field allowing for efficient and consistent data entry. A list in HGA may be considered as a lookup
table.
To find out more about how to use the List Editor to create and edit lists please refer to List
Editor.

Template Manager
If you are wondering about the different fields (columns) you are finding in the Station List
and Station Data tab and thinking you would like to be able to add new field - or make
adjustments to the existing fields (or tables) in your database - you can! This is done in the
Template Manager and you can find more information about this module here: Template
Manager.

New Concept: The Template Manager
is one of the
most powerful modules in HGA. It allows you to make
changes to the database structure. This can have impacts on
your existing data and your ability to enter or import new
data. It is advisable that you have a solid understanding of
database management before making large scale changes
to the database structure. However - for the purpose of this
tutorial you can play around within the Template Manager as
much as you like to see the effects - as you can always go
back to the beginning of the tutorial and re-install the Demo
Project which will restore the project and all the data in it!.
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Now that you are familiar with the Hydro GeoAnalyst interface, you can proceed to the next
section, where you will learn to how enter data in your project.

2.2

Entering Data
In HGA, you can enter data into a project either manually (one record [row] at a time) or by
importing multiple records at a time.
Manual Data Entry
You can manually enter/edited data in the Station List, Station Data, or Non Station Data
tabs. To add a new record (or row) use the
button found at the top of the tabs. You can
edit existing data right within the data grids found in the tabs.
You will notice that as soon as you move your cursor out of a newly created record or edited
record that the entire row is highlighted yellow ( ). This means that there are edits that
need to be committed/saved (use the save button
at the top of the tab) to the project
database. You can also discard changes to the table by clicking the refresh button ( )
which will reload the project database ignoring any of your unsaved changes.
If you need to delete a record you must highlight the entire row and then select the
button.

Import Data Module
It may be more efficient to import the data using the Import Data Module, which provides
several options for importing your data:
· General: Import stations and other associated data from delimited text, Excel, and

Access files. Measured units will be automatically converted during import
· EDD: Import *.zip_hga files generated by the quick checker
· Mobile EDD: Import data submitted with Mobile EDD
· Diver: Import data from .MON files created by Diver-Office, Diver-Office Premium, or

Diver-Pocket
· LAS: Import data from Log ASCII Standard (.LAS) files. Version 2.0 file formats are

supported.
· Images: Import pictures of stations.

For more details on how to import data, please refer to Importing Data section.
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EDD Workflow
If you have several spreadsheets of data you need to import the EDD (Electronic Data
Deliverable) workflow would be your best choice. The EDD workflow provides an efficient
way of getting validated data into HGA. The workflow includes the following three steps:
1. EDD Template Designer
2. HGA QuickChecker
3. EDD Import
Additionally, we also have an option to make your EDD mobile so you can use it on mobile
devices like tablets and smart phones. For more details on the EDD Workflow please refer to
EDD Workflow.
Now that you are familiar with data entry, you can proceed to the next section, where you will
learn to about querying your data.

2.3

Querying
Hydro GeoAnalyst goes beyond simply storing your data. HGA also provides practical
search/query tools to help you access and interact with your data, using the industrystandard 'Structured Query Language' (SQL). Retrieving your data has never been easier!

Query Builder
Several queries have been created for you in the Demo Project - they are saved in the
Project Tree. You will notice that you can group your queries into folders to make it easier to
find the query you are looking for.

To run a query and see the results, simply double-click on the desired query. For example:
q Double click on the Lithology query in the Project tree and you will see the results

displayed on the Data Query tab:
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The results of a query can be used in other modules - like Map Viewer, Plot Collections, Well
Profile, Lab Quality Control, 3D Interpolation, etc. or can be published to Excel or
PowerPoint template files to create tables, pivot tables, charts, or presentations for reporting
purposes. Review the options on the menu bar of the Query Results tab to discover all the
options available to you.
To understand how a query was designed, click the Edit Query button ( ) or right-click on
the desired query in the Project Tree and select Edit Query. The Query Builder will open
showing you the query design. Here for example is the Lithology query:
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The fields you wish to see are in the Display Fields section. Conditions that restrict which
data records are returns are in the Conditions section. For this query, there is only a Source
Condition - indicating that it should only be run against the data associated with stations that
are in the Boreholes station group.
Feel free to review the design of other queries to see what options are available to you. The
names and organization of the queries should give you an idea of their purpose.
For more details on the Query Builder please refer to Query Builder section.

Now that you are familiar working with Queries, you can proceed to the next section, where
you will Review Lithology Data.
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Review Lithology Data
In the standard HGA project templates, lithology data (intervals of soil/material found during
the drilling process) are stored in the Lithology table (Geologic Description category) within
HGA. The different soils/materials encountered during drilling are associated with specific
images when displaying this data within modules (for example the Well Profile, Cross
Section Editor, and Scene Viewer). You may have noticed the images when you ran the
Lithology query in the previous section. You can also review each individual station's
lithology data by selecting the Station Data tab and then selecting the Geologic Description
category. By default, the Lithology table is displayed and the data for the currently selected
station is shown. You can change the station by selecting another station name from within
the Station Picker. Here, for example, is the lithology data from station GB-05:

If you are having difficulties finding stations with lithology data, try doubling clicking on the
Boreholes station group in the Project tree. This will activate the Station List tab and update
it with only the stations in the Boreholes station group. You will also see that the list of
stations in the Station Picker has been updated with these stations. Now go back to the
Station Data tab and navigate through the stations to review the lithology data.
The lithology data are stored as intervals with from and to depths along with the soil type and
other potential descriptions (color, odor etc).
The HGA Demo Project is uses the DIN 4023 specification for associating images to the
material stored in the soil type field of the lithology table. HGA comes with several different
specifications including:
·
·
·
·

USCS
USDA
DIN 4023
IAH

· Compton
· Dunham Carbonate Classification
· Shell Standard

However, you may find you want to create your own specifications that indicate the
soils/material and associated images that are valid for your project. You can do this within
the Material Specification module.
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Material Specification
Select the Material Specifications option from the Modules menu, or click on the
in the main toolbar.

button

The Material Specifications Editor will appear as a tab as shown below:

Here you can see the DIN 4023 specification used for the Demo Project including all the
valid soil/material names and the associated images.
You can review other specifications that are provided within HGA by selecting them from
Select a Specification drop down. For instance below is the USCS specification which uses
black and white images.
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The right side of the tab provides the options for creating a new specification as well as
editing an existing custom specification. When creating new specifications you can use
names and images from any existing specification by selecting them from the left side and
selecting the blue right arrow to copy them to your new custom specification. Or you can
create new names and import your own images.

Please Note: The material specifications that come with
HGA cannot be directly edited; however, you can copy these
specifications and make your own custom version(s).
Custom specifications can be used in other projects using
the import/export functions as well as custom Database
Templates.

For more details on the Material Specification Editor please refer to Material Specifications
Editor.
Now that you are familiar with the Lithology Data and Material Specification, you can proceed
to the next section, where you will Review Well Profiles and their data structure.

2.5

Review Well Construction Data
In this section, we will review the Well Profile module, which allows you to visualize and
analyze a variety of subsurface data related to boreholes and wells. However, before we
can proceed, it is important to review the data structure associated with boreholes and wells
in HGA.

Borehole and Well Construction Data
Well Construction data is stored within several tables in HGA found under the Well
Construction category. If you haven't already done so - double click on the Boreholes
station group in the Project Tree. This will activate the Station List tab and update it with only
the stations in the Boreholes station group. You will also see that the list of stations in the
Station Picker has been updated with these stations. Now select the Station Data tab and
then select the Well Construction category from the the drop down. You will see there are
several tables in this Data Category including:
·
·
·
·

Drilling Protocol
Casing
Screen
Annular Fill
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· Monitoring Points
· Abandonment

For this Demo Project tutorial, we will focus on the first four tables.

Drilling Protocol
The drillling protocol table stores the information regarding the drilling of a station or well.
The from and to values are entered as depths and the diameter of the auger used for drilling
is entered. The method used to drill the hole can also be entered. A typical vertical well will
likely just have one record in this table. However, if you have an angled or deviated hole you
can have one or more records in this table. For example select station GB-09 from the
station picker and review the Drilling Protocol data for this station.

Here you will see there are two records showing the hole was drilling with an inclination of 30
degrees (and an azimuth of 25) for the first 50 m and then at an inclination of 40 degrees for
the second 50 m.

Casing
The Casing table stores the information regarding the casing installed for your well. The from
and to values are entered as depths. The diameter and material of the casing can also be
entered. Some simple wells will only have a single record in this table - however, if you have
a cluster well (also known as a nested well) you can find multiple records in this table. For
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example, select station GB-01 from the station picker and review the Casing data for this
station.

Here you will see there are three records. The first two records have the same Casing ID they belong to the same installation. The first installation has a steel casing for the first 60 m
and then a PVC casing for the last 40 m. The third record has a different Casing ID - so this
is a separate installation. It is using Piezometer material, has a smaller diameter and only
goes to 40 m.

Screen
The Screen table stores the information regarding the screen(s) installed for the current
station. The from and to values are entered as depths. You can see that station GB-01 has
two screens. One from 10 - 20m and a second one from 20 - 30m. These relate to the two
different casings mentioned above.
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Annular Fill
The Annular Fill table stores the information regarding the annular fill (or backfill) for your
well. The from and to values are entered as depths. The Filling Type field is a list that is
maintained by the List Editor that includes not only the name of the filling type but also
images associated with the filling type.

Feel free to review the different tables for the different stations to get familiar with the data.
However, it might be helpful to use the Well Profile module to visualize all this data. In fact
many people find it helpful to view the Well Profile while entering this data (if they need to
enter the data manually from old reports) as they can visualize the data as they enter it and
are more likely to notice typos and errors.

Well Profile
The Well Profile module can be launched by selecting the
icon from the main toolbar or
by selecting Modules > Well Profile from the main menu or by simply double clicking on an
existing Well Profile template found in the Project tree. It will be loaded with the last template
that was used.
The Well Profile module can also be used as a data entry assistant in HGA, by displaying for
example the well construction details we just reviewed within the Station Data tab.
q Select the

icon from the main toolbar now so that the Well Profile tab launches
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q Select the Cluster Well Template from the dropdown template menu. This is a simple

template with only a scale and a well construction column. It displays the data
reviewed above for station GB-01 including the two different casing and two different
screens.
q Now select the edit

button so the designer portion of the Well Profile is revealed.
The designer portion allows you to see and edit the settings for the columns within the
template.

q Select the Well Construction branch of the Design Tree and all the setting for this

column can be found below.
q Select the Cluster wells option under the Data section to see how the casing and

screen settings allow for displaying this kind of data.
Let's take a look at another template:
q Select the Well Construction TVD template from the dropdown
q Select GB-07 from the Station Picker.
q Select the Design item at the root of the template items
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You will notice under the Columns section the option for Display True Vertical Depth has
been set to Yes for this template. This will automatically calculate the True (actual) Vertical
Depth based on the inclination values entered in the Drilling protocol table.
As mentioned above - it can be helpful to view the Well Profile at the same time as the data.
You can do this by right clicking on the Well Profile tab at the top and selecting New Vertical
Tab Group. Now you should be able to see both the Station Data tab and the Well Profile tab
beside one another.

Take some time to review other templates and stations and the data associated with the
stations to see how they are displayed in the Well Profile module. For more details on the
Well Profile please refer to Well Profile.
Now that you are familiar working with Well Profiles and related data structures, you can
proceed to the next section, where you will review Cross-Sections.

2.6

Cross-Sections
Groundwater and environmental site investigations typically entail detailed analyses of
lithologic data acquired from boreholes. Interpreting and visualizing the borehole data are a
crucial steps in understanding the subsurface regime. HGA comes complete with a fullyintegrated cross-section tool that is designed with all the features you need to create
geologic and/or hydrogeologic cross-section interpretations.
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The Cross Section Editor module (which is only available in the 32-bit edition of HGA) is
designed with easy-to-use tools for interpreting geological and hydrogeological data, as well
as interpreting data for groundwater flow models. Generating model layers for use as
modeling layer elevations in groundwater modeling packages such as Visual MODFLOW
Flex has never been easier!
The Cross Section Editor can be launched by:
·
·
·
·

selecting the
icon from the main toolbar,
selecting Modules > Cross Section from the main menu,
double-clicking on an existing cross section found in the project tree, or
from within a Map with one or more existing cross section(s).

The Demo Project has several cross-sections interpreted for you already - we are going to
start by opening cross-section "BB".

You can see that this cross-section has been interpreted in the three ways of conceptualizing
stratigraphy available in Hydro GeoAnalyst:
· Model - line interpretations of where the model layers occur if you are planning on

generating a groundwater model
· Geology - polygon interpretations of the geologic (soil) types from the known points
(at the stations) across the entire cross section
· Hydrogeology - polygon interpretations of multiple soil types that would comprise a
hydrogeologic layer
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You can show/hide each interpretation type by selecting/removing the first checkbox beside
each interpretation layer. For instance if you remove the first check box beside both Model
and Geology you will see the Hydrogeology interpretations for this cross section.

And if you remove the check box from Hydrogeology and select the checkbox beside Model
you will see the model layer interpretations.

©2022 by Waterloo Hydrogeologic

HGA Demo Project Tutorial

37

Turn the Geology interpretation back on by selecting the first check box beside the Geology
layer. Now select the second checkbox - this puts the Geology layer into "edit" mode. You
will notice the Polygon and Rectangle drawing tools become available in the toolbar. If you
select a polygon (for example, the Clay polygon), you will notice the vertices (indicated by
light blue squares) become available and you can adjust them to edit the interpretation.
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You will also notice that when you put the Geology layer into edit mode "ghost wells" appear
- these are the interpretations of an intersecting cross section. (Note that you may need to
open the "Site Map" to load the location of these ghost wells in order to see this information click on the Map tab on the right, select Project > Open from the main menu, select Site
Map.vmp and open it. Once the map has loaded, click on the Cross-Section tab). You can
see that the interpretation of cross section DD is slightly different for the Clay layer. This
allows you to adjust and ensure that interpretations are consistent at intersecting cross
sections.
To confirm information on the cross section selection the information
button on the
toolbar and your cursor will now have a
symbol on it. Hover over items on the cross
section to get further information.
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To return your cursor to the regular select the pointer button
and then you can spend
some time attempting to edit the various polygons within the cross section. When you are
done, remove the second checkbox beside the Geology layer and you will be prompted to
save your changes - select Yes.
For more details on the Cross Section Editor please refer to Cross Section Editor.
Take some time to review some of the other cross sections within the Demo Project to
become familiar with them. In a subsequent section of this tutorial, we will visualize the cross
sections in a 3D Scene. Once you have completed your review, close the Cross-Section
Editor by selecting Project > Exit from the menu of the Cross-Section Editor window or by
clicking the
button in the upper right corner of the window.
Now that you are familiar with Cross Sections, you can proceed to the next section, where
you will review how to work with Maps in Hydro GeoAnalyst.

2.7

Creating Maps (with the Map Viewer Module)
The Map Viewer module is packed with an abundance of mapping features that seamlessly
connects information from your Hydro GeoAnalyst project with external spatial information
from your project. The Map Viewer goes far beyond simple mapping, it also acts as a
fundamental source for developing contour maps (elevations, concentrations, water table,
etc.). The Map Viewer is an integral part of HGA and is ideally suited for analyzing and
presenting your environmental project data.
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In this part of the tutorial, we will create a new map and load some data into it and then
contour that data.
q Select the Map Viewer icon

from the main toolbar (or by selecting Modules >
Map Viewer from the main menu). An empty map will appear.

The Map Viewer allows you to add spatial information from a variety of layer types as Map
Layers. You will add and create a few different types of layers in this section of the tutorial.
The simplest layer type that can be added are project data driven layers - which are based
on information directly available in the project that have spatial information - station groups
and queries that include results for the station id, x-coordinate, y-coordinate, and station
name. To add one of these layers, you can drag and drop the layer from the Project tree
onto the map or click the add layer
button and select a station group or query from the
list.
q Expand the Project tree to the node:

Queries > Concentrations >

max_btex_concentrations
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q Drag and drop the max_btex_concentrations query onto the Map Viewer

The query loads as a set of points on the map and becomes a layer in the Map Layers tree
(on the left side of the map). The data associated with this query (the maximum BTEX
values recorded at those points) is now available for you to use for further analysis. We are
going to create contours and a color shade of the data. But first we are going to label the
points and load a shapefile of the boundary of our area of interest.
q Click the label

button

q Double click Max_conc in the list of field names so that it appears in the Expression as

[MAX_conc]
q Select the Advanced Properties tab and select the following options:

·

Use Halo

· Label Orientation: BottomCenter
· Offset-Y: -2
q Click OK to close the label

The map should now include the BTEX concentration values associated with each point.
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Next we will add a shapefile that includes an area of interest:
q Click the add layer
q Select

button

Shape file and click the

button

q Browse to the Map subfolder of this Demo Project. You will find the "Boundary.shp" file

there - Select it and then select Open.
q Click

to stop adding layers to the map

The boundary will be loaded and displayed on the map (over the points) and becomes a
layer in the Map Layers Tree. Note the Boundary layer that was added to the map obscures
the points since it is on top.
q Reorder the Boundary layer by selecting it - drag and drop it below the

max_btex_concentration layer in the Map Layers tree
q Double click the color swatch below the Boundary layer in the map tree to open the

Polygon Symbolizer Properties window:
· Drag the Opacity slider to 0
· Double-click on the Outline Color color swatch and select Black
· Set the Outline width to 2
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Your map should appear similar to the following:

This would be a good time to save our work:
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q Click the Save

button in the Map toolbar.

q Type "Demo Map" when prompted for a name and click OK to complete the save

Now we will create an interpolated surface based on the concentrations and assciated
contours. First ensure you have selected the max_btex_concentration layer in the Map
Layers tree - you know it has been selected when it becomes
Layers tree:

q Select the Create grid file

in the Map

button from the Layers toolbar

q In the Create Grid window, select the following options:

· Select

Interpolate with attribute and select MAX_conc from dropdown menu

· Check the

Restrict/extrapolate to polygon extent option and select Boundary from
the dropdown menu

· Set the Select Natural Neighbors as the interpolation method and the following

advanced settings
o
o
o
o
o
o

Mag X: 1
Mag Y: 1
Mag Z: 1
No Value: -999
Tautness 1: 1.5
Tautness 2: 7
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There are several methods for interpolating data (inverse distance, kriging, and natural
neighbors). Please refer to the documentation on creating grids for more information about
these and related settings. You may also wish to experiment with some of these settings to
see how they affect the resulting surface.
The resulting map includes a black and white surface that depicts areas of estimated high
concentration (white) and areas of estimate low concentration (black) which is suboptimal for
visualizing the results. Next we will format the surface layer so that it is more meaningful:
q Select the max_btex_concentration surface and drag and drop it to the bottom of the

Map Layers tree so that it appears under the other layers
q Select the Grid settings

button and make the following settings changes:

· Add a color stop by clicking the add color stop

button

· Select the first color (position = 0 and value = 1), change it to light blue (#D6EAF8

), click Update
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· Select the second color (position = 0.5 and value = 20,000), change it to yellow

(#FFFF00

), click Update

· Select the second color (position = 1 and value = 40,000), change it to red (#FF0000

), click Update

q Click the Apply button to apply the changes to the map
q Click Close to return to the map:
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q Add contours by clicking the Create contours

button (note that the
max_btex_contours surface layer must first be selected in the Map Layers tree)

q Verify that the default range for contours is from 5,000 to 40,000 and every 5000
q Click the Add contours button
q Select the

Add single value option

q Enter a value of 2,000, select the Minor Contours type, and click the Add Contours

button
q Select the color swatch in the Major Contours section and set the color to Black

(#000000

)

q Click the Labels button in the Major Contours section

· On the Expression tab: double-click the Elevation field so that [Elevation] appears in

the expression
· On the Basic Properties tab: select the Label Rotation option as Line-based /

Parallel
· On the Advanced Properties tab: select Use Halo option
· Click OK
q Select the color swatch in the Minor Contours section and set the color to Green

(#008000

)

q Set the minor contour line thickness to 2 and the line style to Dash

q Click the Apply button to apply the changes to the map
q Click Close to return to the map:
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q Click the Save

button in the Map toolbar.

We have gone through only a small number of features of the Map Viewer. For more details
on the Map Manager please refer to Map Viewer.
Now that you are familiar with Maps, you can proceed to the next section, where you will
visualize data in the 3D Scene Viewer.

2.8

3D Visualizations
The Scene Viewer module (which is only available in the 32-bit edition of HGA) allows you to
visualize your data in three dimensional (3D) space to get a better understanding of your
entire project.
To create a new 3D scene simply select the Scene Viewer button
from the main toolbar
(or select Modules > Scene Viewer from the main menu) and an empty scene with load as
a new tab.
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Begin by loading the Boreholes station group into the scene. Select the
Boreholes station
group on the Project Tree and drag it over into the (black) viewer area and drop it. The
borehole stations will appear. Rotate the image around to adjust the view. Also try increasing
the Exaggeration to 2 to better visualize the stations.

In a similar way you can drag and drop cross sections into a scene. Try loading the following
Cross Sections; AA, BB, CC, and DD. Your scene should look something like:
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You will notice that there is now a legend for the soil types found within the station data as
well as a legend with the soil types used for the cross section interpretations. You can turn
these off by selecting the Cross Sections branch of the scene tree and then setting the
Legends Visible option to No.
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You can also add multiple items into the scene at once by selecting the green plus
use the Add Scene Objects dialog.

and

At the top of the dialog you can select Project items on the left side - for example select the
BTEX_3DPlume and then select the blue right arrow. You will notice the BTEX_3DPlume
item moves to the Scene items (on the right hand side).
We also want to add the site map from our map project. Select the green plus
in the
bottom half of the dialog and then browse to the Aerial_Geo.tif image that is found in the
Map sub folder of the Demo Project.

Select the OK button and both of these object will load into the scene.

The plume is a transient plume - you can watch it progress over time by selecting the Play
button in the toolbar.
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in the toolbar and you will be prompted to save your scene.

Click OK and you will be able to close the Scene tab and reopen it from the Project Tree
later. These are just some of the features of the Scene Viewer in HGA. For more details on
the Scene Viewer please refer to Scene Viewer.
Now that you are familiar with the Scene Viewer, you can proceed to the next section, where
you will learn how to create and manage Monitoring Event Plans.

2.9

Review Monitoring Event Data
Hydro GeoAnalyst includes a great tool for helping project managers and staff to plan for
future events (i.e. sampling events, reporting deadlines, etc.) and to ensure that field
activities are always completed correctly and on time. This module is called the Event
Planner. It allows you to easily create multiple schedules for various stations and create
event plans to outline the details of the associated field activities. These event plans can be
automatically converted to printable reports and Electronic Data Deliverable (EDD) templates
which can be provided to field personnel and laboratories.
To launch the Event Planning module click the Event Planning icon
on the toolbar, or
access this module from the main menu. A new tab will open containing a calendar, as
shown below:
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At the top left of the Event Planning module you should see a toolbar with several options:

The toolbar options include the following (from left to right):
·
·
·
·
·

Tasks: allows you to schedule stations for regular sampling
Event Plan Wizard: allows you to create an Event Plan
Plan Close Wizard: allows you to close existing Event Plans
Manage Event Plans: allows you to manage Event Plans
Go To Today: the calendar will go directly to the current date

The Event Planning module allows you to schedule both 'Event Plans' and 'Tasks'.
Event Plans allow you to incorporate specific stations to be sampled, which type of data
needs to be collected, whether any QA/QC samples must be collected and to write a
checklist for additional information. A number of individual Tasks can then be scheduled in
relation to a specific Event Plan. Event Plans can also be converted to reports and mobile
EDDs which can be provided to field personnel. Event Plans provide a robust way of
scheduling project work.
A Task is a simplified version of a full Event Plan. Scheduling a Task allows you to specify a
location and date, along with a selection of stations that require attention, and a Task
description specifying what kind of work the Task entails.
Let's explore both of these options by scheduling a new Task and Event Plan.
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Creating a Task
Click on the Tasks button
below:

in the toolbar and the 'Tasks' window will open, as shown

As you can see there is already one Task scheduled in the Demo project (i.e. 'missed
stations'). Double-clicking this task will open a window which describes the details of that
individual task. Let's create a new task by clicking the add button ( ). This will open the
New Task window:
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At this stage you can specify a name, location, start/end time for the task, and specify which
stations are involved. You can also provide a description for the Task, to specify what work is
entailed. Use the Station Group table and the blue arrow buttons to select a few stations and
move them into the 'Selected Stations' table (it doesn't matter which ones). Switch to the
description tab and write something (For example, "Routine weekly sampling"). Finally, you
can click the 'Recurrence' button in the upper toolbar to specify a recurrence interval for this
task. If you click the 'Recurrence' button you should see the following 'Appointment
Recurrence' window:
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The Appointment Recurrence window allows you to specify daily, weekly, monthly or yearly
recurrence intervals for the Task. Utilizing Task recurrence can help you to manage
recurring project work, such as monthly/quarterly sampling or reporting events.
When you have finished exploring the Recurrence and New task windows click 'Save and
Close' from the toolbar in the 'New Task' window.

Clicking 'Yes' in the window above will export the scheduled task to your personal calendar
(e.g. Outlook).
When you're finished scheduling your task you should see it appear in the 'Tasks' window,
and also in the main calendar of the Event Planning module. You can then double-click the
task from the calendar to reopen the task window, which will contain all the previously
specified information.
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Creating an Event Plan
Now let's create a new Event Plan. We will create an Event Plan which will include several
scheduled tasks. From the main Event Planning module, click the 'Event Plan Wizard' button
from the toolbar. The 'Event Planning - Wizard' window will open.
The first step in creating a new Event Plan is to provide a name (e.g. Example Event), a start
and end date for the plan (e.g. today's date). The Event Plan name and dates are
mandatory. If your database contains a list of field personnel or laboratories you may also
specify these types of information at this step:
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Once you have provided a name and date simply click 'Next >>' to proceed to the next step.
At this stage you can select which stations will be involved in your Event Plan. A dropdown
menu is available to select from available Station Groups. For this demonstration change the
station group to 'Monitoring Wells' and select all available wells (i.e. W-01 to W-23):
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Once the stations have been selected we can proceed to the next step, which is to specify
which parameters will be analyzed. Let's select the BTEX series of analytes (i.e. Benzene,
toluene, ethylbenzene, and xylene) as the parameters to be analyzed:

Proceed to the next step, which is to determine which QA/QC samples (if any) must be
collected:
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Click the add button ( ) to add a row to the table. Once a row has been added, you can use
the dropdown menus under the 'Station' and 'Sample Type' columns to select which station
and sample type (i.e. duplicate, equipment blank, trip blank or matrix spike) is required.
Clicking the 'Manage QAQC Sample Type' button (
window:
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This window lists the available QA/QC sample types. The 'ForXStations' and 'AddYSamples'
columns allow you to manage QA/QC sample frequency requirements. To demonstrate,
close the window and click the green checkmark button ( ) in the QA/QC Analysis toolbar,
which will add enough QAQC samples to meet the requirements according to the specified
ratios. For this set of samples, this will automatically add three duplicates, three equipment
blanks, three trip blanks and two matrix spike samples. Considering that 23 stations have
been selected the total number of QA/QC samples is correct, based on the specified ratios in
the image above. At this stage you must select the stations that these specific QA/QC
samples will be applied to. For each row specify a station under the 'Station' column. The
window should look something like this:
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You can now proceed to the next window, for 'Additional Data Collection':

This stage of the Event Plan allows you to specify whether any additional station data should
be collected. You can specify any number of fields. Some examples of additional data which
may be collected include sample information, water level measurements, and field
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measurements, etc. To demonstrate, expand the 'Monitoring Event' category, select the
'Parameter Sample' table (or "Sample" table if using HGA+) and click the add button ( ).
Repeat this for the 'Water Level' and 'Field Measurements' tables. Note that you can add
whole tables, or just individual fields. The window should look similar to the following:

Proceed to the next step, which is the 'Checklist' step. At this stage you can simply write any
additional notes that are required, perhaps providing a checklist of equipment required for
this Event Plan. For example, you could write 'Bring GPS Unit':
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Proceed to the next step, which is the 'Scheduled Tasks' step. At this stage you can
schedule tasks associated with this event plan. For example, if you were performing water
sampling you might schedule three distinct tasks: a preparation day (i.e. bottle prep,
equipment calibration, etc.), a sampling day (i.e. to actually visit the site and collect data) and
a results day (i.e. when you expect to receive lab results). Without scheduling any tasks the
Event Plan itself will not actually appear on the event calendar. By clicking the add button (
), a window will open asking you to select which information (from the Event Plan) should be
included in the scheduled Task which will appear on the event calendar:
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For our event let's include all the available information. Click OK in the 'Export options'
window, and the familiar 'New Task' window will open. This allows you to schedule your task
in the same way explained above. As you can see, the task has automatically been
populated with all the information that has been described in the Event Plan. Let's leave the
scheduled task as is, and proceed to the final step in the Event Plan wizard, which is to
'Publish' the Event Plan. From the Task window click 'Save and Close' and then click 'Next
>>' in the Event Planning wizard (you can decide whether to export to your personal
calendar or not). You should arrive at the following window:
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At the 'Publish' step in the Event Planning wizard you can save your plan (committing all
previous information and actually creating an Event Plan). Once the Plan has been saved
you have the optional ability to publish the Event Plan to a word document and/or an EDD
template. Clicking the 'Save plan' button will activate the 'Create EDD Template' and 'Print to
word...' buttons. If you click the 'Create EDD Template' button you will be prompted to save
the template in the project folder. Once the template has been saved, the following window
will open:
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You can expand the Template Format in the middle table to see that all database
tables/fields which were selected in the Event Plan have already been added to the EDD
template. As you can see, using the Event Planning Wizard to plan for field activities is a fast
and easy way to generate EDD templates for your team. This EDD Template Designer
window works just like the regular EDD Template Designer. You can also generate mobile
EDD templates from this window, which can be provided to field personnel to help with data
collection. For more information on the EDD process please refer to the EDD Template
Designer section.
Close the EDD Template Designer and click the 'Print to word...' button in the Event Planning
Wizard. This should automatically open Microsoft Word, and an Event Plan document should
appear. The first page in the Event Plan document will display a summary of stations to be
sampled:
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Subsequent pages in the report are dedicated to individual stations which have been
included in the Event Plan:

These documents can be provided to your field personnel to ensure that all of the correct
data is being collected at each station. Let's close the word document and return to the
Event Planning module. You can also click 'Finish' in the Event Planning Wizard. You should
see your event plan within the event calendar at this stage (dates may vary):
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Double clicking the new task (i.e. Task 1 - Example Event) will once again open the 'Task'
window, allowing you to reschedule this task if required.
Now that an Event Plan has been scheduled, Hydro GeoAnalyst will prompt you with
reminders regarding that event as the scheduled dates approach. Furthermore, the Event
Planning module will remind you to 'close' an Event Plan one week after the plan was
scheduled to be completed. If you open Hydro GeoAnalyst within the one-week period you
will see a message similar to the following:
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Within the Event Planning module you can click the 'Plan Closure Wizard' (from the toolbar)
and the following window will open:

The Plan Closure wizard provides you with a tool to positively confirm that the data required
by the Event Plan has actually been collected. The first thing to do in the Plan Closure
Wizard is to open an existing Plan using the little folder button next to the 'Event Plan' field.
Once an existing Plan has been opened you can proceed to the 'Collections' step in the Plan
Closure Wizard (click 'Next >>'). The following window will appear:
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At this stage you can specify exactly which of the required samples/data were collected.
Ideally every piece of data will be collected, but oftentimes it's impossible or difficult to reach
a particular station, or perhaps an important piece of equipment was left behind. Whenever a
piece of data was not collected you must provide a comment. For demonstration purposes
we will use the 'Select All' button to 'check' all the completed boxes, but then 'uncheck' one
and provide a comment. The window should look something like this:
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Once a comment is included in each of the not-collected data points you can proceed to the
next step, which is the 'Confirmation' step:

The 'Confirmation' step allows you to easily reschedule missed stations/data by clicking the
'Reschedule Missed Stations' button. This will immediately begin the process of scheduling a
new task, as seen above. If all data was collected, or if the missed data does not require a
rescheduling then you can finalize the process and actually 'Close' the Event Plan by clicking
the 'Acknowledgment' button (under 'Plan Closed by:') and then clicking 'Finish'.
You can now open the 'Manage Event Plans' window by clicking the 'Manage Event Plans'
button in the toolbar. You should see a list of available Event Plans, with a status box
indicating whether or not the Plans have been closed:
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The Event Planning module provides a powerful tool for project managers to keep track of
the different events required by their project, and to ensure that all the required data is being
collected as expected.

This concludes the Demo Project Tutorial.
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HGA+ Demo Project Tutorial
The HGA+ version of the Demo Project is a pre-loaded project that includes the same data
and saved outputs (like queries, maps, cross sections and more!) as the standard HGA
demo project; however, it also includes examples of how to use the advanced modules for
sample management, analysis, plotting, and R-scripting. This tutorial will show you how to
install the Demo Project for HGA+ and then guide you through it so you can become familiar
with HGA+ and what you can accomplish with the program!
Getting Started
To explore the HGA+ demo project, first launch Hydro GeoAnalyst 11.0 and access the Start
Page. On the Start Page, you should see a button to 'Install demo project'. Alternatively,
you can click 'Project > Install demo project' from the main menu, as shown below:

Select the Data source type - the simplest option is the Local Database which is installed on
your machine when you install HGA+. Simply select MSSQLLocalDB or Waterloo as the
Instance Name and provide a Database name (e.g. HGAp_Demo) and then select Next >>
and Finish to Install the Demo Project.
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If you prefer, you can install the Demo Project to other SQL Servers running on your
machine or network - but you must ensure you have appropriate permissions.
· The Demo Project files will be installed to the location designated under Project / HGA

Settings (the Project tab).
· The default location is under My Documents / Hydro GeoAnalyst.

Once the Demo Project is finished installing, it will automatically open and you can see it is
populated with data.
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Now that you have loaded the demo project, you can proceed to the next section, where you
will learn to navigate within the Interface.

3.1

Navigating the Interface

General Program Layout
The HGA+ interface consists of several controls:
· Menu Bar: Contains menu commands with access to most features that are available

in Hydro GeoAnalyst.
· Module Toolbar: A toolbar that contains short-cut buttons for the most frequently used

features in Hydro GeoAnalyst.
· Project Explorer: Hosts controls to help you manage and access your data:
o Project Tree: Allows you to navigate to and interact with subsets of your data in
various formats of interest
o Station Picker: Allows you to select a station that will be used to display and work
with data in other modules, tabs, and plots.
o Sample Picker: Allows you to select one or more sample(s) that are used to display
and work with data in other modules, tabs, and plots.
· Workspace Tabs: Provides access to the various views, modules, and components of

Hydro GeoAnalyst projects.
· Main Workspace: Contains the workspace for the current view.
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· Workspace Toolbars: Contain icons for the main options you can perform with the

current module displayed in the workspace.
· Status Bar: Displays the program status.

Several of the modules will also launch as separate workspace tabs when you open an HGA
project.

New Concepts: The concept of Stations is used throughout
HGA+: these are simply records that refer to a specific
location, often including x and y coordinates as well as other
metadata. The Station Picker can be found below the Project
Tree.
The concept of Samples is also used throughout HGA+:
these are simply records that refer to an event where a
information was collected from a station, often including a
sample date and/or time, one or more measured values
(either directly in the field or via a representative amount of
some medium that is sent to an analytical laboratory for
analysis), as well as other metadata about the event. Note
that more than one physical sample may be represented in a
single Sample within HGA+. For example, you may collect
different physical samples in different sample bottles/vials for
concentration analysis for inorganic constituents than for
organic constituents due to sample varying preservation
requirements (e.g. sample bottle material, preservatives,
head space, maximum holding time, and temperature
requirements). Furthermore, you may also make direct
measurements in the field while collecting the physical
samples. All of these measurements and analytical results
associated with physical samples collected at the same
Station, during the same event should be considered as a
single Sample in HGA with the same Sample ID. This allows
you to more easily manage, evaluate, and present results.
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When first opening a project in HGA+, the default window displays will appear. There are two
tab groups:
· the Project Explorer on the left includes the Project Tree and Station Picker and
· the Main Workspace on the right which includes 5 tabs; the Station List, Sample List,

Station Data, Query Results, and Data Filter. The tabs provide you with different ways
of viewing the data in the database. We will go through each of these in the Demo.
The HGA+ interface is adjustable - you can change the layout to suit your needs. You can
find more information About the Interface in the Fundamental Concepts section.
All spatial data in the Demo Project is projected according to the NAD1983 UTM Zone 17N
coordinate system. This information is defined when creating new projects and can be
viewed by selecting Project > Properties, from the main menu.
The Project Tree can be easily expanded to see all the nodes and entities contained in the
Demo project. Take a moment to inspect the items under each node in the Project Tree.

Station Groups
In HGA+, stations can be sorted into groups allowing for efficient management and quick
retrieval of data stored in the database. All station groups created for a project are listed in
the Project Tree under the Station Groups node. Double clicking on any of the branches
corresponding to a station group will load the Station List tab, and display the appropriate
stations belonging to that group.
In the Demo Project, there are several station groups (for example: All Stations, Boreholes,
Monitoring Wells, etc.).

©2022 by Waterloo Hydrogeologic

80

Hydro GeoAnalyst 11.0

There are three kinds of Station Groups in HGA+:
All Stations: This station group is in all projects and all stations that are entered
(imported or manually) into the project will be found in this station group. You can not
delete or rename this station group.
Static: Select one or more stations directly in the Station List tab, right-mouse click,
and select the Add to Station Group option from the pop up menu.
Dynamic: Using the query builder, define a more advanced search criteria, and build
a station group with those stations that satisfy the query criteria.
Once the stations in a group are displayed, a number of operations can be applied based on
the selection. To find out more about Station Groups please refer to Station Groups.

Sample Sets
HGA+ also includes a node in the Project Tree for Sample Sets. Samples (collected at
stations) can be sorted into sets allowing for efficient management and quick retrieval of
sample and analytical data stored in the database. There are three kinds of Sample Sets in
HGA+:
Static: Select one or more samples directly in the Sample List view, right-mouse
click, and select the Add to [New/Existing] Sample Set options from the pop up menu.
Dynamic: Using the Query Builder, you can define search criteria, and build a
sample set with those samples that satisfy the query criteria.
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Stations: Station groups are also implicitly sample sets as they refer to all of
the samples collected at the stations within that station group. Note that by definition,
the
All Stations station group includes all samples in your project.
Sample sets created for a project are listed in the Project Tree under the Sample sets node.
Double clicking on any of the branches corresponding to a sample set will update the active
Sample set, (optionally) load the Sample List tab, and display the appropriate stations
belonging to that group. In the Demo Project, there are several predefined sample sets (for
example: OW Samples, Major Ion Samples):

To find out more about Sample Sets, please refer to Sample Sets section of the manual.
Sorting & Filtering Records
Using the sorting and filtering options, you can also select different views for the data. For
example, it may be helpful to view just the stations at specific elevation.
To do this:
q Double click the All Stations from the Station Groups branch of the tree
q Select the Elevation column in the Station List

This will sort the values in the elevation column from lowest to highest (arrow is displayed in
the column header) and you can see station GB-34 has the lowest elevation at 321.09m.
q Select the Elevation column again to sort the values from highest to lowest. And now

you will see that the highest elevation is 340.49m and this occurs at station GB-33.
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Additionally you will find the first row in the data grids is a filter row. You may want to find all
the stations in your project that begin with GB.
q Do this enter GB in the filter row of the Station Name column.

You will see that only the stations which name begin with GB are in the station list.
q Clear the filter, simply select the

button in the Station name column.

q Return the stations back into the original sort order by clicking on the ID field.

List Editor
For some fields - like Station Type - you will find there is a drop down menu you can select
from. This list is generated by the List Editor.
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The List Editor provides the ability to create and customize lists for just about any field allowing for efficient and effective data entry. A list in HGA may be considered as a lookup
table.
To find out more about how to use the List Editor to create and manage lists, please refer to
List Editor.

Template Manager
If you are wondering about the different fields (columns) you are finding in the Station List,
Sample List, and/or Station Data tabs and thinking you would like to be able to add new
fields - or make adjustments to the existing fields (or tables) in your database - you can! This
is done in the Template Manager and you can find more information about this module here:
Template Manager.

New Concept: The Template Manager
is one of the
most powerful modules in HGA. It allows you to make
changes to the database structure. This can have impacts on
your existing data and your ability to enter or import new
data. It is advisable that you have a solid understanding of
database management before making large scale changes
to the database structure. However - for the purpose of this
tutorial you can play around within the Template Manager as
much as you like to see the effects - as you can always go
back to the beginning of the tutorial and re-install the Demo
Project which will restore the project and all the data in it!.
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Now that you have loaded the demo project, you can proceed to the next section, where you
will learn to how enter data in your project.

3.2

Managing Data
In this section of the tutorial, you will learn how to enter data manually, import data, and
query your data.
Manual Data Entry
Manual data entry is a very simple process in HGA+. To review:
q Open the

Station List tab from the main toolbar

q Click the 'Add new station' [

] button in the toolbar.

A new row will appear in the Station List, and it will be highlighted yellow to indicate that this
data has not been saved yet and committed to the database, as shown below:

Now that a new record is available, you can simply click in each of the associated fields and
manually specify values.
q Enter the values shown below and also take note how the 'Station Type' field includes

the option to select values from a predefined list. In this case, we want to add a new
type of Station, called "Water Quality". This new station type will be added to the
values stored in the List Editor for later use.

©2022 by Waterloo Hydrogeologic

HGA+ Demo Project Tutorial

85

Once the data has been entered, you have to click the 'Save station changes' [ ] button in
the toolbar (or alternatively press 'CTRL+S') to save the record. Until the record has been
saved, the row will be highlighted yellow [ ]. Note a message will be displayed in the status
bar at the bottom of the interface (shown above) indicating that there are uncommitted
changes in the table. You can also discard changes to the table by clicking the refresh
button
which will reload the project database ignoring any of your unsaved changes.
q Click the 'Save station changes' [

] button now to commit the new record to the

database.
If you need to delete a record you must highlight the entire row and then select the
button. In our case, we will not need this record, so let us find it in the Station List and delete
it.
q In the filter row (which is the empty top row and highlighted blue [

])

q Type "WQ". This will filter the list to just those stations that start with "WQ".
q Select the single record shown:

q Select the delete record

button and note that you will be prompted to confirm
whether or not you want to permanently delete the record:
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q Click OK to delete the record.
q Select the Clear filter

button to restore the entire Station List items to the view:

Import Data Module
In many cases, it is far more efficient to import data using one of the methods available in
the Import Data Module, which provides several options for importing your data in a variety
of formats. For this section of the tutorial, you will review the process for importing sample
data contained in a Microsoft Excel spreadsheet, which is likely the most commonly used
import method in HGA+.
q To initiate the sample import process, open the Import Data Wizard using the main

menu ('Modules > Import Data') or by clicking the
button in the main toolbar. The
first step when importing data is to select from the available data types:
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q Make sure the Samples type is selected and click OK to proceed through the import

process. You will then see the first step of the Import Data Wizard.
q Click the 'Select Files' button [

] next to the 'Specify import file name' field to
navigate to the file. Browse to the 'water_quality_data.xlsx' file, located in the Data
Files folder in the Demo Project. This will likely be:
C:\Users\[user-id]\Documents\Hydro GeoAnalyst\Project Files\HGA Plus Demo\Data
files\water_quality_data.xlsx

The Import Data Wizard window will be updated with a preview of the selected file, as shown
below:
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In this case, the source data file only contains a single worksheet, and a single header row.
However, if future data sources contain multiple worksheets, you can select the desired
worksheet using the menu highlighted in the image above. It is also possible to specify the
exact row containing header information and the first row which contains data to be imported
using the fields highlighted above.
Our sample data contains non-detect data qualifiers (i.e. the "<" symbol) in the results field.
HGA+ contains a mechanism to parse the data so that the qualifiers are split into a separate
field.
q Select the

checkbox beside "result field contains non detect qualifiers (e.g. <0.5)"

and
q Select the Value field next to the "Select Result Field" drop down
q You can proceed to the next step in the import workflow by clicking the

button. You will then see the 'Mapping' step, as shown below:
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This step includes several components: On the left side you have a hierarchical tree that
shows the structure of the project database including Data Categories at the top level,
followed by database tables and their fields. This view is common throughout Hydro
GeoAnalyst. On the right side you have a table listing the fields of each project database
table that data will be imported into. The source column allows you to pick a column from the
file that you are importing that contains the data. Columns in this table that are highlighted
green [ ] are required (i.e. data must be included) as part of the import.
q Map the fields in the Sample table as follows:
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Note that you can specify an input format for the source units, which is particularly
useful when working with dates on international projects where date formats can vary
across regions (e.g. day/month/year vs. month/day/year). The source format can be
accessed by clicking in the field and then selecting the dropdown or typing the number
format directly. In the demo project, the date formats consistently use the same date
format and so explicitly specifying an input date format will not be required.

q Click the Sample Analysis tab and map the fields, including the source unit column

as shown below:
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button to proceed to the next step. Note that since you are not
including spatial information to the station data table, the Source Projection step is
skipped and you will arrive at the Parameters step:
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At this point, most (but not all) of the source parameters have been automatically matched
with and mapped to existing project Parameters. We will first map parameters that exist
under different names in the project.
q Click in the Project Parameters column next to Tetrachloroethylene to open the

Parameter Selector
q Use the dropdown to select "Organic Chemicals"
q Select PCE (which is a common alternative name for Tetracholorothelyene) from the

list:
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q Click OK
q Repeat this for Trichloroethylene and select TCE. and OK.
q Click in the Project Parameters column next to DO and select Field Parameters in the

dropdown and Dissolved Oxygen
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q Click OK
q Repeat this for El. Cond. and select Cond and OK.

The remainder of the parameters are dissolved inorganic constituents that are not present in
the project. To add these, simply:
q Select the create stubs for missing parameters

button at the top of the window.

The parameters should be mapped as follows:
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correctly mapped:
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q Click the

button to proceed to the Preview step. At this step, you can preview
the data as it will be imported into the destination project database tables and
optionally save the import mapping settings. Saving the steps is useful if you will be
receiving data in the same format on a regular basis so Hydro GeoAnalyst can
automatically complete the required information at each step for you. All you have to
do is review the inputs to verify that the inputs are as expected:
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to import the data. You will see a progress bar; once this is complete,
you will should see a confirmation and summary of the imported data:
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q Click the

button to close the wizard and return to the project.

q To review the imported data, open the Sample List by using the main menu ('View >

Sample List') or by clicking the

button in the main toolbar.

q Click the refresh button (

) to load the imported samples into view. There should now
be a total of 510 samples in the project.

For more details on how to import data, please refer to Importing Data section.

EDD Workflow
If you have several spreadsheets of data you need to import, the EDD (Electronic Data
Deliverable) workflow would be your best choice. The EDD workflow provides an efficient
way of getting validated data into Hydro GeoAnalyst. The workflow includes the following
three steps:
1. EDD Template Designer
2. HGA QuickChecker
3. EDD Import

©2022 by Waterloo Hydrogeologic

HGA+ Demo Project Tutorial

99

Additionally, we have an option to make your EDD mobile so you can use it on mobile
devices like tablets and smart phones. For more details on the EDD Workflow please refer to
EDD Workflow.
Now that you are familiar with data entry, you can proceed to the next section, where you will
learn to about creating Sample Sets.

3.3

Creating Sample Sets
Sample sets are static or dynamic selections of samples which can be saved for easy
retrieval and use at a later time. Dynamic sample sets are especially helpful, since new data
introduced into the project are automatically compared against the criteria used to design the
dynamic sample set. This ensures that your sample sets will always be able to retrieve all
necessary data. For instance, you way wish to find all samples that:
·
·
·
·

were collected within a certain period of time,
exceed some water quality standard,
belong to a certain group of stations, or
a combination of the above

Similarly, static and dynamic station groups may be created in order to easily retrieve
particular selections of stations. Station groups and sample sets are also dynamically linked
to each other. Each station group in your project implicitly results in an associated sample
set (i.e. all samples associated with the stations contained in the station group).
Furthermore, dynamic station groups and sample sets can be created based on the criteria
of a dynamic sample set or station group, respectively. For example, a station group may be
created from the stations associated with a specified dynamic sample set and vice versa.
The Demo Project includes several static and dynamic sample sets/station groups already
saved in the Project Tree, under the 'Sample Sets' and 'Station Groups' nodes, respectively:
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To activate any given station group or sample set, simply double-click it in the Project Tree.
For example,
q Double-click the 'All Major Ions' sample set and the Sample List will be

opened/activated and the samples associated with this sample set will be displayed
here and in the sample picker:

Please Note: the status bar at the bottom of the Sample List
should indicate that there are 88 rows, i.e. 88 samples which
meet the criteria for this sample set, assuming you have
imported the sample data set described in the previous
section.

Note that a sample set consists ONLY of the samples which meet the criteria used to
generate the sample set. A station group based on a dynamic sample set also implicitly
results in a station sample set, but this station sample set includes all samples from the
associated station(s).
q To review the criteria used to generate a sample set, simply right-click the 'All Major

Ions' sample set in the Project Tree and select 'Edit'. The Query Builder
then open, as shown below:

module will
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The Query Builder contains a number of simple toolbar buttons, including options to create a
'New Query' [ ]. Let's create a new Sample Set:
q Click the New Query

and the New Query dialog will appear.

q The default Query Type is the Standard Select Query - we need to change this by

selecting the Dynamic Sample Set option.
q Provide a Query Name: Samples with Exceedances.
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q Select OK to create the query. You will notice that the Display Fields and the Group

Conditions sections have become disabled - these are not available for Dynamic
Sample Set Queries.
q Click on the

button to load the Condition dialog:
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The Condition dialog allows you to create parameter-based conditions, including measured,
calculated, station, and sample parameters. These can also be include conditions based on
Water Quality Standards. Some example conditions include:
· samples collected from a station of a particular type (e.g. Station Type = Observation

Well)
· samples collected in a given year (e.g. Sample Date >= Jan 1, 2008 AND Sample
·
·
·
·

Date < Jan 1, 2009)
samples with exceedances (e.g. Benzene >= MCL for Benzene)
samples with a specified concentration above
samples with below a given calculated hardness (e.g. Hardness <= 50 mg/L CaCO3)
samples with below a given calculated hardness (e.g. Hardness <= 50 mg/L CaCO3)

To illustrate, we will create a sample set with the first three of these conditions:
q Select Parameter value
q Change the parameter by clicking the

button to open the parameter selector,
select Station parameters from the drop down and "Station Type" from the list:
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q Click OK
q Type "Observation Well" in the condition textbox:
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q Click OK
q Add a second condition by clicking the
q Change the parameter by clicking the

the drop down and "Sample Date" from the list:
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q Click OK
q Enter a Date value of Jan 1, 2008:
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q Click OK
q Repeat the steps above but enter a condition for samples collected before Jan 1,

2009:
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We will now add one last condition. This time, we will add a condition based on a water
quality standard exceedance:
q Click the

button

q Select "Exceeds Standard" from the top dropdown menu and select the "The following

parameter" option
q Change the parameter by clicking the

button, select Analyzed parameters
from the drop down and "Benzene" from the list:
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q Click OK
q Select the EPA RSL - MCL as the applicable standard. The Condition window should

look like the following:
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q The conditions pane of your query should now contain a total of four conditions:

q Note that there are three validation errors (

) since SQL requires a logic gates
between conditions. We will specify the AND condition for each:
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q Click the Save button

to save the Sample Set. Note that the Sample Set is now
saved in the Project Tree and will be available for use with other modules:

q Select the Execute Query button

and you will be moved Sample List which will
now contain only those samples that meet the conditions specified in the Dynamic
Sample Set query:
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Please Note: that it is also possible to create 'Static' station
groups and sample sets by simply selecting multiple
stations/samples from the station/sample list, right-clicking
on the selected records and selecting 'Add to new sample
set' or 'Add to new station group', as the case may be. But
please be aware that the contents of static station groups
and sample sets are simply that - a static list that will not
change unless stations or samples are manually added or
removed.

Form more information, please refer to the following sections:
· Station Groups
· Station List
· Dynamic Station Group Query - Example
· Sample Sets
· Sample List
· Dynamic Sample Set Query - Example

This concludes the section on creating sample sets and station groups. In the next section
we will discover how to edit parameters and create parameter groups using the Parameter
Editor and Parameter Group Editor modules, respectively.

3.4

Working With Parameters
In this section, we will update the parameters that we imported in a previous step and create
some new parameter groups - one for the newly imported dissolved metals and one for
organic constituents, since there are lots of organic constituent exceedances of water quality
standards within this project and having specific parameter groups will allow us to
find/select/display these parameters more easily throughout the Hydro GeoAnalyst
interface.

Editing Parameters
To work with parameters we will make use of the Parameter Editor module:
q Open the Parameter Editor module by clicking the Parameter Editor

button on the
Main Toolbar or select it from the main menu ('Modules > Parameter Editor').

©2022 by Waterloo Hydrogeologic

HGA+ Demo Project Tutorial

113

Before the Parameter Editor opens, you may see a confirmation prompt similar to the
following:

Because the changes in the parameter editor can cascade through other modules, Hydro
GeoAnalyst must first close these other modules and save any unsaved changes. Similarly,
you will receive an additional notice:

q Click OK and the Parameter Editor will open:
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q Scroll to the bottom of the list on the left side of the window and you will see the

dissolved constituents we imported in the previous section of the tutorial. Select the
parameter "Cu_diss" which represents dissolved copper.
q To enable, the full functionality of this new parameter in HGA+, we must specify a few

attributes:
o Display name: populates label fields in charts and tables. Enter: Cu_diss
o Description: allows you to make notes about the parameter. Enter: Copper,
dissolved
o Valency: the valency of the ionized parameter. Enter: 2
o Formula: the molecular formula of the parameter. Enter Cu
q Once you have entered a molecular formula, you can benefit from a useful feature in

HGA+, namely that it will automatically determine the molecular formula weight of a
parameter for you once you provide the molecular formula.
q Click the

button and the molecular weight of copper (63.546 g/mol) will be

filled in for you.
q Next we, will add a default unit. In the original imported file, the concentration units for

Cu_diss were µg/L. Click the

button and select Concentration units of µg/L:
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q Click the Save
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q Repeat for the other dissolved parameters:

Parame
ter
Cu_diss
Al_diss
As_diss
Cd_diss
Cr_diss
Pb_diss
Hg_diss
Ag_diss
Mn_diss

Description

Formula

Copper,
dissolved
Aluminum,
dissolved
Arsenic,
dissolved
Cadmium,
dissolved
Chromium,
dissolved
Lead, dissolved
Mercury,
dissolved
Silver, dissolved
Manganese,
dissolved

Cu

Molecular
Weight
63.543

Valency

Unit

2

µg/L

Al

26.982

3

µg/L

As

74.922

0

µg/L

Cd

112.411

2

µg/L

Cr

51.996

0

µg/L

Pb
Hg

207.2
200.59

2
2

µg/L
µg/L

Ag
Mn

107.868
54.938

1
2

µg/L
mg/L

Note: the valencies in the table above are based on the most common oxidation
states; where multiple oxidation states are likely to be encountered in the environment
or have significant levels of toxicity [e.g. Cr-VI vs Cr-III], a value of 0 is entered for the
purposes of this tutorial. Depending on the requirements of your project, you may need
to create separate parameters for each oxidation state, particularly if each oxidation
state has different action level concentrations.
q Once you have updated and saved all of the parameters above, you can

the parameter editor.

For more details on how to import data, please refer to the Parameter Editor section.

Editing Parameter Groups
Parameter Groups are special lists of parameters that you can use to quickly access one or
more parameters of interest. This is useful in many modules that we will explore later in the
tutorial.
To create a parameter group first access the Parameter Group Editor module from the
button on the Main Toolbar or from the main menu ('Modules > Parameter Group Editor').
When the Parameter Group Editor opens, you should see the following window:
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On the left side of the Parameter Group Editor module (under 'Parameter List') you will see
a list of the parameters which are included in a number of default parameter groups which
are part of every Hydro GeoAnalyst project, along with any other user-defined parameter
groups. If you open the 'Parameter group' menu item under 'Parameters List' you should
see the following groups:
· Analyzed parameters - a default parameter group which includes all project

parameters which have records associated with them
· Cations - a default group including all parameters with a positive valency (defined in
·
·
·
·
·
·

the Parameter Editor)
Anions - a default group including all parameters with a negative valency (defined in
the Parameter Editor)
Ions - a default group including all parameters with any valency (as defined in the
Parameter Editor)
Required - a default group including all parameters required in calculated functions
(e.g. sum of anions/cations, electroneutrality balance, etc.)
Used in standard - a default group including all parameters listed in the active water
quality standards
Custom Calculated parameters - a default parameter group which includes all
parameters that have been flagged to enable custom calculations
All measured parameters - a default parameter group which includes all active
project parameters (even if they do not have records associated with them)

· Inorganic Chemicals - a user-defined parameter group which includes all active

inorganic parameters
· Isotopes - a user-defined parameter group which includes available isotopes (18O, 2H

and 14C)
· Organic Chemicals - a user-defined parameter group which includes all active
organic parameters
· Major Ions - a user-defined parameter group containing the major groundwater ions
(K, Na, Ca, Mg, Cl, HCO3, CO3, SO4)
· Field parameters - a user-defined group including parameters commonly measured
on-site/in the field (temperature, pH, Eh, conductivity, TDS, dissolved oxygen)
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Please note that the user-defined parameter groups mentioned above can also be listed on
the right side of the Parameter Group Editor module, under the 'Manage parameter groups'
section:

These user-defined parameter groups have been included specifically in the Demo Project
for the purposes of demonstration, and will not be included automatically when a new project
is created. However, as they are user-defined, it is quite easy to recreate them yourself. Let's
review how user-defined groups can be created by creating one for the dissolved constituent
parameters : Cu_diss, Al_diss, As_diss, Cd_diss, Cr_diss, Pb_diss, Hg_diss, Ag_diss, and
Mn_diss.

q First, click the 'Create a new parameter group' [

] button in the toolbar under the
Manage parameter groups section. A window will appear allowing us to name the new
parameter group; type 'Inorganic Chemicals, dissolved' into this window as shown
below:

q Click

and the new parameter group will officially be created. The new group
is currently empty and must be populated using parameters from the existing/default
parameter groups.

q In the 'Parameter List' section on the left side of the Parameter Group Editor module,

select the 'Analyzed Parameters' group.
q Under the Description heading, select the filter type button which is currently set to

"Starts with" [

] and change the filter condition to "Contains" [

].

q Type "dissolved" into the filter and the parameter list will be filtered to only show those

parameters containing the word "dissolved".
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q Select the dissolved metals by sorting the list by description (i.e. click on

to sort the field), selecting the first item (Al_diss), holding
down <SHIFT> and selecting the last item (Ag_diss). You can add all of the selected
parameters at one time by clicking the 'right' blue arrow button [ ] to add them to the
'Manage parameter groups' side of the interface. If you accidentally move any
undesired parameters into the new group, they can simply be removed by selecting
the undesired parameter(s) and clicking the 'left' blue arrow button [

].

Once all the relevant constituents have been added to the new 'Inorganic Constituents,
dissolved' group, the Parameter Group Editor module should look like this:

To make this new parameter group available throughout the rest of the Hydro GeoAnalyst
interface you simply have to click the 'Save' [ ] button in the Manage parameter groups
toolbar. Now you can return to the Sample Results tab in the Sample List and select the new
parameter group using the menu in the Sample Results toolbar, and the results table will be
updated to only display the associated parameters. To see a sample with results, let's select
sample "OW-3-05':
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User-defined parameter groups can be used with many other features throughout Hydro
GeoAnalyst to more quickly and easily find and display parameters that you are interested in.
For example, in the next section of the tutorial, we will explore the Sample Reports module
and we can make use of this newly defined parameter group to efficiently build a report
specifically for these organic constituents.

3.5

Creating Sample Reports
The Sample Report Module allows you to create custom tabulations of your samples and
their results based on one or more criteria including: station/sample sets, specific
parameters or groups, and/or exceedances of one or more active Water Quality Standards.
The report can also produce general statistics for samples included in the report.
To demonstrate the power of the Sample Report module, you can build a simple report
based on the Organic Constituents parameter group. To begin,
q Open the Sample Report module by clicking 'Samples > Sample reports' from the

main menu. The Sample Report module will open, specifically on the settings tab as
shown below:

As you might expect, the Sample Report module includes a number of toolbar buttons which
allow you to 'Execute' [

] or create a report based on the current settings, 'Save' [

] the

existing report to the Project Tree , 'Save as...' [

] which allows you to create a new sample

report based on the current settings, 'Refresh' [

] the module, 'Print preview' [

course 'Export' [

] and of

] the resulting sample reports.

The initial tab which is displayed in the Sample Report module is the 'Settings' tab, which
allows you to specify the building blocks of the desired report. At this stage, you can select
which samples or samples sets and parameters will form the basis for the report. You can
also specify if any summary statistics should be included in the report, and whether the
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report should display all results or whether the results should be limited to records with
applicable standards and/or exceedances.
The first step in defining the sample report is to specify which samples or sample sets will be
included in the report. This information is specified in the 'Sample set' frame on the left side
of the Sample Report module. Two options are available:
1. Selected samples - this option will restrict the sample report to the samples which
are currently selected in the Sample picker tab
2. Specified sample set - this option will restrict the sample report to the specific
sample set or station group/set selected in the available table
In this example, we would like to create a sample report for the organic constituents
collected from the Water Quality Stations.
q Select the 'WQ Stations' sample set in the table. Once this group is selected it will be

listed next to the 'Specified sample set' radial button.
q Select the 'Organic Chemicals' Parameter Group from the Parameter group dropdown

menu and add all eight parameters in this group by simply clicking the double-right
arrow button [ ]. Note that you can select them all individually using the single arrow
buttons. Once the parameters have been selected they should all appear in the menu
to the right of the arrows, and it should list '(8) Selected Parameters'.
q The third step in the sample report is to select which summary statistics should be

included. For this example simply activate all the available statistics, and also activate
the percentile range option.
q Since the 'Count of exceedances' option is active, it is also necessary to specify which

water quality standards will be used for this comparison. Use the checkboxes in the
'Water Quality Standard' frame to activate both 'EPA RSL - Tapwater' and 'EPA RSL MCL'.
q In some cases, you may be interested particularly in parameter records which

represent exceedances, or specific parameters which have applicable standards.
These options can be selected using the radial buttons in the 'Show' frame, but in this
case you can simply leave the default 'All selected parameters' option. The Sample
Report settings tab should now look like the following:
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q Click the 'Execute' [

] button to generate the report, which should be displayed
automatically in the 'Pivot view' tab.

Note how exceedances are highlighted automatically using the color associated with
each water quality standard (these colors - and other water quality standard settings can be customized in the Water Quality Standards module, available through the
'Samples' menu).
q If you scroll to the far right side of the report you will be able to review the summary

statistics:
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If you access the 'Tabular View' tab you will be able to review the results as a 'flat' table,
where each individual record is presented in it's own row with additional metadata. However,
the tabular view tab does not include summary statistics. Both of these tabs can be exported
to Microsoft Excel using the 'Export' [

] button. Be sure to save the sample report by

clicking the 'Save' [ ] button. A window will appear allowing you to name the new report
(e.g. 'Organic Exceedance Report'):

When the report is saved it will appear in the Project Tree, under the Sample Reports node,
and you can simply double-click it at any time to quickly retrieve the report:
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This concludes the introduction to sample reports. In the next section of the tutorial you will
review how to access, edit, and create new plot collections.

3.6

Creating Plot Collections
The Plot Collection Module provides the ability to generate a wide range of water quality plot
types, which can be organized into plot collections consisting of one or more individual plots.
In all, there are nineteen plot types supported in HGA+. Plot collections can be configured
and saved in the Project Tree so that you can quickly build and reproduce standard reports.
In this section, you will first review an existing plot collection which is already built into the
Demo Project and explore how to edit/customize the plot collection. In the final section you
will review the use of symbol groups within an Hydro GeoAnalyst project, and create a new
symbol group based on the 'Watertype' sample data field.
The Demo Project comes with several pre-existing plot collections which you can easily
review by simply double-clicking them from the Project Tree:
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q Double-click the 'All Plots' plot collection, and it will open in a new tab within the main

workspace, as shown below:

The plot collection interface has three main components:
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1. A toolbar which includes buttons to add/delete plots, save/rename plot collections,
add/remove rows/columns for displaying plots, export options, and navigation arrows
which allow you to move to different plot collection pages. The plot collection toolbar
buttons are explained in further detail in the Plot Collections section of the user
manual.
2. The main plot window which displays plots which have been added to the current
plot collection.
3. A table of contents which displays a list of the plots that belong to the current
collection. The functionality of the table of contents is outlined in detail in the Plot
Collections section of the user manual. Note that you can toggle the visibility of the
table of contents by selecting the Table of Contents button [
toolbar.

] in the plot window

As you can see, the 'All Plots' plot collection contains nineteen individual plots distributed
over nineteen pages (i.e. one plot per page), one for each of the plot types available in
HGA+. Take some time and navigate through the plot collection using the page controls:
to see an example of each plot type.
A useful feature of the Plot module is that you can change the layout of a plot collection:
q Return to the first page of the layout by pressing the "First Page" button [
q Add a row to the plot collection layout by clicking the add row button [

]

]

q Add a column to the plot collection layout by clicking the add row button [

]

If you have a smaller monitor, your plots may look somewhat cramped in the plot collection.
You can increase the space available for the plots by closing the table of contents [
minimizing the Project Explorer [

] and

]. The result should look similar to the following:

©2022 by Waterloo Hydrogeologic

HGA+ Demo Project Tutorial

127

Creating a New Plot Collection
We will create a new plot collection to illustrate the functionality of the dynamic plots in
HGA+ with a focus on some common geochemical plots:
q Set the Active Sample Set to "All Major Ions" by double clicking it in the project tree
q Create a New Plot collection by selecting Plots > New Plot Collection from the main

menu
q Click the 'Add plot' [

] button, a menu will appear which displays all the available
plot types. Select 'Piper', and a new Piper chart will be added to the plot collection and
its associated plot settings window will appear. Click OK to accept the defaults:
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Symbol Editor
Note that there are some data points on the plot that are using the default symbol [ ]. These
symbols represent the data points for the samples that was imported earlier in the tutorial
and have not yet been assigned a symbol. To assign the symbols, you can use the Symbol
Editor [
], a module that generates symbol sets for Plot Collections.
q Click Plots > Symbol Editor and the following module will appear:

The plot collection interface has three main components:
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1. Two toolbars which include buttons to manage symbol groups (top level) and
symbols within the active symbol group (lower level). The plot collection toolbar
buttons are explained in further detail in the toolbars subsection of the Symbol Editor.
2. Symbol Group Entries which displays the information related to the individual
symbols within the active symbol group.
3. Active Symbol Settings which displays the settings which define the active symbol
(e.g. fill and line colors, symbol shape, etc.).
For more details on the Symbol Editor please refer to Symbol Editor.
q Update the sample symbols by making sure that "Water Quality Stations" is the active

symbol group (i.e. is the symbol group listed in the toolbar dropdown) and clicking the
Apply button [

]

q Return to the Plot Collection by closing the Symbol Editor and/or selecting the "Plot

collection" tab. The symbols will now be updated as shown below:
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In the image above (and on your screen), you may notice that there are data points
highlighted in a light-blue color ( ). These highlighted symbols represent the currently
selected sample from the Sample Picker (i.e. sample '1-2010-7'). If you select one or more
different samples within the Sample Picker, the associated sample point(s) in plot will be
highlighted. To highlight the utility of the dynamic link between samples displayed in a plot
and in the sample list:
q Right-click on the Plot collection tab and select new horizontal group splitting the

workspace in two, with the Plot collection in the bottom half and the remainder of the
tabs on the top half. Select the Sample List in the top group and set the Parameter
Group to "Major Ions", so that your window should look similar to the following:

Note that the active sample is shown in the Sample Picker, the Sample List (main list and
results panes), and in the plot. Changing the active sample in any one of these windows will
update it in the others! This is an extremely useful feature which allows you to easily interpret
your water quality data by dynamically highlighting selected samples. The exception to this
behavior are plots that average or combine data or do not otherwise have a distinct data
point for a sample (e.g. box and whisker plots, Stiff plots, and pie charts)

Please Note: you can customize the style of selected
samples by clicking the project plot settings [

] button in
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the toolbar.

To further illustrate the dynamic nature of plots in HGA+, we will add one more plot:
q Click the 'Add Column' [

] button to add a new plot area to the right of the existing

Piper plot.
q Click the 'Add plot' [

] button, a menu will appear which displays all the available
plot types. Select 'Stiff' and the Stiff chart will be added to the plot collection and the
associated plot settings window will appear.

q Select "Active Samples" from the Source dropdown menu:

· Click OK to close the Settings window and the Plot will update:
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Since the Stiff plot has the "Active Samples" as its data source, it will update instantly as you
select new samples. You can experiment with this by selecting various samples in the
Sample List and seeing that the highlighted sample(s) in the Piper plot and in the Stiff
diagram update accordingly. Similarly, you can click on a point in the Piper plot and the
Sample List and Stiff diagram will also update.
Now that you have made the desired changes you can click the 'Save plot configuration' [
] button in the toolbar. When you close/reopen the plot collection or project all these
changes will be retained.

q Enter a plot collection name: "Geochemistry":
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q Click OK

Note that the plot collection has now been added to the Project Tree and you can access it
from there at any time:

We can add a some more plots to highlight some additional capabilities of the Plot Collection
module.
q Right click on the Geochemistry tab and select "Move to Previous Tab Group"
q Click the 'Add Row' [

] button to add a new plot area below the existing plots.

q Click the 'Add plot' [

] button and select 'Histogram' and a new histogram chart will
be added to the plot collection and the associated plot settings window will appear.

q Select "Active Station" as the Source for the plot data and Click OK
q Click the 'Add plot' [

] button and select 'Time Series'

q Select 'Active sample set' as the source for the plot data and 'Benzene' as the

parameter for the Y-axis

Depending on display settings, the plots may appear somewhat cramped and could be
improved.
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We can improve the plots by setting adjusting some of the plot settings.
· Right-click on the Piper plot to open its settings and select the General tab
· Deselect the Auto title checkbox and change the Title to "Piper Plot"
· Select the "Axes" tab and set the Tick labels format from "0.0" to "0"
· Click OK
· Right-click on the Time Series plot and select the General tab
· Deselect the Auto title checkbox and change the Title to "Benzene vs. Time"
· Select the "Axes" tab and

o Deselect the "Automatically generate range to fit data" checkbox
o Set the Min date to Jan 1, 1990 and the Max date to Jan 1, 2020
o Set the Tick labels format "yyyy" to display the sample collection year
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o Set the Rotation to -45

· Set the Axis dropdown to the Y-axis

o change the units to mg/L
o set the Tick labels format to "0"
· Click OK to close the settings window and review the changes
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Exporting Plot Collections
You may want to test exporting the plot collection using the 'Export to images or
presentation' [

] button, which allows you to export any or all plots.

q Click the 'Export to images or presentation' [

]button and and the Export to

Presentation pane will open:
q Select 'Presentation' for the Export type
q Under Layout settings:

o select the 'Letter' option for the page size
o set the Orientation to 'Landscape'
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q Click the Browse button beside the "Report path" entry form.
q Select the "Save to project tree" option which will save the PowerPoint file to a file

folder in your project so that you can access it directly from the Project tree within
HGA.
q Enter "Geochemistry Plot Report" for the file name and click OK:
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q Click Export.

After exporting the plot collection to PowerPoint, you should see a PowerPoint file similar to
the following appear:
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When printing to a PowerPoint template, you can select from a number of print-ready
templates using the 'Select a template' menu seen in one of the steps above. You can
customize the print-ready templates by double-clicking them in the Project Tree, making the
desired changes within the applicable Microsoft application and then saving. Any changes
you make within the template will be applied to subsequently printed reports/plot
collections/etc.).
You may wish to edit some of the plot settings (e.g. fonts, titles, etc.) beyond the basic
settings you adjusted above. The plot settings vary depending on the individual plot type
and won't be covered in detail within this tutorial, but you can find more information in the
Plot Module section of this user manual. There you can find information on common plot
features, as well as information regarding plot settings which are unique to specific plot
types.
This concludes the introduction to Plot Collections. In the next section of the tutorial, you will
review how to create a basic map with the Map Viewer module.

3.7

Creating Maps with the Map Viewer Module
The Map Viewer Module provides the ability to generate thematic maps based on a live
connection to project data. Maps can be generated by adding station and sample data layers
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directly from the Hydro GeoAnalyst database and supplemented by adding external layers
(shapefiles and base map images). Layers from the database based on stations or samples
can be presented using a variety of options that we will explore in this section of the tutorial.
Please Note: While you can complete this section of the tutorial on its own; previous
sections and their relevance are discussed. If you have not completed these
sections or are unfamiliar with their related modules, you may benefit from
starting the tutorial from the beginning or reviewing specific sections as they are
mentioned. Links are provided where appropriate.
To open the Map Viewer:
· select the Map Viewer button [

] from the main toolbar
or
· select Modules > Map Viewer from the main menu.
When opening the Map Viewer Module for the first time in a project, you will be prompted to
specify/confirm the default map coordinate system in the project settings:

q Click OK to confirm that default projection system (EPSG: 26917) is correct.and close

the settings
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General Layout
When first opening the Map Viewer Module, you will notice two main components and
related controls:
1. A Map Layers Tree which lists map layers that have been added to the map. Layers
include a label, a visibility checkbox, and a collapsible legend. The Layer Tree also
includes:
· the Map Toolbar provides controls for the map including buttons to save the map,
change the map name, refresh the map, and export the map to a PowerPoint
template.
· the Layer Toolbar provides controls for the map layers, including buttons to
add/remove layers, customize labels, view the attribute table, edit the layer
symbology, and export a layer as a shapefile.
2. A Map Viewport which displays the visible map layers drawn based on the order in
the Layer Tree (layers at the bottom will be drawn first)
· the Map Viewport Toolbar provides controls for the map viewport including pan,
zoom, and selection tools.
· the Status Bar provides controls for the map layers, including buttons to
add/remove layers, edit labels, view the attribute table, alter the layer symbology,
and export a layer as a shapefile.

The Map Viewer controls are described in more detail in the Map Viewer section of the
documentation.
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Adding Layers
As part of the tutorial, we will develop a map that contains several layers including:
· Station locations with labels and symbols from the station
· Samples with Stiff diagrams, and
· A Basemap

To begin:
q Click the Add layer button [

] in the Map Layers toolbar to open the Add map layer

dialog:

q Select the

All Stations station group and click Add to add the layer to the map and
close the dialog.

There is more than one way to add layers to the map: you can also simply drag-and-drop
any station group, sample set, or map-ready query from the project tree onto the Map Viewer
to add it. (Map ready queries are queries that return the station name, id, x- and y-coordinate
fields). Furthermore, we can also add external data to the map in the form of shapefiles
(.shp) and basemap images.
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The shapefiles data format is an open source vector-based Geographic Information Systems
(GIS) data format developed by ESRI (1998) that may include a set of points, polylines, or
polygons. Shapefiles consist of a set of files with the same file name — four of these are
required for use in the Map Viewer Module: .shp (spatial data), .shx (spatial index), .dbf
(attribute data), and .prj (coordinate reference definition).
You can also add basemaps to the Map Viewer module, using the following supported image
formats and associated world files:
Format
Bitmap
Tagged Image Format
JPEG

File Extension
.BMP
.TIF
.JPG

World File
.BPW
.TFW
.JPW

Note that basemaps must match the project coordinate system to be displayed correctly on
the map. Images are not currently reprojected.
Let's add an image basemap to enhance the map:
q Click the Add layer button [

] in the Map Layers toolbar to open the Add map layer

dialog
q Select Image and Click Add
q Navigate to the location of the Demo Project and select the Map folder
q Select Aerial_Geo.tif and click Open
q Click Close to close the Add Map Layer window

Your basemap should be added to the map, but you may notice that the points from the
Station group we added are no longer visible. This is because they are below the basemap
in the rendering order and the basemap is quite prominent in the view. Let's adjust the map
to make the map easier to look at:
q Drag and drop the Aerial_Geo.tif layer in Map Layer tree so that it is below the All

Stations layer
q Right-click on All Stations layer and select Zoom to Layer
q Right-click on Aerial_Geo.tif and select Properties
q Change the Opacity slider to approximately 50%:
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q Click OK

Your map should look similar to the following:

The datapoints are now visible on the map, but depending on your screen settings, they are
likely very small and not at all easy to see. We will adjust their style settings to make them
more visible.
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q Right-click on the 'All stations' layer in the Map Layers tree and select Properties
q Change the Symbology to "Unique Values" and set the display field to "stn_type"
q Click Apply

The symbols on the map will update to reflect the values from the Station Type (stn_type)
data field in the Station List table. We have improved the map in that we can now
differentiate the various station types, but the symbols could be improved.
q Double-click on the symbols for the "Borehole" category to open the Point symbolizer

dialog:
o Click on the fill color (in the Simple frame) and select Red
o Select the Use outline check box
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o Click OK
q Repeat the steps above for each Station Type, but update the colors as follows:

o Observation Well: Green (red = 0, green = 255, blue = 0)
o Pumping Well: Blue (red = 0, green = 128, blue = 255)
o Soil boring: Yellow (red = 255, green = 255, blue = 0)
o Weather Station: Purple (red = 128, green = 0, blue = 255)

q Click OK

The map will now be updated with distinct symbols for each type of station as shown below.
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Data Settings and Layer Attributes
An important point about adding and working with project data-driven layers in the the Map
Viewer is that you can access information about stations and samples from both types (i.e.
station groups and samples sets). By default, added station groups contain one record per
station with attribute data from the station table and sample sets contain one record per
sample with attribute data from the sample table. Because of the relational data structure
underpinning Hydro GeoAnalyst, you can quickly switch back and forth between these two
data tables for an added layer. To demonstrate this:
· Deselect the checkbox next to the All stations layer in the Map Layers tree so that it is

not rendered on the map
· Select the

Monitoring Wells station group from the Project tree and drag and drop
it onto the Map Layers tree above the All Stations layer

· Select the newly added Monitoring Wells layer in the Map Layers Tree so that it is

highlighted
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· Click the Attributes [

] button to open the layer's Data Settings window:

As described above, one record has been added per sample from the Monitoring Wells
station group along with their inherited attributes (i.e. fields) from the station table.
The Aggregate data dropdown in the Data Settings (Attribute table) viewer allows you to
define the scope of the data. Currently, the data are based on the Station List table.
However, we can redefine what data are included by selecting the dropdown:

Note that the data settings table updates to show data from the Sample List table and only
23 stations are shown, since only these stations have samples that meet the requirements of
the dynamic sample set. This further highlights the utility of dynamic station groups and
sample sets that we explored earlier in this tutorial.
That are several options that redefine the scope of the attribute table for the current layer as
follows:
· Station: Station List data for all related stations
· All Samples: Sample List data for all related samples
· Earliest: Sample List data for the oldest Sample Date at each station in the sample

set/station group
· Latest: Sample List data for the most recent Sample Date at each station in the

sample set/station group
©2022 by Waterloo Hydrogeologic

HGA+ Demo Project Tutorial

149

· Minimum: Sample List data for each station in the sample set/station group with

lowest value of a specified numeric parameter
· Maximum: Sample List data for each station in the sample set/station group with

highest value of a specified numeric parameter
In this case, we want to create a layer based on the maximum concentration of Xylene for
the given station group:
q Select the Aggregate data dropdown and select "Maximum"
q Click the Select parameter [

] button and select Xylene from the list

q Click the Remove parameters [

] button, select Calcium from the list and click OK to

remove Ca from the table
q Click the refresh [

] button to apply the change and update the attribute data table

At this point, the attribute table will include the station location and information (name, id, xand y-coordinate), sample information (name, id, and symbol id), and the added Xylene
concentration data for the samples with the highest Xylene concentrations at each of the
stations in the station group. Scroll the far right of the Data Setting table to confirm that the
data for the Xylene parameter have been added to the table:

q Click the

in the upper right corner of the Data Settings window to close it

Next we will explore how to edit the layer style settings in the map.

Layer Symbol Settings
The Map Viewer allows you to render project data-driven layers using several thematic
options that we will now explore:
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q Click the Data Layer Settings [

] button to open the Symbols window:

You will note that there are two options in the Symbol Type Dropdown menu:
· Simple Symbol: allows you to define uniform symbols or ramped symbols with

sizes/colors proportional to a selected field (as shown above)
· Sample Symbol: allows you to use the symbols defined in the Sample List using the

Symbol Editor.
All of these options will render one symbol per record in the Attribute table as defined by the
Aggregate data setting. This has two significant implications:
· The Sample Symbol option is not available if the aggregate data is set to the Station

option, since there may be more than one symbol defined at each station
· The resulting symbols layer may render more than one overlapping symbol at a given

station if the attribute table includes more than one sample per station (e.g. if the
aggregate data option is Station or AllSamples and there is more than one sample per
station in the station group/sample set)
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Uniform Symbols
For now let's define uniform symbols with the following settings to increase visibility on the
map:
q Set the following settings on the dialog:

o
o
o
o

Size = 12
Color = Red (#CF000F)
Outline = True
Outline Thickness = 1

q Click OK
q Deselect the visible checkbox next to the All Stations layer in the Map Layers tree:
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The resulting symbols are much more visible on the map, but they do not convey much
information. We can add more information to the map, by using ramped symbols.

Ramped Symbols
Ramped symbols can be used to visualize the spatial distribution and magnitude of a single
parameter. To create ramped symbols:
q Click the Data Layer Settings [

] button to reopen the Symbols dialog

q Select the "Ramp symbols based on field" option and the following additional settings

shown in the dialog:
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The resulting symbols are now more informative and such a map may be useful when
plotting a lot of data from many stations. Another way to render the data is the use the
symbols from the Sample List so that the map uses the same symbols as the plot collections
we explored earlier in the tutorial.

Sample Symbols
To create sample symbols:
q Drag and Drop the

Major Ion Samples sample set onto the Map Layers Tree

q Click the Data Layer Setting [

] button to reopen the Symbols dialog

q Verify that the Sample Symbols option is selected in the Symbol Type dropdown menu

©2022 by Waterloo Hydrogeologic

HGA+ Demo Project Tutorial

155

q Click OK

Plot Symbols
The map viewer allows you to render project data-driven layers as location-based plots of
any type available in the plot collection module using added callout layers:
q Click on the Major Ion Samples layer in the Map Layers tree so that it is active

(highlighted blue)
q Click the Callout Settings [

] button to open the Callouts dialog

q Click the New plot callout [

] button

q Enter a name for the callout layer: Stiff Plot
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q Click OK

The Plot Callout Settings window will appear.

The Plot Callout Settings window is a modified version of the settings available for plots in
the plot collections. The main differences are as follows:
· plot callouts include the following features that are not available in plot collections:

o a selection list of applicable stations/samples that specifies which plots will be
rendered on the map on the left side of the window in the Data tab
o a Layout tab which defines the size and placement of the plot on the map as well as
leader line settings
· plot callouts do not include the following features that are available in plot collections:
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o generate multiple plots of the same type
o set default settings
o custom lines
For more information, please refer to the Callouts section, which also describes how to add
table callouts. For now, we will continue by adding Stiff plots to the map
q Click the Select all [

] button to add plots for all the stations in the group

q Select the Stiff as the Plot type in the Data tab
q Click Apply

Note that Stiff diagrams have been added to the map, but each covers the Sample symbols
and the concentration axis is shown but not necessary. To show both the plot and symbols,
we will add an offset so that the Stiff plots are rendered above the Station locations and alter
the axis settings. The offset should generally be a little larger than half of its size, since plots
are anchored at their center and we generally want the plot to be rendered a small distance
away from the station location.
q Select the Layout tab and change the plot size settings:

o X offset = 0
o Y offset = 60
o Size = 100
q Click Apply
q Select the Axes tab and deslect the "Show" checkbox in the General section
q Click OK to accept the changes and close the Plot Callout Settings
q Click Close on the Callouts window
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Note the map shows one Stiff Plot per location - the Stiff plot shown is the average
concentration of each parameter. To show only one sample per location, you must (re)
define the sample set so that it only produces one sample per location. As an extra step try
to create a new sample set based on the Major Ion Samples sample set that only produces
one sample per location - perhaps using a date as the limitation.
The map is now quite informative and we have examined how to add multiple types of
information to the map. The controls for adding other plots are similar to the controls for
adding Stiff diagrams. Feel free to experiment with adding and styling these charts. Next we
will add some labels.

Layer Labels
The map viewer allows you to add labels to vector layers (i.e. project data-driven layers
and/or shapefiles) based on one or more attributes. To access the label settings:
q Select the desired layer to which you wish to add labels, in our case, select the "Major

Ion Samples" layer that includes Stiff diagrams
q Click the Labels [

] button in the Layer toolbar to open the Feature Labeler window

The Feature Labeler provides a fairly comprehensive set of controls to customize your labels
organized by tabs, as discussed in the Feature Labeler section. For this exercise, we will first
add some simple labels and then add supplemental information using a more complex
expression.
q Double-click the "Name" field in the Field Names list presented in the Expression tab

so that it appears in the Expression form:
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q Click Apply

Note that the labels appear on top of the symbol; similar to the default location of the Stiff
diagrams, the labels are anchored to their location. To make the labels more legible and
useful, let's add some formatting:
q Click on the Basic Properties tab

o
o
o
o

Select Size = 12
Style = Bold
Priority Field = "Name"
Click Apply
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q Click on the Advanced Properties tab

o
o
o
o

Select
for the Use Halo option
Select Bottom Center for the Label Orientation
Set the Y-Offset = -10
Click OK

The map now has legible labels.
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We can now save the map to make use of it in the future.
q Click the Rename map [

] button in the Map Toolbar to provide a name for the map

q Enter a name for the map: "Intro Map"
q Click OK
q Click the Save [

] button in the Map Toolbar

Note that the Map is now saved in the Project Tree as "Intro Map" for future use.
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This concludes the introduction to working with the Map Viewer module. In the next section
of the tutorial, you will review some basic scripting with the R-Console module.

3.8

Basic Scripting with the R-Console
R is an open-source language for statistical computing, analysis and graphics. The RConsole Module allows you to run scripts in the R scripting language and leverage the
thousands of available libraries that facilitate data analyses, visualization, categorization, and
much more.

Please Note: this tutorial is not designed to be a
comprehensive introduction to the R scripting language. If
you are not familiar with the R-scripting language, you may
want to do a bit of supplemental research, since this tutorial
is only designed to introduce you to the Hydro GeoAnalyst
interface for creating R-scripts. A great place to start learning
about R is on the R Foundation website (https://www.rproject.org/).
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To use the R scripting module you must first install R to your computer. If you haven't
already installed R please take a moment to follow the instructions provided in the Installing
R section of this user manual.
Once R has been installed, you can access the R-console from the main menu (click
'Modules > R-console'), or you can double-click one of the existing R-scripts that have been
saved to the Project Tree. Three 'Basic Scripts' are saved to the Hydro GeoAnalyst Demo
Project:
1. Install Scripts - this script will install the packages and libraries required for the
remaining scripts.
2. Statistical Analyses - this script collects some water quality data from the project (i.e.
major ions including Ca, K, Na, Cl, Mg, CO3 and HCO3) and performs a series of
statistical analyses such as calculating basic statistics (mean/standard
deviation/min/max/quartiles), estimating trends using the Mann-Kendall test, and
creating a correlation matrix.
3. Plotting and Mapping - this script retrieves some station data (i.e. station name,
coordinates, elevations), plots them on an interactive map in your default browser
using the Leaflet package, and creates a series of simple scatter plots.
All three of these basic scripts are annotated - script lines that begin with a '#' are comment
lines which have been included to help you understand what the script is designed to do.
Install Packages
q Double-click the '1-Install Packages' script under the R-Scripts node of the Project

Tree and the R-console will open as shown below:
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There are five main panes in the R-console interface:
1. The Database Tables pane facilitates the selection of data from field in the project
database tables based on (or filtered by) a given station or station group. When using
the project data pane, a command that defines the selected data as a (list) vector is
automatically inserted into the R-script Input pane cursor location.
2. The Parameter Data pane facilitates the selection of parameter data from database
tables based on (or filtered by) a given sample set. When using the Parameters pane
a command that defines the selected data as a (list) vector is automatically inserted
into the R-script Input pane cursor location.
3. The Query Data pane facilitates the selection of a field from the results of a specified
query. When using the Query Data pane a command that defines the selected data
as a (list) vector is automatically inserted into the R-script Input pane cursor location.
4. The Input pane is where the R-script itself is written. The Project data and
Parameters panes can be used to facilitate the creation of data variable, and the Rscript associated with these data will be automatically added to the input section.
5. The Output pane records the results or output of the R-script as it is processed and
reports errors encountered when running a script (if any)
The '1 - Install Packages' script is quite basic and will not require the use of the Project
Data or Parameters panes. Take a moment to review the script and you will see that it simply
is designed to install the following packages/libraries:
· 'ggplot2' package - Create Elegant Data Visualisations Using the Grammar of
·
·
·
·
·
·

Graphics
'leaflet' package - Create Interactive Web Maps with the JavaScript 'Leaflet' Library
'dplyr' package - A Grammar of Data Manipulation
'miscTools' package - Miscellaneous small tools and utilities
'Kendall' package - Kendall rank correlation and Mann-Kendall trend test
'corrplot' package - Visualization of a Correlation Matrix
'viridis' package - Creates a color ramp for data visualization

Note once more that all lines beginning with a '#' are comment lines and simply provide
some context/explanation as to what the script is meant to accomplish. You can find more
information about each of the packages by visiting the URL provided in these comment lines,
which will bring you to the associated page of each package at the R Foundation website.
q For now, simply click the 'Run' [

] button in the toolbar which will execute the 'Install

Packages' script.
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Please Note: If you receive an error at this point, this likely
means that you do not have write access to folder where the
R package installs a targeted. If this is the case, please
follow the steps in the Installing R section guide; in particular,
see step 3.

Since these packages have not been installed previously, you will see a 'Secure CRAN
mirrors' window open, as shown below:

This window allows you to choose from a number of secure mirrors which host the packages
that you are trying to install.
q Select the appropriate mirror for your location
q Click the 'OK' button at the bottom to start installing each of the packages.

After a few moments the script should finish running, and you will see a message in the
Status Bar at the bottom of the 'Output' section indicating that the script ran successfully:

Statistical Analyses
Now that the packages/libraries required for the two remaining scripts have been installed,
you can proceed to the second script.
q Double-click the '2 - Statistical Analyses' script in the Project Tree and you should

see the following:
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The Statistical Analyses script is designed to fetch a set of major ion data (Ca, K, Na, Cl, Mg,
and HCO3) from the 'MW-3 samples' sample set and perform a series of statistical analyses
on that data. The highlighted portion of the script in the image above is the location in the
script where the MW-3 sample set data is assigned to the variable input for the script. You
may notice that these lines have been commented out (i.e. the "#" character has been added
to the first column in those lines of the script) so that the R-Console will ignore these lines
when running the script. For this part of the tutorial, you will recreate the data variable
assignments for the Sample Name, Sample Date, Ca, K, Na, Cl, Mg, and HCO3 using the
interface.
q To start, make sure that the cursor lies on line 29 (just below the commented out

variable assignment block):
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q In the Parameters section select the 'Sample Parameters' parameter group, which

allows you to select sample metadata (e.g. Sample 'Name'):

q Double-click the 'Name' parameter in the Sample parameters list, and the following

'New parameter variable' window will appear:
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q In this example we are ONLY interested in sample data from the 'MW-3 samples'

sample set, so click the
button under the 'Sample set' area (highlighted in
the image above), to open the 'Sample set picker' window. Select the 'MW-3 samples'
set, as indicated in the image below and click

:
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q Back in the 'New parameter variable' window, change the 'Variable name' to 'Sample'.

The 'New parameter variable' window should now indicate that you are selecting a new
variable called 'Sample' from the 'MW-3 samples' sample set:

q Click

and you will see a new line of script is added to the 'Input' section,
effectively matching the first commented line:

You must now repeat these steps for the rest of the required data. Retrieve the 'SampleDate'
data field from the 'Sample parameters' group in the same manner (making sure to change
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the sample set to 'MW-3 samples'), and you should see the script updated with a new line for
SampleDate as shown below:

Next you can retrieve the calcium (Ca) data. In the Parameters section change the
parameter group to 'Analyzed Parameters' and repeat this selection process (once again
making sure to change the sample set to 'MW-3 samples'). You can leave the default units
of 'mg/L', as shown in the image below:

q Repeat the parameter selection for K, Na, Cl, Mg, and HCO3, and finally your script

should look like this:
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#
Sample = c(SAMPLE[Name,SampleSet(6)])
#SampleDate = c(SAMPLE[SampleDate,SampleSet(6)])
#
Ca = c(PARAMETER[Ca,Unit(mg/L),SampleSet(6)])
#
K = c(PARAMETER[K,Unit(mg/L),SampleSet(6)])
#
Na = c(PARAMETER[Na,Unit(mg/L),SampleSet(6)])
#
Cl = c(PARAMETER[Cl,Unit(mg/L),SampleSet(6)])
#
Mg = c(PARAMETER[Mg,Unit(mg/L),SampleSet(6)])
#
HCO3 = c(PARAMETER[HCO3,Unit(mg/L),SampleSet(6)])
Sample = c(SAMPLE[Name,SampleSet(6)])
SampleDate = c(SAMPLE[SampleDate,SampleSet(6)])
Ca = c(PARAMETER[Ca,Unit(mg/L),SampleSet(6)])
K = c(PARAMETER[K,Unit(mg/L),SampleSet(6)])
Na = c(PARAMETER[Na,Unit(mg/L),SampleSet(6)])
Cl = c(PARAMETER[Cl,Unit(mg/L),SampleSet(6)])
Mg = c(PARAMETER[Mg,Unit(mg/L),SampleSet(6)])
HCO3 = c(PARAMETER[HCO3,Unit(mg/L),SampleSet(6)])

This demonstrates the power of the R-console module within Hydro GeoAnalyst, which
facilitates the selection of sample data and the automatic scripting of the data into a new
vector data object.
At this point you can click the 'Run' [
] button in the toolbar to execute the script, but it is
recommended that you take some time to review the entirety of the script before you do.
Each portion of the script is explained through annotation within the script itself, so this
tutorial doesn't review everything in fine detail. However, a short description of each 'section'
of this script is provided below:
· Description section - the first section (Lines 1-16) provides a basic description of the

script, invokes the required libraries, and sets the the name of the output file. Please
note that by default in Hydro GeoAnalyst the location of output data will be in the
'Scripts' sub-directory in your project folder.
· Get Sample Data - the 2nd section (Lines 17- 45) is the section we have just worked

on above. This section retrieves the desired data from the project database. The final
portion of this section combines the new data vectors into a 'data frame' (i.e. table) and
writes the data frame to an output data file (i.e. Stats2.CSV)
· Calculate Basic Statistics - the 3rd section (Lines 46-92) uses the new data vectors

and calculates basic summary statistics (i.e. mean, standard deviation, coefficient of
variation, max value, quantiles (75%, 50%, 25%) and minimum values) for the water
quality parameters (Ca, K, Na, Cl, Mg, CO3 and HCO3). These summary statistics are
written to vectors using the 'get_stats' function, and these vectors are then appended
to the output file (i.e. Stats2.CSV)
· Estimate Mann-Kendall Trends - the 4th section (Lines 93-173) uses the functionality

of the 'Kendall' package to calculate the Mann-Kendall trend statistics for each of the
water quality parameters. A function ('res') is then scripted to determine if there is an
'increasing', 'likely increasing', 'decreasing', 'likely decreasing', 'stable' or 'no trend' for
each a parameter. Once again, the results of the trend test are then appended to the
output file (i.e. Stats2.CSV)
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· Correlation Statistics - the 5th and final section (Lines 174-198) calculates a

correlation matrix between all available water quality parameters and then plots the
results into three separate correlation matrix plots.
q Click the 'Run' [

] button and a couple of things will happen as the script is
executed. First, you should see that the script ran successfully as indicated under the
'Output' section:

You should also see a new window entitled 'R-Graphics' appear. You can click the 'Page
Up' and 'Page Down' buttons on your keyboard to scroll between the available correlation
plots, as shown below:

q And finally, if you navigate to the 'Scripts' folder within the Hydro GeoAnalyst Demo

Project folder, which should be the following assuming you have followed along with
the default settings:
C:\Users\[username]\Documents\Hydro GeoAnalyst\Projects\HGA Plus Demo\Scripts
you should find a new file called 'Stats2.CSV' as shown below. The output file
contains the results of the 'Get Sample Data', 'Calculate Basic Statistics' and
'Estimate Mann-Kendall Trends' sections of the script described above:
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You can close the resulting output file and plot windows and proceed to the third and final
script.

Plotting and Mapping
q Double-click the script '3 - Plotting and Mapping' from the Project Tree and you

should see the following:
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The Plotting and Mapping script is designed to fetch a set of station data from the Station
Data table and perform some mapping and plotting based on that data. You will notice that
the highlighted portion of the script in the image above is another variable assignment block
that is similar to the block in Script ''2 - Statistical Analyses'. The variables in this block have
been assigned using the "Project Data" pane interface. In this part of the tutorial, you will
assign data variable definition commands for the Station Name, X, Y, Latitude, Longitude,
Elevation and Geology list variables.
q To start, make sure that the cursor lies just below the line that reads:

# Type = c(TABLE[station(stn_type),StationGroup(-1)])

as highlighted in the script below:
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q Next, in the Project data section, expand the 'Description' data category and further

expand the 'Station' table.
q Double-click the 'Station Name' data field and the 'New field variable' window will

open as shown below. The default variable name (i.e. 'Name') will suffice, and if the 'All
Stations' station group is not already active, please ensure that you specify it by
selecting the 'Specific station group' option:
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q Click

and you should see the new vector of station data added into the
script as shown below, effectively recreating the first line in the 'Get Station Data'
portion of this script:
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q Repeat these steps to create a new data object for the X, Y, Elevation [Elev], and Type

[Type] fields.
Please Note: make sure to rename the variable to the name in [square brackets]
above (i.e. the same variable as indicated in the original script)

Once you have selected all the necessary data fields the script should look like the image
below:
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This demonstrates the power of the R-console module within Hydro GeoAnalyst, which
facilitates the selection of Station Data table fields and the automatic scripting of the data
into a new vector data object.
At this point, you can click the 'Run' [ ] button in the toolbar to execute the script, but it is
recommended that you take some time to review the entirety of the script before you do.
Each portion of the script is explained through annotation within the script itself, so this
tutorial doesn't review everything in fine detail. However, a short explanation of each 'section'
of this script is provided below:
· Description section - the first section (Lines 1-21) provides some basic description of

the script, invokes the required libraries and sets the 'working directory' (i.e. the name
of the output file). Please note that by default in Hydro GeoAnalyst, the location of
output data will be in the 'Scripts' folder within the Hydro GeoAnalyst project folder.
· Get Station Data section - the second section (Lines 22-38) is the section we have

just altered in order to retrieve the necessary station data fields. The final portion of
this section combines the new data vectors into a 'data frame' (i.e. table) and writes
the data frame to an output data file (i.e. Stations.CSV).
· Map It! section - the third section (Lines 39-51) relies on the functionality of the

'leaflet' library to map the station data to a web-page. When this section of the script is
run, a new tab will open in your default web-browser displaying the location of the
project stations with a legend and inset map.
· Plot It! section - the fourth and final section (Lines 52-117) relies on the functionality

of the 'ggplot2' library to create five different charts. chart1 and chart2 plot the X vs. Y
data and X vs. Elev data, respectively. On Lines 66-69, some additional sample data
(i.e. Na and Cl data from station MW-3) is retrieved and plotted in three additional
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charts: 'chart3' displays the Cl concentrations at MW-3 over time, 'chart4' provides a
scatter plot of Cl vs Na data at MW-3, and 'chart5' displays both Na and Cl
concentrations over time (and includes 'regression' lines).
q Click the 'Run' [

] button and several things will happen as the script is executed:

o First, you should see that the script ran successfully as indicated under the 'Output'
section.

o Secondly, if you navigate to the 'Scripts' folder within the Hydro GeoAnalyst Demo
Project folder:
C:\Users\[username]\Documents\AquaChem\Projects\AQC 9 Demo\Scripts
you should find a new file called 'Stations.CSV' as shown below. The output file
contains the results of the 'Get Station Data' section (i.e. Station Name, X, Y,
Elevation, Latitude, Longitude and Geology data):

o Third, a new tab should open in your default internet browser with the results of the
Map It! section. You should see all five of the stations from this project displayed
within the associated map (all stations are located in Waterloo, Ontario, Canada). If
you click on any of the stations, a small info bubble will appear to display the station
name and geology designation, as shown below:
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Please Note: this is a fully interactive map of the world. Feel
free to zoom in and out, scroll around, etc. You may also
notice the map inset in the lower right corner of the map
which may be useful when you need to view the map at
different scales of interest.

q And finally, you should also see a new window 'R-Graphics' appear. You can click the

'Page Up' and 'Page Down' buttons on your keyboard to scroll between the available
correlation plots, as shown below:
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Once again, it bears repeating that this tutorial is not a comprehensive introduction to the R
scripting language. By reviewing the basic scripts included in the HGA+ Demo Project, you
may be able to learn how to apply some of these scripts to your own projects. However, it is
highly recommended that you study the available resources at the R Foundation website in
order to better familiarize yourself with R.

- This concludes the HGA+ Demo Project tutorial ©2022 by Waterloo Hydrogeologic
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In order to review other components of in Hydro GeoAnalyst, you may wish to review topics
in the HGA Demo project section as well. You can continue with the section on Querying.
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Fundamental Concepts
Before beginning to work with Hydro GeoAnalyst (HGA), you may want to review the topics
in this section to get an understanding of the fundamental concepts of the program. This
might help you become more proficient with the software in less time.
The topics go through the basic concepts of the program as well as main the HGA interface,
including the various modules available to you. The topics also provide you with an
introduction to entering data: manually, importing data, and using the EDD workflow which
helps you to validate your data before importing it into the database.

Learning more
The Fundamental Concepts section provides an
introduction to key concepts that will help you get
the most out of Hydro GeoAnalyst.
Ø See Hydro GeoAnalyst Interface: for a basic

introduction to the interface.
Ø See Data Structure: to understand how your

data is stored in an HGA project.
Ø See Stations: to understand the fundamental

nature of stations and location in the HGA
environment.
Ø See Data Entry: to see how to add data in

your database
Ø See EDD Workflow: to see how to efficiently

integrate external data from a variety sources
Ø See Print To Office Templates: to see how to

quickly generate standardized reports
Ø See Spatial Geo_Point

HGA+ includes additional features and associated
concepts:
Ø See Data Structure in HGA+: to understand

the specific data structure and categories in
HGA+
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Ø See Samples: to understand the added value

of the sample structure in HGA+
Ø See Parameters to understand how to work

with your analytical data
Ø See Projections to understand how projection

systems are used in the mapping features of
HGA+
Ø See Chemical List: to understand how you can

standardize your parameters across projects
Ø See Measurement Units: to understand how to

convert measurement units on-the-fly
Ø See Functions: to see the automatic

calculations that are performed by HGA+
Ø See Upgrading Projects to HGA+: to learn

how to upgrade your projects from the
standard edition of HGA to HGA+
The Demo Project Tutorials will provide you with a
quick start introduction to many of the features
available in Hydro GeoAnalyst:
Ø If you are using HGA, start with the HGA

Demo Project Tutorial
Ø If you are using HGA+, start with the HGA+

Demo Project Tutorial

4.1

Hydro Geo Analyst Interface
This section describes the layout of Hydro GeoAnalyst and how to navigate in it.
Hydro Geo Analyst Layout
The Hydro GeoAnalyst interface is composed of several controls:
· Menu Bar: Contains menu commands with access to most features that are available

in Hydro GeoAnalyst.
· Module Toolbar: A toolbar that contains short-cut buttons for the most frequently used

features in Hydro GeoAnalyst.
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· Project Explorer: Hosts the Project Tree view listing the major components of your

project as well as the Station Picker and Sample Picker.
· Station Picker: Allows you to select groups of station(s) or sample(s) that are used to

display and work with data in other modules, tabs, and plots.
· Sample Picker [HGA+ only]: Allows you to selection groups of samples
· Workspace Tabs: Provides access to the various views, modules, and components of

Hydro GeoAnalyst projects including: the Station List, Sample List, Plot Collections,
and R-Console.
· Main Workspace: Contains the workspace for the current view.
· Workspace Toolbars: Contain icons for the main options you can perform with the

current view in the workspace.
· Status Bar: Displays the program status.

Once a project is loaded, the main window will appear; the HGA demo project is displayed
below:

You also have the option to move tabs around and place them where you like. The default
configuration is to have one tab group for the Project Tree and one tab group with the rest of
the tabs (station list, station data, etc.). However, you can have more tab groups – vertical or
horizontal. You can find these options by right clicking on a tab. Then you can just drag and
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drop the tabs where you prefer them! Here is an example configuration that you might like to
use. You can also undock tabs so that you can make use of multiple monitors.

Project Explorer
The Project Explorer is one of the main navigation tools in the Hydro GeoAnalyst interface.
It is composed of the Project Tree, the Station Picker and the Sample Picker. The main
toolbar of the Project Explorer contains the following commands:
refreshes the Project Explorer from the project database
combines the Project Tree tab with the Station and Sample Picker tabs
separates the Project Tree tab from the Station and Sample Picker tabs
docks the Project Explorer to the left of the main workspace
docks the Project Explorer to the right of the main workspace
toggles the visibility of the Project Tree
toggles the visibility of the Station Picker
toggles the visibility of the Sample Picker

You can hide/show the Project Explorer by selecting the double blue arrows (
between the Project Explorer and the Main Workspace.

) located
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Project Tree
Th project tree allows you to organize and navigate through the data and related
components in your project:

Project Tree Elements:
·
·
·
·
·
·
·
·
·
·
·
·
·

Station Groups
R-Scripts*
Sample Sets*
Sample Reports*
Queries
Well Profile Templates
Cross-Sections
Map Projects
Scenes
Report Editor Reports
Office Reports
Online Sharing
Plot Collections

Note: * denotes a feature on the project tree branch that is only
available in HGA+

Each item is organized as a branch in the tree view with one or more items under each
branch. By double-clicking an item in the Project Tree you will either activate the appropriate
tab or launch appropriate module to view this item. The following options are available in the
Project Tree Toolbar:
collapses all branches in the Project Tree.
expands all branches in the Project Tree.
the search bar filters the project tree to items (and their parents) that contain your
search string.
clears the search filter.
You can organize any of the branches of the Project Tree (except for the Reports branch as
it has it requires its own structure) by creating folders to group the items under the branch.
Simply right click the branch and select Add Folder... . Provide a name for the folder and
then you can drag and drop items from that branch into the folder.
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Station Picker
The Station Picker displays a list of the stations in the currently active station group and
allows you to select the active station to display in relevant tabs (e.g. the Station List and
Station-Data Tab). The active station is highlighted in blue and denoted by the
symbol. It
is set by clicking on a station in the station picker. To change the active station group
double-click on the station group in the Project Tree.

Sample Picker [HGA+ only]
The Sample Picker displays a list of the samples in the currently active sample set and
allows you to select sample(s) to display in relevant tabs (e.g. Sample List View and Plot
Collections). Selected samples are highlighted in blue and the active sample is denoted by
the
symbol. You can select a single sample using the left mouse button. Multiple
samples can be selected using the left mouse button with the <SHIFT> or <CTRL> keys. To
change the active sample set, double-click on a sample set or station group in the Project
Tree.
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Station Groups
In Hydro GeoAnalyst, stations can be sorted into groups allowing for efficient management
and quick retrieval of data stored in the database. All station groups created for a project are
listed in the Project Tree under the Station Groups node. Double clicking on any of the
branches corresponding to a station group will load the Station List tab, and display the
appropriate stations belonging to that group. There are three kinds of Station Groups in
Hydro GeoAnalyst:
All Stations: This station group is in all projects and all stations that are entered
(manually or by import) into the project will be found in this station group. You can not
delete or rename this station group.
Static: Select one or more stations directly in the Station List tab, right-mouse click,
and select the Add to [New/Existing] Station Group option from the pop up menu.
Dynamic: Using the Query Builder, you can build a dynamic station group by defining
define search criteria, which results in a list of stations that satisfy the query criteria.
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Once the stations in a group are displayed, a number of operations can be applied based on
the selection. To find out more about Station Groups please refer to Station Groups section
of the manual.

Sample Sets [HGA+ only]
Similarly, samples can be grouped into Sample Sets allowing you to easily manage, retrieve,
and work with specific and meaningful groups of samples. Sample sets created for a project
are listed under the Sample Sets node in the Project Tree. Double clicking on any of the
branches corresponding to a station group will load the Station List tab. There are three
kinds of Sample Sets in Hydro GeoAnalyst:
Static: Select one or more samples directly in the Sample List view, right-mouse
click, and select the Add to [New/Existing] Sample Set options from the pop up menu.
Dynamic: Using the Query Builder, you can build a dynamic sample set by defining
define search criteria, which results in a list of samples that satisfy the query criteria.
Stations: Station groups are also implicitly sample sets as they also refer to
all of the samples collected at the stations within that station group. Note that by
definition, the
All Stations station group includes all samples in your project.
To find out more about Sample Sets please refer to Sample Sets section of the manual.

Modules
The Hydro GeoAnalyst interface is organized into modules, which are core components of
the application that help you perform specific tasks. For example: that Data Import module
allows you to import data, the Plot Collection module allows you to build plots, etc. A
complete list of modules and links to their relevant topics is presented in the Modules section
of the manual.
Toolbars
There are different tool bars available within the program - the Module Toolbar which
provides quick access to Hydro GeoAnalyst Modules and the Workspace Toolbar which
provides access to common tools and features within each module.

Module Toolbar
The top toolbar with the larger buttons is the main toolbar and provides quick access to the
various views and modules available in Hydro GeoAnalyst. The default toolbar is shown
below; however, the main toolbar is configurable via the Module Manager options in the
Hydro GeoAnalyst Settings:
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Template Manager

Scene Viewer 1

Import Data

User Manager

List Editor

Event Planning

Material Specification
Editor

Quick Checker

Station List

Sample List 2

Station Data Tab

Sample Analysis
Viewer 2

Non Station Data Tab

Parameter Editor 2

Data Filter

Parameter Group
Editor 2

Query Builder

Plot Collections 3

Query Results

Map Viewer 3

Well Profile

R-Console 2

Cross Section Editor 1

AquiferTest
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Map Manager 1
1

only available in 32-bit editions of HGA/HGA+

2

HGA+ only

3

functionality extended in HGA+

Workspace Toolbar
There are also toolbars available on the individual tab groups specific to the actions you may
wish to perform on the data contain within the tab group. Below is the general tool bar found
on most tab groups:

It provides options to add a record and delete items (typically a record) as well as save any
edits made by committing changes to the database. There is also typically an option to
show/hide columns, refresh the data from the database, export data (usually as a table), or
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print the data to a formatted template file. By placing your cursor over any of the icons in the
tool bars you will find a tooltip indicating what the button does.

Data Filtering
Hydro GeoAnalyst has many tabs, windows, and views that include data tables and provides
helpful options allowing you to filter your data so that you can quickly find the information
that you need - the first row on any data grid is the filter row (shown in light blue). You can
filter by unique values; if the field contains date values, the values will additionally be
filterable by groups of year, month, or day:

Filtering By Unique Values

Numeric Field

Text Field

Date Fields

You can also filter by using a relational condition, as shown below:
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Filtering by Relational Conditions

Numeric Fields

Text Fields

Date Fields

In some cases, you will be able to filter data using generalized conditions:
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Adjustable Windows
When opening an HGA project for the first time, the default window displays will appear.
There are two groups, the Project Explorer on the left and the main workspace on the right,
which typically includes one or more of the following tabs:
·
·
·
·
·
·

Start Page
Station List
Sample List [HGA+ only]
Station Data
Data Query
Data Filter
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The tabs which appear on project open can be configured in the Module Manager which are
part of the HGA Settings.

Tab Groups and Undocked Windows
You have several options to adjust the view of these groups. You can add additional groups
(right-click on any existing tab) either vertical or horizontal. Several of the modules within
Hydro GeoAnalyst will launch as a tab (e.g. Query Builder, Well Profile, List Editor, Material
Specification Editor, Event Planning, etc.)
Tabs can be organized in any of the following ways:
· Reorder tabs within a group by simply dragging and dropping a tab to the position

you'd like.
· Move a tab to a new window or tab group by dragging and dropping the tab at the

desired location
· Right-click on the tab to select available options:

Here is an example of another way to organize your windows:
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Data Structure
The Hydro GeoAnalyst data structure is described below:
Data Concepts
The following concepts are fundamental to working with HGA:
· Stations are records that represent a single location with an X- and Y-coordinate,

often including associated metadata. Examples of stations would include groundwater
monitoring wells or fixed locations along a stream. These are designated by a unique
identifying code (Station ID), such as MW-01 for a monitoring well, or SW-01 for a
surface water sampling location although for larger projects with multiple sites and/or
long histories, longer codes are often required. The Station Picker can be found in the
lower left quadrant of the interface (by default) and allows you to select which
Station(s) and by extension which associated Samples are currently selected and used
in various parts of the interface.
· Samples are records that represent unique events where one or more physical

measurements and/or analytical samples have been collected at a given location.
Samples must be associated with an existing Station (using the Station ID) and
typically also include associated metadata, such as the sample collection date, time,
and the name(s) of who collected the sample. In HGA, samples must be identified
using a unique identifying code (Sample ID); however, a given Sample will often be
associated with multiple physical samples collected from the same location (Station)
during the same sampling event. For example, when collecting physical samples from
a given location, different analyses will often require different collection and
preservation methods: samples may include measurements from hand-held devices
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for pH and temperature in addition to physical samples collected for metals analyses,
which are typically pre-filtered to plastic sample containers and preserved with acid or
physical samples collected for organic compound analyses, which are typically notfiltered and filled into glass containers with no head-space. These individual physical
samples should share a common Sample ID so that the results for the various
measurements and analytical results can be correlated.
· Results are records that represent the value and associated data for a single

parameter and associated metadata such as quality assurance/quality control flags,
data validation flags, method detection limits, etc.
· Parameters are the types of measurements and observations that are included

included in the project (for example: temperature, pH, and the concentration of
Calcium are individual parameters). Each parameter must be uniquely named and has
a designated measurement unit. HGA also stores other optional metadata about
parameters, including molecular weights, valence, and CAS numbers.

HGA Relational Database and Simplified Data Model
The information described above is stored in HGA using a structured format in a SQL
relational database. The relational database organizes data into several tables consisting of
columns and rows, with a unique key (e.g. a unique sample ID) that identifies each row.
Rows in a data table are typically called records; while columns are typically called fields.
· Tables store information about specific entity types with common data attributes. For

example, separate tables store information about stations, samples, and results.
· Records represent individual entities (e.g. a specific environmental sample).
· Fields store specific attributes about each record in that table (e.g. sample collection

date).
· Keys are fields that store a unique attribute that is used to identify a record (e.g.
sample ID) that allow you to retrieve information about that record.
One table can can be related to a second table by including the key of the first table as an
attribute in the second (For example, the sample table includes the unique Station ID). A
simplified version of the tables and their relationships is shown below:

Simplified Station>Sample>Result Structure of HGA+
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If you are comfortable working with databases, you can explore the complete data structure
using the Template Manager module. You can also explore the data structure in SQL
Management Studio; however, this is not recommended for all but the most experienced
users to avoid corrupting the Hydro GeoAnalyst data structure. If you chose to work in SQL
Management Studio as well, it is strongly recommended that you first backup your data so
you can recover your project in case it is corrupted.

Data Categories
The tables in an Hydro GeoAnalyst database can be organized into a logical grouping by
placing them into a data categories. HGA provides several data categories, which might be
considered common data categories found for environmental data. However, you can create
as many categories as you wish within the Template Manager. This way you can completely
customize the way in which the tables are organized within HGA. The default template in
HGA provides the following data categories:
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Many of these categories and data tables are designed to work with the modules in HGA.
These structures are flexible and can be reconfigured; however, certain fields cannot be
altered - you will be warned if you attempt to alter these in the Template Manager.
Otherwise, you can edit, delete, and create as many categories, tables, and field as you wish
using the Template Manager. In this way, you can customize how the tables are organized.
Categories of tables that are linked to the Stations using the Station ID, can be accessed by
selecting the Station Data tab and selecting the Data Category combo box (ensure that one
or more stations are selected in the Station List tab):
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After a Data Category has been selected, the appropriate tables and fields belonging to this
category will be displayed in the Station Data tab. All of the data categories may be renamed
and used differently if desired. Placing tables under any one of these categories does not
have any effect on how the tables are stored in the database.

4.3

Stations
Stations are records that represent a single location with an X- and Y-coordinate, often
including associated metadata. Examples of stations would include groundwater monitoring
wells or fixed locations along a stream. These are designated by a unique identifying code
(Station ID), such as MW-01 for a monitoring well, or SW-01 for a surface water sampling
location although for larger projects with multiple sites and/or long histories, longer codes are
often required. The Station Picker can be found in the lower left quadrant of the interface
(by default) and allows you to select which Station(s) and by extension which associated
Samples are currently selected and used in various parts of the interface.

Station Table
The Station Table stores all the station location information for all projects residing in the
database. The Station Table may contain an unlimited number of fields. Though, at a
minimum, the Station Table must contain the following fields:
·
·
·
·
·
·

Station ID (ID)
Station Name (Name)
Station Coordinate (X)
Station Coordinate (Y)
Station ground surface elevation (Elevation)
Top of Casing (TOC)
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Unless your project uses a local coordinate system, the station coordinates are stored in the
Stations Table as latitude (Y) and longitude (X) using the WGS84 datum. However, each
project may contain its own projection and coordinate system settings, so that station
locations may be entered and displayed in an alternate format (e.g. UTM Zones or State
Plane, etc.).

Please Note: Hydro GeoAnalyst supports storing and
displaying spatial data in a local coordinate system (or site
coordinates). There is no need to adapt your spatial data to
world coordinates, if you prefer to work in local site
coordinates.

Stations can be added, modified, or deleted through the Station List tab. The Station List
displays information about the station; whereas the Station Data Tab can be used to show
additional information that links back to the current station (e.g. all samples collected at that
station), as shown below:

Station Groups
Many operations in Hydro GeoAnalyst require the selection of one or more stations. An
example of such an operation is data entry. One or more stations for which you would like to
add, view, and/or modify data need to be selected so that the Station Data Tab is accessible
(activated).
The complete list of stations that comprise a project can be viewed in the Station List tab by
selecting the All Stations item, under the Station Group node in the project tree. By default,
all projects will contain a station group named All Stations that lists all stations in the
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database belonging to the project. However, for some of the tasks commonly performed in
Hydro GeoAnalyst, retrieving the complete list of stations in the project may not be
necessary. Moreover, retrieving all the stations when only few of them are needed may be a
time-consuming process especially for large databases containing hundreds or thousands of
stations.
The solution is to create Station Groups. Grouping stations into their logical groups allows
efficient management and quick retrieval of data stored in the database. For instance, all
stations which contain isotopic sampling data can be grouped together under a group named
as Isotope Sample Locations. Whenever these stations need to be updated with a new
groundwater sampling round, selecting the Isotope Sample Locations group displays only
those stations that belong to this group.
Station groups can be created based on any criteria. Common examples include:

· Locations of the stations (e.g. locations categorized by City, Project Site, watershed,

etc.)
· Station type (e.g. Surface/Groundwater Monitoring Locations, Boreholes, etc.), or
· Purpose of Study (e.g. remediation, site monitoring)
There are three kinds of Station Group in Hydro GeoAnalyst:

All Stations: This station group is in all projects and all stations that are entered
(manually or by import) into the project will be found in this station group. You can not
delete or rename this station group.
Static: Select one or more stations directly in the Station List tab, right-mouse click,
and select the Add to [New/Existing] Station Group option from the pop up menu.
Dynamic: Using the Query Builder, you can build a dynamic station group by defining
define search criteria, which results in a list of stations that satisfy the query criteria.
All Station Groups created for a project are listed in the Project Tree under the Station
Groups branch. Double-clicking on any of the sub-branches corresponding to a Station
Group will load the Station List tab, and display the appropriate stations belonging to that
group. An example is shown below.
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If desired, selected stations can be removed from a static station group or the Station Group
can be deleted as a whole. To remove stations from a static station group, simply select the
stations (by highlighting the row) and then select the delete button - this will remove the
station from the station group - but will not delete the station from the database. To delete a
station from the database you must first select the All Stations station group - and delete the
stations from there.
To delete an entire station group right click on the station group in the Project tree and select
delete.

4.4

Data Entry
Manual Data Entry
You can manually enter and/or edit data in the following tabs:
HGA and HGA+
· Station List
· Station Data
· Non Station Data
· List Editor
· Material Specification Editor
HGA+ only
· Sample List
· Water Quality Standards
An example of manual edits is shown in the image below:
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Refreshing the database
Before making edits to the database, it is generally a good practice to make sure you have
the latest information from the project database. You can reload/refresh a table by clicking
the refresh button ( ).

Editing an Existing Record
To edit an existing record, simply click in the whichever record(row)/field(column) you would
like to make your edit(s) and type or paste the updated value(s). Any records that you edit
will be highlighted yellow ( ).

Adding a record
To add a record (row) to a table, click the add button ( ) within one of the above tabs. New
(and edited) records will be highlighted yellow ( ), and the new record must be saved using
the Save button ( ) before they are committed to the database. Furthermore, you must
save records from a parent table before related data can be entered into any child tables.
For example, you must save a new station record before you can add new samples to the
station, and new sample records must also be saved before result data can be added to that
sample.

Saving Edits
Edits (i.e. newly added or edited records) to a given view or table are only realized when they
are saved/committed to the the project database. To commit your edits, you must click the
save button ( ). Note that the save operation cannot be undone.

Discarding Edits
Edits can be effectively discarded by clicking the refresh button (
reload the table/view from the project database.

) before saving; which will
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Import Data
It may be more efficient to import the data using the Import Data Module. The Import Data
Module give you several options for importing your data:
· The Samples option is only available in HGA+ and should be used to import analytical
·

·
·
·
·
·

data into the HGA+ data structure which manages parameters and units for the the
Sample and Plot module features.
The General option should be used when you are importing general tabular data. The
general option is particularly recommended when you are importing stations as it will
perform coordinate transformations. Additionally, you may convert data units during
your import using the General option.
The EDD option lets you import the files that have been validated within our Quick
Checker program.
The Mobile EDD option lets you import data that has been submitted through a Mobile
EDD form.
The Diver option is available to import pressure transducer data Diver dataloggers.
The LAS is available to import Log ASCII Standard (LAS) files, a standard format
introduced by the Canadian Well Logging Society in 1989.
The Images option is available to import pictures of stations.

For more details on how to import data using the Import Data module, please refer to the
Importing Data section.

4.5

EDD Workflow
The EDD (Electronic Data Deliverable) workflow provides an efficient way of getting
validated data into HGA. The workflow includes the following three steps:
1. EDD Template Designer
2. Quick Checker
3. EDD Import
Additionally, there is an option to make Mobile EDDs so that you can use EDDs on mobile
devices like tablets and smart phones.

4.5.1

EDD Template Designer
You can find this option by selecting Modules > EDD Template Designer from the main
menu. In this first step of the EDD Workflow, you can create a template (which can be
opened in the Quick Checker) for others to use to validate their data.
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Building the EDD Template
EDD Templates are built by adding a set of desired fields to the Template Format pane in
the middle of the EDD Template Designer window.

Adding a Field or Table
To add a field to the EDD Template:
· selecting a field (or table) and clicking the add [ ] button
· dragging and dropping a field onto the Template Format pane
· double-clicking on a field

The list of available fields on the left are provided as you would be used to seeing them in
the Template Manager or the Query Builder. First branch are the Data Categories, next
branch are the Tables, and the final branches are the fields. As you drag and drop fields into
the Template Format section, you will notice that other fields may show up there
automatically and are shown in bold font. These bold fields include required information
necessary to import the data into the select table.
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Template Version Number
You can set a version number to manage and track changes to the structure of a template
as the project progresses. The QuickChecker and the EDD Import routine will verified that
that the current EDD template is the most up to date version of the template if a submission
link (see below) is also provided. Reloading a template from a file [ ] will automatically
increment the template version number by one so that if you make any changes to the
template, the new version number will be captured in the edits.

Submission Link
A submission link can be set as an email address or as a URL to an (S)FTP folder. The EDD
template and EDD submissions will be sent to this location.

Conditions
Additionally, you can add conditions onto the fields you have chosen that the Quick Checker
will verify. Simple For example – you can make the Sample Date field required (even though
it is not a required field to enter the data into the database). Also there is an option for more
Advanced Conditions - here you can enter a numerical range of allowable values.

4.5.2

Quick Checker
The Quick Checker is a tool to help you organize your data from spreadsheets into a format
ideal for importing into your database and then validate it before importing it into the
database.
The Quick Checker module is an important part of the overall EDD workflow, which includes
four simple steps:
· Create a new Electronic Data Deliverable (EDD) template using the EDD Template

Designer
· Open the EDD template and the source data file within the Quick Checker
· Use the Quick Checker to validate your data against the EDD template and generate a
*.zip_hga import file
· Import the *.zip_hga directly into Hydro GeoAnalyst; data mapping and validation has
already been completed by the Quick Checker
The Quick Checker can launch as a module from the main toolbar by selecting the
button on the main Hydro GeoAnalyst toolbar.
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Standalone Version
You can install the Quick Checker as a stand alone application for use on computers that do
not have Hydro GeoAnalyst installed or licensed, including external project stakeholders
such as subcontractors, analytical labs, or support teams. The standalone installation can be
downloaded from the Waterloo Hydrogeologic website at
https://www.waterloohydrogeologic.com/support/getting-started/ and finding the
Hydro GeoAnalyst Quick Checker link:

The standalone version allows project partners (i.e. field personnel, analytical laboratories,
and subcontractors) to use the Quick Checker without requiring a full license of Hydro
GeoAnalyst. This allows them to provide you with a single data file (i.e. the *.zip_hga import
file) which is pre-validated and pre-mapped, making it extremely simple for Hydro
GeoAnalyst database managers to import that data.

Opening Quick Checker
When the Quick Checker module is first launched, the window below will open:
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to create a new quick checker file or open an existing one

button and browsing to your saved *.qck file.

The Quick Checker method is based on the following components:
· An EDD template file (*.tmpl), which contains data validation criteria
· A Microsoft Excel data file (*.xls, *.xlsx), which contains the data to be imported
· A Quick Checker file (*.qck), which represents the combination of the EDD template

and Excel data files (i.e. intermediate file type, after import but before validation)
· A validated Quick Checker import file (*.zip_hga), which can be imported directly

into HGA
When creating a new file you will be prompted to select the EDD template file you wish to
use and then you are given the option to either enter data manually or import data from a
selected excel file.
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When choosing to import data from an excel file you will need to map your spreadsheet to
the fields in the EDD similar to the way you map in the General import routine. If your
spreadsheet does not contain one of the fields you have the option to Add empty column so
you can manually enter this data for validation.
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This quickly brings your data into the Quick Checker for validation. You should see a data
tab associated with data table that was included in the EDD template file. You still have the
option to add or edit data after importing the data in. This can be done manually by simply
selecting the desired data field and typing the required values. If the EDD template includes
a 'pick list' for any particular field then the pick list will be displayed when entering values into
that field (e.g. see the 'Color' field in the image below). It's also possible to manually add or
remove rows from the Quick Checker using the 'Add New Row' ( ) and 'Delete Selected
Row(s)' ( ) buttons.
In the following example you can see there are some problems with the data. The tab where
errors occur are flagged (red) and the errors are displayed on the right hand side Error
section. If you double click on an error it will take you to the row containing the error so you
can correct it. Once all errors are corrected the flag will disappear, and the data will then be
ready for validation.
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Under the Quick Checker toolbar you will be able to save the existing Quick Checker file
(*.qck) for future use by clicking the Save button ( ). If you have additional Excel
spreadsheets with further data to be imported you can click the 'Import MS Excel File' button
( ). This allows you to incorporate data from multiple spreadsheets into the Quick Checker
file. It's also possible to export the data contained within the Quick Checker at anytime by
clicking 'Tools' > 'Export to Excel..' from the main toolbar. This will open a Windows Explorer
window, allowing you to select a location and file name for the exported data.
It's also possible to perform data corrections using the 'Find and Replace' tool, which can be
accessed by clicking 'Tools' > 'Find and Replace...' from the main toolbar. This will open the
'Find and Replace' window, as shown below.
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Finally, it's possible to clear all the data currently loaded into the Quick Checker using the
'Clear Data' tool the main toolbar. Selecting the 'Clear Data' tool will open a warning
message, asking if you would really like to clean the grid data. Selecting Yes will clear all
data from the Quick Checker.

Once all of the required data has been loaded, and all data errors have been resolved, you
can then click the 'Validate and Submit' button (
). You will then be
prompted to save your file as a *.zip_hga file which can be easily imported through the
Import Data module. See the EDD Import section for more information about importing the
validated data file.

4.5.3

EDD Import
To launch the EDD Import routine select Modules / Import / EDD. Then specify the location
of the *.zip_hga file that was generated within the HGA QuickChecker.
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Please be aware that you should not attempt to unzip or modify the file in any way as this
can invalidate the file and cause difficulties importing the data.

As soon as the file is validated you will see the Validation Results dialog appear. Here you
may need to answer a question before continuing. For example the Validation found that
some of the station names I am trying to import do not exist in the database – therefore I can
choose to append the new station names or reject records for stations that do not exist. I
make my choice by selecting the appropriate option in the Action column. If I wish to see
which stations are not currently in the database I can select the Click Here to View Data
option. For this example I choose to Append the stations (so any station names in my data
that are not in the database will be automatically added).
Then the validation also found I have duplicates in the database – some of the sample IDs
already exist in the database! Again, I can select what I want to do – either overwrite what is
in the database or reject the duplicate sample IDs. For this example I will reject these sample
IDs.
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Now I can continue with the import. Now the Import dialog is updated – and I can see how
many records will be imported.
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Select the Import button to import the records – and the import dialog updates to inform you
that the import was successful. Now you can select another EDD file to import or close the
dialog box.

4.5.4

Mobile EDD
Within the EDD Template Designer you will now find an option to Publish Mobile EDD. So
instead of using your EDD within the HGA QuickChecker (MS Excel plugin) you can now use
your EDD on a mobile device!
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Create your EDD as you did previously. Select the fields from the various tables that you
wish to collect data for while you are out in the field. Fields where you have created a list
within the List Editor can be used to provide a drop down list in your Mobile EDD.

Please be aware of the following limitations for Mobile EDDs:
· you must include the Station Name from the Location table within your Mobile EDD

template.
· the Advanced option under the Conditions in the EDD Template Designer is not

supported in the Mobile EDDs.
· You are limited to a maximum of 12 tables.

When you are happy with your EDD template select the Publish Mobile EDD button
you will be provided with the following options.

©2022 by Waterloo Hydrogeologic

and

218

Hydro GeoAnalyst 11.0

The default option is to publish this Mobile EDD to our Waterloo Hydrogeologic Web Server
– therefore all you need to do is confirm the name (Web link folder) that will be used – by
default it takes the Project name and the EDD template name.
Or if you prefer you can publish to another Web Server. When publishing to your own
webserver you need to provide the URL, the FTP Host as well as the User Name and
Password.
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You also have an option to publish a station group within your Mobile EDD - you will find this
option on the Additional Data tab - select the station group you wish to publish with the EDD.
This means that the stations in that station group will appear listed in the Home Page of the
Mobile EDD. This can be very helpful if the stations already exist within your HGA project
and you are sending someone into the field to collect data for specific stations. If you do not
use a station group it simply means you will be creating new stations while collecting your
data in the field.
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Note: We recommend using Apple or Android devices using Safari or Chrome as your
browser.
Here is the Litho EDD that comes with the Demo project as a Mobile EDD. The home page
provides you the option to add a new station or submit the data that you have collected. If
the EDD was published with a station group you would find the list of stations from the
station group by selecting the plus button beside Stations.
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When you select Add New Station you are brought to another page showing all the tables
and fields from your EDD Template.
In this example I selected the Lithology tab. Here you will find the fields from the EDD
including the soil type. The soil type field has a list associated with it - and you can see this
list is also available within the mobile EDD to ensure only appropriate values are being
entered.

You can add more records by selecting the Add New button.
Here for example I have added 4 rows:
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Once you have finished collecting your data you need to return to the Home page. You will
find your list of stations - if you select one of the stations you will be returned to the tabs for
that station so that you can edit the data associated with the station. If you select the X
button to the right of the station name will be given the option to delete the station. All
stations by default are marked as "In Progress" - if you wish to submit your data to be
imported into HGA you first need to indicate that you are done collecting the data for the
station by selecting the check box for the station. You will notice that the "In Progress" flag
has changed to "Done".

Only stations which have been designated as Done will be submitted.
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To submit the data select the Submit button.

You need to provide a name for the file that is being submitted – please note that the date
will be automatically added to the name you provide.
You also have the option to Remove Done stations from memory after sending. This will
remove the data from the device after it has been submitted. This way you can submit your
data throughout the day (when you have a wifi connection) and carry on with collecting
additional data.
When you return to the office you can import this data into Hydro GeoAnalyst by selecting
Modules / Import / Mobile Data.
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HGA will remember the Mobile EDD’s that you published for your project – you can select
them from the drop downlist. Then hit the refresh button to see the files that were submitted
from this site.
Select the file you wish to import and select the Import button.
You will see a validation dialog which shows how many new records will be imported. In this
example I created one new station and entered 4 new lithology records.

Select the Import button to finalize the import process.
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I can review the data that was imported within HGA – for example here are the 4 new
lithology records imported:

4.6

Print To Office Templates
Many of the views and modules in Hydro GeoAnalyst provide the option to export your data
to a variety of Microsoft Office document templates. A number of these templates are
installed with Hydro GeoAnalyst and can be found under the Office Reports > Templates
branch of the project tree:
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There are a variety of formats and templates available as follows:
Excel

PowerPoint

Word

Tabular Modules/Views:
Station List
Station Data
Sample List
Sample Analysis
Viewer
Query Results
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Graphical Modules/Views:
Well Profile
Map Viewer
Scene Viewer
Plot Collections
Other:
Event Planner

Print to Excel Template
When printing query results to to an Excel template [ ], you will be prompted to select an
Excel Tables template. A template called 'Template-Table.xlsx" has provided with Hydro
GeoAnalyst. You can find this template in the Excel Tables subfolder in the Project Tree:

The templates can be accessed and modified using the context menu (i.e. right-click). For
example, you may want to change the logo, add titles for the project or client, etc. Templates
stored in the Office/Excel Tables subfolder will be available in the drop down list under the
Open Template option.
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Please Note: The templates are stored in you file system as
specified in the template settings and are shared across all
of your projects.

When printing query results to an Excel template ( ), you will be prompted to select a
template. A template called "Template - Table.xlsx" is provided with Hydro GeoAnalyst. You
can modify this template by going to the folder where your templates have been stored (see
HGA Settings for more details) and adjust it to suit your needs. Perhaps you may want to
change the logo, add titles for the project or client, etc. Templates stored in the Office/Excel
Tables subfolder will be available in the drop down list under the Open Template option.

For example, Open the Chart in Excel - 2 plots by 2 parameters query in available in the
HGA Demo Project using the Query Results [

] module:
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] option, you will be prompted to select a template:

Clicking OK will send the current table view to the selected Excel Template:

Excel Chart Templates
When printing query results to an Excel Chart template [ ], you will be prompted to select a
chart template. Seven chart templates are provided with Hydro GeoAnalyst. You can find
these templates in the Excel Charts subfolder in the Project Tree:
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The templates can be accessed and modified using the context menu (i.e. right-click). For
example, you may want to change the logo, add titles for the project or client, etc. Templates
stored in the Office/Excel Tables subfolder will be available in the drop down list under the
Open Template option.

Please Note: The templates are stored in you file system as
specified in the template settings and are shared across all
of your projects.

For example, Open the Chart in Excel - 2 plots by 2 parameters query in available in the
HGA Demo Project using the Query Results [

] module:
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When using the Chart in Excel [ ] option, you will be prompted to select a template and
map the required fields for the charts. You also have the option to group charts by a field in
the Query (for example, by station). If this is selected a worksheet and corresponding chart
will be created for each unique value in the selected grouping field:
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When we select OK, we get the Mappings dialog:

The chemical names automatically match because they are exactly the same within our
template as they are stored within the database. Also make sure that you map the Date field.
Then select OK and you will be prompted for a name for the excel spreadsheet that will be
created. Once you provide a name it will open in Excel and you can review to see that each
station has its own tab for the time series chart.
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Excel Pivot Templates
When printing query results to an Excel Pviot template [ ], you will be prompted to select a
pivot template. Two chart templates are provided with Hydro GeoAnalyst. You can find these
templates in the Excel Charts subfolder in the Project Tree:

The templates can be accessed and modified using the context menu (i.e. right-click). For
example, you may want to change the logo, add titles for the project or client, etc. Templates
stored in the Office/Excel Tables subfolder will be available in the drop down list under the
Open Template option.

Please Note: The templates are stored in you file system as
specified in the template settings and are shared across all
of your projects.

For example, Open the Chart in Excel - 2 plots by 2 parameters query in available in the
HGA Demo Project using the Query Results [
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When using the Create Excel Pivot [

] option, you will be prompted to select a template:

When we select OK and select a filename, the pivot file will open in Excel.

Please Note: depending on your security settings, you may find that data
connections have been disabled:

Simply select Enable Content to allow for connection between the SQL Server
and the Excel template.
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The Excel spreadsheet will open and you can select inside the Pivot Table option. This will
make all the fields from the query available in the Pivot Table Field List so that you can pivot
your data:

PowerPoint Templates
Results from several modules can be printed to a PowerPoint Template using the Print to
PowerPoint button [

], including:

·

Query Results

·

Well Profile

·

Map Viewer

·

Scene Viewer

·

Plot Collections

When printing results to a Power Point template [ ], you will be prompted to select a
module-specific PowerPoint template. Templates are available for each of these modules in
Hydro GeoAnalyst. You can find these templates in the PPT subfolders in the Project Tree:
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The templates can be accessed and modified using the context menu (i.e. right-click). For
example, you may want to change the logo, add titles for the project or client, etc. Templates
stored in the Office/Excel Tables subfolder will be available in the drop down list under the
Open Template option.

Please Note: The templates are stored in you file system as
specified in the template settings and are shared across all
of your projects.

Query Results
For example, open the Chart in Excel - 2 plots by 2 parameters query in available in the HGA
Demo Project using the Query Results [

] module:
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] option, you will be prompted to select create a new

You will be prompted to Create a new template. Enter a name for the query PowerPoint
template:
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Click OK and a new PowerPoint file will open:

Note the entries in surrounded by '#' symbols - these are the fields in the template. Save
and close the template. Hydro GeoAnalyst will confirm that the new template has been
created and saved to the Project tree:
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Click OK and select a name for the specific query report you have executed, for example:
"Ion Report" as shown below:

Click OK and the printed report will be displayed in PowerPoint, with one page per record:
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As you can see, the result is not ideal - the fields are too close and span multiple lines such
that they overlap. You can fix this by right clicking on the template you created in the project
tree and selecting open:

©2022 by Waterloo Hydrogeologic

Fundamental Concepts

243

The template will open in PowerPoint and you can make adjustments. For example,
spreading out and vertically distributing the query field placeholders, adding labels to the left
of the query field placeholders, and adding a title for the Report:
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Save and Close the PoiwerPoint template and select the Print to PowerPoint template [
option once again repeating the steps above. This time, the template will include your
improvements:

]
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Well Profiles
Simple Well Profile Templates
For example, in the HGA Demo Project, select the "Boreholes with plot data" station group
from the Project tree and open the "bhlp_intervals" in the Well Profile module [
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When using the Print to PowerPoint template [ ] option, you will be prompted to select a
template. You will also have the option to chose to export the current station or all stations in
the current station group as well as how to handle the depth of each each well (i.e. fixed
depth intervals across multiple pages or one page per well at a specific depth):
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When we select OK twice, the PowerPoint report file will open:
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The resulting report shown above includes an image from the well profile, but could it could
be supplemented using information from a query that includes metadata about the station.
Query Based Well Profile Template
Before creating a Query-based Well Profile Template, we must first create a query for the
template to use. The query should return one record for each station and should ideally not
include any conditions so that it can be used in combination with any station group that might
be used with the Well Profile Template.
· Open the Query Builder module [
· Select New Query [

] from the Modules menu or the main toolbar

] and provide a name for the query (e.g. "BHLP Interval Well
Profile template query"):
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· Add the display fields that you'd like include as data values in the template to the

query, for example:

· Save [

] the query and return to the Well Profile tab

· Open the Print to PowerPoint template [

] dialog again and select the New option:
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· Define the basic structure of the new template:

o Select a base template (e.g. NewTemplateBase.pptx)
o Provide a name (e.g. BHLP Interval Well Profile template query)
o Check the checkbox for "Create template based on query"
o Select a source query (e.g. "BHLP Interval Well Profile template query")
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· Click OK and PowerPoint will load the Template with tags for each field (e.g. #Station

Name# for the Station Name field) and an "Image Placeholder" image that will be used
to place the well profile images:
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Note that you can also add the tags #PAGE# and #PAGECOUNT#. The tag #PAGE# will be
replaced by the page number and the total number of pages for a given station. For
example, if you export the wells in 50 m increments, then GB-03 will be split into a total of
two pages with the interval for 50m-100m below ground surface would be shown as page 2
of 2.
Also, the well profile images will be stretched to fill the "Image Placeholder" while
maintaining the aspect ratio shown on the screen. If you are aiming to have the well profile
images scaled to a particular dimension on the page, then be sure to make the "Image
Placeholder" the exact height desired on the page and sufficiently wide to accommodate the
desired height.

· Format the new template as desired. For example:
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· Save the template and close PowerPoint
· Setup the Export:

o Set a Report Path (e.g. BHLP intervals)
o select the desired Station group (e.g. Boreholes with Plot data)
o set the depth settings (e.g. multi-page with 50m per page)
· Click OK to export and the printed PowerPoint report will open:
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Map Views
For example, open a
Map Viewer object from the project tree such as the "Map" you may
have created while completing the Mapping portion of the Demo Project Tutorial:
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Click the Export to Image or presentation [ ] option and you will be prompted to select the
export type (image or presentation), and an export location. When you select presentation,
you will also be prompted to select a presentation template:

Click the Browse button to select a location for the exported presentation to be stored. Enter
a name such as "Printed Map". If you select the Save to project tree option, the file will be
saved in the project folder and be accessible from the project tree:
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Click OK twice to close both windows and begin exporting the map. Once the export process
has completed, the exported map will open in PowerPoint:
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Scene Views
For example, in the HGA Demo Project, double click the "BTEX_ColorMaps" Scene from the
Project tree to open it:

When using the Print to PowerPoint template [ ] option, you will be prompted to select a
template and an output filename (click Browse):

When you select OK, the PowerPoint report file will open:
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Plot Collections
For example, in the HGA Demo Project, select the "Water Quality Plots" plot collection from
the project Tree:
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For this example, we will use a pre-defined template that is installed with Hydro GeoAnalyst.
The template includes an image placeholder that defines the size and location in the
template where the plots will be placed. In this case, the image placeholder is 7.55 inches
wide by 9.55 inches tall (19.18 cm x 24.26 cm).
To access the Print to PowerPoint template functionality, turn on the Export pane using the
"Export to images or presentation"-[ ] button option.
· Select the "Presentation" as the Export option
· Set the layout settings:

o
o
o
o
o
o
o

Layout: Custom
Width: 7.55 in (19.18 cm)
Height: 9.55 in (24.26 cm)
Margins: 0
Orientation: Portrait
DPI: medium
Export with margins: unchecked

Note: the DPI setting sets the size/resolution of the images to be exported. When
exporting to an PowerPoint Template, the exported images will be vector images so
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the resolution will not affected - only the relative size of the component elements of the
plot. Feel free to experiment with this setting.
· Click the Browse button next to the Report path entry and enter a name for the report

(such as "Water Quality"):

· Select the Template: Template - Letter_Portrait.pptx.

Note that you can review or edit a template by selecting it in the Project tree in Office
reports > Templates > PPT Plots , right-clicking, and selecting open.

· Select Whole Plot Collection to export all plots. In this case, one page will be

generated with both of the two plots in this plot collection.

When we select Export, the PowerPoint file will open:
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Spatial Geo_Point
Making use of the Spatial GeoPoint option within SQL Server 2008 R2 or later, we can
create a more direct link to ArcGIS. When creating or upgrading HGA projects to Version
2012 (or later) and using SQL Server 2008 R2 (or later) there will be a new field called
geo_point in the Location (station) table. We have hidden this field from your view in the
Main HGA view as this is a system field that is automatically calculated based on the X and
Y fields.
Additionally, any Map-Ready queries will now include this field as well. ArcGIS is able to
recognize this field and be able to plot your stations using this field. Any time you make
changes to your X and Y coordinates in HGA (for example adding, deleting, or editing) the
geo_point will be automatically recalculated. Therefore all you need to do is select the
refresh button (F5) in ArcGIS and your points will automatically be adjusted as it is directly
reading the points from the database.
Please be aware that if you are using a Projected Coordinate system for your project the
geo_point is being calculated as WGS 1984 (lat/long) as this is the internal way HGA stores
coordinates in the database. If you are using a local coordinate system for your project then
the geo_point will not contain any coordinate system information (only the values of the
coordinates).
Within ArcGIS you can select File/Add Data/Add Query Layer
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Select New to make a new connection

Provide your SQL Server details (please remember you must be using SQL Server 2008 R2)
and the database you wish to connect to.
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Then select OK and you will see the New Query Layer dialog box – here you can see all the
tables and fields in your database. You can write your own SQL statement – or you can copy
a SQL statement from one of your HGA saved queries (in HGA in the Query Builder on the
SQL Statement section). For this example I wrote a simple query to take all the information
from the station table.

When you select the finish button the layer will be added to your map.
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If any changes are made to the database stations within HGA (you delete stations or add
new stations or even edit the stations coordinates) all you need to do is hit the refresh button
in ArcGIS (F5 or View/Refresh) and the points will be automatically updated.

4.8

Hydro GeoAnalyst Plus
Hydro GeoAnalyst Plus (HGA+) includes additional modules and features to extend to
functionality of the standard edition of HGA. Before beginning to work with HGA+, you may
want to review the topics in this section specific to HGA+ to get an understanding of the
fundamental concepts of the program. This might help you become more proficient with the
software in less time.
The topics go through the basic concepts and components specific to the HGA+ interface,
including the various modules available to you.

Learning more
HGA+ includes additional features and associated
concepts:
Ø See Data Structure in HGA+: to understand

the specific data structure and categories in
HGA+
Ø See Samples: to understand the added value

of the sample structure in HGA+
Ø See Parameters to understand how to work

with your analytical data
Ø See Projections to understand how projection

systems are used in the mapping features of
HGA+
Ø See Chemical List: to understand how you can

standardize your parameters across projects
Ø See Measurement Units: to understand how to

convert measurement units on-the-fly
Ø See Functions: to see the automatic

calculations that are performed by HGA+
Ø See Upgrading Projects to HGA+: to learn

how to upgrade your projects from the
standard edition of HGA to HGA+
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The HGA+ Demo Project Tutorial will provide you
with a quick start introduction to many of the
features available in HGA+

4.8.1

Data Structure in HGA+
The Hydro GeoAnalyst Plus data structure is described below:
Data Concepts
The following concepts are fundamental to working with HGA+:
· Stations are records that represent a single location with an X- and Y-coordinate,

often including associated metadata. Examples of stations would include groundwater
monitoring wells or fixed locations along a stream. These are designated by a unique
identifying code (Station ID), such as MW-01 for a monitoring well, or SW-01 for a
surface water sampling location although for larger projects with multiple sites and/or
long histories, longer codes are often required. The Station Picker can be found in the
lower left quadrant of the interface (by default) and allows you to select which
Station(s) and by extension which associated Samples are currently selected and used
in various parts of the interface.
· Samples are records that represent unique events where one or more physical

measurements and/or analytical samples have been collected at a given location.
Samples must be associated with an existing Station (using the Station ID) and
typically also include associated metadata, such as the sample collection date, time,
and the name(s) of who collected the sample. In HGA+, samples must be identified
using a unique identifying code (Sample ID); however, a given Sample will often be
associated with multiple physical samples collected from the same location (Station)
during the same sampling event. For example, when collecting physical samples from
a given location, different analyses will often require different collection and
preservation methods: samples may include measurements from hand-held devices
for pH and temperature in addition to physical samples collected for metals analyses,
which are typically pre-filtered to plastic sample containers and preserved with acid or
physical samples collected for organic compound analyses, which are typically notfiltered and filled into glass containers with no head-space. These individual physical
samples should share a common Sample ID so that the results for the various
measurements and analytical results can be correlated. The Sample Picker available
in HGA+ can be found in the lower left quadrant of the interface (by default) and allows
you to select which Station(s) and by extension which associated Samples are
currently selected and used in various parts of the interface.
· Results are records that represent the value and associated data for a single

parameter and associated metadata such as quality assurance/quality control flags,
data validation flags, method detection limits, etc.
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· Parameters are the types of measurements and observations that are included

included in the project (for example: temperature, pH, and the concentration of
Calcium are individual parameters). Each parameter must be uniquely named and has
a designated measurement unit. HGA+ also stores other optional metadata about
parameters, including molecular weights, valence, and CAS numbers.
· Standards are threshold values that indicate parameter results may be be present at

levels that may pose an unacceptable risk to the health of receptors or the
environment, require some action or further evaluation. Multiple standards can apply
to the same parameter such as the case of different criteria between federal and
state/provincial criteria or different criteria for different receptors (e.g. human health vs.
aquatic biota).

HGA+ Relational Database and Simplified Data Model
The information described above is stored in HGA+ using a structured format in a SQL
relational database. The relational database organizes data into several tables consisting of
columns and rows, with a unique key (e.g. a unique sample ID) that identifies each row.
Rows in a data table are typically called records; while columns are typically called fields.
· Tables store information about specific entity types with common data attributes. For

example, separate tables store information about stations, samples, and results.
· Records represent individual entities (e.g. a specific environmental sample).
· Fields store specific attributes about each record in that table (e.g. sample collection
date).
· Keys are fields that store a unique attribute that is used to identify a record (e.g.
sample ID) that allow you to retrieve information about that record.
One table can can be related to a second table by including the key of the first table as an
attribute in the second (For example, the sample table includes the unique Station ID). A
simplified version of the tables and their relationships is shown below:

Simplified Station > Sample > Result Structure of HGA+
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If you are comfortable working with databases, you can explore the complete data structure
using the Template Manager module. You can also explore the data structure in SQL
Management Studio; however, this is not recommended for all but the most experienced
users to avoid corrupting the Hydro GeoAnalyst data structure. If you do chose to work in
SQL Management Studio, it is strongly recommended that you first backup your project data
and the underlying database so that you can recover your project in case it is corrupted.

Data Categories
The tables in an Hydro GeoAnalyst database can be organized into a logical grouping by
placing them into a data categories. HGA provides several data categories, which might be
considered common data categories found for environmental data. However, you can create
as many categories as you wish within the Template Manager. This way you can completely
customize the way in which the tables are organized within HGA. The default template in
HGA+ provides the following data categories:

These categories and data tables are designed to work with the modules in HGA+. Many of
these structures are flexible and can be reconfigured; however, the hierarchical relationship
between Stations, Samples, Parameters, Results, and Units must be maintained to work with
the Sample and Plot modules in HGA+. Furthermore, certain fields in other tables cannot be
altered - you will be warned if you attempt to alter these in the Template Manager.
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Otherwise, you can edit, delete, and create as many categories, tables, and field as you wish
using the Template Manager. In this way, you can customize how the tables are organized.
Categories of tables that are linked to the Stations using the Station ID, can be accessed by
selecting the Station Data tab and selecting the Data Category combo box (ensure that one
or more stations are selected in the Station List tab):

After a Data Category has been selected, the appropriate tables and fields belonging to this
category will be displayed in the Station Data tab. All of the data categories may be renamed
and used differently if desired. Placing tables under any one of these categories does not
have any effect on how the tables are stored in the database.

4.8.2

Samples
Samples are records that represent unique events where one or more physical
measurements and/or analytical samples have been collected at a given location. Samples
must be associated with an existing Station (using the Station ID) and typically also include
associated metadata, such as the sample collection date, time, and the name(s) of who
collected the sample. Samples must be identified using a unique identifying code (Sample
ID); however, a given Sample will often be associated with multiple physical samples
collected from the same location (Station) during the same sampling event. For example,
when collecting physical samples from a given location, different analyses will often require
different collection and preservation methods: samples may include measurements from
hand-held devices for pH and temperature in addition to physical samples collected for
metals analyses, which are typically pre-filtered to plastic sample containers and preserved
with acid or physical samples collected for organic compound analyses, which are typically
not-filtered and filled into glass containers with no head-space. These individual physical
samples should share a common Sample ID so that the results for the various
measurements and analytical results can be correlated.
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Please Note: While you can store and work with sample
data in Hydro GeoAnalyst, the information in this section
pertains to how samples are managed in HGA+

The Sample Picker can be found in the lower left quadrant of the interface (by default) and
allows you to select which Station(s), and by extension which associated Samples, are
currently selected and used in various parts of the interface.

Sample Table
The Sample Table stores all of the sample information in the database. The Sample Table
may contain an unlimited number of fields. Though, at a minimum, the Sample Table must
contain the following fields:
· Sample ID (ID)
· Sample Name (Name)
· Station Name (Station)

The Sample Date is also strongly recommended, but not required. Samples can be added,
modified, or deleted when viewing the Sample List View and the All Stations Station Group is
selected. The Sample List Tab displays information about the currently active sample set
and the results for the active Sample (as denoted by a black triangle in the leftmost column
of the sample table).

Sample Sets
Many operations in Hydro GeoAnalyst require the selection of one or more samples. One
example of such an operation is data entry. One or more samples for which you would like to
add, view, and/or modify data need to be selected so that the Sample List is accessible
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(activated). Another such example is plotting: most of the plots you will likely want to create
in Hydro GeoAnalyst will be based on a specific subset of your samples.
The complete list of samples that comprise a project can be viewed in the Sample List tab by
selecting the All Stations item, under the Station Group node in the project tree. By default,
all projects will contain a station group named All Stations that includes all samples for every
station in the database. However, for some of the tasks commonly performed in Hydro
GeoAnalyst, retrieving the complete list of samples in the project may not be necessary or
even desired. Moreover, retrieving all the samples when only few of them are needed may
be a time-consuming process especially for large databases containing hundreds or
thousands of samples.
The solution is to create Sample Sets. Grouping samples into logical sets allows efficient
management and quick retrieval and plotting of data stored in the database. For instance,
you may wish to find all samples that:
·
·
·
·

were collected within a certain period of time,
exceed some water quality standard,
belong to a certain group of stations, or
a combination of the above.

There are three kinds of Sample Sets in Hydro GeoAnalyst:
Static: Select one or more samples directly in the Sample List view, right-mouse
click, and select the Add to [New/Existing] Sample Set options from the pop up menu.
Dynamic: Using the Query Builder, you can build a dynamic sample set by defining
define search criteria, which results in a list of samples that satisfy the query criteria.
Stations: Station groups are also implicitly sample sets as they also refer to
all of the samples collected at the stations within that station group. Note that by
definition, the
All Stations station group includes all samples in your project.
Sample sets created for a project are listed in the Project Tree under the Sample Sets
branch, while station groups (which are also treated as sample sets) are listed under the
Station Groups branch. Double-clicking on any sample set or station group will make it the
active sample which other modules can use (e.g. Plot Module) and optionally load the
Sample List.
If desired, selected samples can be removed from a static sample set or the sample set can
be deleted as a whole. To remove samples from a sample set, simply select the samples by
highlighting the row(s) and then select the delete button ( ) - this will remove the sample
from the samples set but will not delete the sample(s) from the database. To delete samples
from the database, you must first select the
All Stations station group - and delete the
samples from there.
To delete a sample set, right-click on the relevant sample set in the Project tree and select
delete.
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Parameters

Please Note: Parameter-related functionality is only
available in HGA+.

Parameters are those properties whose values describe the state of a particular station or
sample. There are three general kinds of parameters in Hydro GeoAnalyst:
· Station parameters are those parameters that describe a station and its properties.

All of the fields in the Station Table are station parameters; for example: station name,
x- and y-coordinates, and site description.
· Sample parameters are those parameters that describe a sample and its properties.

Similarly, all of the fields in the Sample Table are sample parameters; for example:
sample ID, station, and sample date.
· Analytical parameters are associated with sampling results and describe the value or

measurement of a particular constituent (e.g. calcium concentration, pH, temperature,
etc.).
Generally in Hydro GeoAnalyst, unless otherwise specifically stated, the term parameter
refers to analytical parameters. Analytical parameters may be further subdivided into various
groups as discussed below.

Viewing Parameters and Results
When viewing the Sample List, results for the selected sample are shown in the Results
pane. Results are shown by parameter type in the tab at the top of the results pane (as
denoted by circled area 1):
· Measured parameters are those values that are explicitly stored in the database and

typically have been measured either in the field or in an analytical laboratory.
· Calculated parameters are those values that have been calculated using

AquaChem's built-in functions. These are calculated dynamically and are not stored in
the database.
· Modeled parameters are those values that have been estimated using PHREEQC in

an imported AquaChem 2014 project. This tab is only shown for projects that used
PHREEQC and have been imported into the current version Hydro GeoAnalyst. Note
that support for PHREEQC in Hydro GeoAnalyst is planned for a subsequent release.
Measured parameters can be filtered in the Results tab using the parameter group dropdown
(as denoted by circled area 2), discussed below.
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Parameters and the Parameter Editor
Information about all measured parameters is stored in the Parameter Table, and includes
the relevant chemical and descriptive attributes as follows (using bicarbonate as an
example):
· Short Name: a unique, typically short or abbreviated, name that is easily recognizable
·
·
·
·
·
·

(e.g. HCO3) and used as a look up name and a primary key.
Display Name: a longer descriptive name (e.g. bicarbonate) used for labeling in plots
and tables.
CAS: Chemical Abstracts Service (CAS) Registry number (e.g. 56240-83-6), a unique
number assigned by CAS, a division of the American Chemical Society
Description: typically a more descriptive name that may include a list of alternate
names (e.g. bicarbonate; hydrogencarbonate)
Formula: chemical formula (e.g. HCO3)
Molecular Weight: combined atomic weights of all constituent atoms that compose
the parameter (e.g. HCO3 = 1x1.00794 + 1x12.0107 + 3x15.9994 = 61 g/mol)
Valency: the ionic/electric charge of the parameter in solution (e.g. -1).

For more information, see the Parameter Editor section.
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Parameter Groups
Measured parameters may be grouped into categories called parameter groups to facilitate
viewing, analyzing, plotting, and tabulating your data. Some parameter groups are
automatically created for you by Hydro GeoAnalyst, including:
·
·
·
·
·
·

All Measured Parameters: all of the measured parameters in your project
Analyzed Parameters: parameters with results for the active sample(s)
Ions: parameters with a non-zero valence
Cations: parameters with a positive valence
Anions: parameters with a negative valence
Required Parameters: parameters that are used in a supported formula and are
required
· Used in Standard: parameters in your project that are present in an active Water
Quality Standard.
Custom Parameter Groups may be created in the Parameter Group Editor.

Parameter Selection Window
The parameter selection window is used throughout Hydro GeoAnalyst to allow you to easily
find and select one or more parameters:
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The main portion of the window displays a list of parameters that can be selected. In many
cases, you can select more than one parameter by holding the <CRTL> key to add individual
items to your selection or the <SHIFT> key to add a range of items to your list.
You can filter the list in one of two ways:
· Parameter Group dropdown menu: which will restrict the listed parameters to the

selected parameter group or
· Filter bar: allows you to filter the parameter list using a search term

4.8.4

Projections
A projection is a system that is used to reference geographic locations. Projection systems,
sometimes called coordinate reference systems (CRS) are typically comprised of the
following components:
· Projection (Type): a coordinate system that transforms the 3D surface of the earth

into a 2D coordinate system. Some of the more commonly used projections include:
o the so-called geographic system which consists of a longitude (east/west xcoordinate) and a latitude (north/south y-coordinate);
o Universal Transverse Mercator (UTM), and
o Lambert conformal conic projection which is used by the U.S. National Geodetic
Survey for the State Plane CRS's.
· Horizontal Datum: a reference frame that includes a reference ellipsoid or geoid that

models the shape of the Earth, an origin tied to a know location, and associated
control points. Two of the more commonly used datums include:
o WGS-84 used for global maps and by many national jurisdictions
o NAD-83 used in the United States and Canada
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· Units: measurement units for the coordinate system. Typically, decimal degrees,

meters, or feet.
There are hundreds of well-known CRS that are identified using numeric EPSG codes
developed by the Euro European Petroleum Survey Group and maintained at
https://spatialreference.org/. For example EPSG:4326 represents a CRS with a geographic
system, using the WGS-84 horizontal datum and decimal degrees. Many geographic
information system (GIS) applications store the CRS information in projection (.prj) files that
accompany spatial layers such as those used in the Map Viewer Module (e.g. shapefiles and
images). When creating a map, the map and each layer within it must either have a
common CRS or each component and the map itself must have a specified CRS that allows
the map to correctly position each layer.
By default, maps in your Map Viewer maps will use the CRS defined when you create a new
project or import an existing project from AquaChem. 2014.
For more information, please refer to:
https://docs.qgis.org/3.16/en/docs/gentle_gis_introduction/coordinate_reference_systems.ht
ml

4.8.5

Chemical List

Please Note: The chemical list is only available in HGA+.
The Chemical List is a database of parameters and their properties that is external to your
Hydro GeoAnalyst projects. This is a common resource that is shared across all of your
projects and can be centrally or collectively managed by your organization. Data fields in the
Chemical list table are aligned with the data entry fields in the Parameter Editor, which allows
you to use the Chemical list as a reference for adding parameters.
The default Chemical list is located in the Hydro GeoAnalyst install folder, typically: C:
\Program Files (x86)\Hydro GeoAnalyst\ChemicalList.dmt and is read-only; however, you
can save editable copies of the Chemical List to other locations, including network drives to
which you have access, so that you can share and centrally manage/curate the list with
colleagues.
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Commands
The following commands are available in the Chemicals list:
New: allows you to create a new chemical with a (short) name, display name, CAS,
description, formula, measurement unit (mg/L or µg/L), formula weight, and valency.
Import: allows you to import chemical with a (short) name, display name, CAS,
description, formula, measurement unit (mg/L or µg/L), formula weight, and valency
from an Excel or delimited text file.
Delete: removes the selected parameter(s) from the Chemical List.
Save: saves the Chemical List in its current location; enabled once you edit the list.
Save As: saves a copy of the Chemical List to a new location.
Although there is no export function, you can copy selected records and paste them to an
external application. To select all records, select the first record and press SHIFT+END.
Importing new Parameters into the Chemical List
Clicking the
Import button will open the "Import Chemicals" window, which will allow you
to select an Excel (.xls, .xlsx) or comma separated variable (.csv) file. If an Excel file is
selected, you will also be able to select the worksheet containing the parameter data. The
mapping pane (on the lower left side of the window) allows you to map the fields from the
source file (on the right) to the chemical list fields (on the left). The data preview pane (on
the lower right side of the window) provides a preview of the data to be imported.
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The import chemicals window also provides the option to:
· calculate the formula weights (where values are missing from the file to be imported)

based on the supplied chemical formula.
· select a default unit for parameters where no measurement unit has been specified

Once you click OK to proceed with the import, if one or more matches between a parameter
to be imported and an existing are found, you will be shown information related to the match
and prompted to resolve the conflict using the options shown below:
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Measurement Units
In Hydro GeoAnalyst, measurement units can be specified in any field you like; however, the
measurement units specified in the Parameter Editor (and during a Sample Import or when
importing an AquaChem2014 project) are stored in a specific format and grouped into
categories so that many of the views and modules will be able to perform unit conversions
on demand.

Please Note: The dynamic measurement unit conversion is
only available in HGA+.

In order for the unit conversions to work, parameter values stored in the underlying database
use consistent units. For example, all sodium results stored in the sample results table will
be stored using one common measurement unit, typically milligrams per liter (mg/L), while
PCE results may be stored in micrograms per liter (µ g/L), and temperature is stored in
degrees Celcius (°C).
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Unit Categories
In many situations in Hydro GeoAnalyst, such as viewing the Sample List, creating plots in a
Plot Collection, or generating a Sample Report, it may be preferable to work with or report
values using units other than the measurement unit stored in the database. In these cases,
you may be provided with controls to select a different unit of measurement. In order to
correctly convert units, Hydro GeoAnalyst relies on unit categories. Unit categories consist of
units of measurement that share dimensionality - that is, they share the same dimension of
base units: length (L), mass (M), time (T), and temperature (K). For example, the
concentration (by volume) category is based on a dimensionality of M/L3 and includes the
milligrams per liter, micrograms per liter, and milligrams per cubic meter. Furthermore,
concentration units also include molar concentrations (e.g. moles per liter [mol/L] and millimoles per liter [mmol]) for parameters with a specified formula molecular weight and
equivalent concentrations (e.g. equivalents per liter [eq/L] and milli-equivalents per liter
[meq/L]) for parameters with a specified formula molecular weight and valence.

Unit Conversion
Each unit category has one designated primary reference unit; all other units in the same
category have conversion factors relative to this primary unit. For example, in Hydro
GeoAnalyst the primary reference unit for the Time unit category is seconds and it has a unit
conversion multiplier of 1 - all other units have conversion multipliers relative to seconds, as
shown in the table below:

Unit
s
min
hr
day
yr

Name
second
minute
hour
day
year

Multiplier
1
60
3600
86400
31557600

Offset
0
0
0
0
0

Base
TRUE
FALSE
FALSE
FALSE
FALSE

Note the offset field is present to facilitate conversions for units with linear offsets
such as the conversion from degrees Celcius to degrees Fahrenheit (i.e. °F = 5/9 x °
C + 32).

Units and Importing Data
When importing data, you must also include specifications on the measurement unit of each
parameter to be imported. If the units are recognized by Hydro GeoAnalyst, the values to be
imported will be automatically converted into the units associated with the parameter in the
project (as specified in the Parameter Editor). If the units are not recognized, you will be
asked to map the unrecognized unit to an existing one or add a new unit and conversion
factors. Once a unit is added at the import step, it will be saved in the project for future use.
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Functions
HGA+ provides a number of built-in functions to automatically calculate a variety of
commonly used metrics for geochemical samples.

Please Note: The built-in Functions for samples are only
available in HGA+.

The Functions tab in the Project Properties window lists all of the internal calculations
performed by Hydro GeoAnalyst, with reference information for each calculation provided in
the discussion below. All of the active functions (as indicated by a checkmark) will be
available as "calculated parameters" which can be included in statistical comparisons and for
plotting data. In this dialogue, you may manage which calculations should appear in the lists
and in what order. For example, if you never use the enthalpy calculations, you may
deactivate them here. In addition, you may define the units in which some of the functions
are reported.
The calculated values of functions are displayed in the Calculated tab of the Sample Details
window.
The calculated parameters are treated by Hydro GeoAnalyst as regular database
parameters with respect to plotting, searches, or statistical calculations. However, in order
for the built-in calculations to work, their corresponding database parameters must be
included in the database and mapped to the required parameters in the Project Properties
window. For example, the database must include calcium and magnesium in order to
calculate hardness, and both of these parameters must be identified with an internal name of
`Ca' and `Mg' respectively.
You may edit the name of the function or hide/show a function. Hidden functions will not
appear in the list of functions within Hydro GeoAnalyst. To edit the name of the function,
press Project > Properties, select the appropriate function in the Functions tab and edit the
Label input. For functions that can be expressed in different units (e.g. hardness as meq/L,
mmol/L CaCO3, or mg/L CaCO3) you may specify a default unit.
Hydro GeoAnalyst includes a number of common calculations for determining common
geochemical parameters. Each of the available calculations (functions) is explained below.

Ions, Hardness, and Alkalinity Calculations
· Sum of Ions
· Electroneutrality
· Non-Carbonate

· Sum of Anions
· Total Hardness
· Calculated Alkalinity

Hardness
Agricultural and Irrigation Calculations
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· Sodium Adsorption

· Magnesium Hazard

Ratio (SAR)

(MH)

· Residual Sodium

Carbonate (RSC)

Scaling and Corrosion Calculations
· Langelier Saturation

· Larson-Skold Index

Index (LSI)
· Ryznar Stability Index
(RSI)

(LSkI)

· Puckorius Scaling

Index (PSI)

Organic Calculations
· Calculated Total

· Calculated Total

Organic Carbon
(TOC)

Organic Halides
(TOX)

Isoptope Infiltration Calculations
· z(18O)
· T(2H)

· T(18O)

· z(2H)

Enthalpy Calculations
· Calculated Total

· Calculated Total

Organic Carbon
(TOC)

Organic Halides
(TOX)

Exceedances and Comparisons
· Exceeds Any

· Exceeds Natural

Standard

Occurrence

Date Time Calculations
· Year

· Season

· Month

Ions, Hardness, and Alkalinity Calculations

Note: Ions, Cations, and Anions in AquaChem
Ions, Anions, and Cations are specified in AquaChem using the Valency value
in the Parameter settings:
· Ions are any parameter with a non-zero parameter valency
· Anions are any parameter with a negative parameter valency
· Cations are any parameter with a positive parameter valency
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Valencies are always integer values. New parameters are assumed to have a
valency of zero and are therefore not considered Ions unless/until otherwise
specified.

Sum of Ions:
Sum of the concentration of all measured ion concentrations in the sample, given by the
equation:

where:

Xi is the volumetric concentration in units of meq/L [Default], mmol/L, or mg/L

Sum of Anions:
Sum of the concentration of all measured anion concentrations in the sample, given by the
equation:

where:
Ai is the volumetric concentration of the ith anion parameter measured in the
solution in units of meq/L [Default], mmol/L, or mg/L
Sum of Cations:
Sum of the concentration of all measured anion concentrations in the sample, given by the
equation:

where:
Ci is the volumetric concentration of the ith cation parameter measured in the
solution in units of meq/L [Default], mmol/L, or mg/L
Electroneutrality
The principal of electroneutrality is one of the foundations of aquatic chemistry. This principle
states that the sum of positive and negative charges within a solution must balance to zero.
The electroneutrality ratio (E.N.) is the relative difference in the ionic charge of the solution
and is given by the following equation:
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Electroneutrality is expressed in terms of percent. According to Appelo and Postma (1994),
electroneutrality differences of up to ±2% are nearly inevitable but differences of more than
±5% mean that sampling and analytical procedures should be reviewed as this may indicate
that:
· the sample was subjected to sampling and/or analytical procedural errors, or
· there are other (less common/unanalyzed) major ions in the solution

Total Hardness
The sum of ions that can precipitate from water as calcite or dolomite. Generally, the sum of
Ca2+ and Mg2+, expressed in meq/L or mg/L CaCO3, or mol/L CaCO3.

where:

TH is in units of meq/L
[Ca2+] is the concentration of calcium ions in solution in mmol/L
[Mg2+] is the concentration of magnesium ions in solution in mmol/L
TH unit conversion

1 meq/L [CaCO3] = 50 mg/L [CaCO3] = 0.5 mmol/L

[CaCO3]
Carbonate (Temporary) Hardness:
Carbonate Hardness (CH) is the portion of total hardness that is balanced by carbonate
[CO32-] and bicarbonate [HCO3-] and thus can precipitate as calcium carbonate, magnesium
carbonate, or related minerals.

where:

CH is in units of meq/L
TH is total hardness in units of meq/L
[CO32-] is the concentration of carbonate ions in solution in mmol/L
[HCO3-] is the concentration of bicarbonate ions in solution in mmol/L
CH unit conversion

1 meq/L [CaCO3] = 50 mg/L [CaCO3] = 0.5 mmol/L

[CaCO3]
Non Carbonate (Permanent) Hardness:
Non carbonate hardness (NCH), also known as permanent hardness, is the portion of
calcium and magnesium hardness in excess of carbonate [CO32-] and bicarbonate [HCO3-].
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NCH is in units of meq/L
TH is total hardness in units of meq/L
CH is carbonate hardness in units of meq/L
NCH unit conversion

1 meq/L [CaCO3] = 50 mg/L [CaCO3] = 0.5 mmol/L

[CaCO3]
Calculated Alkalinity
Alkalinity Is a measure of the acid neutralizing capacity of the solution. Alkalinity is most
commonly measured by titration, but can be estimated using the following equation:

where:

Alk is in units of meq/L
pH = -log10[H+]
pOH = -log10[OH-] ˜ 14 - pH (@ 25oC, 1 atm)
Alk unit conversion
1 meq/L [CaCO3] = 50 mg/L [CaCO3] = 0.5 mmol/L

[CaCO3]
Calculated Total Dissolved Solids (TDS)
TDS is a measure of the evaporation residue at a given temperature. It can also be thought
of as the mass of all ions in solution. TDS is calculated as the sum of all ions plus dissolved
silica less the amount of bicarbonate that will outgas under the following reaction (Hounslow,
1995, p 57):

So, the formula to estimate total dissolve solids is as follows:

where:
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Please Note: calculated TDS is only an approximation; it is always
better to have a measured value

Agricultural and Irrigation Calculations

Sodium Adsorption Ratio (SAR)
The sodium adsorption ratio is an empirical water quality criterion that is important for
irrigation waters. It is used in the Wilcox Plot.

where:

SAR is in units of (meq/L)0.5, but the units are not traditionally reported
Inputs are in units of meq/L

Magnesium Hazard (MH)
Magnesium is considered to be harmful for plants, but the effect is reduced by the presence
of calcium. Magnesium Hazard was proposed by Szabolcs and Darab (1964) and is
calculated as follows:

where:

MH is dimensionless.
Inputs are in units of meq/L

Waters with values of MH that exceed 50 are generally considered to be harmful for use in
irrigation.

Residual Sodium Carbonate (RSC)
Residual sodium carbonate (RSC) is similar to the SAR in that it expresses the sodium
content in relation with calcium and magnesium (Richards, 1954). This value may appear in
some water quality reports, although it is not frequently used. Residual sodium carbonate
(RSC) has the following equation:
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RSC is in units of meq/L

Waters are categorized using RSC as follows:
RSC Value
< 1.25 meq/L

1.25 – 2.5 meq/L
> 2.5 meq/L

Significance
waters are generally considered safe
for irrigation, although some crops
may require lower values
waters are considered are
considered marginal
waters are generally not appropriate
for irrigation without treatment

Scaling and Corrosion Calculations

Please Note: The scaling and corrosion indices presented below
are only approximations of the real saturation state and should only be
used in preliminary analyses. Modeled (e.g. PHREEQC) saturation
index values of calcite or dolomite will generally provide more reliable
results since they are based on a thermodynamic dataset and include
more corrosion/scaling-relevant minerals and parameters such as Eh,
Mn, Fe, iron hydroxides, etc.

Langelier Saturation Index (LSI)
The Langelier index is a popular way of expressing the equilibrium state of a solution in
respect to calcite (Langelier, 1936) and is given by:

where:

LSI is in standard pH units
pH is the measured pH
pHs is the estimated pH at calcite saturation

The value of pHs is estimated using temperature, alkalinity, hardness and total dissolved
solids values as follows:

where:
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T is temperature in units of Kelvin
Ca is the concentration of calcium in mg/L-CaCO3
Alk is the alkalinity in mg/L-CaCO3
Waters are categorized using LSI as follows (Belitz et al., 2016):
LSI Value
< -0.5
-0.5 – +0.5
> +0.5

Significance
potentially corrosive
indeterminate
potentially scale-forming

Larson-Skold Index (LSkI)
The Larson-Skold Index (LSkI) is used to describe the corrosivity of water towards mild steel
and was developed based on in situ measurements of corrosion in steel lines transporting
Great Lakes water (Larson and Skold, 1958). The index describes the ratio of concentration
of chloride and sulfate ions to the concentration of bicarbonate and carbonate ions. Because
the LSkI is an empirical correlation, its utility for describing corrosion for other types of water
is questionable. The following equation is used to calculate the LSkI:

where:

LSkI is dimensionless
All inputs are concentrations in meq/L

The following table describes the criteria for evaluating values of L&SkI (Larson and Skold,
1958):

LSkI Value
< 0.8

Significance
Chloride and sulfate concentrations
will not interfere with natural film
formation

0.8 – 1.2

Chloride and sulfate concentrations
may interfere with natural film
formation; corrosion may occur

> 1.2

High corrosion rates are anticipated

Ryznar Stability Index (RSI)
The Ryznar stability index (RSI) attempts to correlate an empirical database of scale
thickness observed in municipal water systems to water chemistry (Ryznar, 1944). Like the
LSI, the RSI has its basis in the concept of saturation level. Ryznar attempted to quantify the
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relationship between calcium carbonate saturation state and scale formation. The Ryznar
stability index is calculated as follows:

where:

LSI is in standard pH units
pHs is the pH at calcite saturation
pH is the measured pH in standard units

The value of pHs is estimated from temperature, alkalinity, hardness and total dissolved
values using the following empirical formula:

where:

TDS is total dissolved solids in units of mg/L
T is temperature in units of Kelvin
Ca is the concentration of calcium in mg/L-CaCO3
Alk is the alkalinity in mg/L-CaCO3

The empirical correlation of the Ryznar Stability Index can be summarized as follows:

RSI Value
<6

Significance
the scale tendency increases as the
index decreases

>7

the calcium carbonate formation
probably does not lead to a
protective corrosion inhibitor film

>8

mild steel corrosion becomes an
increasing problem

Puckorius Scaling Index (PSI)
The Puckorius Scaling Index (PSI) is based on estimates of the maximum quantity of
precipitate that can form and the buffering capacity of the water. The PSI index is calculated
in a manner similar to the Ryznar Stability Index, described above, except that it incorporates
the equilibrium pH and is calculated as follows:

where:
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The value of pHs is estimated using temperature, alkalinity, hardness and total dissolved
solids values as follows:

where:

TDS is total dissolved solids in units of mg/L
T is temperature in units of Kelvin
Ca is the concentration of calcium in mg/L-CaCO3
Alk is the alkalinity in mg/L-CaCO3

The value of pHeq is based on the buffering capacity of the solution and is estimated using
alkalinity:

where:

pHeq is in standard units
Alk is alkalinity in mg/L CaCO3

The empirical correlation of the Puckorius Scaling Index can be summarized as follows:
PSI Value
<6

Significance
the scale tendency increases as the
index decreases

>7

the calcium carbonate formation
probably does not lead to a
protective corrosion inhibitor film

>8

mild steel corrosion becomes an
increasing problem

Organic Calculations

Calculated Total Organic Carbon (TOC)
This function calculates the total carbon associated with organic parameters. Organic carbon
is assumed to be present in parameters with a molecular formula containing carbon and
excluding the following specific inorganic species: HCO3, CO3, and CO2. Values are reported
in mg/L or µg/L.
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Calculated Total Organic Halogens (TOX)
This function estimates the total halogens associated with organic parameters. Organic
halogen are assumed to be those parameters with a molecular formula containing halogens
(i.e. Cl, Br, I) and excluding inorganic species containing only halogens (thus, chloride mass
from Cl- and Cl2 is excluded). Values are reported in mg/L or µg/L.

Isotope Infiltration Calculations
Hydro GeoAnalyst includes functions to estimate infiltration elevation and temperature based
on linear relationships with the measured fractionation of oxygen-18 (18O) and deuterium
(2H) isotopes. The slope and intercept fitting parameters are valid only for a very limited
zone that must be established for your area of interest using empirical data and are specified
in Hydro GeoAnalyst using the project settings for Regional Chemistry.

z(18O)
Average infiltration height as a function of oxygen-18 isotopic composition.

where:
values

zinfiltration is a length unit in meters or feet, depending on the fitting parameter
18O is the fractionation of oxygen-18, usually expressed in units of permille

(‰).
m and b are regression fitting parameters based on regional/site-specific data

T(18O)
Average temperature of infiltration zone as a function of oxygen-18 isotopic composition.

where:
values

Tinfiltration is a temperature unit in oC or oF, depending on the fitting parameter
18O is the fractionation of oxygen-18, usually expressed in units of permille

(‰).
m and b are regression fitting parameters based on regional/site-specific data

z(2H)
Average infiltration elevation of the infiltration zone as a function of deuterium (2H) isotopic
composition.
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where:
values

zinfiltration is a length unit in meters or feet, depending on the fitting parameter
2H is the fractionation of deuterium, usually expressed in units of permille

(‰).
m and b are regression fitting parameters based on regional/site-specific data

T(2H)
Average temperature of infiltration zone as a function of deuterium isotopic composition.

where:
values

Tinfiltration is a temperature unit in oC or oF, depending on the fitting parameter
2H is the fractionation of deuterium, usually expressed in units of permille

(‰).
m and b are regression fitting parameters based on regional/site-specific data

Enthalpy Calculations

Temp > H H2O(l)
The enthalpy (H) of liquid water as a function of temperature (T) in Kelvin is approximated
using the following function:

where:

temperature is in units of Kelvin
a1 = 418.84
a2 = 10.286
a3 = -0.05092
a4 = 0.00026309
a5 = -0.00000069303
a6 = 0.00000000074566
a7 = -1209.8
a8 = 11.99
a9 = -353.76

For more details please refer to Fournier and Potter (1972).

Temp > H H2O(v)
The enthalpy (H) of water vapor as a function of temperature (T) in Kelvin is approximated
using the following function:
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temperature is in units of Kelvin
a1 = 2035
a2 = -5.0499
a3 = 0.057399
a4 = -0.00030426
a5 = 0.00000079095
a6 = -0.00000000086968
a7 = 1342.4
a8 = -13.298
a9 = 396.29

For more details please refer to Fournier and Potter (1972).

SiO2 > H H2O(l)
The enthalpy (H) of liquid water as a function of dissolved silica in mmol/L is approximated
using the following function:

where:

SiO2 is the concentration of dissolved silica in units of mmol/L
a1 = -42.198
a2 = 0.28831
a3 = -0.00036686
a4 = 0.00000031665
a5 = 77.034

For more details please refer to Fournier and Potter (1972).

SiO2 > H H2O(v)
The enthalpy (H) of water vapor as a function of dissolved silica is approximated using the
following formula:

where:
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a1 = -3.5532
a2 = 0.146
a3 = -0.0004927
a4 = 0.0000012305
a5 = -0.00000000049421
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For more details, please refer to Fournier and Potter (1972).

Exceedance Calculations

Exceeds Natural Occurrence Range (NO)
Returns the number of measured parameters in a given sample that fall outside of a
specified natural occurrence range. The natural occurrence range can be defined for a given
parameter using the Parameter Editor.

Exceeds Standard
Returns the number of measured parameters in a given sample that exceed the active
standard(s) as specified in the Water Quality Standards view.

Date Calculations

Year
Returns the calendar year of the sample collection date.

Season
Returns a season index number (1-4) for the sample collection date, based on the time of
year as follows:

Index

Date Range

1
2
3
4

Mar 21 - Jun 20
Jun 21 - Sep 20
Sep 21 - Dec 20
Dec 21 - Mar 20

Season
Northern
Southern
Hemisphere
Hemisphere
Spring
Fall
Summer
Winter
Fall
Spring
Winter
Summer

The season index is a convenient metric to find and select samples that were sampled in the
same season but in different years.
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Month
Returns the index of the month of the sample collection date, where the index is the ordinal
number of the month (i.e. January=1, February=2, March=3, etc.). Using this function is a
convenient metric to find and select sample data for calculating month-based statistics over
several years.

4.8.8

Upgrading Projects to HGA+
When opening a standard HGA project for the first time in the HGA+ edition and opening the
Sample List, you will be prompted to migrate your data:

Caution: migrating a standard HGA project to an HGA+
project will permanently alter the structure of the "Sample"
and "Sample Analysis" tables to facilitate the HGA+
functionality. It is strongly recommended that you fully
back up your project and database before proceeding as
there is no undo function once the migration is complete.
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Step 1: Migration Welcome
The first step in the data migration to HGA+ is a welcome screen that provides some
information about the process and serves as a stepping stone to kick off the migration.

Once you have read the information, select

to proceed with the import.

Step 2: Mapping the Samples Table
The second step allows you to select the table containing information about your samples. If
you used either of the default project templates as the basis for your project, this will likely be
the table called "Parameter Sample" in the map the "Monitoring Event" data category. The
migration wizard will automatically select this table if it exists; otherwise, you may select the
Source Samples table using the table selection button ( ).
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Once the source table has been selected, as shown above, the step will display the fields
that must be mapped to the destination Samples table in the following two columns:
· Destination: The data fields in the destination Sample table.
· Source: corresponding fields from the source data table.

Required fields will be highlighted green, including the (sample) Name, Sample Date and
Station (name) fields. As part of the Mapping step, you must select fields from the source
table. If the field names or aliases in the source table match the name of the destination
field, they will map automatically. If the headers do not match, you may click in the
unmapped Source column and a dropdown will appear allowing you to select a source field.

Migrating other fields
The list of fields displayed at this step will include the default fields in the destination Sample
table as shown above. However, you may also wish to migrate additional fields from the
source table. If so, select the document new ( ) button and you will be prompted to select
a field from the source table.
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Once you have mapped the required field and added any optional fields to the Sample table,
select the

button to proceed to the next step - Analysis.

Step 3: Analysis
The third step is very similar to the previous step and allows you to select the table
containing information about your sample analyses. If you used either of the default project
templates as the basis for your project, this will likely be the table called "Parameter Result"
in the map the "Monitoring Event" data category. The migration wizard will automatically
select this table if it exists; otherwise, you may select the Source Analysis table using the
table selection button ( ).
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Once the source table has been selected, as shown above, the step will display the fields
that must be mapped to the destination Sample Analysis table in the following two columns:
· Destination: The data fields in the destination Sample Analysis table.
· Source: corresponding fields from the source data table.

Required fields will be highlighted green, including the Parameter_Id, Value, Qualifier, MDL,
and Sample_Id fields. As part of the Mapping step, you must select fields from the source
table. If the field names or aliases in the source table match the name of the destination
field, they will map automatically. If the headers do not match, you may click in the
unmapped Source column and a dropdown will appear allowing you to select a source field.
Included in the dropdown is the option to add a constant value rather than a field. You must
also map a result units field which will be used to convert all results into a standard unit.

Migrating other fields
The list of fields displayed at this step will include the default fields in the destination Sample
table as shown above. However, you may also wish to migrate additional fields from the
source table. If so, select the document new ( ) button and you will be prompted to select
a field from the source table.
Once you have mapped the fields for the Sample Analysis table, select the
proceed to the next step - Parameters.
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Step 4: Parameters
At this step, you will map and define the Parameters to be used in your project based on the
unique values found in the Parameter_Id field that was mapped in the previous step. Source
parameters matching exactly with parameters already present in your Hydro GeoAnalyst
project or in the active Chemical List will be mapped automatically:

For unmapped parameters, there are two options to complete the parameter mapping step:
· Manual Mapping: click in the Project Parameters column of an unmapped parameter

and use the Parameter Picker to select an existing parameter or create a new
parameter.
·

Create Stubs: select this option to create new parameters with minimal
information using the source parameter name. You can complete the parameter
information at a later time using the Parameter Editor.
Note that you must map all parameters before proceeding to the next step.
Unmapped parameters will be denoted with a validation error symbol ( ).
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As part of the Parameters step, you may optionally select a preferred measurement unit for
parameters using the "Parameter unit" column. All numerical results for a given parameter
will be converted into and subsequently stored using the specified unit. If no units are
specified, the values will not be converted.

Once you have mapped project parameters, select the
step - Units.

button to proceed to the next

Step 5: Units
At this step, you will map and define the Measurement Units to be used in your project based
on the unique values found in the Source units field defined at the Analysis step above.
Measurement units matching exactly with those already defined in your Hydro GeoAnalyst
project will be mapped automatically:
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Note that all of the measurement units for a given parameter should be of the same category
as the default measurement unit defined at the parameters step. This is important because
you will encounter errors if the source data (i.e. the data to be migrated) includes results with
units that are inconsistent with the unit category of the specified default units.

Once you have mapped project units, select the
Clean up.

button to proceed to the next step -

Step 6: Clean Up
At this step, you can select what happens to the existing sample data in the database:
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Delete old sample data
Sample data will be migrated to the HGA+ data structure and the original sample data tables
will be deleted from the database. If you need to review the sample data in its original form
and select this option, you will need to restore the original data. This option is recommended
in most cases, as there will only be a single dataset for samples and sample results,
particularly if a backup was made before the data migration.

Replace old tables with views (Recommended)
Enabling this option will replace the original sample tables with equivalent SQL views
that maintain the functionality of these queries using the sample data structure used in
HGA+.
If you do not select this option as part of the "Delete old sample data option", queries
that reference the original sample data will no longer function correctly as the relevant
data tables and fields will be missing from the database. Affected queries will need to be
manually updated or deleted.

Keep old sample data
Sample data will be migrated to the HGA+ data structure and the original sample data tables
will be retained in the project database. This option is generally not recommended as there
©2022 by Waterloo Hydrogeologic
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will be two versions of the same data in project database. If there are multiple stakeholders
using the database, this option may lead to confusion about which data to work with. The
following options are provided to alleviate some of the potential confusion.

Replace old tables with views (Recommended)
Enabling this option will update queries that reference the original sample data to use
equivalent data views to maintain the functionality of these queries using the sample
data structure used in HGA+.
If you do not select this option as part of the "Keep old sample data option", queries that
reference the original sample data will reference the original sample data and any data
added to the new structure will not be included when executing affected queries.

Hide old tables
Enabling this option will hide the sample and results tables that contain the original data
(i.e. the tables specified in Steps 2 and 3). These tables can be shown once more in the
application using the Template Manager.

Rename old tables
Enabling this option will rename the sample and results tables that contain the original
data (i.e. the tables specified in Steps 2 and 3). By default, this option will append the
prefix "RETIRED_" to the name of the sample and result tables to remind users that the
tables and their data may not reflect the current data. If you select this option, but do not
select the "Replace old tables with views" option, queries that reference the original
sample data will include missing references to tables and fields and will need to be
deleted or manually updated.

Once you have selected the Clean up options, select the
step - Preview.

button to proceed to the final

Caution: proceeding to the Preview step will initiate the data
migration process and alter the structure of your database
based on the settings entered in the wizard thus far. Only
proceed when ready and/or if you have backuped up your
data as this step has no undo function.

©2022 by Waterloo Hydrogeologic

Fundamental Concepts

305

Step 7: Preview
At this step, you can preview the data in the destination Samples and Analysis tabs. The
resulting Samples table is shown below for the migrated data in the standard edition of the
Demo Project.

The resulting Analysis table is shown below for the migrated data in the standard edition of
the Demo Project:
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Click Close to close the migration wizard and reload the updated project. The resulting
Sample List for the migrated standard edition of the Demo Project is shown below:
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Menu Bar
The HGA menu items have been specifically designed for optimal flexibility and ease of use.
The items in the menu bar are context sensitive; this means that one or more menu items
may be greyed out if a specific feature is not applicable for a particular view.

The following sections describe the items which appear in the menu bar.
·
·
·
·
·
·

5.1

Project
View
Modules
Samples [HGA+ only]
Database
Help

Project
The Project menu contains options for project level actions as described below.
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New
This option launched the New Project wizard which is described further in the next section:
Creating New Projects.

Open
The Open menu item is used to open existing Hydro GeoAnalyst projects by selecting the
*.hga file. The *.hga file contains basic information for the project, including a connection
string to the Hydro GeoAnalyst database. The Open button in the Project Tree toolbar
performs the same function.

Open from Backup
Use this option to open a backup of an Hydro GeoAnalyst project and database.

Import AquaChem 2014... [HGA+ only]
Use this option to import an AquaChem 2014 project (*.aqc). Note that if the .aqc file was
developed using an older version of AquaChem, you may need to upgrade it using
AquaChem 2014.2 before to importing it into Hydro GeoAnalyst 11.0. For more information,
see the topic on Importing AquaChem 2014 Projects.

Close
Close the project which is currently open.

Reopen
This menu item provides a list of projects that have been recently opened. The most recent
project will appear at the top. Simply select the desired project, and it will be loaded into
HGA.

Install the Demo Project
You can Install the Demo Project from within the program by selecting Project / Install the
Demo Project (there is also an option to do this from the Start Page.
The Default option will install the Demo Project to a Local Database. Simple select Next and
then Finish to Install the Demo Project.
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However, if you prefer, you can install the Demo Project to a SQL Server database by
adjusting the Database Type option.
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You simply need to provide the name of the SQL Server you wish to use, the Database
Name for the Demo Project, and then select if you wish to use Windows Authentication or
SQL Server Authentication.

The Demo Project files will be installed to the location designated under Project / HGA
Settings (the Project tab). The default location is under Documents / Hydro GeoAnalyst.

Properties
This menu item will load a window displaying the properties for the current project.

Add GeoPoint support
Making use of the Spatial GeoPoint option within SQL Server 2008 R2 or later your project
can have a more direct link to ArcGIS. When creating or upgrading HGA projects to Version
2012 (or later) and using SQL Server 2008 R2 (or later) there will be a new field called
geo_point in the Location (station) table. For more information see the discussion on Spatial
Geo_Point.
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Make a backup...
Allows you to backup your project/database.
Hydro GeoAnalyst Settings
This option opens the Settings for Hydro GeoAnalyst. For more information, see the subsection on HGA Settings.
Default Tab Layout
The Default Tab Layout will restore your HGA main interface to show the Project Tree on the
left and the follow four tabs on the right:
·
·
·
·
·

Station List
Sample List [HGA+ only]
Station Data
Data Query
Data Filter

Any other tabs that were opened will be closed. Any other tab groups that were created will
be removed.

Exit
This menu item will close HGA, and all related windows (if any are open).

5.1.1

Creating New Projects
This section presents information on how to create new projects, and modify the properties
of existing projects. A new project is usually created with a completely new database;
however, HGA is designed to also allow for managing multiple projects within a single
database.
The most common workflow is to create a new database for each new project and that
workflow is documented here.
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Starting the New Project Wizard
The New Project Wizard can be launched in two ways:

· Select Project / New from the Main Menu; OR
· Click on the

button on the Start Page.

The New Project Wizard will then appear. The Project Wizard contains various steps, each
step appearing in a new window, with the various settings for a new project. It is designed in
a sequential fashion; after defining the necessary inputs in each window, press the Next
button to proceed. The Next button will only become activated after the necessary fields
have been defined.

The Wizard includes the following steps:
·
·
·
·

Data Source
Select Template
Project Settings
Create Project

Data Source
The first step in the New Project Wizard provides the data source settings options.
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Data Source Type
HGA allows you to store your project data base within a Microsoft SQL Server instance or
within a Local Database:
· If this project is intended only for you (others will not need to be given access) then the

Local Database option can be used. It does not require any additional Microsoft SQL
Server installation or connections - as this is already done (silently) during the HGA
installation.
· If however, this project will need to be accessed by multiple users, you should use the

Microsoft SQL Server option. We currently support versions between Microsoft SQL
Server 2012 to 2019 (Express or Full editions).
Local Database
If you have selected to use the Local Database, you only need to specify the Instance name
of your local database. When it is installed with HGA, it is named "Waterloo" - however if you
have another instance installed, you can use that as well. Once you have selected a local
instance, you can provide a name for the database.
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Please Note: If Local Database does not appear in the
dropdown, consider closing and then restarting Hydro
GeoAnalyst to initiate the Local Database. In some cases
you may have to restart your machine.

Microsoft SQL Server
If you have selected Microsoft SQL Server you will need to select the SQL Server that will
hold your project database and then provide a name for the database. You have two options
for authentication:
1. Windows Authentication (default)
2. SQL Server Authentication
Windows Authentication uses your log in to authenticate you on the SQL Server while SQL
Server Authentication requires you to enter an appropriate User Name and Password to be
authenticated on the SQL Server.
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Please Note: Appropriate permissions need to be provided
to use either of the authentication options. Please contact
your IT support to ensure you have appropriate permissions
to create new databases or create new projects on existing
databases.
Refer to Connection Problems for some troubleshooting
suggestions if you cannot see your local instance of SQL
Express when creating a new project, or opening an existing
project.

Once you have define the Data Source information for your project, select the
proceed to the next step in the New Project wizard.

button to

Select Template
This step in the New Project wizard allows you to select which database template to use for
your project. A <Basic Template> that can be extended is provided with Hydro GeoAnalyst.
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When you select a template from the drop down list you can review the database structure in
the preview below.

If you have exported a database template from another project and would like to use it to
create a new project, select the browse button and browse to the location of your template
(*.hgat).
Select the

button to proceed to the next step in the New Project wizard.

Project Settings
This step in the New Project wizard allows you to specify a project name and location for
your project folder.Additionally you can select a Material Specification and then the
Projection Type and Projection to be used for your X and Y coordinates.
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The Unit for your projection will be selected automatically based on the selected projection
type (e.g. UTM will use m, State Planer will use feet, etc.). If the Local Projection Type option
is selected, you can select the desired unit from the drop down box.

Please Note: If Local Projection Type is selected, the project
coordinate system cannot be changed once the project is
created. Furthermore, all imported spatial data must already
be expressed in local coordinates as HGA does support
conversions from projected/geographic coordinates systems
to local systems.

Depending on the projection type that you select, you may also be required to select an
appropriate Geotransformation for your project. If required, the following dialog will display:
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Simply select the area that best represents the spatial extent of your geographic data from
the list, and then click the [Ok] button. Note: You will not be able to create the project until
you have selected an area. For more details on defining geotransformation settings, please
refer to Appendix F: Configuring Geotransformation Settings.
Once you have specified the projects settings select the
step of the New Project wizard.

button to proceed to the final

Create Project
At this final step in the process, click the
project.
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Open from Backup
You can restore a project from a back up copy of your database and project files. This is
useful if you need to restore a project from a backed up version from an earlier point in time
or if you need to transfer/receive a copy of someone else's project and database.
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Restore From Section
In the Restore from section browse to the SQL server backup file (*.bak). Then select the
corresponding project file (*.hga).

Restore To Section
In the Restore to section you need to specify the name of your project (it will use the project
name in the *.hga file by default). and then specify the Data source type and which SQL
Server you will be restoring the backup to. You can select the Refresh button to look for
additional SQL Servers.
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Please Note: The SQL Server instance should be on the
same machine as Hydro GeoAnalyst as SQL Server does
not allow you to restore databases across a network.

· You can specify the name of the database - by default this is also taken from the *.hga

file.
· Finally you have the option to specify to use Windows Authentication (default) or SQL

Server Authentication.
· The select the OK button. The database will be restored onto the SQL Server and the

project will open.

If you ever need to provide a copy of your database to someone - a back up of the SQL
Server database can be made using the BackUp Database option (available in the Database
menu), explained later in this section. A copy of the project can be made by simply copying
the project folder, and its contents, using Windows explorer.

Please Note: On Windows 7 operating systems, User
Account Control (UAC) must be disabled before you can
successfully open a project from backup.

5.1.3

Install the Demo Project
The Demo Project is a pre-configured project that is installed with Hydro GeoAnalyst and
includes the sample data and saved outputs (like queries, maps, cross sections and more!).
If you are using HGA+, it also includes examples of how to use the advanced modules for
sample management, analysis, plotting, and R-scripting.
You can Install the Demo Project from within the program by selecting Project > Install the
Demo Project from the Main Menu. There is also an option to do this from the Start Page.
The Default settings will install the Demo Project to the Waterloo instance of the Local
Database that is installed with Hydro GeoAnalyst. Simply select
to Install the Demo Project.

and then
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However; if you prefer, you can install the Demo Project to a SQL Server database by
adjusting the Database Type option.
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You simply need to provide the name of the SQL Server you wish to use, the Database
Name for the Demo Project, and then select if you wish to use Windows Authentication or
SQL Server Authentication.
The Demo Project files will be installed to the location designated under Project / HGA
Settings (the Project tab). The default location is in the Hydro GeoAnalyst folder in your
user/Documents folder.

5.1.4

Import AquaChem2014 Project
In HGA+, you can import an AquaChem 2014 project. To do this, you can select 'Project >
Import AquaChem 2014...' from the main menu or select
from the
Start Page Tab, which closes the open project (if any) and opens the Import AquaChem
(AQC) Project wizard, which includes four major steps:
·
·
·
·
·
·

Select Project
Data Source
Template
Project Settings
Parameter Units
Import Project
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Please Note: Importing AquaChem 2014 projects is only
available in HGA+.

Select Project
In the first step of the import process, you select the project to be imported; simply use the
button and navigate to the AquaChem 2014 project you wish to import:

Once you have selected the AquaChem 2014 project to be imported, Hydro GeoAnalyst will
scan the project to verify that the sample IDs are unique. If the project is ready to be
imported without further action, you may select
button to proceed to the Project
Location step. If missing or duplicate sample IDs are encountered in your project, you will
be prompted with some options for this to be resolved.

Resolving Missing or Duplicate Sample IDs
If samples in the original project file do not contain unique a SampleID (e.g. Sample IDs are
missing or there are duplicate values), you will be shown a preview of the relevant records in
the Sample table and prompted with the following options:
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· Ignore these samples: samples with missing or duplicate ids will be skipped and not

included in the project import
· Combine the station name and a number: samples IDs will be generated for the

non-unique records by appending a sequential number to the station name. In the
example below, the sample ID would be "MW-1-1", subsequent samples would be
"MW-1-2", "MW-1-3", etc.
· Combine the station name with the following fields: sample IDs will be generated

for the non-unique by appending the station name and one or two selected fields. In
the example below, the sample ID would be appended with the Sample Date: "MW-12002-08-25". Note that you will receive a warning if duplicate records would result from
your selection (e.g. if you collected more than one sample at the same station on the
same date).

These options ensure that each sample in the imported project contains a unique SampleID;
which is a strict requirement in Hydro GeoAnalyst 11.0.
Once the unique sample IDs ensured in the imported project, you can proceed to the next
step by clicking the

button to proceed to the Project Location step.
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Data Source
In the second step of the import process, you select the name of the Hydro GeoAnalyst 11.0
project, the destination folder and the coordinate system units. Simply use the
button and navigate to the folder where you want to store the project and provide a Project
Name, as shown below:

You can now proceed to the Parameter Units mapping step by clicking the

button.

Template
At this third step, you will be prompted to select a template for the database that includes the
full HGA+ table structure as well as the original AquaChem v2014 project structure. Note
that if any of the tables and fields that are required for use with relevant modules are missing
from the template, they will be created by Hydro GeoAnalyst.
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You can review the structure of the selected template in the selected template. You can also
review the parameters included in the template by selecting the
button.

Project Settings
At this fourth step, you will be prompted to define key project settings, such as the project
name, project folder, material specification, and coordinate system (projection type and
projection).
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Parameter Units
At this fifth step, you will be prompted to map measurement units that are present in the
original AquaChem v2014 project to equivalent units in Hydro GeoAnalyst 11.0.
To map units, simply click unmapped (empty) empty cells under the 'Units' column. A 'Select
unit' window will then open allowing you to choose from available unit categories using the
dropdown menu at the top of the window. Available units for the selected category will then
be displayed, allowing you to choose the desired unit:
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You can select the units using Category dropdown list; which will show all of the units for the
selected unit category. Units in the same category can be converted to each other. If the
unit is not available for the appropriate category, select
unit for the current unit category:

button to create a new

· Name: the name of the unit category. For example, micrograms per liter
· Display Name: the name that will be used for labels in Hydro GeoAnalyst. For

example, µg/L
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· Multiplier: the factor that converts the new unit to the base unit. For example, the

conversion factor for µg/L to the base unit (g/L) is 1x106.
· Offset: the unit offset that converts the new units to the base unit. Usually this is 0, but

in some cases, for example: converting between the temperature units degrees
Celcius to degrees Fahrenheit requires a linear offset.
· Base Unit: the base unit is the measurement unit that all other units of the same

category are compared against (using the multiplier and offset).

If no units are specified for the unmapped units, parameters with these unmapped units will
be imported with no units and corresponding values will be imported without any
conversions. You can assign missing units after the import process using the Parameter
Editor module.
Once you have mapped parameter units as desired, click the
final step of the import process: Import Project.

button to proceed to the

Import Project
The final step in the import process, is to simply click the
import process:
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When you click the
button Hydro GeoAnalyst 11.0 will generate the new Hydro
GeoAnalyst project database based on the contents of the original project and populate it
with the data from the AquaChem v2014 project. Database tables, fields and records will be
recreated faithfully in the new project. When the import process is finished, the 'Import
AquaChem (AQC) Project' window will close, and the project will be loaded.

Map Missing Required Parameters
If any of the required parameters from the AquaChem v2014 project have not been
automatically mapped, then the Parameters tab of the Project Properties window will appear,
as shown below:

In Hydro GeoAnalyst there are a number of parameters which must be mapped/included in
order to work with certain features built-into Hydro GeoAnalyst, such as evaluating functions
(e.g. hardness calculations) or adding plots (e.g. Piper plots) that require specific
parameters. If the window above appears, you can use the toolbar buttons to quickly map
the existing database parameters to the required parameters (i.e. indicate to Hydro
GeoAnalyst 11.0 which of the available parameters represents the unmapped required
parameters):
·

Auto-map: automatically matches unmapped parameters from the original project
to the new database structure based on parameter names with similar names.
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Create missing parameters: creates new parameters for the unmapped
parameters using the required parameter name. You will have to use the Parameter
Editor to verify parameter properties (e.g. molecular weight and valence).

You can also click in the blank cells (highlighted
an existing parameter in your database.

) to use the Parameter Picker and select

After mapping the missing parameter(s) simply click
dismiss the Project Properties window.

5.1.5
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to accept the changes and

Properties
This menu item will load a window displaying the properties for the current project.

General Tab
The General tab displays information about the project, including the project name, storage
location, database name and coordinate system.
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On the General tab you can find the settings selected during project creation including:
·
·
·
·

Coordinate System Unit: feet or meters (not editable after project creation)
Project Location: Description of the Project Location
Database Name: File Name of the associated database
Project Folder: location of project files (e.g. output reports, associated images, EDD
templates, plots, scripts, etc.)

Plot Settings
The Plot settings tab allows you to specify how active (selected) data points on interactive
plots are displayed in Hydro GeoAnalyst. The symbol(s) of the active data point(s) will be
modified based on the settings of this tab. You can specify which properties are (or are not)
changed using the check marks. The Test symbol is shown to contrast how the active
symbol will change based on the current active symbol style settings.
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Map Settings [HGA+ only]
The Map tab allows you to specify the default projection system for new Map Viewer maps
created in the project.

Well Profile Settings
The Well Profile Settings tab allows you to specify which tables and fields are to be used to
obtain information related to geology and well construction details in the well profile.
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On the Well Profile Settings tab you will find the settings used within the Well Profile module
- here you can specify which tables and fields are to be used to obtain information related to
geology and well construction details. Each item that requires a setting has its own tab
including:
·
·
·
·
·
·
·

Lithology
Hydrogeology
Drilling
Casing
Screen
Filling
Water Level

For each item, provide the table and the field that stores the patterns or provides interval
data to be used in all the graphical displays. For example, in the Lithology tab, select a table
which contains the Lithology information for your project; then select a field from this table
which contains the Soil Description information. The information provided in this window will
be used when displaying profile diagrams in Hydro GeoAnalyst. The geological data and the
corresponding patterns will also be displayed in the Cross Section Editor, and in the Scene
Viewer. Only tables with the following parameters can be displayed in this dialog:
· Lithology: Tables must have two fields with type DOUBLE (from_, to_) and one field

with type STRING (soil_type)
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· Hydrogeology: Tables must have two fields with type DOUBLE (from_, to_) and one

field with type STRING (ex. formation name)
· Drilling: Tables must have three fields with type DOUBLE: (from_, to_, diam_), and

one field with type STRING (method)
· Casing: Tables must have three fields with type DOUBLE (from_, to_, diam_) and one

field with type STRING (ex. material). If it's desired to have multiple well casings, or
nested piezometers, you must also define two additional fields:
o Casing ID: field type LONG (used to distinguish different well casings)
o Parent ID: field type LONG (required only if a well casing exists within a parent
casing; if so, for the selected well casing, set the ParentID equal to the CasingID of
the parent casing)
· Screen: Tables must have three fields with type DOUBLE (from_, to_, diam_) and one

field with type STRING (ex. material). If you have multiple well casings, you must add
an additional field:
o CasingID: field type LONG (used to distinguish different well casings). This allows to
assign multiple screens to multiple well casings.
· Filling: Tables must have two fields with type DOUBLE (from_, to_) and one field with

type STRING (ex. material)
· Water Level: Tables must have one fields with type DOUBLE (depth_) and one field

with type STRING (ex. comments). In the Water Level tab, you may also select the
reference datum for measuring depth to water levels: select "Ground Surface
Elevation, or Top of Casing"

Please Note: The depth-point and depth-interval information
(from, to fields) are depths and not elevations. As such, the
Well Profile and Cross Section editor require that data be
entered as "depth to" and not as an elevation above sea level
or a benchmark.

Parameters [HGA+ only]
The Parameters tab allows you to map Parameters in your database to the Parameters that
are required by Hydro GeoAnalyst to function. These parameters are required so that Hydro
GeoAnalyst can use them in built-in functions and calculations. If any of the Required
Parameters are unmapped when you create or open a project, Hydro GeoAnalyst will prompt
you to map the required fields using one of three options:
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1. Manual Selection: You can manually map each missing parameter by clicking in the
corresponding empty cell in the Database Parameter column. This will open the
Parameter Selector and allow you to pick an existing parameter from the project
database. Select an existing parameter from the database and Click OK.
2.

Auto-map: you can select the Auto-map button in the upper left corner of the
window and AquaChem will attempt to match the unmapped Required Parameter(s) to
existing parameters in your project database with the same or similar spelling. If you
don't agree with the match(es) that AquaChem suggests you can adjust the values or
click the Cancel button and try again using a different method.

3.

Create missing parameters: you can select the "Create missing parameters"
button in the toolbar and AquaChem will create new parameters in the database.

Please Note: if you create missing parameters, you may
need to review the settings (e.g. molecular weight, CAS#,
etc.) for the new parameters to ensure that they are used
correctly in your project.
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Functions [HGA+ only]
The Functions tab provides a list of the built-in functions supported in Hydro GeoAnalyst and
allows you to manage how they are shown in the Calculated tab of the Results pane in the
Sample List View, including:

· Order: rearrange the order of functions in your project by selecting a formula and

using the up

and down

arrows;

· Label: edit the label that will appear in the Results pane of the Sample List view for the

selected function by editing the Label field;
· Number Format: set the format of function results using the standard formats that are

available in Excel (e.g. #,##0.00; 0.00E+00; and 0); and
· Output measurement units: select one of the measurement units available for the

selected function

Available functions are shown below and explained in detail in the Functions section.
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Regional Chemistry [HGA+ only]
The Regional chemistry settings tab includes variable settings for empirical functions with
parameters that vary regionally. These include the Meteoric Water Line and estimates of the
infiltration elevation and infiltration temperature based on linear relationships with the
measured fractionation of oxygen-18 (18O) and deuterium (2H) isotopes. The slope and
intercept fitting parameters are typically valid only for very limited zones that must be
established for your area of interest using published/empirical values. There are also
settings that allow you to document the scope (i.e. Area of study and Description) and
source (i.e. Reference) of the regional chemistry parameter values.

Water Type [HGA+ only]
The Water Type tab provides settings to facilitate and modify the calculation of water facies
for samples in the project:

· Water type field: select the destination field in the sample table for water type

calculations. This is a field in the Sample table that you wish to store the water type
information. If one is not present in the Sample Table, you can use the Template
Manager to add the field to your project.
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Use long water type: if selected, the long facies name will be selected; otherwise,
the water type will list only the anion and the cation with the highest concentration in
the sample(s).

· Major ion threshold (percent): when calculating the long facies name, only ions that

exceed the specified threshold of the total sample composition will be included in the
construction of the water type.

For more information, see the Calculate Water Type section.

5.1.6

HGA Settings
The HGA Settings dialog provides various settings for a number of options within the
program.

General
Here you can specify application-level settings about where to store project data and other
general defaults.
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· Default data source type: the default database source type (either Microsoft SQL

Server or Local Database)
· Default server: the default server/instance name
· Default Project location: the default location where project information and files will

be stored
· Show/Hide Template Manager automatically saves changes warning message:

allows you to show/hide the warning message when opening the Template Manager.
· Number of rows per page: Allows you to set how many records will be returned per

page when viewing tables and queries. Note: setting a high value may result in
performance issues depending on the size of your project database and connection
speed setting. In general, the number of records should not exceed 10,000 and lower
values may be preferable. This setting can help prevent long wait times as HGA is
trying to load data. If a maximum has been reached in one of the data views you will
notice this indicated at the bottom of the tab. It will also indicate the total rows that are
stored in the table, view, or query.

©2022 by Waterloo Hydrogeologic

Menu Bar

343

· Query Time Length: sets the amount of time (in seconds) that Hydro GeoAnalyst will

attempt to run a query before timing out.
· Logging Level: this setting defines how often HGA will send activity messages to the

Hydro GeoAnalyst log file. The log file can be useful if you run into issues and require
technical support. There are 4 levels of logging available:
o Error - this logs unexpected (bad) things
o Warning - this logs the errors as well as warning which might point to impending
errors [default]
o Information - this logs errors and warnings as well as other helpful things
o Verbose - this logs errors, warnings, information as well as debugging information
The Warning level is the default level; however, if you are encountering errors,
Technical Support may suggest to increase the logging level and have you reproduce
the issue and then send the log file to help us understand the problem. Please be
aware that changing the level to Verbose may have a negative impact on performance,
so you will likely want to lower the level again once you have provided Support with
your log file!
· Anonymous Usage: by default, Hydro GeoAnalyst collects anonymous usage

statistics. The data that we collect enables us (Waterloo Hydrogeologic) to get reliable
statistics on which features are used (or not used). This helps us better understand the
needs of our users so we can build better applications. The information collected is
completely anonymous – it is not traceable to any individual, project, or organization.
You can opt in (or out) at any time by (de)selecting this option.
Start Page
Here you can specify if you want the Start Page to be hidden after opening a project as well
as if you want the Start Page to be shown when you start HGA.
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Additionally, you can change the number of projects to show in the list of recently opened
project - or clear the list.

Help
Here you can specify if you want to use the Online Help (Recommended) or the Local (In
Program) Help. We recommend the Online Help (if you are connected to the internet) as this
set of documentation can be updated more frequently that the Local Help.
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Template Files
Here you can specify where you want to store the HGA template files. These template files
include the database template files used when creating a New Project as well as the office
template files for printing to ExcelTM and PowerPointTM as well as the WordTM template used
for printing Event Plans. The office template files are organized into appropriately named
folders. Do not adjust the folder names as this is how HGA knows which templates are
available.
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You will also find the option to restore all the templates - in case you want to move them to a
different location or if you have made changes to the original ones and want to revert back.

Module Manager
Here you can specify which modules will be opened on Hydro GeoAnalyst startup and which
modules will be included in the Main Toolbar. You can also reorder the modules. Note that
you must restart Hydro GeoAnalyst for changes to take effect.
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Simply use the
and
buttons to include a module in
the startup process or in the module toolbar, respectively. Note that not all modules can be
added to the startup process (e.g. Template Manager).
You can reorder the modules in each list by selecting an item and using the
rearrange the item, the

to remove the item, or the

arrows to

button to restore defaults.

R-Console [HGA+ only]
Here you can specify where the R.DLL library is installed. The location where R.DLL is
typically installed is shown below. Note, you will need to already have R locally installed in
your environment following the installation instructions.
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Chemicals list [HGA+ only]
Here you can specify the location of your Chemical List, which is a database of parameters
and their properties. This is a common resource that is shared across all of your projects and
can be managed centrally by your organization.
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Here you can specify what happens when you activate station groups or sample sets:
When Activated:
Available
Station Group Sample Group
Actions
Do Nothing
Show the Station
List
Show the
Sample List
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External Programs
Here you can specify the location of AquiferTest and other external programs to call them
within the Hydro GeoAnalyst environment. This allows HGA to launch these programs from
the Main Toolbar with optional startup commands.
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After supplying the correct path information, the toolbar will be updated with buttons that will
launch the specified applications.

Event Planner
Here you will find options for when and if you want to be reminded about closing overdue
events from the Event Planner module.
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Scene Viewer
Here you will find the option to switch between using your hardware accelerator of the
Microsoft driver for the Open GL Driver to be used in the Scene Viewer. The default
recommended option is to use your hardware accelerator; however, if you have an older
machine or encounter difficulties with the way things are visualized within the Scene Viewer
you might consider switching to the MS Driver option.
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The virtual grid allows you to boost the performance of the Scene Viewer by downsampling
grids/surfaces. The quality metric specifies how many megabytes of of memory to allocate to
building virtual grids. The full grid will be rendered if it is does not exceed the limit; otherwise
a downsampled grid will be rendered.

Reset
The HGA Settings dialog also has a Reset button which will allow you to reset ALL the
settings to default settings.
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View
The View menu allows you to reopen any closed tabs.

Please be aware, there are other modules that will launch as a tab (for example the Query
Builder, the List Editor, and the Material Specification Editor) but you can view these by
selecting these modules from the Modules Menu or by selecting the Icon in the Main
Toolbar.

Start Page
The Start Page Tab contains information about your version of Hydro GeoAnalyst and
available help and support resources.

Station Data
The Station Data Tab provides an interface for working with data associated with the
currently selected station group (e.g. samples).

Station List
The Station List Tab provides an interface for working with the currently selected station
group.

Non Station Data
The Non Station Data Tab provides an interface for working with data that is not related
directly to stations.

Sample List [HGA+ only]
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The Sample List provides an interface for working with the active sample group and related
results.

Query Results
The Data Results view provides an interface for viewing the results of Queries.

Data Filter
The Data Filter view provides an interface to view and filtering (but not edit) raw tables in
your project database. This is also a mechanism for building simple queries of a single
table.

5.2.1

Start Page Tab
When first launching Hydro GeoAnalyst you will find a Start Page to help you do common
tasks such as creating a new project or opening an existing project – even installing the
Demo Project. There is also a lot of valuable information such as; what’s new in the latest
version, links to online resources including “How To” videos to help you learn about the new
features more quickly, and links to our Technical Support staff to make it easier to ask
questions and report issues.
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The New Features tab describes each of the new features. Some features will also include
links to videos about the new feature.
The Release Notes tab displays our online Readme file. This contains detailed information
about the new features, a list of features and bugs fixed from previous versions, as well as
known issues and limitations of the current version.
The Support tab provides additional sources of information to help you, including how to
contact our support team. If you have a question or concern with the product, you can use
this link to initiate an email to the support team and it will include all the System Information
which can be very helpful for our support team to help resolve your concern. If you are
having difficulties explaining the concern try using the Problem Step Recorder – it does just
what the name implies – it creates a recording of the steps you took (all the clicks) with
screen captures to help make it clear what you were trying to do. On the right side of the
Support tab there are links to more information including:
· The HGA YouTube channel with videos of tutorials, webinars, and more;
· The online Frequently Asked Questions (FAQs); and
· Available Training Options.

5.2.2

Station Data
The Station Data tab provides a detailed view of the active Station's attributes as denoted in
the Station Picker. The Station Data tab displays available information about the currently
selected station based on the active Data Category. Detailed information about the active
station can be viewed, added, edited or deleted through the Station Data tab.

Toolbar
The toolbar for the Station Data tab contains the following controls:
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Navigates data pages; skipping to the first page (in the
sort order), to the previous page, to the specified page, to the next page or to the last
page.
Adds a new record.
Deletes the currently selected record(s) from the database.
Saves the changes you have made.
Allows you to select which columns you want to show or hide.
Refreshes the data in the current tab.
Exports the data from the current tab.
Exports the data from the current tab to an Excel template. (see below)

Working with data
The first line shown on the tables in the Station Data Tab contains field names/column
headers; below this is the filter line, which is highlighted in light blue and denoted by the
clear filter button (
) in the left-most column. The filter line can be used to restrict records
to display based on the values in one or more field and is described in detail in the Data
Filtering section.
You can select one or more records (that will turn bright blue) in the data table by clicking on
the buttons on the left-hand side of the grid (using the <SHIFT> and <CRTL> keys for
selecting multiple records). You can perform the following actions by right-clicking on the
selected record(s) in the currently displayed table:
Hide/Show Columns: allows you to select which columns you want to show or hide
Show All Columns: unhides all hidden columns
Select All Rows: selects all records in the currently displayed page
Copy: copies the selected record(s) and the header row to the clipboard for use in other
applications (e.g. Excel, notepad, etc.)
Add Record: appends a new record to the end of the current page
Save: saves any edited records to the database (note that records with unsaved edits
are highlighted in yellow)
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Delete Record: deletes the selected record(s) from the database
Export: Exports the table to a file format of your choice: Excel (.xls, .xlsx), Access (.mdb,
.accdb), Text (.csv), HyperText (.htm), and portable document (.pdf)
Print to Office: Exports the data from the current tab to an Excel template (see below)
Refresh: Refreshes the data in the current tab from the project database
Resize Columns to Fit Grid: resizes columns to fit the table columns within the
workspace

Values in fields may be modified for the actively selected record (denoted by a
), by
clicking in the cell you wish to edit and entering the desired value. The Station Data tab may
be used to quickly view or manage data for numerous samples or other station-based data.

Print to Excel Template
When printing your Station Data to an Excel template, you will be prompted to select a
template. A template called "Template - Table.xlsx" is provided with Hydro GeoAnalyst. You
can modify this template by going to the folder where your templates have been stored (see
HGA Settings for more details) and adjust it to suit your needs. Perhaps you may want to
change the logo, add others etc. Templates stored in the Office/Excel Tables subfolder will
be available in the drop down list under the Open Template option.

Once you have selected a template you can select the OK button and the Excel template will
open with your data in it - ready for printing or further analysis!

5.2.3

Station List
The Station List tab provides an overview of the available stations in the active station group
as selected from the project tree and displays fields from the Station Table (the main table
within the Hydro GeoAnalyst database) for example: name, X-coordinate, Y-coordinate,
Elevation etc. The Station List tab allows you to manage stations and their associated data.
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Toolbar
The toolbar for the Station List tab contains the following controls:
Adds a new record (only available if the All Stations station group is selected).
Deletes the currently selected record(s) from the active station group. To delete a
station from the project entirely you must activate the 'All Stations' group before
deleting.
Saves the changes you have made to the project database.
Allows you to select which columns you want to show or hide.
Refreshes the data in the current tab from the project database.
Exports the data from the current tab.
Prints the data from the current tab to an Excel template (see below).

Working with the Data
The first line shown on the tables in the Station List Tab contains field names/column
headers; below this is the filter line, which is highlighted in light blue and denoted by the
clear filter button (
) in the left-most column. The filter line can be used to restrict records
to display based on the values in one or more field and is described in detail in the Data
Filtering section.
You can select one or more records (that will turn bright blue) in the data table by clicking on
the buttons on the left-hand side of the grid (using the <SHIFT> and <CRTL> keys for
selecting multiple records). You can perform the several actions by right-clicking on the
selected record(s) in the currently displayed table, including showing/hiding fields and
records, copy, paste, adding the selected station(s) to a new/existing station group,
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refreshing the data from the project database, and resizing the columns to fit the station list
table within the current workspace.
Values in the data fields may be modified for a selected station (simply click in the cell you
wish to edit); or a new station may be created here (selecting the
icon), and the values for
these fields may be defined. The Station List tab may be used to quickly enter numerous
stations, and define the basic attributes for each station.

Print to Excel Template
When printing the Station List table to an Excel template you will be prompted to select a
template. A template called "Template - Table.xlsx" is provided with Hydro GeoAnalyst. You
can modify this template by going to the folder where your templates have been stored (see
HGA Settings for more details) and adjust it to suit your needs. Perhaps you may want to
change the logo, add titles for the project or client, etc. Templates stored in the Office/Excel
Tables subfolder will be available in the drop down list under the Open Template option.

Once you have selected a template, you can select the OK button and the Excel template
will open with your data in it - ready for printing or further analysis!

5.2.4

Non Station Data
The Non Station Data tab provides you with the ability to view tables that are not directly
associated with the Station Table (e.g. the Sample Analysis tables). You can find out more
information about how to add a Non Station Data table in your database in the Template
Manager section. The Non Station Data tab displays available information based on the
active Data Category. Information in the Non Station Data tab can be viewed, added, edited
or deleted.
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Toolbar
The toolbar for the Non Station Data tab contains the following controls:
Adds a new record.
Deletes the currently selected record(s).
Saves the changes you have made.
Selects which columns you want to show or hide.
Refreshes the data in the current tab.
Exports the data from the current tab.
Prints the data from the current tab to an Excel template.

Working with the Data
The first line shown on the table in the Non Station Data tab contains field names/column
headers; below this is the filter line, which is highlighted in light blue and denoted by the
clear filter button (
) in the left-most column. The filter line can be used to restrict records
to display based on the values in one or more field and is described in detail in the Data
Filtering section.
You can select one or more records (that will turn bright blue) in the data table by clicking on
the buttons on the left-hand side of the grid (using the <SHIFT> and <CRTL> keys for
selecting multiple records). You can perform the several actions by right-clicking on the
selected record(s) in the currently displayed table, including showing/hiding fields and
records, copy, paste, adding the selected station(s) to a new/existing station group,
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refreshing the data from the project database, and resizing the columns to fit the station list
table within the current workspace.
Values in the data fields may be modified for a selected record (simply click in the cell you
wish to edit); or a new record may be created here (selecting the
icon), and the values for
these fields may be defined. The Non Station Data tab may be used to quickly enter or edit
data for tables not directly associated with a station (i.e. a database table that does not a link
to the station table as defined in the Template Manager).

Print to Excel Template
When printing a Non Station Data table to an Excel template, you will be prompted to select
a template. A template called "Template - Table.xlsx" is provided with Hydro GeoAnalyst.
You can modify this template by going to the folder where your templates have been stored
(see HGA Settings for more details) and adjust it to suit your needs. Perhaps you may want
to change the logo, add titles for the project or client, etc. Templates stored in the
Office/Excel Tables subfolder will be available in the drop down list under the Open
Template option.

Once you have selected a template, you can select the OK button and the Excel template
will open with your data in it - ready for printing or further analysis!

5.2.5

Sample List
The Sample List tab provides an overview of the samples in the selected Sample Set or
Station Group. This tab displays fields from the Sample table (left) and also displays results
for the active sample, as denoted by the
symbol in the sample table (right). Note that
results with values that exceed an active Water Quality Standard will be color coded.
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Toolbar
The Sample table and results viewer toolbars in the Sample List tab contain the following
controls:

Sample Table Toolbar

Sample Results Toolbar - Measured

Sample Results Toolbar - Calculated

Navigates data pages; skipping to the first page (in the
sort order), to the previous page, to the specified page, to the next page or to the last
page.
Adds a new record (i.e. sample or result) to the appropriate table.
Deletes the currently selected record(s) from the project database.
Saves the changes you have made to the project database.
Allows you to select which columns you want to show or hide in the sample table.
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Toggles the width of the table either stretch to fit the view or allow a horizontal
scrollbar.
Refreshes the data from the project database.
Exports the data from the applicable table to an unformatted Excel file.
Exports the table to a selected Excel workbook based on a selected template.
Calculates the water type for the selected record(s).
Calculates the water type for all records in the sample list.
Splits the sample table and results viewer horizontally.
Splits the sample table and results viewer vertically.
Provides the option to display concentration results using a single/consistent unit for
all applicable parameters in the results viewer.
Provides the option to display the active water quality standards.
Allows you to filter displayed results to the selected
parameter group.
Opens the calculation settings.

Working with the Data
The first line shown on the sample table in the Sample List Tab contains field names/column
headers; below this is the filter line, which is highlighted in light blue and denoted by the
clear filter button (
) in the left-most column. The filter line can be used to restrict records
to display based on the values in one or more field and is described in detail in the Data
Filtering section.
You can select one or more records (that will turn bright blue) in the data table by clicking on
the buttons on the left-hand side of the grid (using the <SHIFT> and <CRTL> keys for
selecting multiple records). You can perform the several actions by right-clicking on the
selected record(s) in the currently displayed table, including showing/hiding fields and
records, copy, paste, adding the selected station(s) to a new/existing station group,
refreshing the data from the project database, and resizing the columns to fit the station list
table within the current workspace.
Values in the data fields may be modified for a selected sample (simply click in the cell you
wish to edit); or a new sample may be created here (selecting the
icon), and the values
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for these fields may be defined. The Sample List tab may be used to quickly enter numerous
samples and their results.

5.2.6

Data Query Tab
The Data Query Tab will display the results of executing (running) a query. When you select
a query from the Queries branch of the project tree, the Data Query tab will be activated and
display the results of the selected query.

As in most tabulated views in Hydro GeoAnalyst, the first line of the Data Results tab is the
Filter Line which is highlighted ( ). The filter line is similar in function to what you find in
Excel when you apply a filter. You can enter values to filter the list of what is displayed only
to those values that you are interested in.
You can also highlight a record (will turn bright blue ) by clicking on the button on the left
hand side of the grid and then right click on the record and select copy or <CTRL><C>. You
can paste this into for example an Excel worksheet and both the header information and the
records you highlighted will be pasted into the spreadsheet.
The toolbar for the Data Query tab contains the following controls:

returned results (
page ( ).
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Creates a new query (you will be moved to the Query Builder tab and prompted for a
name for your new Query).
Edits the current query (you will be moved to the Query Builder tab with the current
query open).
Saves the current query with active filters as a new query.
Executes query again.
Deletes the current query.
Uses the current query to generate a plume for visualization in the Scene Viewer.
Opens the Perform Lab QA/QC Assessment tool from the Quality Control module
based on the current query.
Creates a Pivot table in Excel based on the results of the current query.
Exports the results of the query.
Prints the results of your query to an Excel template.
Sends the results of your query as a time series Chart in Excel.
Prints the results of your query to a PowerPoint template.
Allows you to select which query columns are shown or hidden.

5.2.7

Data Filter
The Data Filter tab allows you to browse through the database tables to see the results of all
stations in a particular table. You can select to browse the entire project, database, or a
particular Station Group. Then select the table you are interested in. Select the excute button
and you will see all the results.
The first line on this tab is the filter line and as such is highlighted in purple-blue. The filter
line is similar to what you find in Excel when you apply a filter. You can enter values to filter
the list of what is displayed only to those values that you are interested in.
You can also select one or more records (which will turn blue ) by clicking on the button on
the left hand side of the grid and then right click on the record and select copy. Then you can
paste this into for example an Excel spreadsheet and both the header information and the
records you highlighted will be pasted into the Excel spreadsheet.
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The toolbar for the Data Filter tab contains the following controls:

These navigation options allow you to scroll through the
records.
This allows you to execute the filter (runs a query to return the records).
This allows you to delete the currently selected records.
This allows you to show or hide the columns.
This allows you to export the results of the query.
Opens the current filter settings as a new Query so that you can save it for future
use.

5.3

Modules
Any module you wish to use within Hydro GeoAnalyst can be found in this menu option.
Each module is explained in further detail in following sections:
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Please Note: not all modules may be available in your
particular edition of Hydro GeoAnalyst. Modules (as denoted
above) are only available in HGA+ and/or in the 32-bit
version of HGA/HGA+.

Template Manager
The Template Manager provides the tools to modify the Hydro GeoAnalyst database
structure, and define user-level views. The Template Manager allows you to categorize data
tables, captures the schema of the database including data quality/field requirements, and
displays database and view settings.
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Import Data
Hydro GeoAnalyst has several import options for you to import your data into the program.
These include: Samples (HGA+ only), General, EDD, Mobile EDD, Diver, LAS, and Images.
To find more information on all these options review the Import Data section.

EDD Template Designer
The EDD Template Designer is the first component in the EDD Workflow and allows you to
choose specific portions of your database structure (e.g. tables and fields) to be shared with
your project team members to manage and facilitate the collection and integration of external
(field and analytical) data into your project.

List Editor
The List Editor allows you to create, manage, and edit and lists for use in the Template
Manager. Lists are used to define standard/accepted values for certain fields (e.g. a list for
the "Watershed" field in the Station table may contain a list of all of the watersheds in your
project area). The purpose of lists is generally to provide consistent and/or streamlined data
entry.

R-Console [HGA+ only]
The R-Console module allows you to create, edit, run, and manage R scripts in your project.
The R-Console includes an interface to build variables based on the data in your project.

Parameter Editor [HGA+ only]
The Parameter Editor module allows you to define and manage the parameters available in
your project. Available functions include adding, removing, editing parameters and their
attributes including names, descriptions, units, molecular formulas, and molecular weights.

Parameter Group Editor [HGA+ only]
The Parameter Group Editor module allows you to define and manage groups Parameters in
HGA+. The Parameter Group Editor greatly facilitates finding and working with parameters in
other modules, such as the results pane of the Sample List, Plot Collections, and R-Console.
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HGA+ includes some automatic parameter groups and allows you to create custom
parameter groups.

Query Builder
The Query Builder module provides the tools to develop queries from simple to complex with
no knowledge of SQL required.

Event Planning
The Event Planning module helps you ensure that your field activities are completed
correctly and on time. Easily create multiple schedules for various stations and then create
event plans that outline the details of your field activities including stations to be sampled,
data to be collected, and field checklists. Event plans are automatically automatically
generates an Outlook calendar event, a detailed report of the event requirements, and EDD
templates that can be shared with analytical laboratories (via the HGA Quick Checker
module) and field staff (via the Mobile EDD). Hydro GeoAnalyst keeps track of all your event
plans and automatically reminds you in advance when scheduled field activities are due.

3D Interpolation [32-bit (x86 only)]
The 3D Interpolation module allows you to generate 3D continuous data solids (i.e. Plumes)
for display in Scene Viewer based on a Query containing the required fields (coordinates in
three dimensions, a numerical value, and an optional time field).

Well Profile
The Well Profile module can be used to develop and display layouts of detailed information
pertaining to a single station or well including: well construction details, geophysical data
plots, lithology information for each formation, description of the geologic formation, depth
and or elevation of each layer, and more.

Cross Section Editor [32-bit (x86 only)]
The Cross Section Editor module can be used to develop, edit, and display geological,
hydrogeological, and model layer cross sections.
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Map Manager [32-bit (x86 only)]
The Map Manager module can be used to create and view 2D maps, create thematic and
contour maps, and define cross section lines.

Map Viewer
The Map Viewer is a newer module that can be used to create and view 2D maps based on
live connections to the station and sample data tables.

Scene Viewer [32-bit (x86 only)]
The Scene Viewer is an advanced three-dimensional visualization and animation module for
displaying and presenting cross-section fence diagrams, 3D plumes, projected basemaps,
and other data.

AquiferTest
The AquiferTest link module allows you to easily send queried water level data to
AquiferTest, a separate application designed to facilitate pumping and slug test analyses.

Online Sharing
The Online Sharing module provides a utility that can publish your HGA project data as a set
of tables, charts, and maps to a webpage, allowing you to share your data with other project
team members and stakeholders who do not have the program.

User Manager
The User Manager provides the tools to manage user access to the Hydro GeoAnalyst
project database. The User Manager provides a direct user interface for adding, removing,
and modifying user access permissions to the database.
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Material Specification
The Material Specifications Editor provides options for editing material specifications,
specifically creating/editing soil classifications for your project. This Editor displays a list of
standard soil specifications shipped with Hydro GeoAnalyst, and allows the display of the soil
type names and patterns for each classification.

Quality Control
The Lab Quality Control module allows you to manage Lab Quality Control templates, and
perform quality control assessments including analysis of sample duplicates, matrix spikes,
hold times, blanks, dilutions, and holding times.

Quick Checker
The Quick Checker is a standalone application that is included with Hydro GeoAnalyst and
can be shared with project stakeholders that do not hold a license. The Quick Checker
module provides a fast and efficient tool to help you organize external data from
spreadsheets into a format which can be imported directly into Hydro GeoAnalyst and to
ensure that the data is validated against criteria built into an electronic data deliverable
(EDD) template. The Quick Checker module is an important part of the overall EDD
workflow and can be downloaded from the Support tab of the Hydro GeoAnalyst webpage
and shared with your team.

5.4

Samples
Modules specifically related to Samples in Hydro GeoAnalyst can be found in this menu.
Each module is summarized below and explained in further detail in following sections:
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Sample List
The Sample List provides an interface for managing samples and results. The following
features are available:
·
·
·
·

Adding, deleting, and editing samples
Adding, deleting, and editing results for the active sample
Comparing results to active Water Quality Standards
Creating static sample sets

Sample Analysis Viewer
The Sample Analysis Viewer provides an interface for viewing and filtering analytical results
for selected samples or for the active station or sample set.

Water Quality Standards
The Water Quality Standards tab allows you to work with water quality standards in your
project. The following features are available:
· Save, edit, and delete a water quality standard
· Import a Water Quality Standard from Excel or delimited text files
· Add, edit, delete water quality criteria for given parameters

Sample Reports
The Sample Report tab allows you to create custom tabulations of your samples and their
results based on one or more criteria including: station, sample date ranges, parameters or
groups, and/or exceedances of one or more active Water Quality Standards. The report can
also produce general statistics for samples included in the report.

Calculate Water Type
The Calculate Water Type menu item allows you to determine the major ionic constituents in
your sample(s) based on the results and specified parameters.
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Calculate Parameter Values
The Calculate Parameter Values menu item opens the Calculate Parameter Values window
and allows you to create and evaluate mathematical expressions including parameter values
and save the result as to a Sample Parameter or a Sample Result parameter that has been
so enabled in the Template Manager. For more details, please refer to the Calculate
Parameter Values section.

Find duplicate Analyses
The Find Duplicate Values menu item will search the project for duplicate results of the same
parameter on the same sample. This condition was allowed in older versions of AquaChem
(i.e. version 2014.2 and older) and may cause problems when working with data imported
into HGA. Selecting this menu option will search your project for such conditions and
provide a window that allows you to review and remove such duplicate results.

5.5

Database
This menu item is used to backup and manage HGA databases/projects:

5.5.1

·

Back Up Database: create a backup of your the project database open in Hydro
GeoAnalyst

·

Manage Databases: compact or delete databases and projects in connected local
and SQL server databases (only available when no projects are open in Hydro
GeoAnalyst)

Manage Databases
Use this option to remove unwanted databases from the local instances of SQL Express.
This option is only available when HGA opened without any loaded/open projects, such as
when HGA is first started.
The following dialog shows the options that are available.
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In this dialog, select the Server and the Database that you would like to delete. Once the
database is selected, a list of projects using the selected database will be listed at the
bottom; the project list is read-only, and displayed in order to assist you to decide if the
selected database can be safely deleted.

STOP: Use all due caution before deleting a project or
database, since there is no "undo" option and data cannot be
recovered (unless you have a separate backup).

Manage Databases Toolbar
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Compact: compress the file size of the database, to save disk space. After the
database has been compressed, you may continue to work with it.
Delete Database: delete the selected database from the current SQL instance.
Delete Project: deletes a project from the database (as a database may include one
or more projects).
Delete Method: option to delete:
o data only (default) or
o data and project folder
If the former is selected, then only the data from a project or database will be deleted.
If you also wish to delete the associated project folder and files, you must first select
the Project Folder and Data option before deleting the project or database.

5.5.2

BackUp Database
Use this option to create a backup copy of the SQL Server database used by the current
project. A backup of the database is helpful, in order to preserve data, or to detach and send
the database to colleagues or Technical Support. Select this menu item and provide the
directory path for the file. It will be saved with the name of the database and the .BAK
extension.
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You also have the option to make a copy of the all the project files or include the
"COPY_ONLY" SQL flag

Warning: If the folder already exists all data from the folder
will be deleted in order to create and save the backup.

Please Note: Backup Database only works if you have
sufficient privileges in the database and are running Hydro
GeoAnalyst on the system that also hosts the SQL Server.
SQL Server does not permit saving a back up copy of the
database to a mapped network drive; it can only be saved to
a local drive.

5.6

Help
The Help menu contains options for learning more about Hydro GeoAnalyst and facilitating
support.

Contents
Displays either the online or in-program Help depending on the settings specified in the HGA
Settings.

About
Displays the Info dialog. This contains the Hydro GeoAnalyst version number, serial number,
and information on how to contact Waterloo Hydrogeologic.
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Release Notes
This option opens your default internet browser to display the online ReadMe file explaining
the changes and additions to the program for the last several releases.

View Log File...
This opens up the Hydro GeoAnalyst log file in the applicable text editor; usually in Notepad.
This log file can be helpful for troubleshooting issues with the support team.

Email Log File
This opens a new email in your default mail client (usually Outlook) with the Log File
attached, relevant system information, and addressed to our Technical Support department
(support@waterloohydrogeologic.com). The log file can be helpful when trouble shooting
issues with the support team.

Problem Steps Recorder
By selecting Help / Problem Steps Recorder you will initiate a Windows program you can use
to record the steps you are taking within Hydro GeoAnalyst that is causing difficulties. This
can be helpful to send to Technical Support to better describe exactly the steps you are
taking when you encounter a problem.

The program is very simple to use - simply select Start Record and then reproduce your
steps within Hydro GeoAnalyst. Once you have finished, click the Stop Record button and
you will be prompted to save the recording as a .zip file that you can send to Technical
Support.

License
Provides a link to our online help for Licensing Hydro GeoAnalyst. Depending on the state of
your Hydro GeoAnalyst, you may also have options to:
· to install a license,
· check a license in/out if you are working with Team licensing, or
· request a temporary/trial license.
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Template Manager
The Template Manager is one of the most powerful tools provided with Hydro GeoAnalyst. It
allows you to edit the structure of your database.
The Template Manager provides the tools to:
·
·
·
·
·
·
·

Add or Delete tables and/or fields
Alter the properties of tables and fields
Define relationships between tables
Group tables under logical data categories
Save database templates for future projects
Set visibility of tables and/or fields
Setting user level table and/or field names, display units (where applicable), and data
formats (where applicable)

You can launch the Template Manager from the main toolbar by selecting the
selecting the Modules > Template Manager menu option.

icon or by

Understanding the Template Manager
Hydro GeoAnalyst is installed with metric and imperial unit versions of the standard
environmental database structure. This environmental database structure is based on
guidance from the US EPA and have been in use around the world for over a decade. When
creating a new database for your project, you have the option of selecting any of the
provided database templates, a custom template, or "No Template", which creates an empty
project with only those tables and fields required for Hydro GeoAnalyst to function. This
allows you to completely customize your project.

Caution: changes you make in the Template Manager are
applied immediately and there is no undo button.

All database structure templates that come with Hydro GeoAnalyst also come with their
respective report and well profile templates. As such, if one of the existing database
templates is selected during the project creation, these templates will be copied to your
project by default. You can later edit them or even remove them from your project if desired.
The Template Manager allows you to modify the view of the database. For example, you
may only need to view tables that are related to geological investigation data. The Template
Manager allows you to hide all unwanted tables and/or fields from view and display only a
smaller set of relevant tables and/or fields.

©2022 by Waterloo Hydrogeologic

380

Hydro GeoAnalyst 11.0

The Template Manager allows you to save the structure the of currently active database as a
Template that can be used to create new projects with the same structure.

6.1

Interface
On the left hand side you will find the tables and fields organized into categories. By
selecting any item in the tree on the left hand side you will find all the properties of the item
displayed to the right.

In the image above you can see the Lithology Table properties displayed. All the fields in this
table are found by opening the Lithology table branch. Primary Key fields are indicated with a
icon while all other fields use the

icon.
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Please Note: Certain tables and fields are required by
HGA/HGA+. You will not be able to change the Database
Name of these (they will be disabled/grayed out). However,
you can change the Display Name or hide these fields so
that these tables/fields appear as you would like to see them
in the main interface.

You can adjust which tables and fields you see within the main interface by simply toggling
the visibility option (i.e. turn tables and fields on or off).
Not visible in the main interface
Visible in the main interface
To add more items to your database structure (you can add as many as you like) you need
to use the following options in the tool bar:
to add a new category
to add a new table
to add a new field
To adjust the order of items in your database structure you need to use the following options
in the tool bar:
moves the item (category, table or field) you currently have selected up
moves the item (category, table or field) you currently have selected down

6.2

How to add Tables and Fields

Within the template manager interface, you can add a Table

or a field

.

Adding A Table
When you are ready to adjust the structure of your database and want to add a new table
use the

icon.

You will find a dialog appears when you can specify the Table Name as well as the Category
the table should go into.
Then you can add as many fields as need for your table by using the
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Be sure to provide a name for each of your fields as well as indicate which field you would
like to assign as the primary key for the table.

Please Note: If you do not assign a primary key field to a
table HGA will add a field named tablename_ID and set it to
the primary key, as well as making it an auto-increment field.
Also, the auto-increment option is only available at the time
of table creation (or field creation). You cannot assign this
option to a field after the field has been created. Therefore it
is important for you to consider your table properties carefully
before beginning to make new tables

Be sure to select the appropriate Data Type for each of your fields and specify whether or
not Nulls are allowed in that field:
· If you wish to set a field to be an auto-increment field its data type MUST be integer.
· If you set a field to be double (think of this as a measured number) then you should

also set a Unit Category and a Unit.
By default the table will be automatically linked to the Station table. However, you also have
the option to remove this link (uncheck the link to station table option at lower left). We refer
to these tables as Non Station Data tables.
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Please Note: to enter data to a Non Station table manually
there is now a new tab: Non Station Data Tab that allows for
this. You can also import data to a Non Station table using
the General Import options within the Data Transfer System
described in the Importing Data General section.

When you select the OK button, the table will be created and you will find it in the database
tree within the Template Manager.

Adding A Field
If you decide you need additional fields in the table simply select the
Field dialog will appear.

icon and the Add

Simply provide a name for the field and select the appropriate Data Type from the drop down
list. Select the OK button and the new field will be added to your table.
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How to set a Field to use a List
Would you like to establish a set of valid values allowed to be entered for a field? You can do
this by setting a field to use a List and then create the list within the List Editor.
When you select a field in the Template Manager you will find the option to set a List Style
as well as a List Type.

You will find three options in the List Style drop down:
None: there will be no list available for this field
Optional: there will be a list available for this field, however you can still enter things
other than the list items
Required: you can only enter items from the list for this field (nothing else will be allowed
You will notice that you have two options in the List Type drop down:
Generic: you will need to create your list in the List Editor (you will notice the icon
appears so you can launch this module and make your list right from here)
Soil: you will need to create your list as a Material Specification (and make sure to set
your material specification as the Project specification).
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How to Adjust Table Relationships
Many tables within the standard environmental database template of Hydro GeoAnalyst have
relationships - One table can be referred to as the Parent table and it is related to a Child
table by a Foreign key.
A common example of this can be found in the Monitoring Event category. The Parameter
Sample table is the Parent to the Parameter Result table. The way this relationship is
established is by a foreign key. Sample ID is the Primary Key in the Parameter Sample table
and it is the Foreign Key in the Parameter Result table.
This means that the Sample ID must be unique within the Parameter Sample table (to
indicate the unique sample that was taken at a particular station); however, the sample
Sample ID will be found multiple times within the Parameter Results table as there will be
many results associated with the single unique sample (you will have one record for every
parameter that you had the lab analyze the sample for).
If you are adding new tables to your database you might also want to establish relationships
between your new tables.
Here is an example of how you can establish a relationship between 2 tables:
Lets say you have created 2 new tables in your database - one called Parent and one
called Child.
The Parent table has a date field as the primary key as well as a field to enter the name
of an event for your project. And the Child table has an auto-increment ID field as the
primary key, as well as a date field (which we will use to establish the relationship back
to the Parent Table) as well as a field to record an observation.
Here is how these 2 tables would look in the Template Manager:

You will notice that the Station field has been added to the Parent table because I made this
table have the automatic link to the Station table. However, the Child table does not have the
link to the Station table (because we are going to link it to the Parent table).
Now when I select the Child table I will find the settings for this table which includes an
option to set the relationships for the table.
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Select the
will appear.

to add a new relationship to this child table and the Define Foreign Key dialog

From the drop down list select the parent table (in this example it is called Parent). Then
select the date field as the ParentKey and the date field as the ChildKey.
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Please Note: it is common practice to use the same name
for the field in both the Parent table and the Child table.
Additionally the fields must have the same data type.

When you select the OK button and review the Child table you will see that the relationship
has been established.

6.5

Managing Database Templates
In Hydro GeoAnalyst, you can develop database templates so that you can pre-configure
new projects based on projects that you have already created. If you have made any
changes to the database structure, including:
· Added/removed tables or fields,
· Created or modified lists in the List Editor,
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· Created or modified material specifications in the Material Specifications Editor,
· Created or modified parameters in the Parameter Editor [HGA+ only], and/or
· Created or modified parameter groups in the Parameter Groups Editor [HGA+ only]

To create a new project template, select the
icon in the Template Manager. This will
save a *.hgat file in the specified Templates folder. The default location is:
C:\Users\[user_id]\Documents\Hydro GeoAnalyst\Templates\Project
However, you may have changed this. You can find out where your templates are saved in
the selecting Project > Hydro GeoAnalyst settings from the HGA Settings main interface.
This way, when you go to create a new project, you will have the option to select your own
database template (instead of just the standard ones provided with HGA).
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Import Data
The Import Data module is a flexible tool used for importing data into an Hydro GeoAnalyst
project. When starting a new project, it will likely be necessary to enter data from other
sources into the Hydro GeoAnalyst database. While you can enter data manually on the
Station List Tab, Sample List tab, and/or the Non Station Data Tab, it is more efficient to
import your data.
You can launch the Import Data module by selecting Modules > Import or by selecting the
Import Data icon from the toolbar. The module will launch and give you several options
for importing depending on what kind of data you wish to import.
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You need to select the option you want and then select the Next button to launch the
appropriate module to import your data:
· The Samples option is only available in HGA+ and should be used to import analytical
·

·
·
·
·
·

data into the HGA+ data structure which manages parameters and units for the the
Sample and Plot module features.
The General option should be used when you are importing general tabular data. The
general option is particularly recommended when you are importing stations as it will
perform coordinate transformations. Additionally, you may convert data units during
your import using the General option.
The EDD option lets you import the files that have been validated within our Quick
Checker program.
The Mobile EDD option lets you import data that has been submitted through a Mobile
EDD form.
The Diver option is available to import pressure transducer data Diver dataloggers.
The LAS is available to import Log ASCII Standard (LAS) files, a standard format
introduced by the Canadian Well Logging Society in 1989.
The Images option is available to import pictures of stations.

Please Note: When formatting your Excel source file for
importing using the Samples or General import options, it is
important to organize your station names so they will be
recognized by the import routine. If left unspecified, Excel will
assume the data type format based on the first 8 rows of
each column; therefore, if you have some station names that
are completely numeric at the top of the file to be imported,
the import options may have difficulty recognizing them as
names (Data Type String). To avoid this, you will need to
ensure that you manually assign the data type within Excel
as Text. To do this:
o right-click on the cells (or their column) and select Format
Cells...
o Selecting the Text option in the Number tab dialog that
appears.
You will notice that your numeric station names are now left
justified in the Excel column. Similarly, if you have
completely numeric Sample ID's you will need to do the
same for this column. In fact any field in the Hydro
GeoAnalyst database that is set to have a data type "String"
you will need to do this in order to be able to import
completely numeric values.
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Samples
The Samples method for importing is specifically designed to facilitate importing external
data sources of sample and related sample result data into the data structure of Hydro
GeoAnalyst for sample and result data. The Samples import process consists of seven
steps:
·
·
·
·
·
·
·

Source
Data Transformation
Mapping
Parameters
Units
Preview
Import

Each of these steps is described in the sections below.

Step 1: Source Selection
The first step in the general import process begins with selecting the file you wish to import
and supports the following file formats:
· Delimited Text (.txt, .csv): If selected, you will be prompted to select one or more

delimiters:
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· Spreadsheet (.xlsx, .xlsx): If selected, you will be prompted to select a worksheet or

named range:

· Database (.accdb, .mdb): If selected, you will be prompted to select a data table:
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File Formats
As part of the Samples import process, you may select one of two file formats:
· One analyzed value per row: data are organized in a formal data table with a unique

sample parameter value in each row/record in the source file:
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· Values in rows or columns: data are organized in a pivoted table format with multiple

parameter values for the same sample in each row/record in the source file:

Below the source-specific controls, you may select a starting data row and, in the case of
text or spreadsheet files, a header row. A preview of the data is provided in the lower portion
of the Source import step. Here you may preview the data and rename field headers if
desired. There is also an option to select a result value field and parse it if it contains nondetect qualifiers.
Once you have selected a data file and corresponding source options, select
to
proceed with the import. If the "values in rows or columns" option is selected, you will be
guided through some additional steps to transform the data at Step 2; otherwise, you can
skip a step and proceed to the Step 3 (Mapping).
Step 2: Data Transformation
The step allows you to convert the samples as rows or columns file format into the one
analyzed value per row format. To perform the transformation, select the anchor cell to pivot
the data around either by using the row and column options, or by clicking in the
corresponding cell in the Original data pane.
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Once you have selected the anchor cell, the Transformed data pane will be populated with
the transformed data. Note that one or more new column(s) will be added to the field
corresponding to the column header row(s). This includes parameter names and may
include parameter measurement units. The column header(s) will be automatically assigned
a sequential name starting with "Column0". You may rename the column header by doubleclicking a header to facilitate the Mapping step. Value and qualifier fields will also be added
with transformed data.

Step 3: Field Mapping
At the Mapping step, the Sample and Sample Analysis tables will be automatically selected.
You may select additional destination tables and corresponding data fields into which you
wish to import the source data. The destination tables are selected using the categorized
data table tree. For example, you may wish to select the Station table to import station data
while importing samples:
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Once the destination tables have been selected, as shown above, a tab will be added for
each table. The currently selected tab will display information about importing the data for
the destination table in the following four columns:
·
·
·
·

Destination: The data fields in the destination table.
Source: corresponding fields from the source data file.
Source Unit: measurement unit from the source data file.
Destination Type: the data type of the destination field.

Required fields will be highlighted green. In the case of the Samples table, the Sample name
and Station Name field are always required. You may toggle the requirement of fields using
the Template Manager. Boolean fields (e.g. the REP field in the example above) are also
required.
As part of the Mapping step, you must select data fields from the source data file that was
selected during the Source step in the Source column. If the headers in the source file match
the name of the destination field in the Hydro GeoAnalyst database - they will map
automatically. If the headers do not match, you may click in the unmapped Source column
and a dropdown will appear allowing you to select a source field, as shown for the REP field
above. Included in the dropdown is the option to add a constant value rather than a field. In
the case above, we will select "Add a constant..." and enter a value of FALSE.
You must select a Unit field associated with the Sample Results table (e.g. the units apply to
the value and method detection limit fields) as part of the Import process using the source
unit dropdown at the top of the form. For all other destination fields that are numeric, you

©2022 by Waterloo Hydrogeologic

Import Data

397

must select a measurement unit for the source data in the "Source Unit" column; available
source units will be of the same unit category as units of the Destination field, which are
displayed in brackets in the Destination column. If the selected source units do not match the
destination units, then the values will be converted into the destination units. If the units
match, then the values will be imported without conversion.
If you have previously imported data using the same source formats (i.e. same tables, fields,
and units) and have saved the import data mappings at the Import step, you may select the
settings from the "Map using saved import settings" dropdown and click the
button
to recall and use these previous mappings.
Select the

button to proceed to the next step - Parameters.

Step 4: Map Parameters
At this step, you will map parameters from the source data to the destination data. Source
parameters matching exactly with parameters already present in your Hydro GeoAnalyst
project will be mapped automatically:

For unmapped parameters, there are three options to complete the parameter mapping:
· Manual: click in the Project Parameters column of an unmapped parameter and use

the Parameter Picker to select an existing parameter or create a new parameter.
· CAS Number: if your project and import source parameters both include Chemical

Abstract Service (CAS) Number, you can map the parameters using matched values.
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Simply select a CAS number field from the source data and click the refresh button (
).
·

Chemical List: select this option to search the Chemical List for matches with any
unmapped parameters.

·

Create Stubs: select this option to create new parameters with minimal
information using the source parameter name. You can complete the parameter
information at a later time using the Parameter Editor.

Searching the Chemical List
Selecting the
find missing parameters in the chemical list option will open a window to
facilitate a search of the Chemical List for any unmapped parameters. Unmapped
parameters will be listed on the left. Select the desired search options (e.g. match full name)
and click the "Find" button to return a list of parameters. Select any matches you want to
keep and click "Import" to complete the parameter mapping.

Once all the source parameters have been mapped select the
the next step - Units.

button to proceed to
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Step 5: Select Units
At this step, you will map measurement units from the import data source to the project units.
Source units matching exactly with units already present in your Hydro GeoAnalyst project
will be mapped automatically:

Unmapped units must be selected using the unit picker. Units are grouped into categories,
which can be selected using the dropdown at the top of the picker:
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If the source unit is not present in the unit picker, you may click the
new measurement unit for the selected category:

button to add a

The new unit must include a Name, a display name for use in labels, and a multiplier and
offset relative to the listed base unit. For example if the new unit is mg/L and the base unit is
g/L, then the multiplier would be 0.001.
Select the

button to proceed to the next step - Preview.

Step 6: Preview the Import
At this step, you may preview the data to be imported. You also have the options to:
· save the import settings
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· cancel the import if it finds records with problems

Select the

button to proceed to the next step - Import.

Step 7: Data Import
Once this step is reached, you can watch the progress of your import. When it is completed,
it will summarize how many records were in the source file and how many were imported to
each table in the database.
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If problems with the import data were detected during the import process, errors and/or
warning will be displayed along with available options to fix them. Example issues may
include:
· source data type that does not match the destination data type,
· duplicate records within the source data, and
· duplicate records between the source and destination data.

If you are satisfied with the import summary, select the
button to finalize the import
and close the wizard. Your data will be available for review in the Destination table.
Alternatively, you may return to a previous step using the
button or abandon the
import process by using the
button.

7.2

General
The General import option imports information from a tabular input source directly into one or
more tables. The General import process consists of four steps:
·
·
·
·

Source
Mapping
Preview
Import

©2022 by Waterloo Hydrogeologic

Import Data

403

Each of these steps is described in the sections below.

Step 1: Source Selection
The first step in the general import process begins with selecting the file you wish to import
and supports the following file formats:

· Delimited Text (.txt, .csv): If selected, you will be prompted to select one or more

delimiters:

· Spreadsheet (.xlsx, .xlsx): If selected, you will be prompted to select a worksheet or

named range:
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· Database (.accdb, .mdb): If selected, you will be prompted to select a data table:
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Below the source-specific controls, you may select a starting data row and in the case of text
or spreadsheet files, a header row. A preview of the data is provided in the lower portion of
the Source import step. Here you may preview the data and rename field headers, if desired.
There is also an option to select a result value field and parse it if it contains non-detect
qualifiers.
Once you have selected a data file and corresponding source options, select
proceed to the Mapping step.

to

Step 2: Field Mapping
At the Mapping step, you select the destination table and corresponding data fields into
which you wish to import the source data. The destination table is selected using the
categorized data table tree. In this example, we have selected the Station table in the
Description category:

Once the destination table has been selected, as shown above, a table will be shown with
the following four columns:
·
·
·
·

Destination: the data fields in the destination table.
Source: corresponding fields from the source data file.
Source Unit: measurement unit from the source data file.
Destination Type: the data type of the destination field.
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Required fields will be highlighted green. In the case of the Station table, the Station Name
field is always required. You may toggle the requirement of fields using the Template
Manager.
As part of the Mapping step, you must select data fields from the source data file that was
selected at the previous Source step in the Source column. If the headers in the source file
match the name of the destination field in the Hydro GeoAnalyst database - they will map
automatically. If the headers do not match, you may click in the unmapped Source column
and a dropdown will appear allowing you to select a source field, as shown for the Total
Depth field below:

Note that included in the dropdown is the option to add a constant value rather than a field.
For destination fields that are numeric, you may select a measurement unit for the source
data in the "Source Unit" column, Available source units will be of the same unit category as
units of the Destination field, which are displayed in brackets in the Destination column. If the
selected source units do not match the destination units, then the values will be converted
into the destination units. Note that if the units match or if no units are selected (e.g. None),
then the values will be imported without conversion.
If you have previously imported data using the same source formats (i.e. same fields and
units) and have saved the import data mappings at the Import step, you may select the
settings from the "Map using saved import settings" dropdown and click the
button
to recall and use these previous mappings.
Select the

button to proceed to the next step - Preview.

Step 3: Preview the Data
At this step, you may preview the data to be imported. You also have the options to:
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· save the import settings
· cancel the import if it finds records with problems

Select the

button to proceed to the next step - Import.

Step 4: Data Import
Once this step is reached you can watch the progress of your import. When it is completed it
will summarize how many records were in the source file and how many were imported.
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If problems with the import data were detected during the import process errors and/or
warning will be displayed along with available options to fix them. Example issues may
include:
· source data that does not match the destination data type,
· duplicate records within the source data, and
· duplicate records between the source and destination data.

If you are satisfied with the import summary, select the
button to finalize the import
and close the wizard. Your data will be available in the Destination table. Alternatively, you
may return to a previous step using the
button or abandon the import process by
using the
button.

7.3

EDD
The EDD option prompts you to specify the location of the *.zip_hga file that was generated
within the Quick Checker.
Please be aware that you should not attempt to unzip or modify the file in any way as this
can invalidate the file and cause difficulties importing the data.
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As soon as the file is validated you will see the Validation Results dialog appear. Here you
may need to answer a question before continuing. For example the Validation found that
some of the station names I am trying to import do not exist in the database – therefore I can
choose to append the new station names or reject records for stations that do not exist. I
make my choice by selecting the appropriate option in the Action column. If I wish to see
which stations are not currently in the database I can select the Click Here to View Data
option. For this example I choose to Append the stations (so any station names in my data
that are not in the database will be automatically added).
Then the validation also found I have duplicates in the database – some of the sample IDs
already exist in the database! Again, I can select what I want to do – either overwrite what is
in the database or reject the duplicate sample IDs. For this example I will reject these sample
IDs.
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Now I can continue with the import. Now the Import dialog is updated – and I can see how
many records will be imported.
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Select the Import button to import the records – and the import dialog updates to inform you
that the import was successful. Now you can select another EDD file to import or close the
dialog box.

7.4

Mobile EDD
The Mobile EDD option allows you to import data that was submitted by a Mobile EDD.
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HGA will remember the Mobile EDD’s that you published for your project – you can select
them from the drop downlist. Then hit the refresh button to see the files that were submitted
from this site.
Select the file you wish to import and select the Import button.
You will see a validation dialog which shows how many new records will be imported. In this
example I created one new station and entered 4 new lithology records.
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I can review the data that was imported within HGA – for example here are the 4 new
lithology records imported:
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Diver
This option allows for importing data from a Diver (.MON) file, a format generated from
datalogger monitoring software such as Diver-Office. MON files consist of three sections:
Logger Settings, Data Series, and Data.
The Logger Settings section contains the current settings of the logger including the location,
sample method, sample interval, serial number and available channels.
The Data Series section contains information on when field measurements were taken.
The Data section contains all the measurements for each channel, ordered by date and time.
To import MON file data into your database, follow the steps below:
· STEP 1: Select MON Data Files
· STEP 2: Map Data Fields
· STEP 3: Import Data into the Database

Each of these steps is described in the sections below.

Please Note: the MON data import procedure can
accommodate multiple MON files simultaneously. However,
for demonstration purposes, only one MON file will be used
in the following guide.

Also, before you import data from MON files, the water level values need to be compensated
with respect to the top of the well casing. This can be done through the Van Essen
datalogger software (Diver-Office) by performing barometric compensation on the MON
data, using the "Top of Casing" method.
Diver data applications, e.g., Diver-Office, allow you reference the water level data in various
ways, i.e., with respect to the top of casing, with respect to a vertical datum, or with respect
to the Diver itself. The first step is to specify how the water level data is referenced in the
MON file.

Please Note: If you wish to show water level data on cross
sections and borehole log plots, the water level data must be
reference to the top of casing (or ground surface) and the
data must be imported into the Water Level table.
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STEP 1: Select MON Data Files
Specify the MON data source:
Click the Open Folder button
Locate and select a MON file(s), and click [Open].
The selected MON file(s) will now appear under the Select data source frame (shown
below).

Below the Select data source frame is the MON file Information table. This table contains the
datalogger information of the selected MON file.
To remove a MON file from the list, select the file and click the Delete button
Select the Next button to proceed to Step 2: Data Mapping.
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STEP 2: Map Data Fields
The next step in the MON data import operation is to map the MON file fields (source) with
the appropriate database fields (destination). To map a source field with a destination field:
· Select a source field from the MON file in the Select Section Field frame
· Select the matching HGA destination field from the Select Table Field frame
· Click the Map button.

Rules for Mapping
The Station Name field of the Location table must be mapped.
All destination tables and fields must already exist in the HGA database.
All channel tables (e.g. Level, Temperature, Conductivity, Oxygen) in the database must
include a Screen ID.
All mapped tables in the database must have primary key(s) mapped.
Data type of mapped fields must be compatible.
The mapped fields will now display in the table at the bottom of the Data Mapping
Configuration dialog. Repeat this process for additional fields.
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To remove a mapping:
· Select the appropriate row in the preview grid
· Click the Delete button
.
· Select the Save mapping to database checkbox to retain the mapping for future MON

file import operations.
Select the Next button to proceed to Step 3: Importing Data into the Database.

STEP 3: Import Data into the Database
From the Select Channel frame, select a parameter (i.e. Level, Temperature, Conductivity,
Flowman). NOTE: A selection is not necessary if all the channels are inactive (greyed-out).

HGA will read the station name in each MON file, and attempt to find an appropriate station
match in the current HGA project database. If one is found, you may proceed. Otherwise, the
field will display a color and you must specify the appropriate destination station name.
The color displayed in the information table represents the number of station names that can
be matched with the location information in the MON file.
· White: indicates that a single station name has been found.
· Red: indicates that a matching station name could not be found.
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· Yellow: indicates that two or more matching station names exist in the database.

If a row is either red or yellow, click the
name from the database.

button and manually specify a destination station

From the Get Station&Screen dialog, select a destination station and a screen id. Click the
List Matched button to open the List Matched dialog. This dialog will display all the possible
station and screen_id combinations that match the MON data. After selecting, click [Ok].
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Click the [Import] button to finalize the data import.
Selecting the OK button will close the import dialog.

7.6

LAS
This option allows for importing data from an LAS (Log ASCII Standard) file, a standard
format introduced by the Canadian Well Logging Society in 1989.
The LAS file contains two types of sections:
· Well Information Section: data related to the station (location, driller, etc.)
· Parameter/Curve Information Sections: descriptive and/or measured data for one or

more down hole parameters.
When importing the LAS file in HGA, the following options are available:
Import the Well Sections and Parameter/Curve sections; use this option if you want to import
a new station, and one or more measured parameters for this station. A new station will be
added to the database, using station details (name, co-ordinates, etc.) in the LAS file. If the
station already exists in HGA, you will be prompted to overwrite the details, using those in
the LAS source. In addition, data from one or more parameters (Parameter Sections) may
be imported to one or more tables in your database.
Import only Parameter sections; use this option if this station already exists in your project.
HGA will read the station name in the LAS file, and attempt to find an appropriate match in
the current project.
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When you select this option, the following dialog will appear:

The first step requires selecting the data transfer package and data source.
A Data Transfer Package (DTP) is designed to store all settings of desired import operations
that may be repeated from time to time. For example, importing several LAS files containing
the same measured parameters. The DTP contains information about the data source, the
selected destination table(s), matching between source and destination tables and fields,
source units, and a number of other settings. You may create an import package, or select
from existing packages.
All Data Transfer Packages (if any) are listed for selection at the beginning of all data
transfer operations. If an existing package is selected, the import routine loads all
information stored in the package. The information can then be reviewed and updated as
desired before as you move through the data transfer operation.
After selecting the package, select the Data Source; please note the following limitations:
· HGA currently supports LAS v.2.0.
· Third dimensional data array handling is currently not supported
· Multiple log runs is currently not supported

When you are finished, select the Next button in the lower right corner to proceed to the next
step. The next step is Data Mapping.
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The next step in the data transfer operation is to match a source table with a destination
table.
You may map the entire LAS file (including the Well Section), or just down hole parameters;
if you do not include the well section, you must have the appropriate station already created
in your project. HGA will read the station name in the LAS file, and attempt to find an
appropriate match in the current project. If one is found, you may proceed. Otherwise, you
must include the well section, or terminate the import routine and return to HGA and create
the appropriate station (using the same station name as found in the LAS source).
If duplicate station names are found in the database, there will be a prompt to select the
appropriate station.
The Data Mapping window is divided into two frames:
· The Source well section, found on left side of the window; and
· The Destination tables and fields, on the right side of the window
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The Source frame (which contains the data to be imported) can be expanded on the left side
of the window. If the field names in the source are identical to those in the destination, then
the fields will be matched automatically. For all others, you must map the fields using the
procedure below.
The Destination frame contains the database schema: all tables and fields under their
appropriate data categories. From this frame, select a Category, then a Table from this
category, and a list of fields will be displayed in the grid on the right side of the window.

Mapping
Mapping fields from the LAS file to the database is described below:
· Select one field from the source file in the left frame
· Select the appropriate matching field from destination in the right (by expanding the

appropriate data category and table)
· Click on the Map button

Mapped fields will then be added to the Preview grid at the bottom of the window. Repeat
these steps for additional fields.
To remove the mapping for a selected field,
· Select the appropriate row in the Preview grid
· Click on the Delete Mapping button

Units
Due to the flexible nature of the LAS file, there may exist one or more parameters with units
that are not supported in HGA; as such, unit conversion will not be possible during the
import. Where the unit categories and units exist, HGA will attempt to do unit conversion,
and import the data. If the destination field does not support the selected source units, there
will be no conversion, and the data will not be imported. For this reason, it may be necessary
to modify the field settings for your database schema, before proceeding with the import. For
more details, see Chapter 13: Modifying Fields and View Settings.
When you are finished, click the [Next>] button in the lower right corner to proceed to the
next step.

If the data to be imported contains the Well Section, then some additional information may
be required in order to allow proper data transfer. The Station Related Settings window (as
shown below) will only be displayed if data is imported to the Stations table.
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Projection Settings
Define the coordinate system, the projection system, and the units for the stations in the
source file. Following successful import, the new stations will be converted to the projection
system and units defined in the HGA project. A detailed description of the coordinate and
projection systems available in HGA is provided in Chapter 3.

Please Note: It is important to know and select the correct projection system during
the import, to prevent erroneous station co-ordinates.
The LAS file allows to specify a place holder for NULL values (common examples are 999.0000). Wherever this value is detected in the source, HGA will insert NULL in the
destination, according to the field setting specified in the Template Manager.
When you are finished, select the Next button in the lower right corner to proceed to the next
step.

The last step in the import involves previewing the data to be imported, and taking
appropriate actions with regards to erroneous data. The Data Validation window (as shown
below) displays all data ready to be imported. Errors or warnings, if any, will be listed along
with the data. Records with errors will not be imported. You may return to previous steps to
make any corrections to the mapping.
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The data is checked against the following conditions:
· Proper Station Locations
· Data type compatibility

Please Note: All coordinates in the database are stored in latitude-longitude format
(WGS 1984) for internal use, regardless of the projection system in the source file and
project. The Preview in this window displays the converted station co-ordinates. However the
station co-ordinates may be displayed in HGA in any projection system desired.
At the top of the window, each tab represents a different database table containing one or
more mapped fields.
Accepting or Rejecting Records
Any of the records in the preview window may be accepted or rejected.
· To accept the selected records, click on the
· To reject the selected records, click on the

(Accept) button.
(Reject) button.

Once you have removed or verified the errors, press the [Import] button to import the data to
the project.
After successfully importing the data, a confirmation window will appear, similar to the one
shown below.

7.7

Images
This option allows for importing images into a specified image field related to a given station
and is a two-step process:
· Image Selection
· Mapping
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Step 1: Image Selection
The first step in the general import process begins with selecting the files you wish to import
and supports the following file formats:
·
·
·
·
·

Bitmaps (.bmp)
Enhanced Metafiles (.emf, .wmf)
Icons (.ico)
JPG (.jpg, .jpeg)
PNG (.png)

To add images to be imported, select the
load button. To remove images, select the
remove button. The image selection step also includes an optional built-in preview pane:

Once you have selected the images to be imported, select
step.

to proceed to the Mapping

Step 2: Field Mapping
At the Mapping step, you must first select one of two import scenarios:
· by image name
· multiple images for one station
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Import Images by name
This import scenario requires that the file name of each image matches either the
corresponding Station ID or Station Name and images will be imported directly into the
specified field in the Station table.

Multiple Images for one station
This import scenario allows you to import multiple image files into any table or field that is
linked to the Station table; however, the images will be imported for a single (specified)
station:
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Once you have selected the import scenario and mapped the images to a destination data
field, select
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List Editor
The List Editor provides the ability to create and customize lists for any field - allowing for
efficient and effective data entry. A field that is set to use an optional or required list in the
Template Manager module becomes a drop down list within the interface (i.e. in the Station
List, Station Data tab, Non Station Data tab, and Sample List).
You can open the List Editor from the Modules menu or click on the
toolbar.

button in the main

The List Editor will appear as a tab in the main Hydro GeoAnalyst view, as shown in the
following screenshot. Note that the List Editor can be dragged out of the main Hydro
GeoAnalyst view and dragged to a secondary monitor if you wish.

On the left side of the tab you will find the database structure tree (similar to what you find in
the Template Manager or Query Builder).
Select the field you wish to edit a list for by highlighting it in the tree. Note that in order to
work with a List, the field must be set to use an optional or required list in the Template
Manager module.
On the right side of the tab you can generate and manage your list by using any of the
following buttons:
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buttons to navigate through the individual entries for a

Use the

button to add a new entry to the list.

Use the

button to delete the selected entry from the list.

Use the

button to save the list.

Use the

button to import images file (.jpg, .bmp, and .png) to be entries in the list.

Use the

button to import names for your entries in the list.

Use the

button to export the list.

Use the

button to find unique values in the field and append them to the list.

Please Note: When importing a file to create your list ensure
that you have the same format for your source file as what
appears in the List Editor. That means there are 4 columns
with the following headers: Item Name, Include, Description,
and Image. The only field that must be pre-populated before
import is the Item name.

If you want to re-use this list in a new project, you must save the database template. Then
create a new project with this new database template, and the list will be available. For
details on saving database templates, see the Managing Database Templates section.
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Material Specification Editor
The Material Specification Editor provides options for editing material specifications,
specifically creating/editing soil classifications for your project. This Editor displays a list of
standard soil specifications shipped with HGA, and allows the display of the soil type names
and patterns for each classification.
The Material Specification Editor may be launched from two locations:
· Click on the Material Specification
button in the main toolbar OR
· Select the Material Specification option from the Modules menu.

The Material Specifications Editor will appear as a tab in the main HGA view, as shown in
the screenshot below:

The left side of the tab displays the existing specifications (which may be chosen from the
drop down box). The right side of the tab provides the option for editing an existing custom
material specification or creating a new one.

Please Note: The material specifications that come with
HGA cannot be directly edited; however, you can copy these
specifications and make your own custom version(s).
Custom specifications can be used in other projects using
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the import/export functions as well as custom Database
Templates.

In the Existing Specification side the following buttons are available:
Use the
specification.

buttons to navigate through the individual entries for a

Use the

button to set the selected specification as the project default.

Use the

button to delete the specification.

Use the
button to edit the selected specification (only available if you have selected a
custom specification) this will move the specification to the right side of the tab for you
to make your edits.
Use the

button to export the specification.

In the Edit Specification side the following buttons are available:
Use the

button to create a specification (don't forget to provide a name).

Use the

button to add a new entry to the specification.

Use the

button to delete the selected entry from the specification.

Use the
button to save the specification (it will now be available on the Existing
Specification side of the tab).
Use the

button to import images file (bmp or jpg) to be entries in the specification.

Use the

button to import names for your entries in the specification.

Use the

button to export the specification.

Creating a New Specification
When creating your own custom specification you may borrow the names and images from
existing specifications.
Use the
button to copy a single entry from an existing specification to your custom
specification.
Use the
button to copy all the entries from an existing specification to your custom
specification.
To select an image to be associated with an entry simply select the image cell and you can
browse to the location of your image.
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Please Note: When importing a custom specification ensure
that you have the same format for your source file as what
appears in the Material Specification Editor. This means
there must be two columns in the file to be imported with the
following headers: Name and Image. Furthermore, at a
minimum, all records in the Name column must be
populated.
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Parameter Editor
The Parameter Editor allows you to define and manage parameters in your project. You can
open the Parameter Editor from the Modules menu or click on the
button in the main
toolbar. The Parameter Editor will appear as a tab in the main Hydro GeoAnalyst view, as
shown in the following example:

Please Note: If you save any changes to one ore more
Parameters, Hydro GeoAnalyst automatically reload your
project, which includes automatic prompts to save or discard
changes to other modules and reset open views and layouts.

On the left side of the tab you will find a list of parameters that can be filtered using a
dropdown list of the Parameter Groups and the standard filter bar in Hydro GeoAnalyst. The
right side of the Parameter Editor window provides the tools to manage the selected
parameter and its associated metadata using the relevant forms and the following buttons on
the parameter editor toolbar:
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Parameter Editor Toolbar
The Parameter Editor toolbar contains the following controls:

·

Parameter: Displays the name of the currently selected parameter.

·

Save: saves changes to the currently selected parameter.

·

Delete: deletes the currently selected parameter.

·

Add Parameter: adds a new parameter from the Chemical List.

·

New Parameter: adds a new blank parameter to the project.

·

·
·

Add Parameters from List: adds one or more parameters in a specified list by
searching the Chemical List for matches.
New Parameter: adds a new blank parameter to the project.
Delete All unused parameters: adds one or more parameters in a specified list
by searching the Chemical List for matches.

Parameter Information
Information about all measured parameters is managed below the Parameter Editor toolbar
and stored in the Parameter Table. Parameter metadata information includes the relevant
chemical and descriptive attributes as follows (using bicarbonate as an example):
· Short Name: a unique, typically short or abbreviated, name that is easily recognizable
·
·
·
·
·
·

(e.g. HCO3) and used as a look up name and a primary key
Display Name: a longer descriptive name (e.g. bicarbonate) used for labeling in plots
and tables
CAS: Chemical Abstracts Service (CAS) Registry number (e.g. 56240-83-6), a unique
number assigned by CAS, a division of the American Chemical Society.
Description: typically a more descriptive name that may include a list of alternate
names (e.g. bicarbonate; hydrogencarbonate)
Formula: chemical formula (e.g. HCO3)
Molecular Weight: combined atomic weights of all constituent atoms that compose
the parameter (e.g. HCO3 = 1x1.00794 + 1x12.0107 + 3x15.9994 = 61.01684 g/mol)
Valency: the ionic/electric charge of the parameter in solution (e.g. -1).
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Custom Calculated Parameters
The check box next to the label "Allow value of this parameter to be created or updated by
the parameter calculator" allows you to enable the Parameter Calculator for the specified
parameter.
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Parameter Group Editor
The Parameter Group Editor allows you to define and manage groupings of project
parameters. Parameter groups make it easier to find and work with parameters in other
modules, such as the results pane of the Sample List view, Sample Reports, Plot
Collections, Map Viewer, and R-Console. HGA+ includes some automatic parameter groups
as well as custom parameter groups.

The 'Parameter list' (left) side of the Parameter Group Editor includes a list of parameters
from which to select and build parameter groups. You can filter the parameter list using the
'Parameter group' dropdown, which includes both automatic parameter groups and custom
parameter groups. The 'Manage parameter groups' (right) side of the Parameter Group
Editor includes controls that allow you to edit parameter groups.

Automatic parameter groups
There are a number of parameter groups that are built into Hydro GeoAnalyst. The list of
parameters within each of these automatic parameter groups is dynamically generated by
Hydro GeoAnalyst as follows:
·
·
·
·
·
·

Analyzed Parameters: includes measured parameters with at least one result
All measured parameters: all measured parameters included in the project database
Cations: measured parameters with a positive valence
Anions: measured parameters with a negative valence
Ions: measured parameters with a non-zero valence
Required: measured parameters required in calculations/functions and commonly
used in many of the plots
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· Used in standard: measured parameters that are included in an active water quality

standard
· Custom calculated parameters: parameters that are flagged as enabled for use with

the Parameter Calculator

Custom parameter groups
In Hydro GeoAnalyst, you can create and manage custom lists of parameters using the right
side of the Parameter Group window. Custom parameter groups can be used to facilitate
working with the sample list view, plot collections, and sample reports. Custom parameter
groups can be generated using the controls described below.

Parameter Editor Toolbar
The Parameter Editor contains the following controls:
·

Parameter group: allows you to select which parameter
group is active.

·
·

New Parameter Group: creates a new empty parameter group.
Generate a New Parameter Group: creates one or more new parameter groups
based on parameters associated with unique values from a specified field (e.g.
analysis method) in the Sample Results table.

·

Save: saves changes to the active parameter group.

·

Rename: allows you to rename the active parameter group.

·

Delete: deletes the active parameter group from the database.

·

Remove Parameter: removes the selected parameter(s) selected from the active
parameter group on the right side of the Parameter Group Editor.

·

Add Parameter: adds the selected parameter(s) selected from the parameter list
on the left side of the Parameter Group Editor to the active parameter list

·

Add All Parameters: adds all parameter(s) selected from the parameter list on
the left side of the Parameter Group Editor to the active parameter list

·

Remove All Parameters: adds all parameter(s) selected from the parameter list
on the left side of the Parameter Group Editor to the active parameter list
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Generating Parameter Groups from a Field
Hydro GeoAnalyst Allows you to generate parameter groups based on unique values in a
field in the Sample Results table. For example, if your Sample Results includes a "Parameter
Group" (e.g. Trace Metals) or "Analytical Method" (e.g. EPA Method 200.7) field, you may
wish to create parameter groups for parameters associated with unique values in the
specified field. To do this, open the Parameter Editor module, as described at the top of this
section, and click the "Generate New Parameter Group" button [ ], which will open a
window similar to the image below with a list of fields in the Sample Results table:

· Simply select the appropriate field (e.g. Group) and Hydro GeoAnalyst will iterate

through your database finding each parameter that is associated with the unique
values in that particular field.
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Please Note: if a parameter is associated with more than one value, it will appear in
both groups. For example, if lead was analyzed in the same project using both EPA
Method 6010C and by EPA Method 200.7, results from both of these methods would
be returned for the either of the automatically created created groups if they both point
to the same parameter for lead.
· If you are satisfied with the groups that will be created, click OK and they will be added

to the list of parameter groups available in your project with the prefix "Group - "
appended to the value(s) found in the specified field.
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Query Builder
Within an HGA project, it may be necessary to perform different types of queries for data
filtering, reporting, and management. A few examples of data queries are provided below:
·
·
·
·
·
·

Select wells drilled later than 1995 and earlier than 2000
Select wells with discharge over 500 gpm
Select boreholes deeper than 150 feet
Select boreholes where the overburden thickness exceeds 20 feet
Locate groundwater samples collected from the surficial aquifer
Locate groundwater samples with exceedances of BTEX

This section provides a detailed description of the Query Builder (
following topics:

) and includes the

· About the Interface
· Query Types

o
General Query
o
Union Query
o
SQL Query
o
Dynamic Station Group Query
o
Dynamic Sample Set Query [HGA+ only]
· Aggregate Functions
In the Query Builder tab, the query display fields and conditions can be quickly defined.
Once the queries have been created, they may be easily saved and re-accessed from the
Project Tree, where each saved query will appear as a branch.

12.1

About the Interface
The Query Builder may be loaded from within HGA in several ways:
· Select Modules / Query Builder from the menu bar
· Select the
icon from the Main Toolbar.
· Right-click on the Queries branch of the Project Tree (or any branch under it) you can

select New Query... to launch the Query builder.
· Right-click on a query in the Project Tree and select Edit Query... the Query Builder
will open displaying the selected query.
The Query Builder tab is shown below and displays the options available for a General
Query.
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The Query Builder tab contains the following sections:
· Available Fields: Select fields for the query from the tables in the database shown in
·
·
·
·
·
·

the tree.
Display Fields: The fields in this section will be displayed when the query is executed.
Conditions: The fields in this section are used to set conditions for the query.
Toolbar: Contains buttons to most of the functions in the Query Builder.
Source Conditions: Provides options for adjusting the source for the query.
Group Conditions: Specifies grouping options when using an aggregate function.
SQL Statement: Allows user to generate their own custom SQL Statement (other
sections will become inactive).

Please Note: The Display Fields and the Group Conditions
sections are not available when creating a Dynamic Station
Group or Sample Set query.

Query Toolbar Items
The toolbar provides access to most functions of the Query Builder. Toolbar buttons are
context sensitive, if there a button is "greyed-out" this indicates that that functionality is not
currently available (based on what has been selected).

New button creates a new query.
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Open button opens an existing query.
Delete button deletes the currently open query.
Save Query button saves changes to the query.
Save As button saves the query under a new name.
Execute SQL Statement button executes/runs the current query.

Query Component Field Toolbar Items
The components of a query, including the Display Fields, Conditions, and Group Conditions
have toolbars that help you construct the required components of a query. Toolbar buttons
are context sensitive, if there a button is "greyed-out" this indicates that that functionality is
not currently available (based on what has been selected).

Adds a display field, condition, or group condition
Adds a sub-query (condition only)
Deletes button the currently selected display field(s), condition(s), or group
condition(s).
Moves the currently selected display field, condition, or group condition up in the
order of its list
Moves the currently selected display field, condition, or group condition down in the
order of its list

Source Conditions
The Source Condition query component also includes the ability to restrict your results to a
specific Project, Station, Group, Sample Set or the entire database:

The default condition is Project.
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Query Types
There are three types of Queries within HGA and a third available in HGA+:
· General Query: tabulates data from fields in one or more linked tables for further
·
·
·
·

analysis typically based on specified conditions and is stored as a Query in the project
tree,
SQL Query: tabulates data (or actions) based on one or more SQL statements
entered directly into the interface
Union Query: tabulates data from similar fields from two or more tables for further
analysis typically based on specified conditions and is stored as a Query in the project
tree,
Dynamic Station Group Query: generates a station group (i.e. a list of stations) in the
project tree based on specified conditions, and
Dynamic Sample Set Query [HGA+ only]: generates a sample set (i.e. a list of
samples) in the project tree based on specified conditions.

General Query
General Queries can provide a more detailed look at your data, and can be used for
quantifying and qualifying any field in the database.
In addition, many of the visualization and data analysis modules use query data sources as
data inputs. Using the Query Builder, you can generate General Queries that provide the
data for:
·
·
·
·
·
·
·
·

Map Layers
Cross section interpretation results
Quality Control Analysis
Well Profiles
3D Interpolation
Reporting
Plot data sources
and more!

To create a General Query, select the General Query dropdown option in the New query
dialog box. Then define the necessary fields and conditions, and execute the query. Once
the query has been saved, the query will appear as a new branch in the project tree, under
the Queries branch.
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Union Query
Union Queries are a special type of selection query that combine similar types of information
from multiple tables. A common use case for a union query is to collate time series data from
differing tables such as precipitation and water levels into the same table for use in a plot
collection. Similar to a general query, results of a union query are tabulated in the query
view when executed.
Union queries are available for use in all of the modules where general queries are available;
however, they are particularly useful in the following modules:
· Plot Collections
· Map Viewer (Plots and Mini Table Callouts)

To create a Union Query, select the union query dropdown option in the New query dialog
box. Add and define one subquery with the correct number of fields and appropriate
conditions to return the desired information to be collated from each of the target tables. In
the root union query, create and map all of the fields to be returned from each subquery note that the number and type of fields returned must match between the subqueries.
Placeholder values such as null may be used if the data should be empty or are not available
from all subqueries (see the example). Once the query has been saved, the query will
appear as a new branch in the project tree, under the Queries branch.

SQL Query
Union Queries are a special type of selection query that combine similar types of information
from multiple tables. A common use case for a union query is to collate time series data from
differing tables such as precipitation and water levels into the same table for use in a plot
collection. Similar to a general query, results of a union query are tabulated in the query
view when executed.
Union queries are available for use in all of the modules where general queries are available;
however, they are particularly useful in the following modules:
· Plot Collections
· Map Viewer (Plots and Mini Table Callouts)

To create a Union Query, select the union query dropdown option in the New query dialog
box. Add and define one subquery with the correct number of fields and appropriate
conditions to return the desired information to be collated from each of the target tables. In
the root union query, create and map all of the fields to be returned from each subquery note that the number and type of fields returned must match between the subqueries.
Placeholder values such as null may be used if the data should be empty or are not available
from all subqueries (see the example). Once the query has been saved, the query will
appear as a new branch in the project tree, under the Queries branch.
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Dynamic Station Group Query
Dynamic Station Group Queries can be created and executed for the purpose of organizing
the stations into meaningful groups.
To create a Station Group Query, select the Dynamic Station Group Query. Then define the
necessary conditions, and execute the query. Once the query has been saved, the query will
appear as a new branch in the Project Tree, under the Station Groups branch. When
selected from the Station Groups branch, the query will be executed and the modules that
are linked to the active station group will be updated and relevant information from the
stations that meet the conditions specified in the query will be displayed.

Please Note: Station Group Queries do not have options for
modifying the display fields, or advanced grouping options.

Dynamic Sample Set Query [HGA+ only]
Dynamic Sample Set Queries can be created and executed for the purpose of organizing
samples into meaningful sets.
To create a Sample Set Query, select the Dynamic Sample Set Query type when creating a
new query. Then define the necessary conditions, and execute the query. Once the query
has been saved, the query will appear as a new branch in the Project Tree, under the
Sample Sets branch. When selected from the Sample Sets branch, the query will be
executed and the modules that are linked to the active sample set will be updated and
relevant information from the samples that meet the conditions specified in the query will be
displayed.

Please Note: Sample Set Queries do not have options for
modifying the display fields, or advanced grouping options.

12.2.1

General Query - Example
A General Query is used to find and return data from one or more data fields in one or more
linked tables based on a set of conditions. You can view the tabulated results of the query in
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the Query Results viewer, and also use general queries as sources of data in many modules
in HGA, such as plot data in a Well Profile, thematic data in a Map, source data for a contour
map or plume in a 3D Scene, or source data for one or more plots in a Plot Collection.
The following provides an example of creating a General Query with guided steps using the
Demo Project.

Creating a General Query (Example)
If the Query Builder tab is not yet opened, select the Query Builder icon
toolbar.
In the Query Builder tab toolbar, select the New button
appear:

from the main

, and the following dialog will

· Select a Query Type: Note the default Query Type is the Standard Select Query -

which is the query type for this example, so we do not need make a change.
· Provide a Query Name: Station with TOC exceeding 320masl (for this example)

We also have the option to specify the location of the Query. By default, new queries will be
stored in the root of the Queries branch of the Project tree; however, you can create folders
to organize your queries and select the folder where you wish to save your query. For this
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example, we we will leave the default which will save the query to the main Queries branch
(i.e. not in a folder).
· Select OK to create the query.

By default, the only field selected to be displayed in the query is the Station Name. We are
going to add other fields to the display fields. Let's select the Map, Plot and Plume Ready
options as well as the Well Profile option - this will automatically add several fields to the
Display Fields section and will make the query available in other modules within HGA.

· Expand the tree in the Available Fields section to find the TOC field (under the

Description category and the Location table.
· Double-click on the TOC field - notice it has been added to the Display Fields section.

Let's add a condition to the Query:
· Click once on the TOC field (it will become highlighted blue), and drag this field into

the blank Conditions field (under the Expression column). The TOC field will be added
to the Query Conditions. (Alternately, you may use the
(Add) button (on the bottom
half of the conditions section) to add conditions, then define them manually).
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· We need to set an operator and value for our Condition. You will notice there are

several options in the Operator drop down list (>, >=, <, <=, =, <>, IS, IS NOT, and
LIKE) providing you several options to query your data from the database.
· Select the > option from the drop down list in the Operator column.
· Enter the number 320 in the Value field.
· In the Conditions section, select the Source Conditions. The options are Project,

Station Group, and Database. If Station Group is selected, then another combo box
will become activated where you can select the appropriate Station Group to be the
source for this query. If Project is selected, then all stations in the project will be
queried. If Database is selected, then the query will be applied to the entire database.
For this example we will use the default - Project.
· The Query Builder should look similar to the image below:
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to see the results of your query.
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The new data query will now appear as a new branch under the Queries node in the Project
Tree - if you do not see it right away right-click on the Queries branch and select Refresh.
This query can be executed/run at any time by selecting it from the Project Tree. The results
will show on the Data Query tab.
If you need to make further changes to the query right click on the query in the Project Tree
and select Edit Query... and the query will be opened in the Query Builder tab.
For further information on what can be done with the query once it has been executed and
the results are being displayed - please see the section on the Query Results section.

12.2.1.1

Aggregate Functions

General queries within Hydro GeoAnalyst may include an aggregate functions. The following
functions are available:
·
·
·
·
·
·
·
·
·

AVG: Returns the average value of a numeric expression evaluated over a set.
COUNT: Returns the number of items in a collection.
MAX: Returns the maximum value of a numeric expression evaluated over a set.
MIN: Returns the minimum value of a numeric expression evaluated over a set.
STDEV: Returns the sample standard deviation of a numeric expression evaluated
over a set.
STDDEVP: Returns the population standard deviation of a numeric expression
evaluated over a set.
SUM: Returns the sum of a numeric expression evaluated over a set.
VAR: Returns the sample variance of a numeric expression evaluated over a set,
using the unbiased population formula.
VARP: Returns the population variance of a numeric expression evaluated over a set,
using the biased population formula.

You can specify the function within the Query Builder by selecting the appropriate function in
the Display Fields section, in the Function column for the appropriate field.

When executing a query containing an aggregate function, the query builder will
automatically group all other fields in the Display Fields. This is required in order to be able
to determine/calculate the function for the selected field.
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In the example above, the query will be grouped by the station name - so only one record
per station name will be displayed - the record with the maximum depth to water level for
each station.

12.2.2

Union Query - Example
A Union Query is a data query that combines similar types of information from two or more
tables and is used to find, return, and append data from information from two or more tables
based on a set of conditions and common fields. You can view the tabulated results of the
query in the Query Results viewer, and also use union queries queries as sources of data in
many modules in HGA, such as plot data in a Well Profile, thematic data in a Map, source
data for a contour map or plume in a 3D Scene, or source data for one or more plots in a
Plot Collection, provided the necessary fields are present (e.g. maps and scenes require
coordinate fields to be present in the query).
A common use case for a union query is to collate time series data from two or more
different tables in the database such as precipitation and water levels. The following provides
an example of creating a Union Query with guided steps for combining precipitation and
water level data from separate tables using the Demo Project that can be used in a multiaxis time series plot.
Creating a Union Query (Example)
In this example, you will build a union query that combines time series data for water level
elevations (based on the measured water levels in the "Water Level" table) and precipitation
(from the Meteorology table). The information in this query will be structured so that it can be
used to plot a multi-series plot in the plot collection.
· If the Query Builder tab is not yet opened, select the Query Builder icon

from the

main toolbar.
· In the Query Builder tab toolbar, select the New button

, and the following dialog

will appear:
o Select a Query Type: Note the default Query Type is the General - we need to
change this by selecting the Union Query option.
o Provide a Query Name: WaterLevels and Precip (for this example)
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We also have the option to specify the location of the Query. By default, new queries will be
stored in the Queries branch of the Project tree - however, you can create folders to
organize your queries. You can select the folder where you wish to save your query. For this
example, we we will leave the default which will save the query to the main Queries branch
(i.e. not in a folder).
· Select OK to create the query.

By default the only field selected to be displayed in the query is the Source Name, this is a
placeholder field for contain a label for the source of each table. The easiest way to build out
the union query is to create the sub-queries which make up the union query:

Adding the First Sub-Query: Water Level Time Series Data
In this section of the example, you will construct a sub-query that will return the water level
time series data for the W-15 station:
· Click the add column [

] button at the bottom of the display fields section to add the

first sub-query
· Type the name "WaterLevels" and Click OK to continue
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This will open a new sub-query to the "Root" query called "WaterLevels". This new subquery is a general query that will return values to the Root query. Now you can begin adding
the desired fields to the "WaterLevels" query:
· First, select the "available to map, and plume modules" option

This will automatically add several fields to the Display Fields section and will help make the
query available in other modules within HGA:

· Click the expand [ ] button next to the Monitoring Event data category in the tree of

Available Fields section to find the "Water Level" table
· Click the expand [ ] button next to the "Water Level" table in the tree of Available

Fields section to find the date field
· Select and (double-click to) add the date field to the Display Fields section of the

Query Builder.
· Select and (double-click to) add the depth_to_water_level field to the Display Fields

section of the Query Builder
As indicated by its name, the depth_to_water_level field contains water level depths as
measured from the top of casing (TOC). While this information does indicate how water
levels change over time, it is less useful than the elevation of the water levels. In order to
convert these values to an elevation, we can use the following relationship: elevation = TOCdepth_to_water_level. Fortunately, the QueryBuilder and SQL, in general, support simple
mathematical statements.
· Click in the Expression column in the last row and edit the expression to: [station].

[TOC]-[gw_level].[depth_]
· Click in the Alias column in the last row and change the alias to: WL
· Click the add [

] button at the bottom of the display fields section to add a final field.

This will act as a placeholder for the precipitation data - even though the current sub-query
will not return any precipitation data, we will need a field with this data so that all sub-queries
have the same number and type of fields.
· Rename the Alias of the new field to Precip and the Expression of the new field to

null:
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We now have completed defining the structure of the first sub-query. However; as currently
written, the sub-query would return blank information from all stations. In this case, we only
want information for one station: W-15. Therefore, we need to add a condition:
· Click the expand [ ] button next to the Description data category in the tree of

Available Fields section to find the "Location" table
· Click the expand [ ] button next to the "Location" table in the tree of Available Fields

section to find the "Station Name" field
· Select, drag and drop the Station Name field onto the Conditions section of the Query

Builder
· Set the Operator to =
· Set the Value to W-15

We now have completed WaterLevels sub-query, which should appear similar to the
following:

· Return to the parent Root query, by clicking on it in the Hierarchy section of the query

builder (shown above)

Adding the Second Sub-Query: Precipitation Time Series Data
In this section of the example, you will construct a sub-query that will return the precipitation
time series data for the WS-1 weather station:
· Add the second sub-query by clicking the add column [

] button at the bottom of the

display fields section
· Type the name "Precip" and Click OK to continue
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· Select the "available to map, and plume modules" option to add the ID, Name, X, and

Y fields to the subquery
· Click the expand [ ] button next to the Monitoring Event data category in the tree of

Available Fields section to find the "Meteorology" table
· Click the expand [ ] button next to the "Meteorology" table (under the Monitoring

Event category) in the tree of Available Fields section to find the Date field
· Select and (double-click to) add the Date field to the Display Fields section of the

Query Builder.
· Select and (double-click to) add the Total Precipitation field to the Display Fields

section of the Query Builder
· Rename the Alias of the new field to Precip
· Click the add [

] button at the bottom of the display fields section to add the
placeholder field for the null water level data.

· Rename the Alias of the new field to WL and the Expression of the new field to null
· Select, drag and drop the Station Name field from the Location table (in the tree of

available fields) onto the Conditions section of the Query Builder
· Set the Operator to =
· Set the Value to WS-1

The Precip sub-query is complete and should look similar to the following:

· Return to the parent Root query, by clicking on it in the Hierarchy section of the query

builder (shown above)

Mapping Fields in the Root Union Query
In this section, you will combine the sub-queries by adding all of the fields from the subqueries and mapping the sub-query fields to in the Root union query.
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· Select the "available to map, and plume modules" option to add the ID, Name, X, and

Y fields to the Root query
· Click the add [

] button at the bottom of the display fields section three times to add

three fields
· Rename the newly added fields to "Date", "WL", and "Precip"

The list of fields in the Display Fields now contains all of the fields that were created in each
of the subqueries. The Display Fields section of the Root query also contains one column
for each of the sub-queries: "WaterLevels" and "Precip". These columns are used to
map/assign fields from each sub-query to the fields in the Root query:
· Click the cell in the ID row and the WaterlLevels column of the Display Fields table and

select ID from the list of available fields (from the WaterLevels sub-query)
· Continue to map all fields for both the WaterLevels and Precip columns until your

mappings appear as follows:

The full union query is complete and ready to executed and/or used in other modules.
· First save the query so that it can be reused, by clicking the save [

] button

· Run the Union Query to review the results by clicking the execute [

] button

The Query Results view will appear with values similar to the following:

For further information on what can be done with the query once it has been executed and
the results are being displayed - please see the section on the Query Results section.
The results include a column for the RowID and for all of the fields that were added in the
Root union query. Note that in rows where the Source Name column has a value of
WaterLevels, there is a value in the WL column and blank (null) value in the Precip column;
similarly, in the rows where the Source Name column has a value of Precip, there is a value
in the Precip column and a blank (null) value in the WL column. The Source name column
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represents which subquery returned the values for each row. Given this field, a more
streamlined way of generating the table might have been to add both the WL and Precip
values to a single "Value" column; however, in order to plot these data separately, they must
be in a distinct field.

Generating a Multi-Series plot using a Union Query
In this section, you will create a time series plot with the water level and precipitation data
plotted on different Y-value axes:
· Open a new plot collection by selecting the Plot Collection icon

from the main

toolbar.
· Click the add plot [

] button from the Plot Collection toolbar

· Select Time Series
· The Chart Settings window will appear
· Click on the dropdown menu at the top of the window (under the Source label) and

select Query as the data source type
· Click the first Select... Button to select the Query to be used in the plot
· Select the WaterLevels and Precip union query you made above:
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· Click OK
· Click the second Select... Button to select the Data Source to be used for the series

names:
· Select the Source Name field:
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· Select Triangles as the Symbol type
· Click the add parameter [

] button in the Parameters toolbar

· In the Parameter column of the Parameters table, select "Date", "WL", and "Precip" as

the parameters for the axes by double-clicking in the appropriate cell and selecting the
appropriate values when prompted
· Set Axis of the last row (with the Precip parameter) as a Y2-axis
· Click Apply

The chart settings window should appear similar to the following:

The plot will appear similar to the following:
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The range of the precipitation data spans a longer time period than that of the water level
data. You can adjust the range of the Time (x) axis:
· Click on the Axes tab in the Chart settings window
· In the scale section of the axis settings, deselect the checkbox next to the

"Automatically generate rate to fit data"
· Set the Min value to Jan 1, 1996 and the Max value to Jan 1, 1997
· Set the Major tick interval to 3 months and the minor tick interval to 1 month
· Click OK
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Your plot should appear similar to the image above. Feel free to make additional formatting
changes. Note that you could have also added additional constraints to the data in either of
the subqueries. As an exercise, try to constrain the data using the query rather than the plot
settings.

12.2.3

SQL Query - Example
If you are familiar with SQL (Structured Query Language) syntax commands, you can
retrieve, manage and manipulate your data through the SQL Statement section of the Query
Builder when editing a general query or a union query.
As soon as you begin typing within the SQL Statement section of the Query Builder you will
be prompted to confirm that you wish only use the SQL Statement to create/edit the query.

When you select yes, you will notice the Display Fields, Conditions, and Group Conditions
sections will become disabled. Moving forward, you can only edit the query by directly editing
the SQL Statement.
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The most commonly used command in SQL is the Select command which is described
below. This command will return query the data based on a set of optional conditions for
specified fields in one or more specified tables.

Select Command
The Select Command retrieves data from tables in a database and is usually followed by a
"where" clause. For example, if you want to create a query to show all chemistry results
where the chemical name is benzene, you would enter the following into the SQL Statement
section:

SELECT * FROM parameter_result WHERE chemical_name = `Benzene'

©2022 by Waterloo Hydrogeologic

Query Builder

463

As soon as you have entered a few characters you will see that the Query Builder
autocomplete tool becomes available to help you write your SQL Statement.

Based on the first few letters of each word you enter the program will try and help you by
suggesting SQL Commands (for example SELECT) or the names of tables or fields in your
database.
Once you have completed entering the statement (ensure it is exactly as written above
including the single brackets around the word Benzene) you can execute the the statement
by selecting

button.

You will be moved to the Data Query tab to see the results of your query.
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Since we used the * in the Select statement ALL fields in the parameter results table will be
displayed - but only the records containing Benzene will be displayed.
Select commands do not alter the underlying data. A more complete reference guide to the
SQL language that interacts with the HGA database can be found here.
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Dynamic Station Group Query - Example
A Dynamic Station Group query is used to group stations that meet specific conditions. The
station groups that are created this way are called "Dynamic" because the stations in the
group may change as data is added/edited in the database. Alternatively, the Stations
Groups that are user defined are referred to as "Static" because they do not change unless
the user makes the changes manually. Station Groups are used throughout Hydro
GeoAnalyst including as source data for Well Profiles, Cross Sections, 3D Scenes, and
more.
The following provides an example of creating a Dynamic Station Group Query with guided
steps using the Demo Project.

Creating a Dynamic Station Group Query (Example)
If the Query Builder tab is not yet opened, select the Query Builder icon
toolbar.
In the Query Builder tab toolbar, select the New button
appear.

from the main

and the New Query dialog will

· The default Query Type is the General Query - we need to change this by selecting the

Dynamic Station Group option.
· Provide a Query Name: Station with TOC exceeding 320masl (for this example).
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· Select OK to create the query.

You will notice that the Display Fields and the Group Conditions sections have become
disabled - these are not available for Dynamic Station Group Queries.
· Click once on the TOC field (it will become highlighted blue), and drag this field into

the blank Conditions field (under the Expression column). The TOC field will be added
to the Query Conditions. (Alternately, you may use the
button (on the bottom half of
the conditions section) to add conditions, then define them manually).
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· We need to set an operator and value for our Condition. You will notice there are

several options in the Operator drop down list (>, >=, <, <=, =, <>, IS, IS NOT, and
LIKE) providing you several options to query your data from the database.
· Select the > option from the drop down list in the Operator column.
· Enter the number 320 in the Value field.

In the Conditions section, select the Source Conditions. The options are Project, Station
Group, and Database. If Station Group is selected, then another combo box will become
activated where you can select the appropriate Station Group to be the source for this query.
If Project is selected, then all stations in the project will be queried. If Database is selected,
then the query will be applied to the entire database and span all projects stored within that
database (if applicable). For this example, we will use the default which is Project.
The Query Builder should look similar to the image below:
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· If you need, you can add multiple conditions - these need to be linked by specifying an

additional Operator (the far right column in the Conditions window); choose from AND,
OR. For this example we will only use one condition.
· Select the Execute Query button

and you will be moved to the Data Query tab to
see the results of your query. The results of a Dynamic Station Group query will have
only 2 columns - the RowID and the Station ID.

More useful is the fact that the new query will now appear as a new branch under the Station
Group branch in the Project Tree and is available for use with other modules.
The Dynamic Station Group queries can be distinguished from a user-defined station group
(static) by the color of the icon used to display in the Project Tree. Blue icons are Static
Station Groups while green icons are Dynamic Station groups.
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Dynamic Sample Set Query - Example
In HGA+, dynamic sample set queries are used to find sets of samples meeting specific
conditions. The sample sets that are created this way are called "Dynamic" because the
samples in the group may change as data is added/edited in the database. Alternatively, the
"Static Sample Sets" are so-called because they are based on a fixed list of samples
selected from the Sample List view and they do not change unless you manually add/remove
samples from the list. Sample Sets are mainly used in the HGA+ modules including as
source data for Plot Collections, Sample Reports, R-scripts; however, they can also be used
in other modules that work with queries.
Follow the steps in the example below (using the Demo project) to create a Dynamic Sample
Set.

Creating a Dynamic Sample Set Query (Example)
If the Query Builder tab is not yet opened, select the Query Builder icon
toolbar.
In the Query Builder tab toolbar, select the New button
appear.

from the main

and the New Query dialog will

· The default Query Type is the General Query - we need to change this by selecting the

Dynamic Sample Set option.
· Provide a Query Name: Samples with Exceedances.
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· Select OK to create the query. You will notice that the Display Fields and the Group

Conditions sections have become disabled - these are not available for Dynamic
Sample Set Queries.

· Click on the

button to load the Condition dialog:
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The Condition dialog allows you to create parameter-based conditions, including measured,
calculated, station, and sample parameters. These can also be include conditions based on
Water Quality Standards. Some example conditions include:
· samples collected from a station of a particular type (e.g. Station Type = Observation

Well)
· samples collected in a given year (e.g. Sample Date >= Jan 1, 2008 AND Sample
·
·
·
·

Date < Jan 1, 2009)
samples with exceedances (e.g. Benzene >= MCL for Benzene)
samples with a specified concentration above
samples with below a given calculated hardness (e.g. Hardness <= 50 mg/L CaCO3)
samples with below a given calculated hardness (e.g. Hardness <= 50 mg/L CaCO3)

To illustrate, we will create a sample set with the first three of these conditions:
· Select Parameter value
· Change the parameter by clicking the

button to open the parameter selector,
select Station parameters from the drop down and "Station Type" from the list:
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· Click OK
· Type Observation Well in the condition textbox:
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· Click OK
· Add a second condition by clicking the
· Change the parameter by clicking the

the drop down and "Sample Date" from the list:
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· Click OK
· Enter a Date value of Jan 1, 2008:

©2022 by Waterloo Hydrogeologic

Query Builder

· Click OK
· Repeat the steps above but enter a condition for samples collected before Jan 1,

2009:
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We will now add one last condition. This time, we will add a condition based on a water
quality standard exceedance:
· Click the

button

· Select "Exceeds Standard" from the top dropdown menu and select the "The following

parameter" option
· Change the parameter by clicking the

button, select Analyzed parameters
from the drop down and "Benzene" from the list:
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· Click OK
· Select the EPA RSL - MCL as the applicable standard. The Condition window should

look like the following:
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· The conditions pane of your query should now contain a total of four conditions:

· Note that there are three validation errors (

) since SQL requires a logic gate
between conditions. We will specify the AND condition for each:
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· Click the Save button

to save the Sample Set. Note that the Sample Set is now
saved in the Project Tree and will be available for use with other modules.:

· Select the Execute Query button

and you will be moved Sample List which will
now contain only those samples that meet the conditions specified in the Dynamic
Sample Set query:
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More useful is the fact that the new query will now appear as a new branch under the Station
Group branch in the Project Tree and is available for use with other modules.
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Query Results
The Data Query Tab will display the results of executing (running) a query. When you select
a query from the Queries branch of the project tree, the Data Query tab will be activated and
display the results of the selected query.

As in most tabulated views in Hydro GeoAnalyst, the first line of the Data Results tab is the
Filter Line which is highlighted ( ). The filter line is similar in function to what you find in
Excel when you apply a filter. You can enter values to filter the list of what is displayed only
to those values that you are interested in.
You can also highlight a record (will turn bright blue ) by clicking on the button on the left
hand side of the grid and then right click on the record and select copy or <CTRL><C>. You
can paste this into for example an Excel worksheet and both the header information and the
records you highlighted will be pasted into the spreadsheet.
The toolbar for the Data Query tab contains the following controls:

returned results (
page ( ).

Navigates to a results page, skipping to the first page of
), to the previous page ( ), to the next page ( ), or to the last

Creates a new query (you will be moved to the Query Builder tab and prompted for a
name for your new Query).
Edits the current query (you will be moved to the Query Builder tab with the current
query open).
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Saves the current query with active filters as a new query.
Executes query again.
Deletes the current query.
Uses the current query to generate a plume for visualization in the Scene Viewer.
Opens the Perform Lab QA/QC Assessment tool from the Quality Control module
based on the current query.
Creates a Pivot table in Excel based on the results of the current query.
Exports the results of the query.
Prints the results of your query to an Excel template.
Sends the results of your query as a time series Chart in Excel.
Prints the results of your query to a PowerPoint template.
Allows you to select which query columns are shown or hidden.
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Event Planning
The Event Planning module ensures that your field activities are always completed correctly
and on time. Easily create multiple schedules for various stations and then create event
plans that outline the details of your field activities including stations to be sampled, data to
be collected, field checklists and more. Event plans are automatically converted into reports
which can be printed and given to field personnel. Hydro GeoAnalyst keeps track of all your
event plans and automatically reminds you in advance when scheduled field activities are
due.
The following topics describe the Event Planning Module:
·
·
·
·
·

14.1

About the Interface
Schedule Stations
Event Plan Wizard
Event Plan Closure
Manage Event Plans

About the Interface
The Event Planning module can be launched by selecting the
or by selecting Modules > Event Planning from the menu bar:

icon from the main toolbar

The module launches as a tab and displays as a calendar to allow you to see any upcoming
schedules.
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If you select a schedule in the calendar you will see the stations that are due to be sampled
that are associated with the schedule on the right hand side.

allows you to schedule your stations for regular sampling
allows you to create an Event Plan
allows you to close any existing Event Plans
allows you to manage your Event Plans
allows you to go to today (current date) in the calendar (helpful if you have scrolled
ahead or behind in the calendar).

14.2

Schedule Stations
You can schedule your stations for regular sampling by selecting the
Schedules dialog will appear.

icon and the Event
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Here you can see all current schedules for your project. You can create a new schedule, edit
an existing schedule or delete a schedule.
To create a new schedule select the New... button and the New Schedule dialog will appear.
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You must provide a name for the schedule in the Subject field and then you have the option
of providing a description for the schedule.
Indicate the start and end date for the schedule.
Select the Stations you wish to schedule from the list of stations on the left hand side. You
can reduce the list of all stations by selecting an appropriate Station Group.
Once you have selected the stations (will be highlighted blue). Select the
the stations to the Selected Stations area (right hand side).

button to move

To move all stations from a Station Group to the Selected Stations area use the

button.

You also have the option to set the Recurrence for your your schedule (similar to the options
found in Outlook) and the following dialog will appear.
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Once you save an close your New Schedule you will find it in the list of Event Schedules.
You find also find it in your calendar.

14.3

Event Plan Wizard
You can create your Event Plans by selecting the
appear.

button and the Event Plan wizard will

Event Plan Information
The first step of the Event Plan wizard allows you to provide some basic information about
the plan including the Name and the Start and End dates.
Additional option information can also be provided including the Field Technician, the
Primary Lab where the samples will be sent, the Plan Approver and Comments regarding the
plan.

©2022 by Waterloo Hydrogeologic

488

Hydro GeoAnalyst 11.0

Stations to be sampled
The next step of the Event Plan wizard indicates which stations will be sampled in the plan. If
you had a schedule selected in the calendar when you selected the Event Plan wizard the
stations that are due will already be populated.
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You can add more stations to the plan if you wish - select the Stations you wish to add from
the list of stations on the left hand side. You can reduce the list of all stations by selecting an
appropriate Station Group.
Once you have selected the stations (will be highlighted blue). Select the
the station(s) to the Selected Stations area (right hand side).

button to move

To move all stations from a Station Group to the Selected Stations area use the

button.

Parameters to be Analyzed
The next step of the Event Plan wizard allows you to indicate which parameters will be
analyzed.
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By default the parameters selected will be applied to all Stations - however if you wish you
can select different parameters for each individual station.
Once you have selected the parameters (will be highlighted blue). Select the
move the parameters to the Selected Parameters area (right hand side).

button to

To move all the parameters from a Station Group to the Selected Parameters area use the
button.
To make it easier to select parameters - since the list can be very long (the list is taken from
the List Editor list for the Chemical Name field in the Parameter Results table) you can
create Parameter groupings. Several groupings have been provided by default, but if you
wish, you can create your own by selecting the
List Editor.

button. This will launch the Parameter
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This module is similar to the Material Specification Editor. Provide a New Group name on the
right hand side and select the parameters you wish from the left hand side to be included in
the new grouping. Once you have selected the parameters (will be highlighted blue). Select
the
button to move the parameters to the Selected Parameters area (right hand side).
To move all the parameters from a Station Group to the Selected Parameters area use the
button. Once you save the new grouping it will be available within the Event Planning
wizard.

QAQC Analysis
The next step of the Event Plan wizard allows you to indicate if you want QAQC analysis
samples to be taken.
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Select the
button to add a QAQC sample to be taken. Then you need to specify at which
station the sample should be taken, and what kind of QAQC sample should be taken
(options include duplicate, trip blank and equipment blank). You also have the option to
provide a comment.
If you need to delete a QAQC sample highlight the sample and then select the
To add QAQC samples based on the programmatic ratios, select the
button.

button.

Apply QAQC ratios

You can create entries for the correct number of QAQC samples based on programmatic
QAQC sample ratios using the Manage QAQC Sample Type button (

).
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Additional Data Collection
The next step of the Event Planning wizard allows you to indicate if any Additional Data
needs to be collected while in the field.

By default the additional data to be collected will be applied to all Stations - however if you
wish you can select different data to be collected for each individual station.
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The data fields to be collected can be selected from the datamodel tree on the left hand
side. Once you have selected the field (will be highlighted blue) select the
move the data field to the right hand side.

button to

Checklist
The next step of the Event Planning wizard allows you to prepare a checklist to help ensure
all required items for performing the field activities are remembered. You can enter one item
per line.

Scheduled Tasks
The next step of the Event Planning wizard allows you to schedule tasks related to the Event
Plan that can be saved to an iCalendar (.ics) file and shared to your Calendar or the
Calendars of your project team members.
To schedule a new task click the
New Task button. A dialog will appear that allows you
to select what information will appear in the description of the task:
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After selection the relevant information, you can edit the Task information, including Subject,
Location, Start/End Time, Reminders, Recurrence, and description.
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Clicking Save and Close will close the item in HGA and open in it your default Calendar
application (e.g. Outlook). Note that the entire sample plan will be included as a formatted
Word Document.

You can also

Edit or

Remove Scheduled Tasks.

Please Note: Editing or Removing a scheduled task will not automatically update your
Calendar application (e.g. Outlook). Edited Tasks will result in a new iCalendar file - existing
events saved to your Calendar application (and the Calendars of project team mates) will
need to be deleted and updated with the newly created item.
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Publish
The final step of the Event Planning wizard allows you to publish the Event Plan by several
options. At this step, you can:
· Save the plan: saves the plan.
· Create and EDD template: allows you to create a new EDD Template based on the

Event. From there you can create a Mobile EDD.
· Print to Word: publishes the plan to a Word Document Template so that you can

share it with Project Team Members.
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The first page of the Event Plan report is a summary including the list of stations to be
sampled along with the coordinates as well as the checklist.
Each page thereafter contains the information for what needs to be collected at each station.
Including the parameters that will be analyzed, any QAQC samples that should be taken,
and any additional information that should be collected in the field while at that particular
station.

These plans can be saved and printed out for field personnel. The templates used to
generate the plan reports can be modified if for example you wish to change the logo. The
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template can be found in the Templates folder - the location can be found in the HGA
Settings.

14.4

Event Plan Closure
The Event Planning module will remind you to close an Event Plan 7 days after the plan was
scheduled to be completed. This can be adjusted in the HGA Settings.
The Event Plan Closure wizard allows you to close an Event Plan. In the first step you need
to select the Event Plan you wish to close by selecting the
browse button. Once the plan
is selected you will see the basic information of the Event Plan displayed.

The Next step allows you to indicate what was collected during the field activities.
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If all the required collections (Station samples, QAQC samples, and Additional Data) were
made you can simply select the Select All option to indicate that everything was collected. If
however some items were not collected during the field activities they should remain
unchecked and a comment indicating why must be provided.

The next step confirms your collections.
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You have the option to reschedule any Stations that may have been missed during the field
activities as well as entering comments regarding the plan.
You must select the Acknowledge button in order to select the Finish button the Event Plan
(which will then be considered closed).

14.5

Manage Event Plans
When you select the Manage Event Plans icon the list of all Event Plans will be displayed
indicating the Name, Start and End dates as well as whether the plan has been closed.
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Here you have the option to re-print the plan if necessary as well as the option to re-open a
plan if it was mistakenly closed. You also have the option to delete Event Plans in this dialog.
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Well Profile
The Well Profile module can be used to display detailed information pertaining to a single
station or well including:
·
·
·
·
·
·

Well construction details (casing, screens, annular fill)
Geophysical data plots
Lithology information for each formation
Description of the geologic formation
The depth and or elevation of each layer
many others...

In a typical profile report, there may be one or more instances of the items listed above. The
number of columns, and their order of display, is flexible and can be set at the time of
designing the template and edited at any point thereafter. Templates can be created for one
or more stations at once based on a desired design. You can create as many different
templates as you need to suit your project needs.
The Well Profile module can also be used as a data entry assistant in Hydro GeoAnalyst, by
displaying for example well construction details as data is entered in tables on the Station
Data tab.
Please refer to the following sections for more information on how to set up a Well Profile:
·
·
·
·
·
·
·
·

15.1

Well Profile Interface
Scale Column
Lithology Column
Interval Column
Depth Column
Well Construction
Plot Column
Display on Cross Section

Well Profile Interface
The Well Profile can be launched by selecting the
icon from the main toolbar or by
selecting Modules/Well Profile or by simply double clicking on an existing Well Profile
template found in the Project tree. It will be loaded with the last template that was used.
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You can change the template you are viewing by selecting from the list of templates
available in the drop down. The current station displayed is presented in the toolbar - you
can change stations by selecting another one from the Station Picker in the Project Tree.

The following options are available on the Well Profile toolbar:
Refresh data: refreshes the display with latest data from database
Zoom In: this will give you an option to enter top and bottom values of the interval
you wish to view
Zoom Out: this will zoom out the display to full extents
Create a new template: will prompt you for the name of your new template and then
open the editor options
Edit: will open the editor options
Delete selected template: will delete the currently select template
Save Image As: allows you to save your well profile as a .bmp or .emf file format
Create new PowerPoint template: allows user to create a new PowerPointTM
template using a query to have fields from query appear on the template
Print to PowerPoint: allows user to push well profiles for one or more stations to a
PowerPoint template
Export to cross section: allows you to save images that can then be used to
display on a Cross Section
The editor portion of the toolbar becomes available when you select the Create a new
template or Edit button. You will notice it opens a new set of options on the left side of the
toolbar.
Save: saves any edits done to the current template
Save As: allows you to save the current template with a new name
Rename template: allows you to rename the current template
Add column: adds a new column
Delete column: deletes the selected column
Move column up: moves the selected column up in the design
Move column down: moves the selected column down in the design
Reset to column defaults: restores the settings for the selected column back to
default values
Add annotation: adds an annotation anywhere on the Well Profile template
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Delete annotation: deletes selected annotation
Close editor: this will close the editor portion of the Well Profile
The editor portion of the Well Profile provides you the ability to add several different column
types to the template as well as adjusting the settings for the columns.
The overall settings for the design of the template (like header height, outline colour and
thickness as well as column defaults) can be found by selecting the Design node.

Here you can find the option to display your template as True Vertical Depth by selecting
Yes for this option. All data will be calculated as true vertical depth based on the inclination
angle entered into the Drilling Protocol table.
You also have the option to use 0 (zero) as your top value or the minimal measured value.

15.2

Scale Column
The scale column displays a vertical scale beside the Well Profile template.
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The following settings are available:
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Here you will find the option to Show Elevation values instead of depth values on the scale
column - this will automatically be calculated by using the elevation value in the Station table
and subtracting the depth values.
You also have the option to change the Display Unit - this allows you to display multiple
scale columns within a template showing different units.

15.3

Lithology Column
The Lithology column displays the intervals of data from the Lithology table. Displaying both
the images from the project Material Specification as well as the name of the soil type
entered in the Lithology table.
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The following settings are available:
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By default the Data settings are mapped to the Lithology table and the Entities are mapped
to from, to, and soil type for both the text and the image; however you can adjust these.

15.4

Interval Column
The Interval column is meant to display data that has been stored as from and to
measurements. You can display descriptive text, values, or images associated with the
interval.
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The following Settings are available:
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You can choose to display data from a table or from a query in the Data settings.
Then you can select the From, To, Text and Image fields from the drop down options in the
Entities settings.
The settings also allow for user to show text or image or both, also options are available to
select the style of images and the percentage of the column the images should fill.

15.5

Depth Column
The depth column is meant to display data related to a specific depth. You can display text
or values associated with the depth.
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A typical use might be to display water levels displaying the date of the water level.

The following settings are available:
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The Data options allows you to select either a table or a query and the Entities options
allows you to select the associated fields.
The settings options allows you to display no image, show image or show symbol.
The show symbol allows you to display the water level symbol and the Symbol options allows
you to adjust the look of the symbol.

15.6

Well Construction
The Well Construction column is the most comprehensive data column in the Well Profile. It
displays data from various sources in your database including:
·
·
·
·
·
·

Drilling details
Lithology
Annular filling
Casing
Screen
Water Level
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The following settings are available:
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The Settings options allow you to customize the well construction column to show or hide
various components.
The Data options allows you to further adjust the column.
· Casing options include color, or use of an image, and stick up and reducer options
· Cluster Wells options include layout (stacked or side by side), order to allow for

displaying your cluster (or nested) wells
· Lithology option includes which side (left, right or both) to display the lithology images
· Scale options include similar options to a scale column like major and minor tick

marks, unit, using elevation etc.
· Screen options include color, or use of an image and labels
· Water Level options include which ones to display (All, Earliest, Latest, Minimum,
Maximum, or Average) as well as label options and location of symbol

15.7

Plot Column
The Plot column is designed to display various types of depth dependent graphs. It supports
both the Interval as well as the Depth based data types. The following are some example
data that may be displayed using this column type:
· Geophysical investigation results
· Analytical results (chemical concentration)
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· Analytical results for soil physics (moisture content, bulk density, etc.)
· Soil testing results (pocket Penetrometer, SPT)

The following settings are available:
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The data section provides you with the option to add one or more series to the plot by
selecting the ... button beside the Edit Series.
You can add either depth or interval series to the plot.
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The following options are available for a depth series:

While the following options are available for an interval series:
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Display on Cross Section
The Well Profile tab provides the option to export images to be used on the Cross Section
Editor. This option will let you choose which Cross Section you wish to generate images for.
There is also an option to generate images for all Cross Sections.
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Images for each station within the selected cross section will be generated based on the
currently selected template. A common template to use is the resistivity_plot_only as it is a
simple plot column. The images that are generated have a transparent background so that
you can visualize them over the cross section interpretations.
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Map Viewer
In Hydro GeoAnalyst, you can use the
Map Viewer Module to easily map location-based
representations of your project data and add external data layers to enrich your map.
To Open the Map Viewer Module:
· Click the Map Viewer [

] button on the main toolbar
or
· Select Modules > Map Viewer from the Main Menu

Layout
The layout of the Map Viewer is divided into two separate panes and their related controls:
1. The Layer Tree lists map layers that have been added to the map and includes the
layer toolbar.
2. The Map Viewport displays visible map layers that are rendered in the (bottom to
top) order in the Layer Tree and includes the Map Viewport Toolbar and Status Bar
The Map Viewer also includes the Map toolbar which controls the map view itself.

Map Toolbar
The Map Toolbar provides controls for managing the map:

Save: saves changes to the current Map View in the Project Tree.
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Save as...: saves a copy of the current Map View with a new name in the Project
Tree.
Rename map: renames the current Map View.
Refresh layer data: refreshes layers and associated data in the current Map View.
Export Map...: exports the current map to an image or PowerPoint template.

Map Layers and the Layer Tree
The layer tree organizes map data layers that have been added to the map. A data layer is a
specific dataset that contains geographic information in either vector or image/raster format.
Layers will be rendered in the map in the order in which they the layer tree. The layer at the
bottom of the tree will be rendered first and therefore will be shown as beneath overlapping
layers that are higher in the tree. In addition to layer order, the layer tree provides controls
on how each map layer will be rendered, including a
checkbox that toggles each layers's
visibility and a toolbar for additional controls.
Vector Datasets
Vector datasets represent discrete locations as one or more points, polylines, or polygons.
Each point, polyline, or polygon is composed of spatial information (i.e the set of vertices that
define the point, polyline, or polygon) and associated attributes (i.e. information about the
point, polyline, or polygon). There are two types of supported vector datasets in Hydro
GeoAnalyst 11.0:
· Project data-driven datasets are vector datasets that are based on a sample set or

station group and are dynamically generated by Hydro GeoAnalyst based on the
project database
· Shapefiles are an open source vector-based Geographic Information Systems (GIS)

data format developed by ESRI (1998) that includes a set of points, polylines, or
polygons. Shapefiles consist of a set of files with the same file name — four of these
are required for use in the Map Viewer Module: .shp (spatial data), .shx (spatial index),
.dbf (attribute data), and .prj (coordinate reference definition). Shapefiles can be
imported from external sources in Hydro GeoAnalyst.

Raster Datasets
Raster datasets generally represent continuous data over a specified area discretized in a
grid of point values. There are two main types of raster datasets supported in the Map
Viewer:
· Image formats are a grid based data type covering a defined rectangular area and

are commonly used to store/present basemaps and aerial imagery. Hydro GeoAnalyst
supports common image types with an associated world file.
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· Surfaces are grid-based data type that covers a defined area with each point on the

grid representing values of some generally continuous dataset (e.g. elevation,
concentration, temperature, etc.). <%APP> supports common raster surface formats:
o Surfer Grid Files (.grd)
o ESRI ASCII Grid Files (.asc)
Please Note: the projection of the image or surface must match that of the map.
On-the-fly Image reprojection is not currently supported in Hydro GeoAnalyst 11.0.
Layer Toolbar
The Layer Toolbar provides controls for managing and configuring map layers:

Add layer: opens the Add map layer window
Delete layer: removes the layer selected in the Map Tree
Labels: opens the Feature Labeler window
Create Grid File: creates a new surface (grid file) based on an input point layer
Grid Settings: opens the grid settings window for the selected surface
Contour Settings: opens the contour Surfaces settings window for the selected
surface
Attributes: opens the Data settings window
Data Layer Settings: opens the Data Layer Settings window (only applies to project
data-driven layers)
Callout Settings: opens the Callout settings window for the selected layer (only
applies to project data-driven layers)
Export to shapefile: Exports the selected data layer or surface layer to a shapefile

Map Viewport
The map viewport is where map layers are displayed and provides controls to interact with
the map layers.

Map Viewport Toolbar
The Map Viewport Toolbar provides controls to manipulate the viewport and interact with
visible layers:
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Pan Tool: allows you to pan around the map view. When this tool is active (framed in
a solid blue line), you can:
§ click and drag the mouse pointer on the map to pan around
§ use the mouse wheel up/down to zoom in/out, respectively

Selection Tool: allows you to select one or more features from the active layer.
When this tool is active (framed in a solid blue line), you can:
§ click on a feature in the active layer to select it
§ click, drag, and release to select features in the active layer within the resulting

rectangle
§ press and hold the <shift> key while performing the above actions to add to the

existing selection or
§ press and hold the <control> key while performing the above actions to flip the

selection
§ click on the map where no features in the active layer exist to deselect all

features in the active layer
Deselect All: deselects all features in the mapview
Zoom in: allows you to zoom in on the map. When this tool is active (framed in a
solid blue line), you can:
§ click on the map to zoom in by an approximate factor of 2
§ click, drag, and release to zoom in to the resulting rectangle

Zoom out: allows you to zoom out on the map. When this tool is active (framed in a
solid blue line), you can:
§ click on the map to zoom out by an approximate factor of 2
§ click, drag, and release to zoom out based on the scale of the resulting

rectangle to the current viewport
Zoom to full extent: zooms the map viewport to the full extent of all layers in the
layer tree.
Zoom to selection: zooms the map viewport to the extent of the selected feature(s)
in the active layer.
Zoom to Layer: zooms the map viewport to the extent of the active layer.
Move Callout: allows you to move chart and mini-table callout features on the map
layer from the active layer. When this tool is active (framed in a solid blue line), you
can:
§ click, drag, and release to move features in the active layer (selected items will

be highlighted red)
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Sync selected samples: toggles whether the map selection is synchronized with
sample selections in the rest of Hydro GeoAnalyst (e.g. Sample Picker, Sample List,
Plot Collection(s), etc.)
Show scale: toggles the scale bar on the map. If turned on, a scale bar will be shown
in the lower right hand corner of the map. The length of the scale bar (in terms of both
the map and screen space) will automatically adjust based on the scale of the map on
the screen to the nearest single digit value.

Status Bar
The Status bar provides additional controls for the map viewport

Map Scale: displays the current map scale and allows you to set the map scale to one of
several common scales
Map Projection: displays the current map projection and allows you to set the map
projection.
Coordinates: displays the map coordinates for the location of the mouse pointer on the
map if it is located within the viewport

16.1

Add Map Layer
This section describes the layer types that are supported in the Map Viewer and how to
manage them.
Supported layer types
The following types of layers are supported file types are supported in the Map Viewer maps:
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Vector Data
Vector datasets represent discrete locations as one or more points, polylines, or polygons.
Each point, polyline, or polygon is composed of spatial information (i.e the set of vertices that
define the point, polyline, or polygon) and associated attributes (i.e. information about the
point, polyline, or polygon). There are two types of supported vector datasets in Hydro
GeoAnalyst 11.0:

Hydro GeoAnalyst Data (Project Data-Driven Layers):
Project Data-Driven Layers are point locations with associated data that are dynamically
generated by Hydro GeoAnalyst based on data in the the project database:
Spatial Queries from the project tree that include the X and Y location fields from the
station "Location" table
Station Groups from the project tree as defined in the station list (static groups) or in the
query builder (dynamic sets)
Sample Sets from the project tree as defined in the sample list (static sets) or query
builder (dynamic sets) [HGA+ only]]
Shapefiles
Shapefiles are an open source vector-based Geographic Information Systems (GIS) data
format developed by ESRI (1998) that includes a set of points, polylines, or polygons.
Shapefiles can be loaded into HGA and consist of a set of files with the same base file name
— four of these are required for use in the Map Viewer Module: .shp (spatial data), .shx
(spatial index), .dbf (attribute data), and .prj (coordinate reference definition). Shapefiles can
be imported from external sources in Hydro GeoAnalyst.
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Raster Datasets
Raster datasets generally represent continuous data over a specified area discretized in a
grid of point values. There are two main types of raster datasets supported in the Map
Viewer:

Image formats
Images are a grid based data type covering a defined rectangular area and are commonly
used to store/present basemaps and aerial imagery. Hydro GeoAnalyst supports common
image types (.bmp, gif, .png, .tif) with an associated world file.

Surfaces
Surfaces are a grid-based data type that covers a defined area with each point on the grid
representing values of some generally continuous dataset (e.g. elevation, concentration,
temperature, etc.). <%APP> supports two of the most common raster surface formats,
Surfer Grid Files (.grd) and ESRI ASCII Grid Files (.asc). Surfaces can also be created by
interpolating data from a project data-driven layer (i.e. a spatial query, a station group, or a
sample set)

Please Note: the projection of the image or surface must
match that of the map. On-the-fly Image reprojection is not
currently supported in Hydro GeoAnalyst 11.0.

Adding a map layer
You can add a layer to the map by:
· Clicking the Add layer button [

] in the map layers toolbar to open the Add map layer

dialog
· Dragging-and dropping a station group, sample set, or Spatial Query onto the Layer

Tree or Map Viewport
· Dragging-and-dropping a supported external file type (shapefile, image, or surface)

from a Windows Explorer window onto the Layer Tree or Map Viewport
Add Map Layer Window
The Add Map Layer window includes a radio button selection for the type of layer to add:
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Add Station Group/Sample Set
Selecting the station group or sample set option shows a searchable subset of the project
tree that includes the station groups and sample sets:
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Clicking the
button adds the selected station group or sample set to the layer
tree and map viewport.

Add Query
Selecting the station group or sample set option shows a searchable subset

Add Shapefile
Selecting the Shapefile option and clicking the
button opens the windows
explorer and allows you to navigate to and select a shapefile to be added to the layer tree
and map viewport.
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Add Image
Selecting the Image option and clicking the
button opens the windows explorer
and allows you to navigate to and select an image file (.bmp, .jpg, .png, or .tif) to be added to
the layer tree and map viewport. A valid world file, must also be present to georeference the
image.

Add Surface
Selecting the Surface option and clicking the
button opens the windows explorer
and allows you to navigate to and select a surface file (.grd or .asc) to be added to the layer
tree and map viewport.

Working with Map Layers
You can toggle the visibility (show/hide) a layer on the map by toggling the layer checkbox in
the Map Layers tree.
You can reorder the layers by clicking, dragging, and dropping the selected layer in the
desired position on the map. Layers at the bottom of the tree are rendered first so that they
appear "under" layers higher up in the tree.

Deleting a Map Layer
To delete a layer from the map, simply select it in the Map Layers tree and click the delete
layer [ ] button to remove it from the Map.

Exporting Map Layers
To export a map layer, select it in the map tree and select the Export Shapefile
button in
the Map Layers toolbar. The subsequent export steps depend on the type of layer to be
exported as follows:
· If the selected layer is a Point Layer whether from an external shapefile, station

group, sample set, or spatial query, then you will be prompted to select the export file
path and you will have the option to add a numerical field as the Z-coordinate:

©2022 by Waterloo Hydrogeologic

532

Hydro GeoAnalyst 11.0

· If the selected layer is a Polyline or Polygon layer, then you will be prompted to select

an export file path
· If the selected layer is a surface, then you will be prompted to save one or more types

of information:

o Export grid points: exports a point shapefile with one point at the centroid of each
grid cell including the elevation (or surface value).
o Export major contour lines: exports a polyline shapefile with the major contour lines
currently displayed on the map
o Export minor contour lines: exports a polyline shapefile with the minor contour lines
currently displayed on the map
· Images cannot be exported to a shapefile
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Image World File Format
World files are companion files to geospatial images that contain spatial reference
information to locate the image within its projection.

Please Note: the projection of the image must match that of the map in Hydro
GeoAnalyst 11.0; on-the-fly Image reprojection is not currently supported.

Filename
In order to work with its associated image file, the worldfile must be located in the same
folder as the image and have the same filename. The file extention must be as follows:
Image File Type/Extension

Associated World File
Extention

.BMP

.BPW

.GIF

.GFW

.JPG

.JPW

.PNG

.PGW

.TIF

.TFW

Contents
An ASCII world File consists of an ASCII text file with six items, each on a separate line:
Line

Symbol

1

∆x

pixel size in the x-direction in map units
(typically meters or feet)

2

θy

rotation/skew about y-axis

3

θx

rotation/skew about x-axis

4

∆y

pixel size in the y-direction in map units
(typically meters or feet). The value is
typically negative to indicate that the first
pixel of the image/raster is located at the
top/North

5

x0

x-coordinate of the center of the first
(typically leftmost/East) pixel
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6

y0

y-coordinate of the center of the first
(typically topmost/North) pixel

Example
The image used in the Creating Maps called Basemap.tif has an associated world file
(Basemap.tfw) with the following contents based on the UTM Zone 17N, NAD1983,
projection in meters (EPSG 26917):

2.0000000000
0.0000000000
0.0000000000
-2.0000000000
532001.0000000000
4816499.0000000000

16.1.2

Surface File Formats
Surface data files consists of an ordered array of interpolated values at regularly spaced
intervals that represent the spatial distribution of an attribute, such as elevation, elevation
models, temperature, concentration.
Hydro GeoAnalyst supports the following surface file types:
•SURFER Grid Files (*.GRD)
•ESRI ASCII Raster Files (*.ASC, *.TXT)

Surfer ASCII Grid File (.GRD) Format
The format of a Surfer ASCII grid file consists of six items:
DSAA
Nx Ny
Xmin Xmax
Ymin Ymax
Zmin Zmax
Z1 Z2 Z3 Z4
Znx+1 ...
. .
.
.
.
.

... Znx

... Znx*ny

Where:
Parameter

Description
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DSAA key

first line of the file must include the text "DSAA"
which is a text key used to indicate that the file is a
SURFER ASCII grid file

Nx Ny

Nx - the number of grid cells in the x-direction
(integer)
Ny - the number of grid cells in the y-direction
(integer)

Xmin
Xmax

Xmin - the X-coordinate of the centroid of the
left-/western-most cell
Xmax - the X-coordinate of the centroid of the
right-/eastern-most cell

Ymin
Ymax

Ymin - the Y-coordinate of the centroid of the
bottom-/southern-most cell
Ymax - the Y-coordinate of the centroid of the
top-/northern-most cell

Zmin
Zmax

Zmin - the smallest value in the surface
Zmax - the largest value in the surface
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Data Block See description below

Data Block
The data component of the SURFER ASCII grid follows the header information.
· Cell values should be delimited by spaces.
· No carriage returns are necessary at the end of each row in the raster.
· Row 1 of the data is at the bottom (south) side of the raster, row 2 is the data for the

next northward data above row 1, and so on.
Example
An example dataset follows:
DSAA
10 15
480025 480475
4865025 4865725
321.162 336.095
335.007 334.943
330.317
334.818 334.729
329.693
334.743 334.640
329.528
334.337 334.291
329.314
333.094 333.228
329.278
331.413 331.859
329.304
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334.974 335.267 335.899 336.095 335.553 333.868 332.647
334.820 335.349 335.765 335.623 333.998 332.027 330.824
334.695 335.157 334.620 334.012 332.142 330.947 330.267
334.323 334.729 333.095 331.948 329.890 329.682 329.606
333.393 333.985 332.567 331.600 330.137 329.879 329.704
332.229 332.919 332.253 331.781 330.973 330.326 329.915
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330.267
329.355
329.510
329.496
328.748
329.024
328.164
327.945
327.754
326.505
327.139
325.212
326.452
325.050
325.728
326.150
324.672
327.178

331.006 331.457 331.975 331.785 331.566 330.869 330.279 329.891
330.272 330.688 330.975 330.612 330.271 329.539 329.721 329.755
329.396 329.695 329.593 328.536 327.843 326.796 327.963 328.638
328.715 328.879 328.422 326.930 325.949 324.327 325.862 326.817
328.045 328.072 327.573 326.338 325.279 322.970 323.706 324.460
327.053 326.932 326.492 325.839 325.008 322.361 321.909 322.297
326.145 325.915 325.448 325.291 324.766 322.293 321.339 321.549
325.247 324.908 324.425 324.513 324.136 322.078 321.162 321.638
323.889 323.423 322.897 323.037 322.829 321.355 321.259 322.214

Imported example dataset, as displayed in Hydro GeoAnalyst.

ESRI ASCII Raster File (.ASC) Format
The format of an ESRI ASCII raster file consists of seven items:
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NCOLS xxx
NROWS xxx
XLLCORNER xxx
YLLCORNER xxx
CELLSIZE xxx
NODATA_VALUE xxx
Z1 Z2 Z3 Z4
... Znx
Znx+1 ...
. .
.
.
.
.
... Znx*ny

Where:
Parameter

Description

Requirements

NCOLS

Number of cell
columns.

Integer greater
than 0.

NROWS

Number of cell
rows.

Integer greater
than 0.

XLLCORNE
R

X coordinate of
the centroid
of the westernmost cells

YLLCORNER

Y coordinate of
the centroid of the
southern-most
cells

CELLSIZE

Cell size.

Greater than 0.

NODATA_V
ALUE

The input values
to be NoData in
the output raster.

Optional.
Default is -9999.

DATA
BLOCK

See description below

Data Block
The data component of the ESRI ASCII raster follows the header information.
· Cell values should be delimited by spaces.
· No carriage returns are strictly necessary at the end of each row in the raster. The

number of columns in the header determines when a new row begins.
· Row 1 of the data is at the bottom (south) side of the raster, row 2 is the data for the
next northward data above row 1, and so on.
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Example
An example dataset follows:
NCOLS 10
NROWS 15
XLLCORNER 480025
YLLCORNER 4865025
CELLSIZE 50
NODATA_VALUE -999
335.007 334.943 334.974
330.317
334.818 334.729 334.820
329.693
334.743 334.640 334.695
329.528
334.337 334.291 334.323
329.314
333.094 333.228 333.393
329.278
331.413 331.859 332.229
329.304
330.267 331.006 331.457
329.355
329.510 330.272 330.688
329.496
328.748 329.396 329.695
329.024
328.164 328.715 328.879
327.945
327.754 328.045 328.072
326.505
327.139 327.053 326.932
325.212
326.452 326.145 325.915
325.050
325.728 325.247 324.908
326.150
324.672 323.889 323.423
327.178

335.267 335.899 336.095 335.553 333.868 332.647
335.349 335.765 335.623 333.998 332.027 330.824
335.157 334.620 334.012 332.142 330.947 330.267
334.729 333.095 331.948 329.890 329.682 329.606
333.985 332.567 331.600 330.137 329.879 329.704
332.919 332.253 331.781 330.973 330.326 329.915
331.975 331.785 331.566 330.869 330.279 329.891
330.975 330.612 330.271 329.539 329.721 329.755
329.593 328.536 327.843 326.796 327.963 328.638
328.422 326.930 325.949 324.327 325.862 326.817
327.573 326.338 325.279 322.970 323.706 324.460
326.492 325.839 325.008 322.361 321.909 322.297
325.448 325.291 324.766 322.293 321.339 321.549
324.425 324.513 324.136 322.078 321.162 321.638
322.897 323.037 322.829 321.355 321.259 322.214
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Imported example dataset, as displayed in Hydro GeoAnalyst.

16.2

Map Data Settings
The Data Settings window in the Map Viewer Module allows you to review the attributes of
vector data layers that have been added to the map, including station groups, sample sets
[HGA+ only], spatial queries, and imported shapefiles. The Data Settings window also
allows you to control the scope of project data-driven layers (i.e. station groups and sample
sets) as described below in the aggregating data section.
The Data Settings window can be accessed hgafor the selected layer by clicking the
Attributes

button in the Layer Tree toolbar.
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The Data Settings window has two components:
· Toolbar: allows you to modify the attribute table of the selected map layer and is only

available if the selected map layer is a station group or sample set.
· Data view: allows you to review the attribute data and includes the standard data
filters available in Hydro GeoAnalyst so that you can quickly find data of interest.

Toolbar
The Data settings toolbar (only available if the selected layer is a station group or sample
set) provides controls for altering the scope and structure of the attribute table:

Aggregate data: allows you to change the scope of the
data set and aggregate the data.
Select Parameter: lists and allows you to select the relevant parameter if the
Minimum or Maximum aggregate data option is selected and is not shown otherwise.
Add Parameter: allows you to add one or more parameters as an attribute field.
Remove Parameters: allows you to remove one or more added parameters from
the attribute table
Change units: allows you to change the measurement units of an added parameter
in the attribute table (e.g. from mg/L to meq/L)
Refresh data: refreshes the data in the attribute table and map.

Calculated parameters cannot be added to the attribute table; however, you can save values
from a calculated field into the sample table using the save values
button in the Sample
Results toolbar of the Sample List view and subsequently add the resulting sample
parameter to the attribute table.

Aggregating Data
The Aggregate data dropdown in the Data Settings window allows you to change the data
scope of the active sample set or station group and aggregate sample data based on the
selected criteria. The following options are available:
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· Station: one record will be displayed per station that is part of the selected station

group or sample set. The attribute table will include a sequential record ID, the X- and
Y-coordinates of the station, the station parameters (i.e. data fields from the station
list), and any parameters that have been added using the toolbar. This is the default
data aggregation setting for added station groups.
· AllSamples: one record will be displayed per sample that belongs to the selected

station group or sample set. The attribute table will include a sequential record ID, the
X- and Y-coordinates of the station, the sample parameters (i.e. data fields from the
sample list), and any parameters that have been added using the toolbar. This is the
default data aggregation setting for added sample sets.
Stations in the selected sample set/station group that have multiple samples for a
given station will result in multiple records in the attribute table and overlapping
symbols on the map. For improved map performance and visual clarity, it may be
useful to use one of the remaining four options which are guaranteed to produce one
sample record per station.
· Earliest: one record will be displayed for the first sample collected at each station that

belongs to the selected station group or sample set - The earliest sample is defined as
the sample with the oldest sample date value in the station list. The attribute table will
include a sequential record ID, the X- and Y-coordinates of the station, the sample
parameters (i.e. data fields from the sample list), and any parameters that have been
added using the toolbar.
· Latest: one record will be displayed for the most recent sample collected at each

station that belongs to the selected station group or sample set - The latest sample is
defined as the sample with the newest sample date value in the station list. The
attribute table will include a sequential record ID, the X- and Y-coordinates of the
station, the sample parameters (i.e. data fields from the sample list), and any
parameters that have been added using the toolbar.
· Minimum: one record will be displayed for the sample collected at each station that

belongs to the selected station group or sample set with the lowest measured value of
the selected parameter. If more than one sample is returned per location because
multiple samples have the same lowest value for the same parameter, then the first
such record encountered will be returned. The attribute table will include a sequential
record ID, the X- and Y-coordinates of the station, the sample parameters (i.e. data
fields from the sample list), and any parameters that have been added using the
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toolbar. If it is not already included, the minimum parameter will be added to the
attribute table.
· Maximum: one record will be displayed for the sample collected at each station that

belongs to the selected station group or sample set with the highest measured value of
the selected parameter. If more than one sample is returned per location because
multiple samples have the same highest value for the same parameter, then the first
such record encountered will be returned. The attribute table will include a sequential
record ID, the X- and Y-coordinates of the station, the sample parameters (i.e. data
fields from the sample list), and any parameters that have been added using the
toolbar. If it is not already included, the maximum parameter will be added to the
attribute table.

Please Note: you must click the refresh [
aggregate data options.

16.3

] button to apply any changes to the

Feature Labeler
You can add and configure labels to a vector map layer by:
· Right-clicking on the map layer and selecting Labeling > Label Setup
· Clicking the Labels button [

] in the map layers toolbar

Label Categories
The left pane of the Feature Labeler includes a list of label categories. A label category is a
distinct set of labels for the map layer that can have its own label expression,
basic/advanced style settings, and member definition. In this way you can define customized
labels for the map layer, for example differing label styles and values based on whether a
sample exceeds a water quality standard.
You can

add or

remove a label category. Label categories can be reordered by

selecting a layer and using the

and

buttons.
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Expression
The Expression tab provides an interface that helps you define the label values for the
current label category.
· Expression: the input form to define the label based on field attributes
· Field Names: provides a list of fields in the attribute table. Clicking a field name will

select it. Double-clicking a field name will add it to the statement input.
· New Line button: adds a line break to the label expression
· Validate button: allows you to test the input statement and will return an example the

statement is valid and an error if not.
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Please Note: field names that include a space are not supported by the labeling
engine and will result in an error. You will need to change the alias of the field
name in the Template Manager to one without spaces.

Basic Properties
The Basic Properties tab provides an interface for setting some basic labeling settings for
the current label category, including font, background, border, collision handling, and label
rotation:
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Advanced Properties
The Advanced Properties tab provides an interface for setting more advanced labeling
settings for the current label category, including shadows, halos, orientation, alignment, and
offsets:

©2022 by Waterloo Hydrogeologic

546

Hydro GeoAnalyst 11.0

Members
The Members tab provides an interface that helps you build a query statement that will be
used to determine which features in the current label category will be labeled.
· Field Names: provides a list of fields in the attribute table. Clicking a field name will

select it. Double-clicking a field name will add it to the statement input.
· Unique values: provides a list of the unique values in the currently selected field when

the "Get Unique Values" button is pressed
· Operator buttons: provides a set of buttons (highlighted in light red) representing

common keywords/operators used in SQL statements. Clicking a button will add it to
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the statement input
· Statement input: the input form to complete the SQL statement (SELECT * FROM

[Attributes] WHERE...) that determines which features will be used to determine which
features in the current label category will be labeled.
· Validate button: allows you to test the input statement and will return an example the

statement is valid and an error if not.

An example statement would be:
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([SampleDate] > #1/1/2000 12:00 AM# AND [SampleDate] < #1/1/2010 12:00 AM#)
AND [WATERTYPE] LIKE 'Ca*'

which would limit labels to only those samples collected between Jan 1, 2000 and Dec 31,
2009 where the water type included calcium.

16.4

Surfaces
Surface data files consists of an ordered array of interpolated values at regularly spaced
intervals that represent the spatial distribution of an attribute, such as elevation, elevation
models, temperature, concentration. The Map Viewer in Hydro GeoAnalyst supports
SURFER Grid Files (*.grd) and ESRI ASCII Raster Files (*.asc).

Adding an existing Surface (Grid) to the Map
To add a grid to the Map Viewer, select the Add layer [
option and navigate to a supported layer file.

] button, select the Add Surface

Creating a Surface (Grid)
To create a grid, select a point layer in the Map Layers tree and select the create grid [
button from the Map Layers toolbar. This will open the Create Grid Window:

]
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The following settings will be provided

· Grid file: The location where the grid file will be stored. The default location is in the .

\Map\Grids subfolder in the current project.
· Interpolation Options:

o Interpolate with point X values: this will use the elevations embedded in the
shapefile. Note: this value is not defined (NaN) for project data driven layers
(including Spatial Queries, Station Groups, and Sample Sets).
o Interpolate with attribute: this will interpolate values from the specified attribute
field. Note: you can add attributes to a Station Group or Sample set using the Map
Data Settings for that layer.
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· Restrict/extrapolate to polygon extent: allows you to define the interpolation

domain/grid extents based on the extents of a specified polygon in Map Tree. If
checked, the interpolation domain (Xmax, Ymax, Xmin, Ymin) will be updated to the
rectangular extents of the specified polygon layer.
· Interpolation Settings: a collection of input settings that define how the input values

will be interpolated to the grid. Please see the Interpolation Methods and Settings
section below for more details
Clicking the Create
button will generate a grid file based on the provided settings
and add the new grid to the Map Layers Tree.

Interpolation Methods and Settings
Select the interpolation method to use for generating the surface. Choose from the following
interpolation methods:
· Inverse Distance
· Kriging
· Natural Neighbor

A complete description of the interpolation methods, which are part of a large and complex
branch of statistical sciences, is beyond the scope of this help documentation and a working
knowledge of this topic by the user is assumed. The methods implemented in Hydro
GeoAnalyst are based on the public domain Geostatistical Software Library (GSLIB), written
by Deutsch and Journel (1997) and distributed by Stanford University. A brief summary is
provided below; however, interested users or users who are unfamiliar with these methods
should consult references and resources.

Inverse Distance
The Inverse Distance Weighting method is very a fast and efficient weighted average
interpolation method. The weighting factor applied to the data depends on the distance of
each point from the grid cell, and is inversely proportional to the distance squared.
Consequently, the greater the distance the data point is from the grid node, the smaller the
influence it has on the calculated value at the grid node. The Inverse Distance method for
interpolation may generate patterns similar to the “bull’s-eye” surrounding points of
observations. Selecting a larger number of nearest neighboring data points may smooth this
effect, but if the bull’s eye pattern is undesirable, then other methods for interpolation, like
Natural Neighbor and Kriging, are recommended.

Kriging
Kriging is a group of geostatistical techniques that are based on Gaussian process
regression of spatial input data. Anisotropy and underlying trends suggested in the raw data
or inferred by expert knowledge of the site and associated geologic processes can be
incorporated in an efficient manner through Kriging methods. Hydro GeoAnalyst incorporates
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kt3d, a public-domain program in the Geostatistical Software Library (GSLIB), written by
Deutsch and Journel (1997) and distributed by Stanford University. All kriging methods
provide minimum error variance estimates of values at unsampled locations and rely on the
concept of auto-correlation - that is, the values of samples nearer to one another are more
related to each other than samples that are farther apart. There are several multiple ways in
which the relationship between proximate samples can be estimated/modeled based on the
selected method of kriging. Hydro GeoAnalyst includes the following kriging methods:
· Stationary Kriging: stationary kriging (also known as simple kriging) is a basic

generalized linear regression of local departures from the known (or specified) global
mean value
· Ordinary Kriging (default): Ordinary kriging is a special case of simple kriging that
automatically estimates the global mean value such that the kriging weights add up to
0.
· Nonstationary: non-stationary kriging (also known as linear drift kriging, kriging with a
trend model, or regression kriging) is a more generalized form of simple kriging that
assumes that there is an underlying (linear) trend inherent in the data
· External Drift: external drift kriging (also known as universal kriging) is a special form
of non-stationary kriging where local and regional trends of the values are unknown,
but the variance of the variable is assumed to be constant.
Kriging methods rely on the use of a semi-variogram which describes the degree of spatial
dependence of values between points on in the field. If the semi-variogram components
have already been modeled or estimated by the user, they can be incorporated into the
program by choosing the appropriate set of parameters in the advanced settings. The semivariograms available include Spherical, Exponential, Gaussian, Power, and the Hoe effect
models. If the variogram information is not available, the default linear variogram with no
nugget effect should be used. This option is a special case of the Power model with the
exponent equal to 1. When using the Kriging interpolation method, you may need to adjust
the min and max radii of the variogram in order to get an ideal interpolation; these parameter
values will depend on your data set. Default values are 100 and 100 along the major and
semi-major axes. You will likely need to alter these values based on your input dataset and
on the characteristics of the model domain.

Natural Neighbors
The Natural Neighbor method (Sibson, 1981 and Watson, 1994) is based on a Voronoi
tessellation of the Euclidean plane about a specified number of the nearest input data points.
Voronoi diagrams are often called Thiessen polygons, which are method commonly used in
meteorology and related geosciences. The grid node for interpolation is considered a new
point, or target, to the existing data set. With the addition of this point, the Voronoi polygons
based on the existing points are modified to include the new point. The reduction in area of
the existing polygons to include the new point is called the “borrowed area”. The interpolation
algorithm calculates the interpolated value as the weighted average of the neighboring
observations where the weights are proportional to the borrowed areas. The Natural
Neighbor method is valid only within the convex hull formed by the data points, and values
extrapolated outside of the hull should be used with caution.
The Natural Neighbor interpolation scheme may be visualized as a taut rubber sheet
stretched to satisfy all the data points. The interpolated value at any location is a linear
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combination of all Natural Neighbors of that location, and the resulting surface is continuous
with a slope that is also continuous. Combining the gradients or slopes with the linear
interpolation provides results that are more smooth, and may anticipate peaks and valleys
between data. Singularities and other undesirable effects may be reduced by incorporating
the gradient factor.
The gradient influence on the results can be manipulated by two tautness parameters that
you can enter. These parameters allow the interpolated surface to vary from purely linear
interpolation to one which is well rounded and has a gradient factor. In all cases the slope
discontinuities are removed and the resulting surface has slope continuity everywhere.

General Settings
The following general settings are used for interpolation:
· Min Value: minimum output value in the grid (by default this is the minimum input

value)
· Max Value: maximum output value in the grid (by default this is the maximum input

value)
· Interpolate Log Values:

o If set to yes, then the logarithm of the values will be interpolated and converted back
to the anti-logarithm values once interpolated. This setting is useful if the values are
log-normally distributed, which can the case for many naturally occurring systems.
o If set to no, then the untransformed data will be interpolated
Note that some interpolation methods, particularly kriging, can result in values outside the
range of measured values and in output values collacated with input locations that do not
match the input values. In such cases, it may be desirable to truncate the output to a
specified minimum and maximum value.

Grid Settings
The following settings are used to define the grid over which the surface will be defined:
· X intervals: the number of columns in the grid along the x-direction
· Y intervals: the number of rows in the grid along the y-direction

Interpolation Domain
The following settings are used to define the extents of the grid over which the surface will
be defined:
·
·
·
·

X Max: the maximum X-coordinate (at the eastern edge) of the grid
Y Max: the maximum Y-coordinate (at the northern edge) of the grid
X Max: the minimum X-coordinate (at the western edge) of the grid
Y Max: the minimum Y-coordinate (at the southern edge) of the grid
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Advanced Settings
The following settings are available depending on the selected interpolation method:
Advanced Settings for
Inverse Distance

Advanced Settings for
Kriging

Advanced Settings for
Natural Neighbors

Grid Settings (Surface Colors)
Surfaces added to the map layers will be rendered as using a color ramp that maps values to
colors to values that adds or imbues meaning and appeal to visualizations of the surface
grid. By default, grids are rendered with a black to white color ramp. To change the colors of
the ramp, select the surface in the Map Layers tree and click the Grid Settings
button in
the Map Layers toolbar. This will open the Surface Colors window:

The Surface Colors window contains the following settings:
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Color Ramp Definition Table
The color ramp definition table consists of two or more rows of color stops. Each color stop
in the table consists of a specified color that corresponds to both a position along the color
ramp (from 0 to 1) and a corresponding value of the surface. Colors in between the color
stops are interpolated in in the red, green, blue (RGB) color model. A preview of the resulting
color map is shown in the preview at the top of the window. Clicking on a row in the table
makes that row the active color stop as denoted by the arrow symbol on the left and blue
highlighting [
]. Settings for the active color stop are displayed and editable in the right
side of the window and are described in the "Color stop settings" section below.
The color ramp definition table includes a toolbar with the following controls:

Add color stop: adds a color stop to the color ramp at the mid point between the
active color stop and the row below
Delete color stop: removes the active color stop from the table
Dropdown: allows you to set the number of color stops (only works with the
auto-ramp button)
Auto-ramp: recolors all of the stops based linear interpolation of the RGB values of
the first and last stop
Smooth All: sets all color stops to continuous color stops
Classify All: sets all color stops to hard color stops so that the first stop of a given
color is the last stop of the previous color so that surface values between stops are all
one color
Save: saves the color ramp definition table to the color ramp library in the color ramp
editor
Load: opens the color ramp editor
Opacity: changes the relative opacity of the surface (100 is completely opaque, 0 is
completely transparent)
Logarithm: changes the scale of the surface values relative to the color ramp space:
o If unchecked: the surface values are scaled linearly relative to the color ramp
(default)
o If checked: the logarithm of the surface values are scaled linearly relative to the
color ramp
Color stop settings
Each color stop has the following settings:
· Position: the position of the color stop along the color ramp between 0 and 1
· Value: the corresponding value of the surface
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· Hard Stop Checkbox: a setting for whether the color stop is a hard or smooth

o If checked: the color stop is a hard stop with a different color above and below the
color stop
o If unchecked: the color stop is a smooth stop such that the color ramp transitions
through the color stop smoothly from above and below
· Update: the update button commits any changes you've made to the settings above to

the active color stop in the color ramp definition table

Color Ramp Editor
The color ramp editor contains a list of pre-configured color ramps that can be used to
render surfaces. You can delete [ ], rename [ ], export [ ], or import [ ] a color ramp
from a .clr file. Any changes made to the list of color ramps can be saved [ ]. Clicking OK
will load the active color ramp in the Surface Colors window, while clicking Cancel closes the
color ramp editor without changing the Surface Colors window. A preview of pre-configured
color ramps available with HGA is shown below:
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Contour Settings
Surfaces added to the map can be contoured - that is Hydro GeoAnalyst can use a surface
to generate a set of polylines representing lines of constant value in the surface. Contours
can be added as either major or minor contours. There is no real difference between major
and minor contours except that the distinction allows you to assign separate settings. To
generate major/minor contours for a given surface, select the surface in the Map Layers tree
and click the Create Contours
button in the Map Layers toolbar. This will open the
Create contours window:

The create contours window contains two main sets of controls:

Contour Settings
The left side of the Create contours window contains settings for a single contour or range of
contours that you can add to the map as either major or minor.
The first group of settings allows to define which contour(s) will be added to the map:
· Add single value: a single specified value that can be added to the map
· Add range: a range of values based on the following settings:

o From: the lower value in the range
o To: the upper value in the range
o Every: the increment between values
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The second group of controls allows you to add the contours to the map:
· Do no add duplicates: if checked (default), then any values already added as either

major or minor contours will not be added to the map. If unchecked, then duplicate
values will be added to the map
· Contour type: allows you to select if the contours to be added (based on the settings

above) will be major or minor contours
· Add Contours: clicking this button adds contours to the map based on all of the

settings above

Added Major/Minor Contours
The right side of the Create contours window contains a list of the major contour values and
a list of the minor contour values with the following distinct settings/controls for each:
· Checkbox: the checkbox above the list toggles whether the major/minor contour(s)

are shown on the map
· Delete: deletes the selected contour(s) from the list
· Clear: deletes all contours from the list
· Labels: label/format settings for the contours (major contours only)
· Line Settings:

o Color: click on the color to edit the color of the contour line(s)
o Thickness: the number value defines the thickness of the contour line(s)
o Type: the dropdown defines the style of the contour line(s) - solid, dash, dot, dashdot, dash-dot-dot

16.5

Symbols
The Symbols window in the Map Viewer Module allows you to define the symbology of
station groups, sample sets, and queries that have been added to the map.
The Symbols window can be accessed for the selected layer by clicking the Data layer setup
button in the Layer Tree toolbar.
Symbology Options
The Charts and Symbols Data Settings allows you to define the symbology for the selected
station group or sample set using one of the following options:
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Symbols
· Simple Symbol: symbols will be placed at the station coordinates. The symbols may

be uniform or ramped based on a selected numeric parameter field.
· Sample Symbol: symbols based on the symbols defined in the symbol editor and

shown in the sample list will be placed at the station coordinates.
For each of these options one symbol will be placed on the map per record in the attribute
table based on the aggregate data option in the Data Settings for that layer. This may result
in overlapping symbols, particularly if the Station or AllSamples options are selected.

Simple Symbol
The simple symbol option allows you to place uniform symbols or ramped symbols for each
record in the layer attributes:

Uniform Symbols
The simple (uniform) symbols option allows you to specify the settings for a symbol that will
be used to represent all records uniformly:
· Shape: choose from: diamond, ellipse (circle), hexagon, rectangle (square), pentagon,
·
·
·
·
·

star, or triangle
Size: set the size of the symbol
Color: set the fill color of the symbol
Outline: toggle the visibility of the symbol outline
Outline Color: set the color of the symbol outline
Outline thickness: set the thickness of the outline
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Ramped Symbols
The simple (ramped) symbols option allows you to define a specified number of symbols that
will be ramped/graduated by either size and/or color based on the value of a given
parameter for each record:
· Field: allows you to specify a numeric parameter in the attribute table that will be used

to ramp/graduate the symbols
· Add Parameter: opens the data settings window so that you can add a parameter if it

is missing from the list
· Ramp color checkbox: allows you to specify if the symbols will be ramped/graduated

by color
· Ramp size checkbox: allows you to specify if the symbols will be ramped/graduated

by size
· Shape: choose from: diamond, ellipse (circle), hexagon, rectangle (square), pentagon,

star, or triangle
· Start Color: set the fill color of the symbol (with the lowest value if ramp color is off)
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· End Color: set the fill color of the symbol with the highest value (shown if ramp color

on)
· Outline: toggle the visibility of the symbol outline
· Outline Color: set the color of the symbol outline
· Outline thickness: set the thickness of the outline
· Start Color: set the fill color of the symbol (with the lowest value if ramp size is off)
· End Color: set the fill color of the symbol with the highest value (available if ramp size

on)
· Groups: specify the number of graduated symbols to use. Note that one of the groups

will always be the "Undefined" category in case one of the records includes a null
value (e.g. no measurement) as shown below. The minimum number of groups is 2:
which would include records with a numeric value and those without. The maximum
number of groups is 20.
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The ramp symbols option also includes a preview window allows you to review and edit the
range of values for each symbol.
Sample Symbol [HGA+ only]
The simple (ramped) symbols option allows you to plot the defined in the symbol editor and
shown in the sample list on the map. No special controls are provided for this option.

16.6

Callouts
The Map Viewer allows you to add and manage callout layers for project data-driven layers
in the Map Layers tree of the Map Viewer. There are two types of callout layers:
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· Table Callouts: a customizable table is added for selected stations with selected

information from/about that location
· Plot Callouts: a customizable plot is added for selected stations with data series from

that location. Any plot type available from the plot collections can be displayed.
The following image is an example map with table and plot callouts:

Managing Callouts
Each project data-driven layer (i.e. station group, sample set, or spatial query) added to the
Map Viewer may have one or more added plot or table callout layers. To add or manage
callouts for a given layer, select it in the Map Layers tree and select the Edit Callouts [ ]
button from the Map Layers toolbar to open the Callouts window:
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The Callouts window includes a list of the existing callout layers associated with the current
active project data-driven layer in the Map Layers tree and a toolbar with the following
options:

New table callout: creates a new table callout layer
New plot callout: creates a new plot callout layer
Edit: opens the settings for the selected table or plot callout layer
Rename map: renames the current Map View
Delete: deletes the selected callout layer from the list

Table Callouts
Table callouts can be added to the map and allow you to quickly/efficiently show tabulated
data from a project data-driven layer (station group, sample set, or spatial query) for a
selected set of stations.

Adding a Table Callout
To add a table callout to a given project data-driven layer:
· select the layer in the Map Layer tree
· select the Edit Callouts [ ] button in the Map Layer toolbar
· select the New table callout [ ] button in the Callouts window

This will open the Table Callout settings window. The table selection window contains five
main components:
· Station Selection
· Field Selection
· Table Settings

o Table Formatting
o Table Position
· Preview
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Station Selection
The leftmost part of the Table Callout settings window provides a list of stations associated
with the parent spatial layer. You can select all [ ], none [ ], or some [ / ] of the
stations for which you'd like to add table callouts. You can also use the selection from the
map.

Field Settings
The second part of the Table Callout settings window provides a list of data fields associated
with the parent spatial layer. You can select all [ ], none [ ], or some [ / ] of the
fields to be added to the table callouts.

Table Formatting/Position Settings
The third part of the Table Callout settings window provides settings for the formatting (Table
tab) and position (Leader tab) of the table callouts as described below:

Table Format Settings Tab
Available table settings include:
·
·
·
·

Header Row settings for cell color, text color, and text font
Record Row settings for cell color, text color, and text font
Table grid line settings for line color and line width (points)
Conditional Formatting settings to highlight table rows with a specified color when a
specified condition is met.
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Leader Settings Tab
There are two major options for placing the table callouts on the map:
· Screen Layer: the callouts will be placed on the computer screen at a specified offset

(point) distance relative to the station in both the X and Y directions.
· Map Layer: the callouts will be placed on the map and can moved using the move

callout button [ ] on the map viewport toolbar. If the callout is placed away from its
parent station, then a leader may appear (if the show leader option is selected). The
leader line includes the formatting settings for its color, line width, and style (solid,
dash, dot, dash dot, or dash dot dot).

Preview
The right-most part of the Table Callout settings window provides a preview of the table
based on the table format settings.

Plot Callouts
Plot callouts can be added to the map and allow you to quickly/efficiently show add any plot
type available in the Plot Collection module to the map using data from or associated with a
project data-driven layer (station group, sample set, or spatial query) for a selected set of
stations. Plot callout layers several settings tabs:

Data Sources and Plot Type
The Data Tab includes settings for:
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· the stations that will have an added plot. You can select all [

], none [ ], or some [
/ ] of the stations for which you'd like to add plot callouts. You can also use the
selection from the map.
· the plot type dropdown allows you to select which type of plot (from the available plot
types based on your edition of HGA) to add (for the selected stations).
· the source data and parameters/fields for each relevant plot. Note that these settings
are variable and based on the type of plot selected.

General, Axes, and Plot Specific Settings
The plot callout settings window includes tabs for common plot features including general
settings, axis settings, and plot specific settings. (For plot-specific settings, please refer to
the documentation for the associated plot type.

Layout
The layout tab includes settings for how the plots will be placed on the map. You can place
the plots on screen layer or map layer as follows:
· Screen Layer: the callouts will be placed on the computer screen at a specified offset

(point) distance relative to the station in both the X and Y directions.
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· Map Layer: the callouts will be placed on the map and can moved using the move

callout button [ ] on the map viewport toolbar. If the callout is placed away from its
parent station, then a leader may appear (if the show leader option is selected). The
leader line includes the formatting settings for its color, line width, and style (solid,
dash, dot, dash dot, or dash dot dot).
The layout tab alson includes settings for the format and size of the plot:
· Border settings: you can add an optional border to the plot with a specified line color

and thickness
· Padding: allows you to add a buffer around the plot and its border (in points)
· Plot size: allows you to specify the size of the plot to a maximum of 400 points.
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Map Manager
The Map Manager is built on ESRITM Map Objects technology and is packed with an
abundance of mapping features that seamlessly connect your project maps with the Hydro
GeoAnalyst database. However, the Map Manager goes far beyond simple mapping, it also
acts as a fundamental source for producing cross sections, accessing borehole logs and well
construction details, and developing contour maps (elevations, concentrations, water table,
etc.). The Map Manager is an integral part of Hydro GeoAnalyst and is ideally suited for
analyzing and presenting the spatial orientation of your groundwater or borehole project
data.

Some of the key features of the Map Manager include:
· Import vector maps into a map project
· Import BaseMap Layers to the Map Project (DXF, Raster and Shapefile formats),

including high resolution MrSid image files.
· Georeference and import raster image maps
· Display Station Groups or Data Queries from the Hydro GeoAnalyst project as a Map

Layer in the Map Project
Edit map layers (labels, order, style, visibility)
Draw and edit a point, line, polygon, or text on a map with Annotation tools
Create contour, color shade and zebra maps of a desired data set
Create Thematic Maps: Bar and Pie Charts of selected fields
Select stations using a rectangle, polygon, circle, line, or a single point
Create new station groups with stations selected in the map project
Send a Map view to the Report Editor
Export Map view as Raster images
Create a legend for the Map Project
Turn layers on/off and set their properties using Layer Manager
Define locations for cross section lines
View statistics for selected data or station group layers (Min, Max, Sum, Standard
Deviation, Mean)
· Label and symbol renderer allows for creating color ramps, gradients, shading, etc.,
based on specified station data
· Line measurement tool allows for measuring the distance between two points on the
map project
·
·
·
·
·
·
·
·
·
·
·
·

Legacy Module
The Map Manager Module is a Legacy 32-bit Module that is
only accessible using 32-bit editions of HGA to maintain
compatibility. The Map Manager module functionality has
largely been replaced by the Map Viewer Module. The
remaining use case for the Map Manager is to define cross-
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sections. Where possible, it is recommended that you migrate
your maps to the Map Viewer.

17.1

About the Interface
Map projects are created and modified within the Map Manager application linked
to Hydro GeoAnalyst. The Map Manager can view and modify one map project at a
time. In addition, the map projects should be modified by only one user at a time.
A map project may have an unlimited number of map layers.
The Map Manager may be loaded from Hydro GeoAnalyst in several ways:
· Select Tools / Map Manager from the Main Menu of Hydro GeoAnalyst
· In the Hydro GeoAnalyst toolbar, click on the
(Map) button
· From the Hydro GeoAnalyst Project Tree, double click a map from the Map

Projects branch
Once the Map Manager window is loaded, the display should be similar to the one
shown below.

The Map Manager window contains the following elements:
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Menu Bar: Contains program menu commands
Toolbar: Contains short cut buttons to some of the most commonly used features
in the Map Manager
Layer Manager: Manages activating a layer, visualizing, and/or editing layers.
Map Window: Contains the visible layers for the map project.
Layer Information: Displays the system for the selected layer.
Coordinates: Displays the X,Y coordinates for the current mouse cursor location,
and the Map Projection system.
Scale: Displays the scale for the map window.
Active Window: Select between the Map Manager window and the Cross Section
Editor window.
The Layer Manager allows you to manage the layers in the map project. The icons
at the top of the Layer Manager provide some insight into the functionality.
These features include:
Group Control: Expand and
collapse group layers.
Visible: Set the visibility status of
the selected layer.
Editable: Make the selected layer
editable (or not) by checking (or
unchecking) the check box. Currently,
only those shapefiles created in the
Map Manager are editable.
Label: Displays the Layer name.
Symbol: Edit the symbol
identifying the layer on the map.
The Layer Manager will contain
numerous types of layers, each
represented by a different symbol type.
In the example shown here, the layer
types, from top to bottom, are as
follows:
PointLayer: Point shapefile,
represented by a point symbol. These
include station groups and data query
layers imported into the map project.
LineLayer: A line symbol indicates a cross section line, contour line layer, or
annotation line
PolygonLayer: Polygon shapefile, represented by a polygon symbol
TextLayer: Text annotation layer, represented by a T symbol
Contour Layer: Contour line layer
Station Layers: A group layer containing several component layers
Boreholes and Monitoring Wells: Station group layers
vc_exceeds_1 mg per: A data query
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CrossSectionLine2: Cross section line layer
Color Shade: A color shade layer
Airport_color.bmp: Georeferenced raster image
WQ Stations: A station group layer with graduated rendering
DEM_UTM17: A surface (DEM) layer

17.1.1

Grouping Layers
Group Layers help organize map layers that share similar characteristics, in a map
project. For example, if your map contains a railroad layer and a highway layer,
you may choose to group these layers into a single group layer called
Transportation Network.
Group Layers behave similarly to other layers within the Layer Manager panel. If
you turn off the visibility for a group layer, the component layers will also turn off.
You can also move a group layer up or down the layer list, change its draw order
and ungroup layers as needed.
Creating a Group Layer
To create a Layer Group, follow the steps below:
Right-click anywhere within the Layer Manager panel.
From the pop-up menu, select Create Layer Group.

Enter a name for the layer group.
Click [Ok]
The new layer group will now appear in the Layer Manager panel.
Adding Layers to a Group
To add a layer to a layer group, simply drag and drop the desired layer onto the
layer group.
Removing Layers from a Group
To remove a layer from a layer group, simply drag and drop the desired layer out
of the layer group.
Removing Layer Groups
To remove a layer group, follow the steps below:
Right-click on the desired layer group.
From the pop-up menu, select Delete.
The component layers will ungroup and return to the root of the layer list.
All layer types, including layer groups, can be moved up and down within the Layer
Manager panel, by simply dragging and dropping the layer into a new position.
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Description of Toolbar Items
The toolbar in the Map Manager provides access to most of the same features
available in the Main Menu. Most toolbar buttons are context sensitive, and react
according to the active layer, window, or dialog. If there are no options for the
selected layer, the respective toolbar button(s) will become inactive, indicated by a
"greyed-out" appearance.
New button creates a new map project.
Open button opens an existing map project.
Save button saves the current map project.
Print button sends the current map view to the report editor.
Selection Pointer button allows objects in the active layer to be selected.
Draw Polygon button allows a polygon to be drawn in the active layer.
This feature is active only when a polygon shapefile layer is selected and set to be
editable.
Draw Rectangle button allows a rectangle to be drawn in the selected layer.
This feature is active only when a polygon shapefile layer is visible and set to be
editable.
Draw Circle button allows a circle to be drawn in the selected layer. This
feature is active only when a polygon shapefile layer is selected and set to be
editable.
Draw Line button allows a line to be drawn in the selected layer. This feature
is active only when a line shapefile layer is selected and set to be editable.
Draw a Point button allows a point to be inserted in the selected layer. This
feature is active only when a point shapefile layer is selected and set to be
editable.
Insert Text button allows for text to be inserted on the selected layer. This
feature is active only when a text file layer is selected and set to be editable.
Information button allows the information for the selected station, or any
other object such as contour lines, to be viewed.
Measure button allows the distance between two points on the map to be
measured.
Delete Selected Object button allows the selected object (polygon, rectangle,
circle, line, point, or text) to be deleted from the active layer. This feature is active
only when an object is selected.
Add Vertex button allows a vertex to be added to the selected object (polygon,
rectangle, circle, or line). This feature is active only when an applicable object type
is selected.
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Delete Vertex button allows a vertex to be deleted from the selected object
(polygon, rectangle, circle, or line). This feature is active only when an applicable
object type is selected.
Zoom In button allows zooming in on the map window. Draw a rectangle in
any direction around the area you wish to zoom in to.
Zoom Out button allows zooming out from the map window.
Pan button allows panning the current map view left, right, up, or down.
Full Extent button restores the map view to the full extent of the map's
coordinates.
Previous Extent button allows restoring the map view to the previous zoom
extent.
Next Extent button advances the map view to the next zoom extent.
Select Single button allows individual objects such as stations to be selected.
This feature is active only when a layer containing Hydro GeoAnalyst stations is
visible, and selected from the Layer Manager.
Select In Rectangle button allows selecting all stations within a rectangle that
is drawn by the user. This feature is active only when a layer containing Hydro
GeoAnalyst stations is visible, and selected from the Layer Manager.
Select In Polygon button allows selecting all stations within a polygon that is
drawn by the user. This feature is active only when a layer containing Hydro
GeoAnalyst stations is visible, and selected from the Layer Manager.
Select In Ellipse button allows for selecting all stations within an ellipse that is
drawn by the user. This feature is active only when a layer containing Hydro
GeoAnalyst stations is visible, and selected from the Layer Manager.
Select Along Line button allows for selecting all stations within a buffer
distance of a line that is drawn by the user. This feature is active only when a layer
containing Hydro GeoAnalyst stations is visible, and selected from the Layer
Manager.
Select All button selects all stations in the current map layer. This feature is
active only when a layer containing Hydro GeoAnalyst stations is visible, and
selected from the Layer Manager.
Select None button de-selects all stations in the current map layer. This
feature is active only when a layer containing Hydro GeoAnalyst stations is visible,
and selected from the Layer Manager, and at least one station has been selected.
Cross Section Line button allows the location and buffer distance for cross
section lines to be defined. This feature is active only when a layer containing
Hydro GeoAnalyst stations is visible, and selected from the Layer Manager.
Show/Create Cross Section button allows a cross section corresponding to a
selected cross section line on the map to be created or viewed. This feature is
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active only after a cross section line has been selected or drawn in the map
window.

17.2

Description of Menu Items
New
The New item provides options for creating a new map project file. Map projects
are saved with the extension *.VMP in the project sub-directory "Map". The new
map project will use the same projection system and extents as defined in the
current Hydro GeoAnalyst project.
NOTE: Each Map Project has required fields which must be present in your
database structure, as defined in the Profile Settings. For more details, see
Chapter 4:Template Manager - Profile Settings.
Open
Provides options for opening an existing Map Project; only files with the (*.VMP)
extension can be opened using the Map Manager.
Save
Provides an option to save the current map project file. All current Map Layers that
are displayed will be saved to the current Map Project file.
Save As
Provides the option to save a copy of the current Map Project with a different
name.
Close
This will close the current Map Project. If there are unsaved edits, there will be a
prompt to save changes before closing.
Reopen
A list of recently accessed map projects will be displayed beside the Reopen item.
This is an alternate method of opening map project files, instead of using the Open
command.
Export Project
Creates a copy of all layers in the current map project, for use in other
applications.
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In this dialog, select the layers you with to export, and define names for the layers;
the same can be done for Surfaces (if any are available). Finally, specify the
Destination Folder for the copy of the map files.
On exporting a map project, selected shapefiles will be exported in the current
projection system if selected by the user. Raster images will use the projection
system at the time the image was georeferenced.
Export Map
Provides options for exporting the current map view to a Raster Image file.
Supported file types include: Bitmaps (*.BMP), JPEGs (*.jpg), and Enhanced Meta
Files (*.EMF). Enter a filename, and choose the file format, and click Save. An
Export dialog will appear with settings for the image file, as shown in the following
figure:
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There are several options for modifying the image:
Scale Factor: Choose a scale factor from the combo box. This factor will determine
the resolution of the exported image. The greater the factor the better the
resolution will be.
Quality: Using the scroll bar, define the image quality. This option is available only
if the JPEG export format is selected. The greater the percentage the higher the
quality will be. The image size is also directly proportional to this value.
Scale Symbology: Determines if the scale factor will be applied to symbols and
lines.
Export Depth: Choose the color quality for the exported image.
Palette: Determines the color palette to be applied to the exported image.
The Palette and Color Depth options are available only for bitmaps (*.BMP) and
enhanced Meta File (*.EMF).
Properties
The Map Project Properties dialog contains general settings for the map project.
This dialog is shown below:
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In this dialog, there are options for editing the Projection System, units, and
description.
In the Name field, a new name may be defined for the map project.
In the Projection Type frame, there will be a list of Projection Systems supported
by Map Manager and stored in the Database. For each Projection Type, a
Projection must be defined, along with a corresponding Unit. The default unit for
each projection will be displayed. If your HGA project uses a local coordinate
system, all map projects must also use the local coordinate system. In this case,
this setting cannot be modified and will be disabled.
In the Description text box, you may define a brief description of the project.
IMPORTANT: Currently, cross sections cannot be displayed in the Scene Viewer if
they have been created in a map project that uses a geographic coordinate system
(latitude, longitude). If you wish to display your cross section(s) in the Scene
Viewer, please be sure to create your map project using a projected coordinate
system, e.g., UTM.
NOTE: Projects in the Map Manager can use co-ordinate systems that differ from
those used for displaying stations in the main HGA window.
NOTE: Changing the projection of a map will affect any existing georeferenced
raster image layers in the map project. If the projection of a map is changed, all
georeferenced raster images must be georeferenced again in the new coordinate
system.
Print
Loads the map view into the Report Editor, where the report may be printed and/or
saved for later retrieval. For more information please see The Report Editor.
Exit
Exit the Map Manager and return to Hydro GeoAnalyst.

17.2.2

Layer
A Map Layer is a set of points, lines, polygons or a raster image that have
geographic coordinates attached to it. A Map Layer may be imported into any Map
Project.

17.2.2.1

New

Provides options for creating a new map layer. A new layer may be created as one
of the following file types:
· ESRI Polygon shapefile (*.shp)
· ESRI Line shapefile (*.shp)
· ESRI Point shapefile (*.shp)
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· ESRI Text shapefile (*.shp)

These are Annotation Layers, meaning that they can be used to draw various
shapes or labels (text) on your map project.
The new map layer will use the projection system of the current map project. After
entering a filename for the layer, the new map layer will be created, then placed in
the Layer Manager and added to the current Map Window.
HINT: For easy maintenance, it is suggested that the shapefiles be kept in the
same folder as the current map project. By default, Map projects are created in the
Map sub-folder of the current Project folder.
17.2.2.2

Open

Shapefile
Provides options for opening a map layer. The Map Manager is able to open any
shapefile that has a projection system already assigned to it. These shapefiles
include all types of ESRI shapefiles (polygons, lines, points, and text). Once a map
layer is opened, it will appear in the Layer Manager, and is added to the current
Map Window.
If the selected shapefile contains numeric attribute data, the Set Field Precision
data will appear on your screen.
Surface
Provides options for importing 3D surface layers. The following surface files are
supported:
· Surfer grid (.grd) version 6 and 7
· DEM (.DEM)
· ESRI ASCII (.asc)
· Text (.txt)
Upon selecting this option, an Open dialog will display (shown below).
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Locate and select a surface file, and select [Open]. The following dialog will display
where you can specify a Name, Projection Type, Projection system and
Description. The surface projection system must be the same as the projection
system defined for the Map Project. For example, if your Map Project is set to the
NAD83 projection system, you must select NAD83 for the surface layer.

Once the surface layer settings have been defined, click [Ok]. The Color Settings
dialog (shown below) will appear.

The Color Settings dialog allows you to define different colored zones/ranges
according to their specific interval of elevation values.
The [Classify] button allows you to decide how many intervals you wish to have,
and HGA automatically divides the available range of values into that number of
equal intervals.
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The [Ramp] option loads the following dialog.

You can choose a monochromatic ramp that provides a range of the same color,
but with varying degrees of darkness, a dichromatic ramp that provides a spectrum
between two different colors, or a custom ramp by choosing colors for the Start
Color and End Color boxes (to load the color dialogue, click on the colored box).
Click [OK] to return to the renderer screen.
Alternatively, you may set the color for each value; simply click on the Color box
under the Color column, and the Windows Color palette will display. Select the
desired color, and click [OK] to continue. Repeat this for other values, as desired.
Adjust the Transparency option to make it possible to see layers under the color
shading/zones. The higher the value, the more transparent the layer will be. The
value must be within the range 0-100.
To display the value intervals in discrete color zones, rather than continuous
shading, select the Zebra checkbox.
Once the color settings have been defined, click the [Ok] button.

A surface file with a large grid size may take several minutes to load depending on
the performance capabilities of your computer. For example, a DEM surface file
that is approximately 9mb, may take up to 10 minutes to load.
If the grid size for the selected surface file exceeds 300,000 nodes, the message
shown above will display, and you can choose to accept the original grid size or
modify its dimensions to lower the resolution and decrease the loading time.
To accept the original grid size, click [Ok]. Otherwise, click the [Modify] button to
specify a new grid size. The following dialog will be shown:
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The NCols and NRows fields represent the number of columns and number of
rows for the surface file, respectively. These fields will contain recommended
values for the new grid size. However, you can manually define a new grid size by
entering the desired values for these fields.
Click [Ok] once the new grid size has been defined.
The surface layer will then be generated and added to the Layer Manager panel.
17.2.2.3

Load HGA Data

This menu item provides options for loading Hydro GeoAnalyst data as a new map
layer. The data source may be a list of stations from a Hydro GeoAnalyst Station
Group or those resulting from a Data Query. Upon clicking on this menu item, the
following dialog will appear:

In this dialog, select the data source type and choose (from the appropriate combo
box), the desired Station Group or Data Query. The data will be used to create a
new Map Layer, and the layer will be displayed in the Layer Manager as well as in
the map window. This option is available only if a map project is open. The
resulting shapefiles will be saved as follows:
· for Station groups, the shapefiles (and supporting files), will be saved to the sub-

directory Map\Selection
· for Data Queries, the shapefiles (and supporting files), will be saved to the sub-

directory Map\Data
Setting Field Precision
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If the selected station group or query contains numeric data fields, you will be
prompted with the following dialog:

The Set Field Precision dialog box lists all the numeric fields in the selected station
group or query. For each numeric field, you can specify the number of decimal
places to include when generating the layer's shapefile. Enter the desired number
of decimal places under the Decimals column for each numeric field, and then click
the [OK] button.
Please note that all contouring of numeric values is performed using the precision
specified in this dialog. Moreover, the label renderer will display all numeric values
on the map using the specified precision. If you wish to change the precision after
the layer has been created, you must reload the HGA data into the map project.
17.2.2.4

Import

This menu item provides options for importing basemap layers to the current Map
Project. Basemap images may be Raster Images (*.bmp, *.jpg, *.tif, *.sid, and
others) or AutoCAD files (*.dxf). Each format is explained below.
Raster Image
A critical element of any Map Project is registering the image map with the correct
real world coordinates. This procedure is called Georeferencing. Since raster
images do not contain information on the site's projection system or length units,
these details must be manually added using Georeferencing. Georeferencing
assigns points with known coordinates to the image; the image is then scaled and
the map extents are calculated.
NOTE: The Map Manager does not provide an error trap for invalid georeferencing
points.
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Georeferencing Raster Images
If a Raster image is selected from the Layer / Import menu, a message will appear
stating that the image must be georeferenced. Click [Yes] to continue, and you will
be prompted to save the georeferenced image as a new file:

Enter a name for the new image. The file will be converted and saved as a bitmap
(*.BMP). This new name will be used as the map layer name in the Map Manager.
Click [Save] to continue, and the Georeference window will appear as shown in the
following figure.
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In order to map the pixels of the image to a coordinate system, the image must
have at least two georeference points with known coordinates. These
georeference points can be defined using the procedure described below.
Note: The real world georeference points must have coordinates that are in the
same projection system as the Map Project. Map Manager will not make
adjustments or conversions for georeference coordinates that are in a different
projection system.
To set a georeference point,
Click on the first map location where the X and Y world coordinates are known. A
Georeference point dialog will appear prompting for the X1 and Y1 world
coordinates of the selected location:
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Enter the X1 and Y1 coordinates for this point.
Click [OK]
Click on the second map location where the world coordinates are known.
Enter the X2 and Y2 coordinates for this point.
Click [OK]
A box will appear around the map region, similar to the window shown below.

The Georeference utility will convert the Raster Image to project coordinates; in
the top right corner of the window, the two Georeference Points will be displayed.
These values cannot be modified unless one of the georeference points is deleted
and a new georeference point is assigned.
A box will appear in the map window, defining the image corners. The image
region can be modified as explained below.
To delete a georeference point,
Click the
(Delete Point) button in the toolbar
Select one of the georeference points to delete it.
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NOTE: When a georeference point is deleted, a new georeference point must be
added, since two georeference points are required to create a coordinate system.
Once the Georeference points have been defined, the map region may be
modified. In the Select Map Region window, the map region is represented by an
outline of a box with circular nodes at each corner and with arrows pointing along
the X and Y axes. The map region box can be shifted or expanded to any
alignment on the site map using the toolbar options described below. These
options may also be accessed from the Options menu on the Main Menu bar.
Resize Region Click-and-drag a corner of the map region box to stretch or
shrink the size of the map region. The new map coordinates will be updated to
display the new map region.
Rotate Region Rotate the map region
Align Rectangle Align the map region with the x-axis.
Maximize Enlarge the map region to the full extents of the basemap.
HINT: If it is desirable to use the entire image for the map, use the Maximize
option to expand the map region to the full extents.
Adding Control Points
You can validate the accuracy of the georeferenced raster using Control Points.
Control points are simply locations on the raster image of which real-world
coordinates are known. Real-world coordinates can be derived from geographic
sources such as topographical maps or GPS units. By comparing the
georeferenced raster coordinates with their corresponding real-world coordinates,
you can determine if the raster has been georeferenced accurately.
To add a control point,
Click the
button from the toolbar.
Click a location on the raster image where the real-world coordinates are known. A
dialog similar to the one shown below will display.

Coordinates shown in the above dialog (X2, Y2) represent the interpolated
coordinates derived from the two or three specified georeference points, for that
particular location on the image. You can validate the accuracy of these
coordinates by comparing them to the real-world coordinates of that location. Note:
To improve precision, you may want to Zoom In directly on the location, before
adding the control point.
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Click [Ok] to accept the Control point. You can add additional control points by
simply clicking on a different location on the raster image.
All control points are stored in a table (shown below) which can be accessed by
clicking Edit / Control Points from the menu bar.

Here you can review all of the control points. To delete a control point, simply click
the appropriate row in the table and click the [Delete Row] button. Click [Ok] to
close the table.
If there is a significant difference between the georeferenced coordinates and realworld coordinates, check the precision of the georeference points, and reassign if
necessary.
Once the georeferencing is completed, click [OK] in the Georeference window. A
confirmation dialog will appear as shown below:

Click [OK] to continue. The Raster Image will then appear as a new Map Layer in
the Map Project.
CAD
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The Map Manager also allows you to import AutoCAD files (*.dxf) into a map
project. CAD layers may be built in a Projection that is different from that used for
the current map project; therefore, when a CAD file is selected, the projection
system and units may need to be converted to the current projection system and
units. In addition, CAD files may contain graphic features on different layers; as
such, there are options to select the layer to import. These options are explained
below.
HINT: If you are having difficulties importing your CAD drawing please try
exploding all blocks and re-saving as a dxf file before attempting to import into
HGA.
Selecting Layers
When a CAD format is selected using the Layer / Import menu, navigate to the
appropriate file and open it. The following dialogue will load:

The top portion of the dialogue lists the projection system properties of the current
map project. Below this frame is a [Transform] button. This option is required only
if you are not sure that the CAD file has the same projection system as the current
map project. In this case, click [Transform] to georeference the CAD image. Once
you are done, click [OK] to return to the Import DXF dialogue.
In this dialogue, select which layers you wish to import into the map and click [OK].
Transforming Coordinates
The CAD file must contain the same units and projection system as the current
map project in order for it to be displayed properly. If there are differences, then
the CAD file can be Transformed to the map project's projection and coordinate
system.
From the Import DXF dialog, click on the [Transform] button. This will launch the
Map Georeference window as shown below.
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Transformation is performed using two points on the DXF file, with known
coordinates. The Map Manager does not provide an error trap for invalid
transformations.
Follow the procedure below to import a DXF file, and use the coordinate
Transformation option:
To set the georeference point, click the Georeference button
Click on the first map location where the world coordinates are known. A
Georeference point dialog will appear prompting for the X1 and Y1 world
coordinates of the selected location:

Enter the X1 and Y1 coordinates for this point.
Click [OK]
Click the Georeference button again
Click on the second map location where the world coordinates are known.
Enter the X2 and Y2 coordinates for this point.
Click [OK]
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The coordinates will be entered into the corresponding Georeference fields on the
right-hand side of the window.
Once this is complete, click [OK] to continue, and the CAD file will be loaded as a
new layer into the map project.
17.2.2.5

Save

Saves the selected layer.
17.2.2.6

Delete

Deletes the selected layer. A layer cannot be deleted while it is in Edit mode.
17.2.2.7

Create Intersection

With this option, you can create a new map layer from the intersection of any
station (points), polyline, polygon layer, surface layer or color shade/zebra layer,
with another polygon layer.
First, select the map layer that will be intersected, from the Layer Manager
Toolbar.
Next, select the Create Intersection option from the Layer menu. The following
dialog will appear:

Select the desired layer from the combo box, and enter a name for the new layer.
Click [OK] when you are finished, and the new layer will be added to the Layer
Manager panel.
Note: When clipping color shade and surface layers, the Name of the new layer
field will be greyed-out as it is not required
17.2.2.8

Properties

Provides options for modifying the symbol for the shapes (point, line, polygon) on
the current (active) layer in the Layer Manager. The options dialog is shown below:
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The dialog shown here is for point shapes. There are similar dialogs for line and
polygon shapes.
The available symbol Patterns include circle, square, triangle, cross or any symbol
from all true type fonts that may be available on your system. If the latter is
selected, you will have to select the desired font from the Font combo box and the
desired symbol from the Symbol combo box. Choose a symbol size from the
combo box in the upper right corner. Finally, the symbol Fill color may be chosen
from a color palette. If a border around the symbol is desired, select the check box
beside Border and provide a border color.
17.2.2.9

Statistics

Displays statistics for the selected data field of a selected layer. These include:
Count, Maximum, Minimum, Sum, Mean, and Standard Deviation, as shown in the
figure below.
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17.2.2.10 Renderer

Provides options for a Map Renderer. The Map Renderer allows assigning labels
to objects on the map layers.

There are two types of renderers: System Renderers and Custom Renderers.
The System Renderers are renderers provided by MapObjects and include label,
value and graduated renderering.
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Custom Renderers are renderers developed by Waterloo Hydrogeologic. These
renderers may provide the same functionality as the MapObjects renderer, i.e.,
label renderer, but with additional options.

System Renderers
A new System Renderer may be added by clicking on the
(Add) button. The
following dialog will appear with the available Renderers from which you can
select.

The Graduated Renderer provides a way of classifying features into categories or
classes, by drawing different symbols for features based on numeric attribute
values and their ranges.
The Value Renderer provides a means of representing features of a map layer by
drawing a symbol for each unique data value.
The Label Renderer: can be used to display labels on contour maps, or to place
labels on stations or any other object.
Select the desired type, and click [OK].
For each Renderer type, there is a corresponding settings dialog, which is
launched automatically when you create a new renderer; this can also be loaded
by selecting the

(Edit) button after selecting the renderer you wish to change.

Graduated Renderer
Graduated Renderer allows you to graphically display station data according to
their specific interval of values. You have the option of specifying the color scheme
and/or the symbol that represents the station. To use the Graduated Renderer,
select Renderer from the
Layer menu, click the
(Add) button, and choose Graduated renderer from the
available list.
The following dialogue will allow you to compose a set of symbols for different
value intervals:
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Enter the Name for the renderer and choose the Field based on the values from
which you want to classify your data.
[Classify] button allows you to decide how many intervals you wish to have, and
HGA automatically divides the available range of values into that number of equal
intervals.
Clicking on the symbol beside each interval will load the standard "Point Style"
dialog allowing you to choose a specific symbol and/or color for each interval.
Color may also be specified as a spectrum using the Ramp function.

You can choose a monochromatic ramp that provides a range of the same color,
but with varying degrees of darkness, a dichromatic ramp that provides a spectrum
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between two different colors, or a custom ramp by choosing colors for the Start
Color and End Color boxes (to load the color dialogue, click on the colored box).
This dialogue also allows you to specify the size of the symbols or, if you wish, the
start and end size for a range.
Click [OK] to return to the renderer screen. At the bottom of the Renderer dialog,
there is a toolbar with additional options. These are described below:

From left to right, the function of these buttons are:
· Add a new row to the renderer table, with a new value and symbol/color
· Delete the selected row from the renderer table
· Order the values by Ascending order
· Order the values by Descending order
· Reverse the order of the colors/symbol; lowest will be flipped to highest, and
highest will be flipped to the lowest.
When you are finished, click [OK] again to confirm the renderer settings.
Make sure the renderer you've created has a check mark in the "Visible" column
and click [OK] to apply the renderer.
Value Renderer
The Value renderer function is very similar to the Graduated renderer. The Value
Renderer dialog is shown below.
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At the top of the dialog, specify a Name for the renderer and select a Field Name
for the renderer.
The Value Renderer dialog allows for detailed symbol and label rendering. Use the
Frequency for display value vertical scroll box to set the label display frequency.
You can manually specify value symbols and their corresponding labels by clicking
in the desired symbol and label field. Alternatively, specify a default symbol and
select the Default Symbol checkbox to apply the same symbol characteristics to
each value.
Use the Ramp function to specify the color scheme and size for the symbols and
click [OK] first to return to the Value renderer dialog, click [OK] again to accept the
settings. Then also make sure the "Visible" box is checked, and click [OK] to apply
the renderer.
Label Renderer
This renderer allows you to display various labels for the selected layer (stations or
contour map, for example).
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Enter the Name for the renderer and choose the Field Name which will be
displayed as a label. Customize the settings as desired. Please note that for
numeric fields, labels will be displayed using the precision defined in the Set Field
Precision dialog box, when the HGA data is being loaded into the map project.
Note: Flip option applies only to the labels that may appear up-side down, such as
line labels. Checking Flip will ensure that all labels will appear right-side up.
Click [OK] to accept the settings.
Make sure the "Visible" box is checked and click [OK] to apply the renderer.
You can add, delete, and edit different renderers using the toolbar located under
the renderer list.

The renderer may also apply a background to the data symbols; this background
can be modified using the standard "Point Style" dialog.

Custom Renderers
Custom renderers are renderers that have been developed by Waterloo
Hydrogeologic. Currently, the only custom renderer available is the custom label
renderer. The custom label renderer is similar to the system label renderer
(described above), however it provides additional options, allowing for greater
control and flexibility when displaying labels on the map.
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Note: Please note that system renderers and custom renderers are mutually
exclusive, i.e., you cannot apply both a system renderer and a custom renderer to
the same map layer.
To add a new custom renderer, make sure "Custom Renderers" is selected from
the comb box at the top of the Renderers dialog.
A new Custom Renderer may then be added by clicking on the
The Label renderer will be added to the list of renderers.

(Add) button.

To configure the custom label renderer, click the
(Edit) button. The Custom
Label Renderer dialog box will appear on your screen.

The label renderer settings are described below:
Name: Specify the name of the renderer configuration
Show Secondary Label: This control allows you to show/hide a secondary label.
Field: Allows you to specify which layer attribute to show as the object label.
Prepend: Allows you to prepend text to the chosen layer attribute.
Append: Allows you to append text to the chosen layer attribute.
Font...: Loads the generic font settings, e.g., font style, size, color, etc.
Rotation: Allows you to rotate the label.
Alignment: Allows you to set the default label alignment.
Offset: Allows you to offset the label from the default alignment by specifying X
and Y values.
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Once you have defined the renderer settings, click the [OK] button.
17.2.2.11 Create Thematic Map

This menu item allows the user to create a thematic map for any of the active Map
Layers containing numeric data. A thematic map shows the spatial distribution of
one or more specific data values in the form of a Pie or Bar chart. Thematic Maps
can only be drawn on layers that contain data (such as stations, contour maps,
etc.). They are not applicable to annotation layers.
A common example of the applications for a thematic map would be displaying the
distributions of multiple chemicals.
To create a Thematic Pie Chart for Hydro GeoAnalyst station data,
A Hydro GeoAnalyst Data layer from the Layer Manager, to ensure that this layer
is active. (e.g. a Station Group or Data Query layer, such as Boreholes, Monitoring
Wells, etc.)
Select the menu option Map / Create Thematic Map / Pie Chart from the Map
Manager main menu.
A Thematic map window will appear as shown below:

Enter a name for the map in the Name field. This name will appear in the thematic
map list, should you choose to edit it later.
From the left panel, select the fields for map. Move fields to the right panel using
the [>] button. To move all fields, press the [>>] button.
[Next] to proceed to the next window.
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In this dialog, specify the field color by clicking on the colored rectangles to the
right of each field, and specify the chart size in the Max size and Min size fields. A
preview window in the lower right corner displays a preview of the true size and
color of the thematic map, as it will appear in the Map Manager.
[OK] to create the map.
The thematic map is an entity of the selected layer; when this layer is hidden, the
corresponding thematic map will also be hidden.
The Bar Chart is created in much the similar way. Choose Bar Chart from the
Layer /Create Thematic Map menu and choose which fields you wish to map. The
following dialogue will allow you to choose colors for the bars representing
different fields, as well as the max height and width of the bars.
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17.2.2.12 Modify Thematic Map

Provides options for modifying the properties of an existing Pie or Bar chart.

Select the map you wish to edit by clicking on the check box beside the name you
entered for that map, and click [Modify]. The same Bar Chart dialogue will appear
allowing you to go through the procedure again and change various aspects of the
chart
17.2.2.13 Create Contours

With HGA
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Provides options for creating contours with data from a selected field, from the
selected points layer. Upon selecting this menu item, the following dialog will
appear:

The gridded data can be represented as the following Contour Types:
· Contour lines
· Color shaded map
· Zebra
Select the desired Contour type, and enter a name for the layer. For each type,
there are additional settings that can be accessed by clicking on the [Settings]
button. See the sections below for more details on these settings.
Data to be contoured
Select a Field that contains the data you want to contour.
Define the Min and Max values, or accept the defaults
Interpolation Settings
Under Interpolator Settings, select the interpolation method (choose from Natural
Neighbor, Inverse Distance, or Kriging).
To use the advanced interpolation settings, click the [Advanced Settings] button,
and advanced options will be displayed as shown below (for Natural Neighbor):
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You may modify the interpolation settings, then click [OK] to return to the main
window. For more details, see "Appendix C: Advanced Interpolation Settings" .
Use Only Selected Stations
When selected, the contour component will use only those stations that are
selected on the layer, as the data source for the contouring. The option is only
enabled when one or more stations are selected. If not selected, all stations on the
layer will be used.
Restrict Within Domain
This option allows you to clip contours lines to a selected polygon layer.
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You may select any polygon shapefile from the combo box. Then click [OK] to
continue. The calculated contours will then be clipped at the edges of the polygon.
NOTE: If the polygon is greater in extents than the selected station layer, the
contouring will end at the furthest point. Currently, extrapolation to the edge of the
polygon is not possible.
When you are satisfied with the settings, click the [Create] button to create the
contour map.
Contour Line Settings
Click on the [Settings] button beside Contour Lines, and the following dialog will
appear:

Specify Intervals; you may select to define the Contour Interval (e.g. 0.5, 1.0, 5,
etc.) or the Number of Intervals (5, 10, 20, 50, etc.).
You may also define Custom Contour Lines in the grid in the lower corner. Use the
+ and X buttons to add/remove custom contours respectively.
Note: Custom Contour Lines will be added to the map in addition to the ones
defined by selecting Contour Interval or Number of Intervals.
Under Contour Line Settings, specify the line color, thickness, style, and label
settings. Label Renderer will add a label to the lines.
Color Shading / Zebra Map Settings
Click on the [Settings] button beside Color Shading or Zebra, and the following
dialog will appear
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The Color Settings Renderer allows you to define different colored zones/ranges
according to their specific interval of values.
The [Classify] button allows you to decide how many intervals you wish to have,
and HGA automatically divides the available range of values into that number of
equal intervals.
The [Ramp] option loads the following dialog.

You can choose a monochromatic ramp that provides a range of the same color,
but with varying degrees of darkness, a dichromatic ramp that provides a spectrum
between two different colors, or a custom ramp by choosing colors for the Start
Color and End Color boxes (to load the color dialogue, click on the colored box).
Click [OK] to return to the renderer screen.
Alternatively, you may set the color for each value; simply click on the Color box
under the Color column, and the Windows Color palette will display. Select the
desired color, and click [OK] to continue. Repeat this for other values, as desired.
Adjust the Transparency option to make it possible to see layers under the color
shading/zones. The higher the value, the more transparent the layer will be. The
value must be within the range 0-100.
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The remaining options are similar to those for Graduated Renderers (Add Value,
Delete Value, Ascend, Descent, Change Color); see Renderer for more details.
When you are finished, click [OK] to return to the Contours screen.

17.2.2.14 Create Gridded Data

This feature allows you to interpolate data for the current layer, and create a grid
file (.GRD) for visualization in the Scene Viewer or other applications. For
example, if you have a station layer selected, you can create a grid file based on
station elevations or TOC (top of casing) elevations.
Select this menu item and the following dialog will appear:

Enter a name for the grid file, and select a field containing the source data. Click
the [Create] button to create the file. The grid file will be created in the HGA
project's folder, in the "Surface" sub-folder:
(for example, "D:\Program
Files\HGAnalyst\Projects\Demo_Project\Surface\test.grd")
NOTE: As with contours, you can select an interpolation method, and customize
interpolation settings by clicking on the [Advanced Settings] button.
17.2.2.15 Display Data

This feature allows you to display data in a plot or tabular format on the map, for
the current points map layer. Fields are based on points data loaded from Station
Groups or Data Queries (created using the Query Builder). You may define
conditions for fields, and highlight rows in the tables that violate the conditions. For
plots, the templates are selected from available Chart templates.
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To activate this feature, first select a layer that contains points data (i.e. a data
query or a station group) from the Layer Control. When you select the Display
Data option from the Layer menu, the following dialog will appear:

This dialog allows you to manage the various layouts for the map layer.
In the first column, show/hide the layout by setting the Visible status.
Define the Name in the second column.
In the third, you may optionally enter a Description.
Click on the
(Add) button to add a new layout. In the combo box that appears,
select either Tabular or Plot (shown below).

Click on the
Use the

(Delete) button to delete the selected layout.
button to move the selected layout up.

Use the
button to move the selected layout down.
Next you must define the settings for the layout.

Plots
For a Plot display, click on the [Data Settings] button and the following dialog will
appear:
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In the list, choose from available plot templates that were created using the chart
component. For details on how to create plot templates, please see Managing Plot
Templates. In order to display the plot in the map, the following requirements in the
template must be met:
· Plot Grouping and Series Grouping must be done by station ID
· The plot template must contain data for the selected stations

The remaining settings for the plot are similar to those described in the sections
"Choose Data" tab below.

Tabular
For a tabular display, click on the [Data Settings] button and the following dialog
will appear:
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In the Data Settings dialog, you select which Layer Fields from the layer should
appear as Display Fields in the layout table, as well as define the Display settings.
Select the desired fields from the left panel under Layer Fields, then move fields to
the Display Fields under the right panel using the [>] button. To move all fields,
press the [>>] button. To remove fields from the Display Fields, click on the [<] or
[<<] buttons respectively. Use the

button to move the selected field up. Use

the
button to move the selected field down.
Click on the Condition tab, and you will see options for defining validation rules for
one of the selected fields, along with display settings for the table.
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The Header Row Color controls the color of the first row in the layout table.
The Violation Row Color allows you to assign a color to values in the table that
exceed the violation conditions (explained below). This is useful for quickly
identifying exceedences on the map.
The Grid Line Color controls the color of the gridlines in the table.
Under the Violation Field frame, you may specify a condition for one of the display
fields. Select a Field from the combo box, then a Condition (<, >, =, etc.), and
define the Compare To settings. There are two options available:
· Compare to a Value: simply type the value in the provided text box, OR
· Compare to a Field: select another field from the data query, to compare

against.
The possibilities are limitless, but here are some examples:
· concentration > 5000 ug/l (a government guideline, or MCL) as shown in the
screenshot above
· depth to bedrock > 40 feet
· overburden thickness < 50 feet
· concentration of a chemical exceeds the criteria limit, where the criteria limit is
available in another field in the selected data query
In the Choose Data tab, you can specify which stations should display the data
table. This is useful if you have a station group with numerous stations, and are
interested in displaying the data summary table only for a few stations.
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Simply place a check-box beside the stations that should display the data
summary table.
If you click on the Get Selection Map button, then the Map Manager will "get" only
those stations that are selected on the map layer on the map project, and use only
those for the Display Data. This button is enabled only if you have at least one
station selected in the map layer.
Once you are finished, click [OK] to return to the layout window. From the Layout
Setting dialog, click on the [Display Settings] button in the Callout Box column, and
the following dialog will appear:
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In the Callout Box Settings dialog, you can modify several display properties for
the callout box. The callout box is the box, oval, or bubble, that contains the data
for the selected station. A preview is shown on the right side of the window, in the
image above. The following display settings are available:
Fill Color: set the fill color for the callout box
Outline Color: set the color for the outline of the callout box
Transparent: set the transparency; select from True or False
Box shape: select the box shape; choose from Rectangle, Round Rectangle, or
Oval
Tip style: set the tip style; choose from Triangle or Line
Padding: set the padding thickness, the higher the value, the larger the box shape
will be around the tabular values in the layout
Shadow: display a shadow around the callout box; select from True or False
Shadow Color: select the shadow color; only used if Shadow has been set to
True
Offset X: set the X Offset; this parameter controls how far the callout box will be
placed horizontally from selected station.
A positive offset will result in the callout box displayed to the right of
the station
A value of 0 will center the call out box over the station
A negative offset will result in the callout box displayed to the left of
the station
Offset Y: set the Y Offset; this parameter controls how far the callout box will be
placed vertically from selected station.
A positive offset will result in the callout box displayed below the
station
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A value of 0 will center the call out box over the station
A negative offset will result in the callout box displayed above the
station
When you are finished with the Display Settings, click [OK] to return to the layout
window. Click [OK] once more to create the layout on the map, as seen in the
examples below.

Example of Display Data: Chart
You can see that sample values that exceed the specified conditions (TVOC
concentration result value greater than 5000 ug/l), are shaded red for easy
detection.
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Example of Display Data: Plot
When stations are clustered, it may be necessary to modify the display location of
the callout boxes. You have the option to manually move individual callout boxes to
a new location to improve presentation. This is explained below.
Edit Layout Setting
To edit the position of the callout box:
Right-mouse click on the map window, and select Edit Layout from the pop-up
menu
Click once on any callout box to select it; the box will become highlighted in a color
outline, indicating it has been selected
Left click on the callout box, and using your mouse, drag the box to the new
location
When you have done this, the result could be similar to the example shown below.
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When you are finished with the position edits, you must right-mouse click on the
map window and turn off the Edit Layout option, to disable this feature.
To edit the remaining layout settings, including fields, violation conditions, and
display properties, simply select Layer / Display Data from the main menu, then
modify the settings as explained above.

17.2.3

Edit
The Edit menu contains standard windows functions such as Cut, Copy, and Paste
objects, as well as other options for editing shapefiles.
NOTE: Before editing a layer make sure that the Editable check box is selected.
After editing, deselect the Editable check box on the Layer Manager.
Cut
Cuts the selected object to clipboard; only available if an object (polygon,
rectangle, circle, line, or text) is selected.
Copy
Copies the selected object; only available if an object (polygon, rectangle, circle,
line, or text) is selected.
Paste
Pastes the clipboard item onto the current layer.
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Delete
Deletes the selected object.
Delete All
Deletes all objects from the current map layer.
Add Vertex
Provides an option to add a vertex to the selected object. To add a vertex:
Activate the desired map layer containing an annotation object and make it
editable
Select an object on this layer
Click on the
(Add Vertex) button or select the Add Vertex option from the Edit
menu/
Place the mouse cursor at the desired location; the mouse cursor will change to a
pen
Click once with the left mouse button at this location to add a vertex
This menu item is only available when an object (polygon, circle, line or rectangle)
is selected.
Delete Vertex
Provides an option to delete a vertex from the selected object. To delete a vertex:
Activate the desired map layer containing an annotation object, and make it
editable
Select an object on this layer; all its vertices will be highlighted
Click on the
(Delete vertex) button or select the Delete Vertex option from the
Edit menu
Place the mouse cursor on the vertex to be removed; the mouse cursor will
change to an "X"
Click once with the left mouse button on this vertex to remove it from the object
This menu item is only available when an object (polygon, circle, line or rectangle)
is selected.
Copy Map to Clipboard
Copies the entire Map Window to the clipboard. The map window can then be
pasted as an image in other applications.

17.2.4

Tools
The Map Manager provides annotation tools which allow for drawing shapes and
inserting text labels on the map. The drawing tools are available in both the Tools
menu and in the Map Manager toolbar.
The options for the annotation tools allow modifying the color and style of the
annotation objects.
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The annotation items are only available on map layers with the corresponding
object type (i.e. text, line, point, polygon). These are called annotation layers. For
example, to draw polygons on the map, a new map layer with the type "Polygon"
must first be created (using the Layer / New menu option), or if a polygon layer
already exists it has to be set to "edit" mode. To add text to a map layer, a new
layer with the type "Text" must first be created (using the Layer / New menu
option).
The following annotation options are available:
Polygon
Provides the option to draw a polygon. This option is available only when a
polygon shapefile layer is selected and set for editing.
Shifting and Scaling Digitized Polylines/Polygons
Map Manager allows you to shift and scale digitized polygons and polylines. These
options are NOT accessible through the main menu. However, they can be
accessed by double-clicking on a digitized polyline or polygon, while you are in edit
mode. When double-clicked, a blue box will appear around the vertical and
horizontal extents of the digitized shape indicating that the whole shape is selected
(as shown in the image below).

You can scale the polyline/polygon by clicking on one of the vertices located on the
blue box, and moving it to a new position (holding the left mouse button).
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You can shift a polyline/polygon (up, down, left or right) by placing your mouse
cursor inside the blue box (mouse cursor symbol will change) and then clicking
and dragging the entire shape to a new position.
Note: These features are only available for polyline and polygon layers, which
have been digitized (created) in Map Manager.
Rectangle
Provides the option to draw a rectangle. This option is only available if a polygon
shapefile layer is selected and set for editing.
Circle
Provides the option to draw a circle. This option is only available if a polygon
shapefile layer is selected and set for editing.
Line
Provides the option to draw a line. This option is only available if a line shapefile
layer is selected and set for editing.
Point
Provides the option to add points to the map layer. This option is only available if a
point shapefile layer is selected and set for editing.
Text
Provides the option to add text labels to a map layer. This option is only available if
a text layer is selected and set for editing.
Information
Provides a dialog containing information about the selected station, or other
objects such as contour lines; an example is shown below.
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To load the Information dialog,
Select a layer containing HG Analyst station data.
Select Information from the Tools menu, or click on the
in the toolbar
Click once on any station within the selected layer.

(Information) button

This window will display Station ID, Name, Elevation, TOC, and any other fields
depending on the layer type. If there are stations that share the same ID, and are
hidden behind the selected station, then the scroll arrow buttons (in the lower-left
corner) can be used to view the information for other stations.
NOTE: The information tool can only be used on shape layers that are visible and
active.
Measure
Provides an option to measure distances on the map window. To use this utility:
Select Measure from the Tools menu, or click on the
(Measure) button in
toolbar.
Place the mouse cursor at the start point for the line. The mouse cursor will
change to a cross-hair.
Click once with the left mouse button to start the line
Drag the mouse cursor to the end point of the line
To add a vertex to the line, click once with the left mouse button, then continue
drawing to the new location.
As the line is drawn, the distance from the start point to the end point (i.e. the
current mouse cursor location) is displayed in a status bar at the bottom of the
Map Manager window. This is indicated in the sample image below:
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There will be two values displayed here; The Seg value is the distance from the
current cross hair to the previous vertex location (i.e. the distance of the line
segment). The Line value is the total line distance from the start point, including all
segments.
To finish the line and end the line measurement, double-click the left mouse
button.
Define Cross Section Line
Allows you to create a cross section line. Make sure you are in one of the HGA
data layers before drawing a cross section line.
Please see the section Defining a Cross Section Line for more details.
Create Cross Section
Loads the cross section editor, for the selected cross section line. This menu item
is activated only when a cross section line is selected/highlighted. There are two
ways to highlight a cross section line:
· Choose the cross section line on the cross section line layer
· Draw a new cross section line on a station layer.
For more details on creating cross sections, please see Cross Section Editor.

17.2.5

View
This menu provides options to modify the appearance and size of the Map
Window, and the layers within the map project.
Full Extent
This menu item will zoom the map window to its original full extents.
Zoom In
Provides options for zooming into a section of the map that is defined by drawing a
rectangle. Place the cursor on the map and click once to define one corner of the
rectangle, drag to a second position to define the opposite corner of the rectangle,
and release the mouse button. The selected section will be adjusted to fill the
screen.
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Zoom Out
Provides options for zooming out on the map. Click this menu item and the map
window will zoom out. The current screen will be zoomed out by a factor of two
unless it is already in full-extent mode.
Zoom to Active Layer
Zooms the map window dimensions to the extent of the selected map layer.
Previous Extent
Zooms the map window to the previous window dimensions.
Next Extent
Zooms the map window to the next window dimensions. Activated only after
Previous Extent has been used.
Custom Extent
Allows you to manually set the zoom extents and the center of the Map Window.
When this menu item is selected, the following dialog will appear.

Provide, the desired viewable width, map scale, and X, Y coordinates of the map
that will be repositioned at the center of the map window.
As the Zoom (window width) changes, the Map Scale changes and vice versa.
The Zoom window width has equal proportions left and right of center.
TIP: When you save the map project, the view extent is saved together with the
map project. The next time the map project is opened, the view extent will be
restored.
Turn on All Layers
Makes all layers visible.
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Turn off All Layers
Hides all layers.

17.2.6

Select
This menu provides options for selecting or de-selecting stations on the selected
layer in the Map project. Typically, this involves stations from the Hydro
GeoAnalyst project. Once the station's data points are selected, a red circle will
appear on top of the station's symbol.
Stations may be selected on the map by:
· Clicking individually
· Drawing a polygon, box, or circle (all stations inside the object become selected)
· Drawing a line and defining a buffer distance (all stations within the buffer
distance become selected)
· Multiple station selections may be accomplished with the use of the <Ctrl> key.
Simply press and hold down the Ctrl key after making the initial selection, then
use one of the tools to select or de-select additional stations.
Each selection option is described below.
Pointer
Allows to select stations one by one. When a station is selected, a red circle will
appear on top of the station's symbol. When another station is selected, the
previously selected station is un-selected and the new station's symbol becomes
selected, indicated by a red circle on top of the station's symbol.
Rectangle
Allows to select stations within a drawn box. To draw a rectangle, place the cursor
in the map window, click once with the left mouse button in the area of interest and
drag a window around the area, then release the mouse button. All stations within
the box will become selected, indicated by a red circle on top of the station's
symbol.
Polygon
Allows to select stations within a drawn polygon. Place the cursor in the map
window at one point of interest, click once with the left mouse button and digitize a
polygon around the area of interest. To add a vertex to the polygon, continue to
click with the left mouse button. To close the polygon, double click the left mouse
button at the final vertex. All stations within the polygon will become selected,
indicated by a red circle on top of the station's symbol.
Circle
Allows to select stations within a drawn circle. To draw a circle, place the cursor in
the center of the area of interest, click with the left mouse button and drag an
expanding circle around the area, then release the mouse button. All stations
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within the circle will become selected, indicated by a red circle on top of the
station's symbol.
Line
Allows to select stations near a drawn line. To draw a line, place the cursor at one
end of the area of interest, click with the left mouse button, and digitize a line
through the area of interest. To add a vertex to the line, click with the left mouse at
the vertex location. To finish the line, double click the left mouse button at the final
vertex location. This will open the buffer distance window.

Enter a buffer distance from the drawn line, and click [OK]. All stations within the
buffer distance of the line will become selected, as indicated by a red circle on top
of the station's symbol. The Buffer distance extends out, perpendicular to the line
location.
All
All stations on the current Map Layer will be selected.
None
All stations that are selected on the current Map Layer will be deselected.
NOTE: Once selected, you cannot deselect individual stations.
Add to Station Group
Provides an option to add the selected stations to a Hydro GeoAnalyst station
group. Using one of the Selection tools mentioned above, select one or more
stations, then choose this menu item from the Select menu, and the following
dialog will appear.

Stations can only be added to an existing station group.
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Delete from Station Group
Remove the selected stations from a Hydro GeoAnalyst station group. The
stations will be removed from the station group map layer currently selected and
active in the layer manager.

17.2.7

Settings
Cross Section
This dialog allows modifying the display properties of features that intersect with cross section lines,
when viewing a cross section in the Cross Section Editor. Selecting this option launches a dialog
similar to that shown in the following figure. The dialog makes a list of all line type layers available for
selection.

A cross section line may intersect with one or more cross sections, or any line type features such as
rivers and highways; in this dialog it is possible to specify the features to be displayed on the cross
section plots. The dialog also allows you to set display properties of these features. The following
options are available:
Name: Name of the intersecting layer (read-only)
Field: Select a field to represent the layer (typically Name, ID, Text)
Font: Select a font for the label
Symbol: Define symbol properties for the selected layer
Angle: Define label angle
The Field column contains a list of available fields for the selected layer. This field will be used as the
label in the cross section view.
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The Symbol column contains the symbol options for the selected layer. Double click on the field in this
column to load the options shown below.

To show the intersections on the Cross Section,
Click on the Cross Section tab.
From the top Menu Bar click Tools, and then Update Cross Section.
The following image shows the intersections between the cross sections:
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NOTE: In order to see intersecting cross sections in the cross section editor, the corresponding Map
Manager project must be open.

Graticule
Provides settings for the graticule (also referred to as gridlines) on the map. The following dialog will
appear:

©2022 by Waterloo Hydrogeologic

Map Manager

627

Appearance
In the appearance frame, you can edit the line color, style, font.

Tic
Allows defining the number of minor and major tics.

Paddings
Controls the amount of buffer space between the edge of Map Manager window display, and the labels
on the axis. It may be necessary to increase this value when the X and Y co-ordinates contain many
digits

Intervals
Controls the space between the major graticule lines. You can accept the system calculated Auto
values, or enter Manual values.

Mark Text
Controls the axis labels. For each axis, you can set the visible status, rotate the label, and control the
gap between the label and the axis itself.
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Code Page
Use these settings to convert accented characters into a shapefile format that can be recognized by
the Map Manager. The following options are available:

From the combo-box, select the Code Page that should be used for the shapefiles in your map project.
The Map Manager provides several ISO standards. For a complete list of which standard you should
select (based on your language and regional settings) please see "Appendix D: Map Manager: ISO
Codes".
Click [OK] when you are finished.
NOTE: This option is available for new shapes files only; existing shapefiles cannot be converted.

17.2.8

Help
Contains the contents of the Map Manager help.

17.3

Defining a Cross Section Line
Use the Map Manager to define the locations of cross section lines, which can then
be interpreted in the Cross Section editor. There are two methods for defining
cross section lines: Digitizing and Use Existing Polyline. Additionally, you can
modify the buffer area for your cross sections. Each method is described below.
Digitizing a Cross Section Line
In the Map Manager, open an existing map project or create a new map project.
Select a Hydro GeoAnalyst data layer (i.e. station data), and ensure this is visible
and active (selected). If you do not have such a layer, you may create one based
on station groups that are available in your Hydro GeoAnalyst project. To do this
use the Layer > Load HGA Data option to select a station group. The Map
Manager creates a layer with stations that are available in the group.
Zoom-in to the area of interest (optional).
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Click the
(Cross Section Line) button at the right end of the toolbar, or select
Tools/Define Cross-Section Line from the Main Menu.
Place the mouse cursor at the starting point of the line, and click once with the left
mouse button.
Click again at another location to add a vertex to the line. You may add one or
more vertices that define the cross-section line. Note: If you wish to place a vertex
beyond the extent of the current map view, click and hold the right mouse button to
pan across the map. Also, you can use the mouse wheel to zoom in and zoom out,
while defining the cross section line.
At the end point of the line, double-click the left mouse button to finish. This will
launch the dialog shown below:

For each cross section line, specify a Name, Buffer Distance and Description. The
Buffer Distance determines which stations will be included in the cross section;
stations which lie within the buffer distance will all be selected (as indicated by a
red circle on top of the station's symbol) and included in the cross section. The
Buffer Distance is projected out perpendicular to the cross section line.
Click [OK] to accept the Line attributes.
If necessary, selected stations can be deselected by clicking on each of them
while holding down the <Ctrl> key.
If necessary, extra stations may be added to the selection by clicking on one or
more stations while holding down <Ctrl> key.
NOTE: Once a cross-section line has been created, stations can still be added to
or removed from the line by selecting the line, then right-clicking and choosing the
Add/Remove Stations option. Stations can then be added/removed by clicking on
the desired stations. In order to use this feature, the station layers on which the
cross section are based (e.g. Boreholes), must be set to Visible in the
Layer Control.
The cross section can then be created as follows.
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Select Tools > Create Cross Section from the Main Menu, or click on the Cross
Section button
on the toolbar.
Click [Yes] to create the cross section; the name assigned to the cross section line
will be used for the cross section name.
Use Existing Polyline
You can create a cross section line from an existing polyline layer. To do so, follow
the steps below:
Right-click the desired line segment and select Convert to Cross Section Line from
the pop-up menu.

Specify a Name, Buffer Distance and Description. The Buffer Distance determines
which stations will be included in the cross section; stations which lie within the
buffer distance will all be selected (as indicated by a red circle on top of the
station's symbol) and included in the cross section. The Buffer Distance is
projected out perpendicular to the cross section line.
Click [Ok] to accept the line settings. The Select Station Layer dialog will display.
Select the appropriate station layer from the dropdown list box and click [Ok].

The following message will display:
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Click [Yes] to open the cross section in the Cross Section editor.
This will load the cross section editor. For more details on creating cross sections,
you may refer to Cross Section Editor section.
Modify Buffer Distance
To modify the buffer distance of a cross section line:
· Select the cross section layer from the Layer Manager panel.
· Select a cross section line.
· Right-click, and select Update Buffer from the pop-up menu.

From the CrossSection Line dialog, specify a new buffer distance.
Click [Ok].
Map Manager will now regenerate the cross section line using the new buffer
distance.
Note: Buffer distances for cross sections generated in past versions of HGA
cannot be modified.
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Cross Section Editor
The Cross Section Editor is designed with easy-to-use tools for interpreting geological and
hydrogeological data, as well as interpreting data for groundwater flow models. Generating
model layers for use as modeling layer elevations in groundwater modeling packages such
as Visual MODFLOW Flex has never been easier!
In addition, the Cross Section Editor is seamlessly integrated with the Scene Viewer, a tool
that combines and displays one or more cross sections in a 3D fence diagram view!
The Cross Section Editor allows for three types of data interpretations:
· Geologic (containing lithology structure data)
· Hydrogeologic (containing locations of aquifers, aquitards, etc.)
· Model (containing locations of model layer lines, which may be used in numerical

groundwater modeling)
The Cross Section Editor provides users with the following key features:
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·
·

18.1

Digitize geologic and hydrogeologic layers using the polygon draw tool
Select standard cross section fill patterns from the Geology
Copy zones from geology layers in order to define hydrogeology zones
Display the locations of intersecting layers and other cross sections (using
symbols and labels)
Display water table location in cross section view
Dynamically view the spatial orientation of the boreholes in the Map Preview
Window - simply move the mouse over the 2D borehole to highlight its location
on the map
View the orientation of cross sections as they relate to the Map Preview Window
Define properties of intersecting features (other layers or cross sections)
Display screened interval in cross section view
Modify labels for lines and polygons
Zoom in/out and pan features
Launch cross section for viewing in the Scene Viewer
Export cross section view to image format
Export model layer points for use in groundwater models, including Visual
MODFLOW
Send cross sections to the Report Editor to be included in a report template
Copy window to clipboard

About the Interface
The Cross Section Editor may be launched from Hydro GeoAnalyst:
· In the Project Tree, double click on an existing cross section from the Cross
Sections node;
· Select the Cross Sections icon

on the main toolbar and then select the
cross section you wish to launch from the drop down list
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· Select Modules / Cross Section Editor and then select the cross section you wish

to launch from the drop down list
The Cross Section Editor may also be launched from the Map Manager in one of
the following ways:
Activate the cross section lines layer from the layer manager, and select a Cross
section line by clicking on the desired cross section.
To create a new cross section, select the Create Cross Section menu option from
the Tools menu, or click on the Show/Create Cross-Section button
on the
toolbar. This option will create a new cross section based on the selected cross
section line.
To open an existing cross section based on an existing cross section line, click on
the Show/Create Cross-Section button
on the toolbar. This opens the cross
section editor with the corresponding cross section.
Click on the Cross-Section tab, in the upper right corner of the window (see figure
below) to activate an existing cross section from a list of cross sections that are
available for your project.
The Cross Section Editor window is shown in the figure below (with a cross section
loaded for demonstration purposes).

The Cross Section Editor window contains the following items:
Menu Bar: Contains program menu commands
Toolbar: Contains short cut buttons to some of the most commonly used features
in the Cross Section Editor.
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Layer Control: Manages cross sections, visibility, and editability of interpretation
layers. Right-click a layer to access additional options such as Move up/Move
down, View 3D and Properties.
Cross-Section Window: Contains the cross section view for the selected cross
section line.
Site Map: Displays the selected cross section line, as it appears in the map
project. The selected stations for the cross section are highlighted in this Map
preview window.
Coordinates: Displays the X, Z coordinate for the current mouse cursor location.
Active Window: Select between the Map Manager window and the Cross Section
window.
Description of Toolbar Items
The Cross section editor contains a toolbar with short cut buttons to some of the
commonly used features. Most toolbar buttons are context sensitive, and react
according to the active layer, window, or dialog. If there are no options for the
selected layer, the respective toolbar button(s) will become inactive, indicated by a
greyed out appearance. For example, the option to add a vertex is active only
when a polygon or a line is selected.
Save button saves the current cross section project.
Print button sends the current cross section view to the report editor.
Selection Pointer feature is used for selecting objects in the active
interpretation.
Draw Polygon feature is used for drawing a polygon or a rectangle in the
active layer.
Draw Line feature is used for drawing a model layer line in the selected layer.
Add Text features is used for adding annotation to the selected layer.
Delete Selected Object feature deletes the selected object (shape) from the
currently activate layer.
Add Vertex feature is used for adding a vertex to the selected object (polygon
or line). This button is activated only if an object is selected.
Delete Vertex feature is used for deleting a vertex from the selected object
(polygon or line). This button is activated only if an interpretation having at least
one object is activated, and at least one of the objects is selected.
Link Vertex feature is used for linking two vertices from two polygons or lines.
This feature is only available if an interpretation having at least two polygons or
lines is activated, and at least one of them is selected.
Remove Links feature is used for breaking the vertex link between two or
more polygons or lines. This button is activated only if an interpretation having at
least one object is activated, and at least one of the objects is selected. For more
information, see "Link Vertex"
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Zoom In option is used to zoom in on an area of the cross section, defined by
a rectangle.
Zoom Out option is used to zoom out from the current cross section view.
Pan button allows the user to pan the current view left, right, up, or down.
Full Extent button restores the cross section view to the full extents of the
Cross Section's coordinates.
Previous Extent button restores the cross section view to the previous zoom
extent.
Next Extent button switches the cross section view to the next zoom extent.
Information button displays information for the selected station. Moving the
mouse cursor overtop of a station will display the information.
Export to Visual MODFLOW Flex button provides an option to export model
layers to xyz text files for importing into modeling project.

18.2

Description of Menu Items
Save
This menu item will save all current edits for the cross section to the current cross
section project file (.VCP).
Close
Closes the currently open cross section.
Export Model Layers
This option allows you to export the model layer lines for all cross sections, to XYZ
text file format. These files can in turn be used to define layer elevations in
groundwater flow models, such as Visual MODFLOW. When this option is
selected, the following dialog will appear:
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In this dialog, select the model layers you wish to import. Each model layer will be
exported as a separate file; for each file, you may define the name under the
Export As column.
Next select which cross sections should be considered in the export. Click the
[Create] button to generate the files. The files will be generated in the Model subfolder, of the Project folder (for example: D:\Program Files \ HGAnalyst\ Projects\
Demo_Project\ Model\ Topography.txt)
The Cross Section editor will generate the text files based on the vertex location of
each model layer line, in each cross section. For example, for model layer 1
(Topography), if cross section AA' contains this model line with 5 vertices, and
cross section BB' has the same model line with 10 vertices, then the text file
should contain 15 rows (if both cross sections AA' and BB' are selected).
The X,Y location for each vertex corresponds to the X,Y location on the cross
section line; the Cross Section editor also provides the option to save the well
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contacts using the station's X,Y co-ordinates, and retrieve this info from the
database.
Export Image
Provides options for exporting the current cross section to a Raster Image file.
Supported file types include: bitmaps (*.BMP), Joint Photographic Experts Group
(*.jpg), and enhanced Meta Files (*.EMF). Enter a filename, and choose the
desired export format, and click [OK]. An Export dialog will appear with settings for
the image file:

There are several options for the modifying the image provided in this dialog:
Scale Factor: Choose a scale factor from the combo box. This factor will determine
the resolution of the exported image. The greater the factor the better the
resolution will be. A scale factor of 1 will keep the original size while a scale factor
of 2 will be twice the size both in height and width.
Resolution: Instead of a scale factor you can choose a specific resolution (in units
of dpi). The vertical scale is the ratio of the height of the Cross Section in actual
world units / height of the Cross Section in screen units. These are used to
calculate the output image size. So a higher a resolution will mean a bigger image,
while a smaller vertical scale will mean a larger image.
Quality: Using the scroll bar, define the image quality. This option is available only
if the JPEGs export format is selected. The greater the percentage the higher the
quality will be. The image size is also directly proportional to this value.
Scale Symbology: Determines if the scale factor will be applied to symbols and
lines.
Export Depth: Choose the color quality for the exported image.
Palette: Determines the color palette to be applied to the exported image.
The Palette and Color Depth options are available only for bitmaps (.BMP) and
enhanced Metafiles (.EMF).
Print
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Loads the current cross section into the report editor's runtime designer. Please
refer to The Report Editor for more details on managing reports.
Exit
Exit the Cross Section Editor, and return to the main window of Hydro GeoAnalyst.
Note that this menu option also closes the map manager.

18.2.2

Edit
Delete
Deletes the selected object.
Delete All
Deletes all shapes from the currently active cross section interpretation.
Add Vertex
Provides an option to add a vertex to the selected object. To add a vertex:
Activate the desired cross section interpretation (make it editable);
Select an object that is a polygon or a line (depending on the active interpretation
type);
Click on the
button or select the Add Vertex option from the Edit menu.
Place the mouse cursor at the desired location; the mouse cursor will change to a
pen;
Click once with the left mouse button at this location to add a vertex;
Repeat the last two steps to add more vertices at other locations on the selected
object.
Delete Vertex
Provides an option to delete a vertex from the selected object. To delete a vertex:
Activate the desired cross section interpretation;
Select an object that is a polygon or line;
Click on the
button or select the Delete Vertex option from the Edit menu.
Place the mouse cursor on the vertex to be deleted; the mouse cursor will change
to an "X";
Click once with the left mouse button on this vertex to remove it from the object;
Repeat the last two steps to delete more vertices from the selected object.
Link Vertex
The Link Vertex option allows for linking two vertices from two polygons or lines. It
is intended to assist in filling in gaps between adjacent polygons (or lines), thus
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creating continuous interpretations. The end result is that polygons (or lines) will
be able to share a common "linked" vertex (or vertices).
To Link Vertices on polygons (or lines),
Select the desired interpretation layer and make it editable;
Select the polygon or line whose vertex will be linked with another vertex;
Click the Link Vertex option from the Edit menu or click the
button from the
toolbar.
Click on the desired vertex (source vertex) that will be linked with another one; the
color of the vertex changes to green to indicate it has been selected;
Move the mouse cursor to the desired destination vertex, to which the previously
selected vertex will be linked. The mouse cursor will change to a red square
outline, when a vertex is identified;
Click on this red square, and the vertices will be linked.
The Linked Vertex will turn orange to indicate that the vertex is linked, and shared
by two or more polygons (or lines).
NOTE: "Link Vertices" option is activated only if there are at least two objects on
the layer. Once two vertices are linked, they behave as a single vertex.
Remove Links
The Remove Links option allows for separating previously linked vertices.
To use this option,
Select the interpretation layer containing at least two polygons or lines whose one
or more vertices are linked;
Make this layer editable;
Click the Remove Links option from the Edit menu or click the
button from the
toolbar;
Click on one of the linked vertices in the selected polygon; linked vertices are
colored orange;
Upon clicking on a linked vertex, the vertex will change back to blue color to
indicate that the link has been successfully removed;
Click on the pointer button
in the toolbar;
Place the mouse cursor on this vertex which has been separated;
Click once on this vertex, and drag the mouse away from its position, and place
the polygon vertex in the new position (if desired);
Set Features
The Set Features option allows for modifying the display properties of most layers
in your map project and other cross sections that intersect with the current cross
section. If this option is selected from the Edit menu, a dialog similar to that shown
below will be displayed.
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A cross section line may intersect with one or more features that are displayed in
one or more layers in your map project. For instance, one or more rivers from the
"Rivers" layer may intersect with a given cross section at one or more points. Other
features of importance may include roads, railway lines, lakes, etc. Features from
selected map layers that intersect with a cross section may be displayed as a
symbol and/or label on the cross-section line.
NOTE: The intersecting items display options can be defined only at the time when
the cross section is created; currently, it is not possible to set these features later
on, once the cross section has been created. Also, intersecting items must be
selected in Map Manager before the cross section is created.
In the Set Features dialog, there are several options:
Name: Name of the intersecting layer (read-only)
Visible: Defines if the element is visible or not.
Field: Allows you to select a field to use as a label for the intersecting feature
Symbol: Allows you to select a symbol to represent the intersecting feature
Label: Allows you to set properties of the label representing the intersecting
feature
The Field column contains a list of available fields for the selected layer. This field
will be used as the label in the cross section view.
Double-click on the desired cell in the Symbol column to load the dialog where a
symbol can be selected and its properties set.
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NOTE: You will only be able to change the Font and Symbol of the point if the
Pattern is set to "True type".
The Label Properties dialog may be loaded by selecting the [...] button; the
properties that are available are shown below.

The Placement options allow you to set the default label placement relative to the
feature. Use the Offset controls to fine tune the placement by adjusting the X and
Y values. The labels can also be rotated by specifying a desired Angle .
Change Well Width
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Provides options for increasing the display width of stations (wells and boreholes)
plotted on the cross section.

You can change well width as it appears on the screen by a factor displayed in the
"Current width" drop-down menu. Using this factor, you can make the wells thinner
or thicker on the cross-sectional display.
Change Vertical Axis
This option allows you to extend the vertical range of the elevation axis. When this
option is selected, the following dialog will display:

Specify a Top value and a Bottom value. Click [Ok] to accept the new values.
Change Vertical Exaggeration
This option allows you to change the vertical exaggeration of the current cross
section. The vertical exaggeration is simply the ratio of the vertical scale to the
horizontal scale.
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Specify a new vertical exaggeration and click the [Ok] button. The cross section
will then be regenerated to reflect the new vertical exaggeration.
Copy Window
Provides an option for copying the current cross section window to the Windows
clipboard. The window may then be pasted into a supporting application (such as a
document, or image editor, or slide presentation).

18.2.3

View
This menu provides options to modify the appearance and size of the Cross
Section Window.
Full Extent
This menu item will result in zooming out the cross section window to its original
full extents.
Zoom In
Provides options for zooming into a section of the cross section that is defined by a
rectangle drawn around the desired area. Place the cursor on the cross section
and click once to define one corner of the rectangle, drag to a second position to
define the opposite corner of the rectangle, and release the mouse button. The
selected section will be adjusted to fill the screen.
Zoom Out
Provides options for zooming out on the cross section. Click this menu item and
the cross section window will zoom out. The current screen will be zoomed out by
a factor of two unless it is not already in a full-extent mode.
Previous Extent
Zooms the cross section window to the previous window dimensions.
Next Extent
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Zooms the cross section window to the next window dimensions.
Export to Visual MODFLOW Flex
Allows you to export one or more cross sections to a 3XS file which can be
imported into Visual MODFLOW Flex. Upon selecting this menu item, the following
dialog will appear:

Select the Cross sections to display from the dialog, by placing a check mark
beside each cross section name. Or, to select all cross sections, place a check
mark beside the Select All check box at the top of the dialog.
When you select [OK] you will be prompted for a file name and location.

Information
Provides a window containing information on the selected station. After selecting
this option, you may place the mouse cursor on a particular lithologic column within
a selected station. A small text box appears displaying specific information about
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the layer (layer type, top and bottom elevations, and thickness). If the station in
question has screens, the Information feature can also highlight their pertinent
features.

Create Surface Line
Allows you to take surface layers from the map manager and display them as a
line layer on cross section interpretations. Surface data can be used to show the
relationship between interpretation layers and numerical model layers, or for
showing interpolated subsurface features, e.g., water table.
In order to show surface data on a cross section, you must first import or create
the surface in the map manager. Once the surface exists in the map manager,
select Tools > Create Surface Lines from the cross section editor toolbar.
The following dialog will appear on your screen

The Display Surface on Cross-Section dialog displays all surfaces currently loaded
in the Map Manager. These surfaces may have been imported, or interpolated
from point data (Layer > Create Contours).
Select the desired surface to show on the cross section. You may also change the
name of the surface, and specify the color, size and pattern of the surface line by
clicking on the Line Style preview.
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Click the [OK] button to add the surface line to the cross section. The surface line
will appear in the cross section legend under the "Surface" category where it can
be shown/hidden,

18.2.4

Tools
Options
Allows setting line snapping options for lines drawn on the cross section. If this
feature is selected, the dialog shown below will appear.

Editor Tab
In this tab, there are options for specifying the snapping buffers for the selected
cross section and its elements. The Snapping Buffers are specified in pixels. The
buffer values determine the distance to which lines and vertices will snap (i.e. join)
to the nearest line or vertex. If a low value for the Snapping Buffer is specified, the
mouse cursor must be very close to a vertex or line in order for snapping to occur.
If a high value for the Snapping Buffer is specified, then snapping will occur at a
distance further away from the destination vertex (or line).
Snapping allows for exact placement of vertices, and eliminates the need for
repetitive use of zooming in to specific locations. If the snapping is used, the
vertices will be connected (but not linked) at the desired locations.
Well Snapping Buffer
The default Well Snapping Buffer is 10 pixels. When a line is drawn, and the
mouse cursor comes within 10 pixels of another well (borehole), then the borehole
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will be highlighted; upon clicking the left mouse button on this station's lithologic
interval, the line will be automatically snapped to the closest vertex.
Boundary Snapping Buffer
The default Boundary Snapping Buffer is 5 pixels. When a line is drawn, and the
mouse cursor comes within 5 pixels of a cross section boundary line (either the left
or right), then the boundary line will become highlighted; upon clicking the left
mouse button on this boundary line, the drawn line will be automatically snapped to
this boundary line.
Vertex Snapping Buffer
The default Vertex Snapping Buffer is 5 pixels. When a vertex on a polygon is
selected, and the Link Vertex option is used, and the mouse cursor comes within 5
pixels of a vertex on an adjacent polygon, then the vertex will become highlighted
with a red box outline; upon clicking the left mouse button on this vertex, the vertex
on the selected polygon will be automatically snapped to this newly selected
vertex. Polygon Vertex Snapping makes it easy to place polygons adjacent to one
another, for continuous cross section views.
Labels Tab
Provides options for modifying the label fonts for the interpretation layers
(Geology, Hydrogeology, and Model). Simply click on the sample box beside the
appropriate label, and a Font options dialog will appear as shown below.

Define the desired font settings, then click [OK] to return to the Options dialog.
Rulers Tab
Controls the appearance settings for the axis of the cross section plot. For each
ruler (vertical and horizontal) you may define:
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·
·
·
·
·
·
·

Foreground Color
Background Color
Marker Width
Min Tic Pixels
Tic Numbers
Font
Vertical Exaggeration

Define the vertical exaggeration scaling factor for new cross sections. There are
two options: Default value, or User-defined (Specific). If the default option is
selected, the map manager will automatically calculate and assign the most
appropriate vertical exaggeration factor.
NOTE: Please see "Change Vertical Exaggeration" in the Edit menu item
discussed previously for information on how to change the vertical exaggeration
once a cross section has been created.
Screen / Water Levels
Controls the appearance settings for how screens and water levels are displayed
on the cross section. These options are shown below

In this dialog, there are options for the view settings (color, style, etc) for both the
screen and the water levels. The "Gap between Well and Screen" controls the
distance between the station and where the screen is placed. The larger this Gap
value, the further away the screen will be from its respective station.
Intersecting Tab
During a cross section interpretation, knowledge of other interpretations is
essential. In this dialog, you can define display options for intersecting cross
sections.
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Specify the color and line style under the Intersecting Layer Symbol frame. In the
View Intersecting While Editing frame, specify the view options for different
interpretation types. By default, all modules will be active.
The intersecting cross sections will be visible when you set one of the
interpretation types to visible, and editable. In the example screen shot below, you
can see that cross sections EE and BB along with their interval locations, are
visible while interpreting cross section ZZ:
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Grid Tab
Set the display properties for grid lines in the 2D cross section view.
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In the Grid Lines frame, set the line style, color and width, and also set visibility
settings for the horizontal and vertical grid lines. The Show on Load option will
result in the grid being displayed each time the cross section is loaded.
Interpretation Tab
Define the data storage options for cross section interpretations.

The cross section editor now saves the cross section interpretations to the project
database. The interpretations are also linked to the stations that were selected for
the cross section, and these stations, along with their interval data, are also saved
to the database. The interpretations, and the wells and corresponding interval
data, can be retrieved later, using the Query Builder.
Store Soft Data Points
Whenever a layer intersects with a station at only one point, it could be because of
one of the following reasons:
The layer truly touches the well at only one location (e.g. pinch-out), or
There is no contact with the well
In either case, the following options are available:
Consider the actually intersecting point as the top elevation and insert NULL for
both the thickness and bottom elevation
Extend the depth of the station fictitiously (within the bounds of the cross section)
to determine the location of the other point. These extensions are known as Soft
Data Points. If this point can not be found within the bound, the layer will be
considered to be a zero thickness layer (with thickness of NULL).
Save All Contacts
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Some stations may be crossed by a layer but may not be involved in the
interpretation (e.g. bad wells or data in those wells did not make sense, etc.) and
as such, the following options are available:
Consider all intersection points as valid contacts; this is the option Save All
Contacts
Only store contacts where there are vertices within the well (e.g. user snapped to
intervals or clicked within a well and created a vertex). To do this, disable the
option Save All Contacts
Model Layers
Before drawing model layers, the model layer attributes must first be defined in the
dialog shown below. Model layers can be added, deleted, or edited in this dialog.

In the Model Layers dialog, there are four columns:
·
·
·
·

Order: Layer order, from top to bottom (read-only)
Name: Defines the layer name
Description: Defines layer description
Pattern: Defines line properties for the model layer

In this dialog, specify the total number of model layers, and the properties for each
layer. Layers will be ordered from top to bottom; the first layer will always be Top
of Layer 1 (i.e. Ground surface), followed by Bottom of Layer 1, Bottom of Layer 2,
and so forth. The top most layer represents the top surface for the first layer while
the bottom most layer represents the bottom surface of the last layer. (i.e. each
model line defines the bottom of the model layer (excluding the top layer)).
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Additional model layers may be inserted at any location, at any time.
Press the
(Add) button to add a new model layer. The new layer will be added
ABOVE the currently selected layer.
Press the

(Delete) button to remove the selected model layer.

To edit an existing layer, press the
containing this layer.

(Edit) button or double-click on the row

Each model layer does not need to appear in all cross sections.
NOTE: The Model Layers options are not available when the Model Layer
interpretation is set to edit mode in the layer manager.
Update Cross Section
Use this option to update the screen, water level, and intersecting layer information
displayed on the current cross section. The corresponding map project should be
open in order to update information from intersecting cross sections.
Cross Section Info
Displays summary info for the selected cross section.

Display Well Profile
Use this feature to display a well profile directly on the selected cross section;
when displaying elements such as geophysical plots and well screen intervals, the
well profile can be a valuable asset when creating a cross section interpretation.
The layout settings is shown below:
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You can select which station to display a well profile for - remember selecting too
many stations may result in a crowded display.
The well profile is displayed to the right of the station in the cross section.

18.2.5

Help
Launches HGA Help, placing the focus on the Cross Section Editor section.

18.3

Cross Section Interpretations
Creating the Cross Section
As mentioned earlier, cross section locations must be drawn using the Define
Cross-Section Line option, or the CrossSection Line button (
) in the Map
Manager. See Defining a Cross Section Line for details on this procedure.
Once the cross section line is defined, the corresponding cross section can be
created from the Map Manager, as follows.
In the Map Manager, select Tools > Create Cross Section from the main menu, or
click on the Show/Create Cross-Section button
on the toolbar.
Click [Yes] to create the cross section; the name assigned to the cross section line
will be used as the cross section name.
If surface layers are present in your Map Project, you will be prompted to select a
surface layer.
Please see Loading Surface Layers for further information.
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The cross section editor opens the selected cross section and displays the stations
and related information.
The cross section shows projections of the borehole lithology columns on the
cross section plane. By default, the topography (top of model layer 1), will be
drawn in for you. The starting point of the cross section line will appear on the left
side of the cross section window; the end point of the line will appear on the right
side of the window.
Locations for layers must be interpreted, and drawn manually using lines or
polygons; layer types may be Geologic, Hydrogeologic, or Model
The process of drawing layers is described in the next section.
NOTE: Each cross section has required fields which must be present in your
database structure, as defined in the Profile Settings.
Drawing Cross Section Interpretations
Interpretation of the cross section is a considerably creative process, however the
cross section editor makes it easy for you. Once the selected stations have been
loaded into the cross section editor, the appropriate layers must be manually
drawn, and interpreted. Start the interpretation by selecting the layer type from the
layer manager. Choose from Geologic, Hydrogeologic, or Model. Each of these is
explained below.
Hydrogeologic interpretations can be copied from geologic interpretations. As
such, it is a better practice to first perform geologic interpretations of the cross
section.

18.3.1

Loading Surface Layers
Surface layers (e.g DEM, Surfer GRD) in a Map Project can be used to generate a
detailed topography model line for a cross section.
Note: A surface layer can only be defined for a cross section line when the cross
section is being created, in the Map component of Map Manager.
When a surface layer is present in a map project, you will be prompted to select a
surface layer when creating your cross section line. The following dialog will
display:
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This dialog contains all of the surface layers currently present in your map project.
Select a surface from the dropdown list box and click [Ok] to create the cross
section. Be sure to select a surface layer that covers the full extent of the cross
section line. Leave this dialog blank if you do not wish to use a surface layer.

18.3.2

Geology Layer Interpretations
This option allows for drawing interpretation layers that assist in defining the
geology (sand, clay, till, bedrock, etc) at the site. To draw Geologic interpretation
layers, the polygon draw tool must be used, and the polygon must be digitized
manually using the mouse.
Follow the directions below:
· Activate (make it editable) the Geology interpretation from the layer manager;
· Select the
(Polygon) button from the toolbar
· Place the mouse cursor at the desired location of the first vertex of the intended

geology layer;
· Click once on the left mouse button to add a vertex and start digitizing the

polygon in the desired direction;
· Add more vertices by clicking on the left mouse button at desired locations.
Move the mouse cursor to an interval on a desired station; the mouse cursor will
snap the vertex of the polygon to the nearest station interval. A vertex can also
be added anywhere on the cross section by clicking on the left mouse button.
· Double click anywhere on the cross section using the left mouse button to close
the polygon; the following dialog will appear:

· In the dialog that appears, enter a Name for the layer, a brief Description, and

select a soil Pattern. If the geologic layer you have just digitized in the current
cross section has already been created, you may select it from the list, instead of
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typing a new name. Click on the blank area beside Pattern to load the pattern
options, as shown below:

· Select a pattern, then click [OK]

Repeat the same sequence of operations for other layers within the active cross
section. The result will be a layered structure of the geological domain. The cross
section may contain some gaps where polygons do not completely touch adjacent
polygons; this can be easily fixed by selecting a vertex on a polygon, and using the
pointer tool to re-position the vertex. Alternately, gaps between polygons can be
filled by using the Link Vertex option. These options are explained below.
Once a layer is created in one cross section, it will be available for selection in all
other cross sections that you might have for your project. Altering the properties of
a given layer will be reflected in all cross sections.

Editing Layers
Once the interpretation layers are drawn, it may be necessary to modify the
positions of one or more vertices, or fill in the gaps between any two adjacent
layers, to create a continuous layered structure.
To move a vertex,
Select the
(pointer) tool from the toolbar
Click on one of the vertices of the polygon
Drag the vertex to a new location.
To add a vertex,
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Select the
(pointer) tool from the toolbar
Click once anywhere on the polygon to activate the object
Select the
(Add Vertex) tool from the toolbar
Place the mouse cursor at the desired location; the mouse cursor will change to a
pen
Click once with the left mouse button at this location to add a vertex
Geologic interpretation layers can have a free form, and do not have to conform to
a conceptual model (e.g. a sand layer may appear more than once in an individual
cross section). Layers may not have to continue from first to last borehole.
However, to have a meaningful view of your cross sections in the Scene Viewer,
you must avoid creating overlapping interpretation layers.
When defining Geologic interpretation layers, there is an option to snap the
vertices of one polygon to adjacent polygons. For instance, if after drawing
polygons and the cross section still contains gaps, the gaps may be filled in by
linking the vertices of the polygons, using the Link Vertex option.
To use this option, please refer to the "Link Vertex" in the Edit menu.
NOTE: Moving a vertex of a selected polygon will also move the linked vertex of
any polygons (or lines) that might have been linked through the "Link Vertices"
operation.

18.3.3

Hydrogeologic Layer Interpretations
This option allows for drawing layers that define the hydrogeologic layers
(Aquifer1, Aquitard1, Upper Unconfined Aquifer, etc.) based on relevant data in
the stations that are displayed in a cross section. The hydrogelogic layers must be
drawn using the polygon tool.
The procedure for drawing and editing these layers is identical to drawing geologic
layers, as explained above.
The position of the hydrogeologic interpretation layers may be defined based on
the position of any Geological interpretations that may already be available.
Translating Geology Interpretations into Hydrogeology Interpretations
A hydrostratigraphic unit will generally include one or several geologic layers and
the boundaries of a hydrostratigraphic unit will usually conform with the boundaries
of the geologic layers. As such, you can copy one or more of your geologic
interpretation layers and use them as a startup for hydrogeologic interpretation
layers.
To do so:
Select the Hydrogeology option from the Layer Manager, to make this layer visible
Right mouse click on this interpretation layer, and select Copy from Geologic
Layers, and the following dialog will appear:
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In this dialog, select one or more geologic interpretation layers to copy
For each layer to be copied, provide the name, pattern and description of the
corresponding hydrogeologic interpretation layer (Aquifer or Aquitard)
Once this is complete, the cross section editor draws the selected hydrogeologic
interpretation layers.

18.3.4

Model Layer Interpretations
This option allows for defining the unique model layers (Model Layer 1, Model
Layer 2, etc.) for the displayed stations. Model layers can be used for numerical
groundwater flow models, or for general purposes. The layer positions for model
layers must be drawn in manually with the mouse, using the Line tool.

18.3.4.1

Defining Model Layers

Before drawing model layers, the layer attributes must first be defined.
To do so,
Select Tools > Model Layers from the main menu
This will load the Model Layers dialog as shown below.
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In this dialog, you can specify the total number of model layers, and set properties
for each layer. In addition, the layers can be numbered in a particular order. Layers
will be numbered starting with 1 for the top most layer and increase with depth.
The top most layer represents the top surface for the first layer while the bottom
most layer represents the bottom surface of the last layer. (i.e. each model line
defines the bottom of the model layer). Once the layers have been defined,
additional layers may be inserted at any location, at any time.
18.3.4.2

Drawing Model Interpretation Layers

Before starting to draw model interpretation layers, please ensure that you have
defined the model layer settings explained in the previous section.
You will see that the top of layer 1 (ground surface) is drawn in automatically for
each new cross section.This layer can be modified by moving it through its existing
vertices, adding new vertices at desired locations or deleting existing vertices.
To draw model layers, follow the directions below:
Activate the Model Interpretation Layer in the Layer Manager;
Select the Line draw button
from the toolbar. As soon as this option is
selected, the following Model Layers dialog will appear
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In this dialog, choose the desired model layer by selecting the radio button from
the first column in this grid. Each model layer may be selected and assigned only
once. Interpretation layers that are already drawn in the cross section are colored
in orange and are not selectable.
Click [OK] to continue
Place the mouse cursor at the left boundary at the desired depth of the intended
model layer; when the mouse cursor becomes close enough to the boundary line,
the cursor will snap to the boundary.
Click once on the left boundary to add a vertex at this location, and start the line.
Slowly move the mouse cursor (to the right) across the cross section to the interval
in the first station which represents the model layer. When the cursor is within the
specified buffer distance from the station's lithology interval, snapping will be
activated.
With a left mouse click, add a vertex at desired and appropriate locations both
within and outside station intervals.
Continue to move the mouse cursor across the cross section, using the left mouse
button at each station to add a vertex at the desired location for the model layer.
At the right cross section boundary, click once more with the left mouse button to
add a vertex and complete the line; when the mouse cursor becomes close
enough to the boundary line, the line will snap to the boundary. The selected
model line will be drawn at the specified location.
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NOTE: The model line is drawn using the attributes that were defined for it at the
time it was created. Most attributes of a model interpretation layer can be modified
by right-clicking on the desired model interpretation layer and choosing Properties
from the pop-up menu.
A dialog similar to that shown below will appear.

Provide a Description, Line Style, Line Color, Fill Pattern for the model
interpretation layer; the Name for the layer cannot be modified, as the name is
defined in the Model Layer Options dialog.
Click [OK] to close the dialog.
Once this is finished, repeat the same sequence of operations for other model
layers within the cross section domain.
Restrictions on Model Layers
The following restrictions apply when drawing model interpretation layers:
· The model layer line must start at the left boundary and end at the right
boundary.
· The line must be drawn from left to right, and may not go backwards (i.e. no
vertices can be drawn left of a previously drawn vertex.)
· Model layer lines cannot intersect each other.
· Model layers need to be drawn in the order they are created. For instance the
bottom of model layer 3 can not be drawn between model layers one and two.
18.3.4.3

Snapping Vertices to Other Model Layer Lines

While drawing a model layer interpretation line, it is possible to snap to part of, or
all of, the vertices of an already drawn model layer line. This can be helpful for
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defining geologic layers that pinch out (i.e. have zero thickness in some parts of
the site).
Snapping between two selected vertices
Whenever a model layer line is drawn, and the vertex of the line is within the buffer
for a vertex of an adjacent model layer line, a blue box will appear outlining the
vertex on the adjacent line. If the mouse is clicked on this vertex, the vertex will
snap to the existing vertex. The line vertex will change to an orange color to
indicate the vertex is linked (shared) between the two model layer lines. You can
link to as many vertices as desired by repeating the above step.
However, if snapping to a series of consecutive vertices is desired, you may click
on the first and the last desired vertices. The cross section editor will create the
necessary number of vertices on the model layer line being drawn and link them to
their respective vertices. For instance, if there are five vertices on the existing
model line layer between the selected first and last vertices, six vertices will be
created on the current model layer line. Linked vertices will move together, and
can be separated if needed. The following figure depicts an example of a model
layer pinching out around the middle of the cross section.

Snapping to the end of the cross-section line
If the model layer pinches out from any given point on the cross section to the end
of the cross-section line, the cross-section editor can draw the model line from that
given point on for you. To do this, double-click on the first vertex. The model line
will automatically be created for you. See the bottom most layer in the figure
above.
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In this example, the model layer pinches out at the right side of the cross section.
18.3.4.4

Editing Model Layers

Editing Model Layers
Once the model interpretation layer lines are drawn, it may be necessary to modify
the positions of one or more vertices or add more vertices.
To move a vertex,
·
·
·
·

Select the
(Pointer) tool from the toolbar
Click once on the desired model layer line to activate
Click on the vertices to be moved
Drag the vertex to a new location.

To add a vertex,
· Select the
(Pointer) tool from the toolbar
· Click once anywhere on the line to activate the line
· Select the
(Add Vertex) tool from the toolbar
· Place the mouse cursor at the desired location on the line; the mouse cursor will

change to a pen;
· Click once with the left mouse button at this location to add a vertex

Adding Multiple Vertices
To insert multiple vertices along a model line, follow the steps below:
· From the layer manager panel, enable edit mode for the Model interpretation
layers.
· Select a model interpretation line from the cross section.
· Right-click the line and select Insert Vertices along Line. The following dialog will
display:
·

You can insert multiple vertices in one of the following two ways:
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· By number: inserts a specified number of vertices along the model line, at

regularly spaced intervals.
· By distance: inserts a vertex at a specified distance interval (e.g every 50

metres), along the entire model line.
Select the desired method, specify a value and click [Ok] to insert the vertices.
Other properties of model layers (such as name, pattern and description) can be
edited by using the Tools > Model Layers menu option described in the "Model
Layers".

18.3.5

Remove Stations from Cross Sections
When working with a cross section in the Cross Section tab, one or more stations
can be removed from the cross section line by right-clicking on the cross section
and selecting the Remove Stations option. Then simply click on a station to
remove it from the cross section. Stations can also be added to/removed from a
cross section line in the Map tab, as described in Defining a Cross Section Line .

18.4

Querying Cross Section Interpretations
In earlier versions of HGA, the cross section interpretations were saved in
shapefiles and along the cross-section line. The cross section editor now saves
the interpretation results to the database, for various uses including:
· displaying the results of each interpretation in HGA
· querying the interpretation table for any desired surface(s) or thickness data,
that can be used for groundwater modeling applications
The final interpretation results may be queried for information such as layer
thickness at selected station(s), top elevation(s), bottom elevation(s), layer type,
name and description.
When you create a Data Query in the Query Builder, and expand the Description
data category, you will see the Interpretation Results table, as shown below:

©2022 by Waterloo Hydrogeologic

666

Hydro GeoAnalyst 11.0

The Interpretation Results table is read-only (also known as a View), and stores
data from the cross section interpretations. By default, the following fields are
included:
· Station ID
· Station Name
· X (using project coordinates)
· Y (using project coordinates)
· Slice Name
· Layer Description
· Top Elevation
· Thickness Below Slice
· Interpretation type
Simply select the desired fields from the tree view, and move these into the
Display Fields, or Conditions as required. When you are finished, Generate and
Execute the query. An example of the results is shown in the screenshot below.
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For more details on using the Query Builder, please see Query Builder section .

18.5

Adding Annotations to the Cross Section
Text labels, lines, and shapes can be added to any layer in the cross section. To
add annotations, you must select the layer, but NOT make it active (i.e. do not
check the active (edit) check box). Once the layer has been selected, right-click
and select Annotations from the list of options. The Edit options shown in the
following screenshot can be used to add, edit, and delete text, lines, and polygons.
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To add an annotation, select the appropriate option from the list to enter Edit
mode, then click the corresponding button from the toolbar. You can then user
your mouse to select the location to add your annotation. After adding an
annotation, you will need to click on the corresponding button again to add another
annotation of the same type.
NOTE: If you are adding/editing/deleting one annotation type, you must right-click
on the selected layer and either switch between annotation types, or de-select the
current annotation type, otherwise you will remain in Edit mode for the selected
annotation type. Upon deselecting/switching annotation types, you will be
prompted to save your changes.

Add Text
To add text:
Select the Edit Text option from the pop-up menu.
Click on the
Text button on the toolbar
Click on the desired text location in the cross section window
Enter the text in the Input text window that appears.
Once a text box has been created, it can be moved by clicking-and-dragging, or
edited by double-clicking on the existing text. Text can be deleted by right-clicking
on a text box and selecting the Delete option. All text added to a layer can be
deleted by right-clicking and selecting the Delete-All option.

Add Lines
To add Lines:
Select the Edit Lines option from the pop-up menu
Click on the
Draw Line button on the toolbar
Click once on the desired line location in the cross section window, and simply
drag and click to create a line with several vertices.
A vertex can be added to an existing line by right-clicking on a line and selecting
the Add vertex option. A line can be deleted by right-clicking on a line and
selecting the Delete option. All lines added to a layer can be deleted by rightclicking and selecting the Delete-All option.

Add Polygons
To add polygons or rectangles,
Select the Edit Polygons option from the pop-up menu
Click on the
Draw Polygon or Rectangle buttons on the toolbar
Insert the mouse cursor at the desired location
Click-and-drag the mouse to create the desired shape (double-click in the case of
a polygon to finalize the shape).

Settings
The Settings dialog for Annotations is displayed below:
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For each Annotation type, you may show/hide using the Visible check box, or edit
the display properties by clicking on the preview in the Symbol column. You can
modify the standard properties for Text, Line and Polygons.
To save the annotation changes you have made, you can either deselect/switch
annotation types, or click the Save button from the button bar.

18.6

Limitations
Although the cross section component currently allows creating complex,
overlapping, zig-zagging interpretations, these types of interpretations are not
suitable for the purpose of saving (and later querying) in the database. As such,
the following rules/limitations are enforced to avoid saving such results in the
database:
· A given layer may not be allowed to intersect a given station more than twice.
·
·
·

·

When this rule is violated, HGA will consider the two top-most intersection points
as defining the layer
All layers in a cross section must be uniquely identified by the layer name. HGA
may pick the top most layer and ignore all other layers with the same name.
If a station is removed from a cross section, related saved interpretations
(contacts) are removed as long as this station is not involved in any other cross
sections;
If a layer is deleted from a cross section, all related interpretations (contacts) are
removed from all stations that are involved in the cross section as long as this
layer does not appear in another cross section for any of the stations involved in
the current cross section;
If a given well appears in more than one cross section, interpretation results are
updated with interpretations from the cross section that is last updated.
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Scene Viewer
The Scene Viewer allows you to visualize your data in 3D space to get a better
understanding of your entire project. Launch it by selecting the
button in the main
toolbar and it will launch as a tab. Unlike other modules in HGA you are able to launch
multiple scene viewers at once - so you can visualize multiple scenes at once.

Data you can load:
·
·
·
·
·
·
·

Station Groups
Cross Sections
Plumes
DXF files
Image files
Shape Files
Surfaces
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Scene Viewer Interface
When you launch a new scene in the Scene Viewer it will appear empty and ready for you to
add data to it.
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You will find the following options in the toolbar above the Scene tree:
provides you with options for adding data to the scene
allows you to delete the selected item from the scene
lets you save the scene so it can be recalled later
lets you save the current scene with a new name
allows you to save the current scene as an image file (*.bmp)
allows you to print the current scene to a Power Point template
allows you to refresh the Scene tree
allows you to filter for anything in the Scene tree - simply start typing the name of the
item you are looking for
allows you to clear the filter on the Scene tree
allows you to dock the Scene tree on the left
allows you to dock the Scene tree on the right
allows you to collapse all branches in the Scene tree
allows you to expand all branches in the Scene tree
There are additional options available in the toolbar above the Scene:
allows you to zoom in
allows you to zoom out
lets you rotate on the axes within the scene
lets you pan within the scene
resets the view back to home
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allows you to show or hide the axes within the scene
You also have the option to adjust the vertical exaggeration of the scene
.
Once you have loaded a plume into the scene you will find additional options available in the
toolbar above the scene:
There are sliders for both the current time as well as the speed option
allows you to play the plume in a continuous loop
provides options for time settings including the start and end dates as well as label
options

19.2

Adding Data to a Scene
Once you have opened/create a new scene you will want to add data into it. You can drag
and drop your Station Groups or Cross Sections (one at a time) from the Project Tree into
the scene. Or you can use the
button to add multiple items at once.
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This dialog allows you to add project items like Station Groups, Cross Sections, and Plumes
in the top half of the dialog.
Double clicking on an item will move it from the Project Items over to the Scene Items. You
can also use the blue arrows ( or
).
In the bottom half of the dialog you can add external files like:
· DXF files (*.dxf)
· Surface files (*.asc, *.txt, *.grd, *.dem)
· Image files (*.bmp, *.tif, *.jpg, *.png)
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· Shape files (*.shp)

You can add multiple external files by selecting the
and browsing to them. Select multiple
files at once and they will all be added to the dialog and then to the scene when you select
OK.
·
·
·
·
·
·
·

19.2.1

Station Groups
Cross Sections
Plumes
DXF files
Image files
Shape Files
Surfaces

Station Groups
When you load a station group into a scene an item will be placed into the Scene tree under
the Stations Groups branch and this is where you can access the settings for how that
particular Station Group is displayed in the scene.

These settings include whether or not to show labels (station names) the size and colour of
the labels as well as an option to show the Lithology of the stations (based on the soil type
field in the Lithology table (Geologic Description category) and the Material Specification set
for the project).
Angled or deviated stations can be displayed in the Scene - the inclination and azimuth are
taken from the Drilling Protocol table (Well Construction category) to display these wells.
The settings for the legend for ALL Station Groups loaded into the scene will be found by
selecting the Station Groups branch of the Scene tree.
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These settings include whether or not the legend is visible as well as the size of the items in
the legend background colour and location of the legend in the scene. The location can be
adjusted using the Horizontal location and Vertical location settings by entering values
between 0 - 100 as a percentage of the Scene window.

19.2.2

Cross Sections
When you load a Cross Section into a scene a node will be added under the Cross Sections
branch of the Scene tree for each cross section. The main Cross Sections branch of the
scene gives you access to the Interpretation type setting as well as the settings for the
Legends. When you load a Cross Section into a scene you will notice there are 2 legends.
One for the Cross Sections (interpretations) and one for the Stations.
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The Legend for the Cross Sections displays the material images that were used for the
interpretation of the cross section. While the Legend for the stations displays the soil type
images for the stations that are used in the cross sections. The legend for the stations of the
cross section are combined with the legend for any Station Groups that have been loaded
into the scene.
The interpretation type can be adjusted to display any of the available interpretations done
for the cross sections - Geology, Hydrogeology or Model.
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The settings for the legends include the title, size of the legend entries, text color,
background color, etc. Also the location of the legend can be adjusted using the Horizontal
location and Vertical location settings by entering values between 0 - 100 as a percentage of
the Scene window.
When you load a cross section you will be able to toggle the stations and the interpretations
on and off with the check box for each of these items as they are sub nodes for each cross
section.
And you can turn the entire cross section off by using the visibility check box beside the
name of the cross section.

19.2.3

Plumes
You can load one or more plumes into a scene. Each plume will have its own node under the
Plumes branch of the scene tree. By default when you load a plume an isosurface will be
created and loaded for this plume. Here for example is the BTEX plume from the Demo
Project.

When select you select the name of the plume in the scene tree you will find the settings for
the Legend including the title, color, entry size and location. As well as the options to add
Isosurfaces and color maps.
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Additionally you have options to edit the default color scheme that has been generated for
the plume.
When selecting to add an isosurface you will simple need to provide a name and a value and
then you can select the color for the isosurface - or by default the color from palette will be
selected. This means depending on the value you enter for the isosurface - the appropriate
color will be selected.

The Show border option when selecting will mean that the isosurface is shown as a
continuous object even when it extends outside the bounds of the grid using during the
creation of the plume.
You can add as many isosurfaces as you would like to the scene. Once you have created an
isosurface these same settings can be found by selecting the isosurface sub node on the
scene tree. You will also find an estimate of the volume of the isosurface in the settings.
When selecting the add a colormap you will have several options.
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You can create colormaps on a North-South slice or an East -West slice. Additionally you
can create a Horizontal slice color map. And finally you can also use a Cross Section (which
has been loaded into the scene) to display your color map.
Once you have created the color map another sub node is added to the plume node. From
here you will find the settings to adjust the color map line and labels.
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You will also find the settings for the transparency of the color map and the clip value. When
you enter a clip value - any part of the color map below the clip value will be removed. Here
for example you can see the BTEX color map clipped at 5000.

©2022 by Waterloo Hydrogeologic

682

Hydro GeoAnalyst 11.0

To edit the colormap palette select the ... button and you will find the following dialog:
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From this dialog you can adjust the number of classes and adjust the style from Stretched
(where the colors blur from one to the next) to Classified (where there are distinct bands of
colors).
You will also find preset options for Equal intervals, Log intervals as well as an option to
return to the default settings.
Once you have added a (transient) plume to the scene you will also notice that some
additional options are available on the toolbar on top of the scene window.
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It displays the current time on a slider bar and gives an option for you to play
the plume
through time. There is also a loop option which will continue the animation over and over
until the pause button is selected. There is also a slider bar option to adjust the speed of the
animation of the plume. As well as an option to adjust the time settings :
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The Time tab of the Time Settings displays the start and end of the plume (or if multiple
plumes have been loaded the start of the earliest plume and the end of the latest plume). As
well as an option for the number of intervals along the timeline to display. Less intervals will
make the animation skip through time quicker while more intervals will mean more steps
through the timeline.
The label tab gives you the settings to adjust the time label size, color location etc.

19.2.4

DXF files
When you load DXF files into the Scene they will appear under the Site Maps node of the
Scene tree. Each DXF file will have its own node.
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When you select the name of the dxf you will find the associated settings. By default it will
load with the color designated within the file - however you can change this by selecting Yes
for Custom Color and then select a new color to use for displaying the DXF. Similarly, the
DXF will display using the elevation designated within the DXF file - however you can
overwrite this by selecting Yes for Use custom Elevation. This allows you to place the DXF
file at any elevation within the scene.
You can also change the name of the dxf (by default it uses the file name).
The scene viewer supports 3D DXF files as well as the following DXF entities:
§
§
§
§
§
§
§
§
§
§

LINE
POLYLINE
LWPOLYLINE
FACE3D
SOLID
CIRCLE
ARC
BLOCK
INSERT
TEXT

Please Note: If you are encountering difficulties displaying your DXF it may be due to
unsupported entities (like SPLINE or 3DSOLID) or the DXF was created by a third party
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writer that does not adhere to AutoCAD DXF standards or was created in a very old version
of AutoCAD.

19.2.5

Image files
When you load image files into the Scene they will appear under the Site Maps node of the
Scene tree. Each image file will have its own node.

When you select the name of the image file you will access the associated settings. You can
enter adjust the transparency as well as the elevation. By default if nothing else is loaded
into the scene an image will load at an elevation of 0. Otherwise it will load at the bottom of
whatever other items have been loaded into the scene.

Please Note: Image files must have the associated georeferencing file in the same
folder as the image in order to be brought into the scene.
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Shape Files
When you load Shape files into the Scene they will appear under the Site Maps node of the
Scene tree. Each Shape file will have its own node.

When you select the name of the shape file you will access the associated settings. You
have 3 options for the elevation - by default it loads using the source elevation. However,
you can adjust this to use a specified value or you can drape the shape file over a surface
which is already loaded into the scene.
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All elements of the shape file have associated settings including the Labels, Lines, Points
and Polygons. You can turn each element on or off, adjust the colour, size/width.

19.2.7

Surfaces
When you load surface files into the Scene they will appear under the Surfaces node of the
Scene tree. Each surface file will have its own node.
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When you select the name of the surface you will access the associated settings. Under the
Colors section you can choose to display the surface as a color map or using a custom color
- and you can set the custom colour. By default surfaces are displayed as color maps. You
can adjust the color map palette from the colours selected by default. You can also set a
transparency for the surface.
To adjust the color map palette select the ... button and you will find the following dialog:
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From this dialog you can adjust the number of classes and adjust the style from Stretched
(where the colors blur from one to the next) to Classified (where there are distinct bands of
colors).
You will also find preset options for Equal intervals, Log intervals as well as an option to
return to the default settings.
You will also find settings for the Labels (size, color etc) for the Legend (title, color, entry
size, location etc.) and Lines (color, width, style etc).

19.3

Saving and Recalling Scenes
Scenes can be saved so that they can be recalled later. When you save a scene you will find
it in the Project tree under the Scenes branch.
To recall (or reload) a scene simple double click on it from the Project tree. And remember
you are able to open multiple scenes at once.
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3D Interpolation
The Scene Viewer is able to display and animate 3D volumetric plumes of one or more soil
or groundwater contaminants. The plume is generated using the 3D Interpolation tool, then
displayed with the Scene Viewer. The following section describes how to interpolate 3D
points data in order to create 3D plumes; for details on viewing the plume, see the Scene
Viewer section.
The 3D Interpolation starts with a data set - the data set must be created by building,
executing, and saving a query with the Query Builder. The query should contain the data set
your are interested in analyzing, along with the fields containing the data required by the 3D
Interpolation, which include the following:
·
·
·
·
·

X-Coordinate
Y-Coordinate
Z (elevation of sampling point)
Value (concentration value for one or more contaminants)
Sample Date (if transient plume display is desired)

The Z value should be a field that represents the depth or elevation at which the data value
(sample) was observed. If you want to display the plume on the same elevation scale as your
cross sections (where data are displayed as an elevation) you may need to convert your
sample depths to sample elevations. This can be done in the query builder, by adding a
calculated display field, as shown below:
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The last display field in the screenshot above, combines the sample elevation, and the
screen depth (from) fields; the screen depth is subtracted from the station elevation (or
station TOC elevation if desired), using the Expression below:
Expression: station.elevation - soil_sample.end_depth
Alias:
Z
Executing this query, will produce the results shown below:
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The last column displays the calculated sample elevations (Z). This value should be mapped
to Z in the 3D Interpolation to generate your plume.

Please Note: It is recommended that the X, Y, and Z fields
all be displayed with the same length units.

Once you have created a data query, you may use the 3D Interpolation module to generate
a plume. To access the 3D Interpolation tools, select Tools / 3D Interpolation from the main
menu, and the following dialog will appear:
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In the 3D Interpolation window, specify the various settings related to the grid size, extents,
and data mappings.

3D Plume Project Name: Define the plume project name. One plume project can contain
multiple plumes (e.g. for one or more contaminants).

Data Source
Define the various properties relating to the data source:
Data Source: select a field from the data query that contains the data to be interpolated
(e.g. concentration, or result value)
Name: define a name for the parameter
Date Field: select the field that contains the sampling date (if available)
Date Granularity: This option controls how to accumulate the data items of various date
stamps. For example, assume you have data for the following sample dates (could be
from the same, or other stations):
· 5 stations sampled on 03/05/99
· 6 stations sampled on 03/14/99
· 4 stations sampled on 03/19/99
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·
·
·
·

5 stations sampled on 03/27/99
6 stations sampled on 04/04/99
5 stations sampled on 04/15/99
4 stations sampled on 04/25/99

If you select Day for date granularity, you will obtain 7 data sets to interpolate.

If you select Month for date granularity, you will obtain 2 data sets to interpolate:
20 stations sampled in March, and
15 stations sampled in April
In this case, the first observation from a station will be selected.
If you select Year for date granularity, you will obtain only one data set, which will effectively
result in a static plume for this dataset. In this case, the first datapoint from each
station/depth-interval sampled in 1999.

Grid Region
Define the various properties relating to the grid size:
· X Value: select a field from your query to be used for the X axis
· # of nodes: define the number of grid nodes in the X direction
· X min, X max: define the minimum and maximum X values for the interpolated grid; by

default, these will be read from the data source, however you may modify these values
if necessary
· Similar parameters exist in the Y and Z directions.
Interpolation Method:
Available interpolation methods include:
· Krigging (default), and
· Inverse distance

[Advanced Settings]: Press this button to see advanced settings for the selected
interpolation method. For more details, see " Appendix B: Advanced Interpolation Settings".
Interpolate log values: This option will interpolate the log values of the data points and then
invert the log value distribution. This option is useful when interpolating data with a high
degree of variance.
When you are finished, click on the [OK] button.
HGA will create a 3D plume file, in the "Plumes" sub-directory for your project, with the file
name provided, and the extension .nc. For example, TVOC.nc, in the directory:
D:\Program Files\HGAnalyst\Projects\Demo_Project\Plumes
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To display the plume, proceed to the instructions in Scene Viewer.
In addition to the *.nc file, HGA will save a *.txt file that stores the results from the query (x,
y, z, value) that is used by the interpolator in generating the interpolation using the same file
name, and in the same "Plume" sub-directory.

Please Note: Currently there is no method of opening plume
projects in the Interpolation tool to make modifications.
Therefore, it is suggested that you save the data query so
the 3D Interpolation can be quickly re-created if necessary.
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User Manager

Please Note: Only users with the "Full access" (db_owner)
permission level, as described below, may open and use the
User Manager module.

The User Manager module provides a simplified interface for managing user access and
permission levels to your Hydro GeoAnalyst project databases. The User Manager allows
you to add, remove, and set user permissions to preconfigured access levels in the
database. However, access is ultimately managed by SQL Server itself and HGA will defer
to/rely on permissions stored on the SQL Server instance hosting the project database, so
advanced users familiar with SQL may manage permissions more precisely. This provides a
compromise between useability for beginner users and flexibility/control for advanced users,
while providing all of the enhanced/enterprise-level security features available through the
Microsoft implementation of SQL and related tools. An example of the User Manager module
interface is shown below:

Toolbar
The User Manager toolbar contains the following controls:

Adds a new user or group.
Deletes the currently selected user or group (note: you cannot delete your own
account)
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Edits the permission levels for the selected user or group

User Table and Permissions
The main window of the User Manager module includes a table of project users with
headings for account information and associated permissions.
Hydro GeoAnalyst Account Information
· Name: the user or role defined within the settings of the database itself.
· Server Login: the user or role defined under the main Security settings of the SQL

Server instance. Only those users or roles with a corresponding name in the current
project database will be displayed.
Permissions
Users may be granted a combination of preset user permissions, ordered in terms of
increasing control over the data:
· Read access: provides the user with the db_datareader level of access in the

database and allows the user to read database records. In practice, this means that
users can view data in most of the modules but not modify records. Certain modules
require edits to the various tables including creating/modifying plot collections, saving
queries, and creating cross-sections and maps. Users with only read-level access
have very limited ability to use Hydro GeoAnalyst.
· Edit access: provides the user or group with the db_datawriter level of access in the

database and allows the user or group to add/remove/edit database records. In
general, users with both Edit and Read access can use all of the functionality of HGA
except for the ability to use the Template Manager module, User Manager module, or
make backups.
· Template Access: provides the user or group with the db_ddladmin level of access in

the database and allows the user or group to modify the database template (i.e. make
changes in the Template Manager module). Users with Template access may not
make changes in the User Manager module or make backups.
· Full Access: provides the user or group with the db_owner level of access in the

database and allows the user or group complete control over the project database,
including all of the functionality provided in the template access level above and the
ability to add/remove users and backup the database.
Generally, users should only be given the permission level(s) they require to complete their
assigned duties. Users with higher-level permissions should generally also be given lowerlevel permissions (e.g. a user requiring Template access should also be granted Read and
Edit access).
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As discussed above, advanced users may wish to provide alternate/custom permission
levels to users or groups. These permission levels will be honored by Hydro GeoAnalyst.
Users and groups with permission levels exactly matching the presets and related
security/permission settings available in Hydro GeoAnalyst will be displayed in User Manager
module. If permission levels/settings for a given user configured outside of Hydro
GeoAnalyst, user permission levels may not appear as expected. For more information on
database level roles, please refer to the Microsoft SQL Server documentation here:
https://docs.microsoft.com/en-us/sql/relational-databases/security/authenticationaccess/database-level-roles?view=sql-server-ver15

Adding a new user
To add a new user, select the add user button

and the following dialog will appear.

There are three types of user you may add in any combination, provided that the host SQL
Server instance is configured to allow such login methods to work:
· Windows User or Group
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· SQL Server Login

which are described below:
Windows User or Group
User accounts and passwords for individual users or windows groups will be managed using
Windows Authentication. When using this option, you may only add existing users or groups
on a Windows domain and will be warned if the domain, user account, or group cannot be
found. Adding a Windows User or Group using the User Manager will assign dbo as the
default schema for all users in that group. Otherwise HGA, will assume the dbo schema
when creating new tables using the Template Manager for users with Template access.
SQL Server Login
The user account will be managed by SQL Server. When using this option, you have the
option to add existing users or create a new user along with a corresponding password.
HGA creates a user in SQL Server Instance and adds them as a user in the project
database with the assigned permission levels. Hydro GeoAnalyst provides the option to
create a SQLServer login for a new user if it doesn’t exist. One implication for this method is
that the user may have broader access to any databases on the server instance and to the
instance itself. This method is likely more desirable for users who need access to multiple
databases on a server instance.

Please Note: SQL Server user account passwords are
subject to the SQL Server password policy as specified in
the following link: https://docs.microsoft.com/enus/sql/relational-databases/security/password-policy.

Editing permission levels for an existing user
To modify an existing user, select the Edit Selected User button
. You will be presented
with the option to modify the selection(s) of permissions for the selected user:
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Please Note: Users cannot delete or modify their own
permissions.
Modifying the permissions of a fellow db_owner in HGA will
remove them from the db_owner group in SQL Server. HGA will
warn users who are about to do this.

Removing an existing user
To remove an existing user, select the Delete Selected User button
prompted to confirm the deletion.

. You will be

Please Note: Users cannot delete or modify their own
permissions.
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Sample Module
Modules specifically related to Samples in Hydro GeoAnalyst 11.0 can be found in this
menu. Each module is summarized below and explained in further detail in following
sections:

Sample List
The Sample List provides an interface for managing samples and results. The following
features are available:
·
·
·
·

Adding, deleting, and editing samples
Adding, deleting, and editing results for the active sample
Comparing results to active Water Quality Standards
Creating static sample sets

Sample Analysis Viewer
The Sample Analysis Viewer tab provides a read-only viewer and fitler tools to display
analytical data associated with the active Station, active Sample Set, or selected Samples. In
addition to information from the Analytical table, this tab optionally displays fields Station and
Sample tables.

Water Quality Standards
The Water Quality Standards tab allows you to work with water quality standards in your
project. The following features are available:
· Save, edit, and delete a water quality standard
· Import a Water Quality Standard from Excel or delimited text files
· Add, edit, delete water quality criteria for given parameters
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Sample Reports
The Sample Report tab allows you to create custom tabulations of your samples and their
results based on one or more criteria including: station, sample date ranges, parameters or
groups, and/or exceedances of one or more active Water Quality Standards. The report can
also produce general statistics for samples included in the report.

Calculate Water Type
The Calculate Water Type menu item allows you to determine the major ionic constituents in
your sample(s) based on the results and specified parameters.

Calculate Parameter Values
The Calculate Parameter Values menu item opens the Calculate Parameter Values window
and allows you to create and evaluate mathematical expressions including parameter values
and save the result as to a Sample Parameter or a Sample Result parameter that has been
so enabled in the Template Manager. For more details, please refer to the Calculate
Parameter Values section.

Find duplicate Analyses
The Find Duplicate Values menu item will search the project for duplicate results of the same
parameter on the same sample. This condition was allowed in older versions of AquaChem
(i.e. version 2014.2 and older) and may cause problems when working with data imported
into HGA. Selecting this menu option will search your project for such conditions and
provide a window that allows you to review and remove such duplicate results.

22.1

Sample List
The Sample List tab provides an overview of the samples in the selected Sample Set or
Station Group. This tab displays fields from the Sample table (left) and also displays results
for the active sample, as denoted by the
symbol in the sample table (right). Note that
results with values that exceed an active Water Quality Standard will be color coded.
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Toolbar
The Sample table and results viewer toolbars in the Sample List tab contain the following
controls:

Sample Table Toolbar

Sample Results Toolbar - Measured

Sample Results Toolbar - Calculated

Navigates data pages; skipping to the first page (in the
sort order), to the previous page, to the specified page, to the next page or to the last
page.
Adds a new record (i.e. sample or result) to the appropriate table.
Deletes the currently selected record(s) from the project database.
Saves the changes you have made to the project database.
Allows you to select which columns you want to show or hide in the sample table.
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Toggles the width of the table either stretch to fit the view or allow a horizontal
scrollbar.
Refreshes the data from the project database.
Exports the data from the applicable table to an unformatted Excel file.
Exports the table to a selected Excel workbook based on a selected template.
Calculates the water type for the selected record(s).
Calculates the water type for all records in the sample list.
Splits the sample table and results viewer horizontally.
Splits the sample table and results viewer vertically.
Provides the option to display concentration results using a single/consistent unit for
all applicable parameters in the results viewer.
Provides the option to display the active water quality standards.
Allows you to filter displayed results to the selected
parameter group.
Opens the calculation settings.

Working with the Data
The first line shown on the sample table in the Sample List Tab contains field names/column
headers; below this is the filter line, which is highlighted in light blue and denoted by the
clear filter button (
) in the left-most column. The filter line can be used to restrict records
to display based on the values in one or more field and is described in detail in the Data
Filtering section.
You can select one or more records (that will turn bright blue) in the data table by clicking on
the buttons on the left-hand side of the grid (using the <SHIFT> and <CRTL> keys for
selecting multiple records). You can perform the several actions by right-clicking on the
selected record(s) in the currently displayed table, including showing/hiding fields and
records, copy, paste, adding the selected station(s) to a new/existing station group,
refreshing the data from the project database, and resizing the columns to fit the station list
table within the current workspace.
Values in the data fields may be modified for a selected sample (simply click in the cell you
wish to edit); or a new sample may be created here (selecting the
icon), and the values
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for these fields may be defined. The Sample List tab may be used to quickly enter numerous
samples and their results.

22.2

Sample Analysis Viewer
The Sample Analysis Viewer tab provides information about all of the samples collected
samples in the selected Sample Set or Station Group. This tab displays fields from the
Sample table (left) and also displays results for the active sample, as denoted by the
symbol in the sample table (right). Note that results with values that exceed an active Water
Quality Standard will be color coded.

Toolbar
The Sample table and results viewer toolbars in the Sample List tab contain the following
controls:

Sample Analysis View Toolbar

Navigates data pages; skipping to the first page (in the
sort order), to the previous page, to the specified page, to the next page or to the last
page.
Allows you to select which columns you want to show or hide in the sample analysis
table.
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Refreshes the data from the project database.
Exports the data from the applicable table.
Exports the table to a selected Excel workbook based on a selected template.
Allows you to configure the view including the data source, whether or not to display
fields from the station or sample tables, and pick highlight colors for column headers.

Working with the Data
The first line shown on the sample table in the Sample List Tab contains field names/column
headers; below this is the filter line, which is highlighted in light blue and denoted by the
clear filter button (
) in the left-most column. The filter line can be used to restrict records
to display based on the values in one or more field and is described in detail in the Data
Filtering section.
You can select one or more records (that will turn bright blue) in the data table by clicking on
the buttons on the left-hand side of the grid (using the <SHIFT> and <CRTL> keys for
selecting multiple records). You can perform the several actions by right-clicking on the
selected record(s) in the currently displayed table, including showing/hiding fields and
records, copy, paste, adding the selected station(s) to a new/existing station group,
refreshing the data from the project database, and resizing the columns to fit the station list
table within the current workspace.
Values in the data fields cannot be modified in this view. You must modify values in the
Sample List, Station List, or Station Data tabs.

Configuring the Sample Analysis View
Selecting the settings
button in the Sample Analysis View will open the Settings dialog
(shown below), which has the following options:
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· Source Data: choose which data are shown in the Sample Analysis view table.

Available data sources are the active station, active sample set, or selected samples.
These can be selected using the Sample Picker or Station Picker as appropriate.
· View Options: show/hide fields from the Sample table and/or the station table.
· Highlight column headers: optionally define highlight colors for the Sample Analysis,

Sample, and Station (location) tables.

22.3

Water Quality Standards
The Water Quality Standards view allows you to manage Water Quality Standards in the
current project in Hydro GeoAnalyst. The options in this view allow you to see and modify
water quality standard criteria and create or import new sets of standards. These standards
are used throughout Hydro GeoAnalyst, including in the Results pane of Sample List view,
when adding parameter-based conditions to the Query Builder, and building a Sample
Report. Multiple standards can be made active in the project, allowing you to check values
against a mix of criteria across jurisdictions (Federal, State/Provincial, local) or target
receptors (human health: drinking water, dermal contact, etc. or the environment).
Parameter values exceeding their respective water quality standards will be highlighted using
a color code specific to each water quality standard when displaying the data throughout
Hydro GeoAnalyst. Measured parameters which exceed these pre-defined levels are
highlighted in predefined colors depending upon specified preferences. This allows you to
quickly identify sample exceedances and water samples which may be harmful to human
health or the environment.
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The Water Quality Standard view can be accessed by selecting Samples > Water Quality
Standards from the Main Menu.

Toolbar
The main toolbar of the Water Quality Standard view contains the following controls:

·

Create a new standard: create a new water quality standard.

·

Import: imports a water quality standard from an existing file.
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Save changes: saves changes to the current water quality standard.
Standard Dropdown Menu: Allows you to
specify the current selected water quality standard, which will be shown in the Water
Quality Standard viewer to view and/or modify.
Delete standard: deletes the currently selected water quality standard.
Refresh: refreshes the currently selected water quality standard from the
database and discards any unsaved changes.

Creating a New Water Quality Standard
To create a new water quality standard, select the
Create a new standard button. You
will first be prompted to provide a (short) name for the standard that will be used to identify
the standard in the database and in the Standard Dropdown Menu (e.g. New WQS):

Once you have entered a name, Click
blank water quality standard that you can edit:

and Hydro GeoAnalyst will create a new

For more information, see the section on editing existing water quality standards.
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Importing a Water Quality Standard
To create a new water quality standard by importing the standards from an external file,
select the

Import button to open the Import Water Quality Standard window:

At the Import Water Quality Standard window, you must enter the following information to
complete the import:
· Name: a (short) name for the standard that will be used to identify the standard in the

database and in the Standard Dropdown Menu;
· Select file to import: enter the full path of the file to be imported or select the

button to navigate to the file. Note that excel (.xlsx, .xls) and comma delimited text files
(.csv) are supported;
· Worksheet (shown if importing an Excel file) allows you to select which worksheet to

import;

· Delimiter (shown if importing a text file) allows you to select which delimiter(s)

separate the data fields to be imported;
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· Header row: the row containing headers for the data fields to be mapped
· Start Importing data using row: the row where the data starts (default = 2)

Below these inputs, you will be shown a preview of the data to be imported. Click
to proceed.

Map Columns
At this step in the import process, you will be asked to map the following fields in the
standard to be imported:

· Parameter*: the parameter to which the standard applies
· Unit*: the unit of measurement of the standard for the given parameter. If the unit is

different from the specified of the parameter in the project but of the same unit
category, it will be converted at the edit window.
· Upper limit*: the value above which the parameter will exceed the standard
· CAS: the Chemical Abstract Service (CAS) number of the parameter. The CAS

number will be used to match parameters where the project parameter and imported
standard parameter name do not match exactly.
· Lower Limit: the value below which the parameter will not comply with the standard. If

not specified, the lower limit will not be considered in the project.

Please Note: fields marked by an asterisk (*) are required, you must map these
fields in order to finish importing the standard.
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Click
to finish the import. Once the standard has been imported, it will be shown
in the Water Quality Standard view and you can review and edit the standard as necessary.
Editing an Existing Water Quality Standard
The currently selected water quality standard (i.e. the standard that is selected in the
Standard Dropdown Menu) will be shown in the Water Quality Standard view, which
consists of two parts: the left side contains a list of the properties of the currently selected
standard, while the right side contains a list of the criteria of the currently selected standard.

Standard Properties
The left side of the Water Quality Standards view shows the properties of the currently
selected standard:

· Active: a Boolean (True/False) variable that allows you to specify if the standard is

active. Standards that are active (i.e. Active = True) in the project will be available
throughout Hydro GeoAnalyst including in the results pane of the Sample List, when
adding conditions to the Query Builder, building a Sample Report, and adding Plots.
Standards that are inactive (i.e. Active = False) will be unavailable in these features
· Description: a description of the Standard. You may include pertinent information

about the standard in this field such as the data of applicability, references,
promulgating agency, etc.
· Exceedance color: a color picker control. The color you chose will be used to

highlight cells where parameter values exceed the standard.
· Factor: a value from 0 to 1 (default =1). All values in the standard will be multiplied by

this value, which can be used to add a factor of safety when evaluating parameter
values against the selected standard
· Name: the name of the water quality standard
· Short Name: an abbreviated name for the water quality standard
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Standard Parameter Values
The right side of the Water Quality Standards view shows the standard criteria table and a
toolbar:

Standard Criteria table
The standard criteria table includes the following six columns that describe the criteria in the
standard:

Imported Standard Criteria Fields - the following columns are populated when
importing a standard and are not editable:
· Standard Parameter: the name of the imported parameter
· Standard: the value of the criteria for the given imported parameter
· Unit: the measurement unit of the imported parameter

Hydro GeoAnalyst Standard Criteria Fields - the following columns are editable and
are the actual standards that your project will use:
· HGA Parameter: the name of the parameter in the project. Only mapped parameters

in this column will be used elsewhere in the application. To map a parameter, click in
the cell and you can select the parameter using the parameter picker.
· Effective Standard: the value of the criteria for the given project parameter. Values

will only be shown for mapped parameters using the project parameter units
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· Unit: the measurement unit of the project parameter; can only be edited in the

Parameter Editor.

Edited criteria will be highlighted yellow ( ), while selected criteria will be highlighted in blue
( ).

Toolbar
The toolbar includes the following controls:
·

Add a parameter: adds a new row to the standard. If selected, a new row will
appear in the standard. You can click in the new row to select a parameter using the
parameter picker.

·

Remove selected parameters: removes the selected parameter(s) from the
standard.

·

22.4

Auto-map selected parameters: maps selected parameters.

Sample Report
The Sample Report provides you with the tools to build a customized summary of sample
results for a select set of samples that includes optional statistics and comparisons to one or
more active standards.
The Sample Report view can be accessed by selecting Samples > Sample Report from the
Main Menu.

Toolbar
The main toolbar of the Sample Report view contains the following controls:

·

Execute: builds the sample report based on the current criteria.

·

Save: saves the sample report.

·

Save As: saves a new copy of the sample report.

·

Refresh: refreshes the sample report and project database and discards any
unsaved changes
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Print Preview: provides a print preview of the sample report when viewing the
Pivot View or the Tabular View.
Export Data: exports the Pivot View or the Tabular View, whichever is active.

Settings View
The Settings View allows you to build the Sample Report by selecting a set of samples and a
group of parameters. The report may also include statistics about the set of samples for
each parameter and comparisons to one or more water quality standards.

Sample Selection
The left-most portion of the settings tab contains options to include the selected samples or
a selected sample set or station group.
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Parameter Selection
The middle portion of the Settings tab contains a parameter picker. Parameters can be
selected for use in the Sample Report by using the directional arrows:
·

add selected parameters to the Sample Report

·

add all parameters in the sample picker to the Sample Report

·

remove selected parameters from the Sample Report

·

remove all parameters from the Sample Report
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Statistics
The following statistics may be included in the Sample Report:

Standards
As part of the Sample Report, you may select one or more Water Quality Standards to
include in the report. Options include:
· All selected parameters: all parameters will be included in the sample report
· Only parameters with applicable standard(s): only parameters with an applicable

standard will be included in the sample report.
· Only parameters with exceedances: only parameters that exceed an

Only active water quality standards will be shown in the list of available standards.
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Pivot View
The Pivot view provides a structured view of the Sample Report. Columns will be shown in
the following order:
· Parameters: the names of parameters selected in the settings
· Unit: units of the project parameters
· Standards: water quality standards selected in the settings
· Samples: samples selected in the settings. A column for the qualifier, value, and data

flags will be shown for each sample. Values that exceed a standard will be highlighted
using the exceedance color of that standard
· Statistics: statistics selected in the settings

Tabular View
The tabular view provides a "flat" database view of the Sample Report that may be useful for
exporting to other applications.
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Calculate Water Type
The Calculate Water Type sub-menu that is accessible through the
Samples item in the
Main menu (and related functions in toolbar of the Sample List) allow you to calculate the
Water Type of a sample.

Theory
The Water Type, also known as the water facies, of a sample describes its major ionic
constituents. The Water Type of a given sample will be influenced by the interaction of the
water with the minerals that it has been in contact with. These types of interactions include
precipitation, dissolution, ion exchange, geological structure, and the mineralogy of
watershed/aquifer.
The Water Type is determined by calculating the percent contribution of each cation and
anion to the total concentration of ions in solution on a equivalents per liter basis. In Hydro
GeoAnalyst, you can calculate a "short'" water type or a "long" water type. The "short" water
type is calculated by concatenating the cation and anion with the highest equivalent
concentrations. The "long" water type is calculated by concatenating cations and anions with
concentrations above a specified percent contribution threshold.
The threshold for determining if an ion is major is normally 10%; however in some countries
12.5% is more common. the higher the threshold, the smaller number of parameters that
may exceed this threshold is. Usually, only major ions (Na, Ca, Mg, HCO3, Cl, SO4) will
have a concentration that allows them to exceed the defined threshold. If you want to make
sure, that other important elements such as potassium or nitrate appears in the water type
expression, then you can achieve this by lowering the threshold value. Examples of short
and long water calculations are shown in Table 1 below.

Table 1. Major Ions and Water Type for Example Samples
SAMPLE
MW-1-04

MW-2-07

OW-3-04

OW-4-05

Na+

3.74 (15%)

1.96 (5%)

10.66 (28%)

0.22 (1%)

K+

0.06 (0.2%)

0.06 (0.2%)

0.05 (0.1%)

0.05 (0.1%)

Ca2+

6.74 (26%)

14.72 (40%)

6.29 (17%)

13.65 (34%)

Mg2+

1.93 (8%)

1.50 (4%)

1.70 (4%)

10.81 (27%)

Cl-

3.61 (14%)

0.90 (2%)

9.90 (26%)

0.23 (1%)

HCO3-

2.13 (8%)

9.51 (26%)

2.46 (6%)

2.48 (6%)

CO32-

0.46 (2%)

0.53 (1%)

0.41 (1%)

0.55 (1%)

SO42-

6.77 (27%)

7.31(20%)

6.42 (17%)

12.28 (30%)

Cations

Anions
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SAMPLE
MW-1-04

MW-2-07

OW-3-04

OW-4-05

Short

Ca-SO4

Ca-HCO3

Na-Cl

Ca-SO4

Long (20%)

Ca-SO4

Ca-HCO3-SO4

Na-Cl

Ca-SO4

Long (10%)

Ca-Na-SO4-Cl

Ca-HCO3-SO4

Na-Ca-Cl-SO4

Ca-SO4

Water Type

Menu Commands
The options in the menu include:

Calculate the water type:
· For the active sample set: calculates the water type for the active sample set, that is

the sample set shown in the sample list
· For all samples: calculates the water type for all samples in the project database
· Settings...: opens the Water Type tab in the project settings window and allows you to
configure how the water type will be calculated.
Water Type Toolbar Commands in the Sample List
The Sample List view also contains buttons to help you calculate the water type for samples
in the active sample set:
Calculates the water type for the selected record(s).
Calculates the water type for all records in the sample list.
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Calculate Parameter Value
The Parameter Calculator allows you to create and evaluate simple to complex mathematical
expressions:

Parameter to Calculate
The
button below the "Parameter to calculate" label allows you to select the
parameter that will be calculated.using the parameter selection window. Only the following
types of parameter are allowed to be calculated:
· Sample Parameters: numeric fields in the Sample Table/Sample List
· Custom Calculated Parameters: parameters in the Sample Results table with the

calculation option enabled in the Parameter Editor module.

Scope
The
button below the "Apply to all samples in the following sample set: the
Parameter to calculate" label allows you to select the parameter that will be calculated.using
the parameter selection window. Only the following types of parameter are allowed to be
calculated:
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· Sample Parameters: numeric fields in the Sample Table/Sample List
· Custom Calculated Parameters: parameters in the Sample Results table with the

calculation option enabled in the Parameter Editor module.

Expression
The expression entry allows you to enter an expression on the left side. The expression can
be built using a combination of parameters (see section below) or mathematical expression
components. For example an approximation of alkalinity is the sum of bicarbonate and
carbonate (expressed in equivalents per liter) and converted to the equivalent concentration
of calcium carbonate:

PAR[HCO3 AS meq/L] + PAR[CO3 AS meq/L] * 100
Parameter Picker
On the right side of the expression builder, you can select a parameter and a desired unit.
Upon selecting the desired parameter (and optional unit), select the "Add parameter to
expression" button. This will add the parameter as "PAR[ ]" with optional units at the
location of the cursor. For example, adding HCO3 with units of milliequivalents per liter will
be added as "PAR[HCO3 AS meq/L]".

Preview
You can preview the result of the expression for a selected sample:

Select
The
button allows you to pick a sample that will be used to evaluate the expression
for the preview.

Test
Clicking the
sample.

button allows you to preview the evaluated expression for the selected

Calculate
Clicking the
defined samples.

button evaluates the expression to the selected parameter for the
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Expression Components
The parameter calculator supports more than just simple expressions and includes support
for various number formats, operators and relations, many functions, constants, and random
variables. The following section includes a comprehensive listing of supported expression
components and syntax.
Number Formats
The following number formats are supported in expressions:
Key word

Description

Examples

Integer

Integer numbers

1, -2, 3

Proper decimal

Decimal numbers

0.1, -0.2, 1.3

Leading zeros

Integer / Decimal numbers
with leading zeros
Integer / Decimal numbers
without leading zeros
Decimal numbers in
scientific notation
Fractions

001, -000.2, 00001.3

Numbers in other numeral
bases

b1.111, b2.1001, b3.12021,
-b16.af12, h.af1, b.1001,
o.0127

No leading zeros
Scientific notation
Fraction
Other base

.1, -.2, .3
1.2e10, 1.2e+10, -3.2e-5,
2.eE+10
1_2, 2_3, 2_3_4, -2_4

Operators and Relations
Expressions support standard mathematical operators as well as boolean relations and
operators.

Mathematical Operators
The following mathematical operators are supported in expressions:
Key word

Description

Example

+

Addition

a+b

–

Subtraction

a–b

*

Multiplication

a*b

/

Division

a/b
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Key word

Description

Example

^

Exponentiation

a^b

!

Factorial

n!

#

Modulo function

a#b

%

Percentage

n%

^^

Tetration (hyper-4, power
tower, exponential tower)

a^^b

Boolean Relations
The following mathematical operators are supported in expressions:
Key word

Description

Example

=

Equality

a=b

==

Equality

a == b

<>

Inequation

a <> b

~=

Inequation

a ~= b

!=

Inequation

a != b

<

Lower than

a<b

>

Greater than

a>b

<=

Lower or equal

a <= b

>=

Greater or equal

a >= b

Boolean Operators
The following boolean (logical) operators are supported in expressions:
Key word

Description

Example

&

Logical conjunction (AND) p ~& q

&&

Logical conjunction (AND) p ~&~& q

/\

Logical conjunction (AND) p /\ q

~&

NAND – Sheffer stroke

p ~~& q

~&&

NAND – Sheffer stroke

p ~~&~& q

~/\

NAND – Sheffer stroke

p ~/\ q
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Example

|

Logical disjunction (OR)

p|q

||

Logical disjunction (OR)

p || q

\/

Logical disjunction (OR)

p \/ q

~|

Logical NOR

p ~| q

~||

Logical NOR

p ~|| q

~\/

Logical NOR

p ~\/ q

(+)

Exclusive or (XOR)

p (+) q

–>

Implication (IMP)

p –> q

<–

p <– q

<->

Converse implication
(CIMP)
Material nonimplication
(NIMP)
Converse nonimplication
(CNIMP)
Logical biconditional (EQV)

~

Negation

~p

-/>
</-

p -/> q
p </- q
p <-> q

Functions
Calculations support a large number of functions:
·
·
·
·
·
·
·
·

common mathematical functions
number format functions
logical functions
trigonometric functions
inverse trigonometric functions
hyperbolic functions
inverse hyperbolic functions
other functions

Common Mathematical Functions
The following common mathematical functions are supported:
Key word

Description

Example

ln

Natural logarithm function
(base e)
Binary logarithm function
(base 2)

ln(x)

log2

©2022 by Waterloo Hydrogeologic

log2(x)

729

730

Hydro GeoAnalyst 11.0

Key word

Description

lg

rad

Common logarithm function lg(x)
(base 10)
Common logarithm function log10(x)
(base 10)
Degrees to radians function rad(x)

exp

Exponential function

exp(x)

sqrt

Squre root function

sqrt(x)

deg

deg(x)

log

Radians to degrees
function
Logarithm function

root

N-th order root of a number root(rootorder, number)

add

Summation operator

add(a1, …, an)

multi

Multiplication

multi(a1, …, an)

log10

Example

log(a, b)

Number Format Functions
The following number format functions are supported:
Key word

Description

Example

abs

Absolut value function

abs(x)

sgn

Signum function

sgn(x)

floor

Floor function

floor(x)

ceil

Ceiling function

ceil(x)

not

Negation function

not(x)

ulp

Unit in The Last Place –
ulp(x)
ulp(0.1)
Returns true = 1 if value is isNaN(x)
a Not-a-Number (NaN),
false = 0 otherwise – usage
example: isNaN(x)
Number of digits in numeral ndig10(x)
system with base 10
Modulo function
mod(a, b)

isNaN

ndig10
mod
round

ndig

Half-up rounding, usage
round(x, n)
examples: round(2.2, 0) =
2, round(2.6, 0) = 3,
round(2.66,1) = 2.7
Number of digits
ndig(number, base)
representing the number in
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dig

base

Description
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Example

numeral system with given
base
Digit at position 1 … n (left - dig10(num, pos)
> right) or 0 … -(n-1) (right > left) – base 10 numeral
system
Digit at position 1 … n (left - dig(num, pos, base)
> right) or 0 … -(n-1) (right > left) – numeral system
with given base
Returns number in given
base(b, d1, …, dn)
numeral system base
represented by list of digits

Logical Functions
The following logical functions are supported:
Key word

Description

if

If function

iff
or
and
xor
xor
not
isNaN

Example

if(cond, expr-if-true, expr-iffalse)
If function
iff(cond-1, expr-1; … ;
cond-n, expr-n)
Logical disjunction (OR) – or(a1, …, an)
variadic
Logical conjunction (AND) – and(a1, …, an)
variadic
Exclusive or (XOR) –
xor(a1, …, an)
variadic
Exclusive or (XOR) –
xor(a1, …, an)
variadic
Negation function
not(x)
Returns true = 1 if value is isNaN(x)
a Not-a-Number (NaN),
false = 0 otherwise – usage
example: isNaN(x)

Statistical Functions
The following statistical functions are supported:
Key word
min
max
mean
var
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Mean / average value
Bias-corrected sample
variance

Example
min(a1, …, an)
max(a1, …, an)
mean(a1, …, an)
var(a1, …, an)
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Key word
std
med
mode
ndist
pStud
cStud
qStud

pChi2
cChi2
qChi2

pUni

cUni

qUni

pNor
cNor
qNor

Description
Bias-corrected sample
standard deviation
The sample median
Mode – the value that
appears most often
Number of distinct values
Probability distribution
function – Student’s tdistribution
Cumulative distribution
function – Student’s tdistribution
Quantile function (inverse
cumulative distribution
function) – Student’s tdistribution
Probability distribution
function – Chi-squared
distribution
Cumulative distribution
function – Chi-squared
distribution
Quantile function (inverse
cumulative distribution
function) – Chi-squared
distribution
Probability distribution
function – Uniform
continuous distribution
U(a,b)
Cumulative distribution
function – Uniform
continuous distribution
U(a,b)
Quantile function (inverse
cumulative distribution
function) – Uniform
continuous distribution
U(a,b)
Probability distribution
function – Normal
distribution N(m,s)
Cumulative distribution
function – Normal
distribution N(m,s)
Quantile function (inverse
cumulative distribution
function)

Example
std(a1, …, an)
med(a1, …, an)
mode(a1, …, an)
ndist(v1, …, vn)
pStud(x, v)
cStud(x, v)
qStud(p, v)

pStud(x, k)
cStud(x, k)
qStud(p, k)

pUni(x, a, b)

cUni(a, a, b)

qUni(q, a, b)

pNor(x, mean, stdv)
cNor(x, mean, stdv)
qNor(q, mean, stdv)
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Trigonometric Functions
The following trigonometric functions are supported:
Key word

Description

sin

Trigonometric sine function sin(x)

cos

Trigonometric cosine
function
Trigonometric tangent
function
Trigonometric tangent
function
Trigonometric cotangent
function
Trigonometric cotangent
function
Trigonometric cotangent
function
Trigonometric secant
function
Trigonometric cosecant
function
Trigonometric cosecant
function

tg
tan
ctg
cot
ctan
sec
csc
cosec

Example

cos(x)
tg(x)
tan(x)
ctg(x)
cot(x)
ctan(x)
sec(x)
csc(x)
cosec(x)

Inverse Trigonometric Functions
The following inverse trigonometric functions are supported:
Key word

Description

Example

asin

Inverse trigonometric sine
function
Inverse trigonometric sine
function
Inverse trigonometric sine
function
Inverse trigonometric
cosine function
Inverse trigonometric
cosine function
Inverse trigonometric
cosine function
Inverse trigonometric
tangent function
Inverse trigonometric
tangent function

asin(x)

arsin
arcsin
acos
arcos
arccos
atg
atan

©2022 by Waterloo Hydrogeologic

arsin(x)
arcsin(x)
acos(x)
arcos(x)
arccos(x)
atg(x)
atan(x)
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Key word

Description

Example

arctg

Inverse trigonometric
tangent function
Inverse trigonometric
tangent function
Inverse trigonometric
cotangent function
Inverse trigonometric
cotangent function
Inverse trigonometric
cotangent function
Inverse trigonometric
cotangent function
Inverse trigonometric
cotangent function
Inverse trigonometric
cotangent function
Inverse trigonometric
secant
Inverse trigonometric
cosecant

arctg(x)

arctan
actg
acot
actan
arcctg
arccot
arcctan
arcsec
arccsc

arctan(x)
actg(x)
acot(x)
actan(x)
arcctg(x)
arccot(x)
arcctan(x)
arcsec(x)
arccsc(x)

Hyperbolic Functions
The following hyperbolic functions are supported:
Key word

Description

Example

sinh

Hyperbolic sine function

sinh(x)

cosh

Hyperbolic cosine function cosh(x)

tgh

Hyperbolic tangent function tgh(x)

tanh

Hyperbolic tangent function tanh(x)

coth

Hyperbolic cotangent
function
Hyperbolic cotangent
function
Hyperbolic cotangent
function
Hyperbolic secant function

coth(x)

Hyperbolic cosecant
function
Hyperbolic cosecant
function

csch(x)

ctgh
ctanh
sech
csch
cosech

ctgh(x)
ctanh(x)
sech(x)

cosech(x)
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Inverse Hyperbolic Functions
The following inverse hyperbolic functions are supported:
Key word

Description

asinh

Inverse hyperbolic sine
asinh(x)
function
Inverse hyperbolic sine
arsinh(x)
function
Inverse hyperbolic sine
arcsinh(x)
function
Inverse hyperbolic cosine acosh(x)
function
Inverse hyperbolic cosine arcosh(x)
function
Inverse hyperbolic cosine arccosh(x)
function
Inverse hyperbolic tangent atgh(x)
function
Inverse hyperbolic tangent atanh(x)
function
Inverse hyperbolic tangent arctgh(x)
function
Inverse hyperbolic tangent arctanh(x)
function
Inverse hyperbolic
acoth(x)
cotangent function
Inverse hyperbolic
actgh(x)
cotangent function
Inverse hyperbolic
actanh(x)
cotangent function
Inverse hyperbolic
arcoth(x)
cotangent function
Inverse hyperbolic
arccoth(x)
cotangent function
Inverse hyperbolic
arcctgh(x)
cotangent function
Inverse hyperbolic
arcctanh(x)
cotangent function
Inverse hyperbolic secant asech(x)
function
Inverse hyperbolic secant arsech(x)
function
Inverse hyperbolic secant arcsech(x)
function
Inverse hyperbolic cosecant acsch(x)
function
Inverse hyperbolic cosecant arcsch(x)
function

arsinh
arcsinh
acosh
arcosh
arccosh
atgh
atanh
arctgh
arctanh
acoth
actgh
actanh
arcoth
arccoth
arcctgh
arcctanh
asech
arsech
arcsech
acsch
arcsch
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Key word

Description

arccsch

Inverse hyperbolic cosecant arccsch(x)
function
Inverse hyperbolic cosecant acosech(x)
function
Inverse hyperbolic cosecant arcosech(x)
function
Inverse hyperbolic cosecant arccosech(x)
function

acosech
arcosech
arccosech

Example

Other Functions
The following functions from number theory, calculus, and other branches of mathematics
are supported:
Key word
Sa
sinc
Sinc
Bell
Luc
Fib
harm
ispr
Pi
Ei

li

Li

erf
erfc

erfInv

Description
Example
Sinc function (normalized) Sa(x)
Sinc function (normalized) sinc(x)
Sinc function
Sinc(x)
(unnormalized)
Bell number
Bell(n)
Lucas number
Luc(n)
Fibonacci number
Fib(n)
Harmonic number
harm(n)
Prime number test (is
ispr(n)
number a prime?)
Prime-counting function – Pi(n)
Pi(x)
Exponential integral
Ei(x)
function (non-elementary
special function) – usage
example: Ei(x) [also known
as the well function W(u)]
Logarithmic integral
li(x)
function (non-elementary
special function) – usage
example: li(x)
Offset logarithmic integral Li(x)
function (non-elementary
special function) – usage
example: Li(x)
Gauss error function (non- erf(x)
elementary special function)
– usage example: 2 + erf(x)
Gauss complementary error erfc(x)
function (non-elementary
special function) – usage
example: 1 – erfc(x)
Inverse Gauss error
erfInv(x)
function (non-elementary
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Key word
erfcInv

nfact
Gamma
LambW0

LambW1

sgnGamma
logGamma
diGamma

C

nCk

Bern
Stirl1
Stirl2
Worp
Euler
KDelta
EulerPol
Harm
factval
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Description
Example
special function) – usage
example: erfInv(x)
Inverse Gauss
erfcInv(x)
complementary error
function (non-elementary
special function) – usage
example: erfcInv(x)
Prime decomposition –
nfact(x)
number of distinct prime
factors
Gamma special function
Gamma(x)
Γ(s)
Lambert-W special function,LambW0(x)
principal branch 0, also
called the omega function
or product logarithm
Lambert-W special function,LambW1(x)
branch -1, also called the
omega function or product
logarithm
Signum of Gamma special sgnGamma(x)
function, Γ(s)
Log Gamma special
logGamma(x)
function, lnΓ(s)
Digamma function as the diGamma(x)
logarithmic derivative of the
Gamma special function,
ψ (x)
Binomial coefficient
C(n, k)
function, number of kcombinations that can be
drawn from n-elements set
Binomial coefficient
nCk(n, k)
function, number of kcombinations that can be
drawn from n-elements set
Bernoulli numbers
Bern(m, n)
Stirling numbers of the first Stirl1(n, k)
kind
Stirling numbers of the
Stirl2(n, k)
second kind
Worpitzky number
Worp(n, k)
Euler number
Euler(n, k)
Kronecker delta
KDelta(i, j)
EulerPol
EulerPol(m, x)
Harmonic number
Harm(x, n)
Prime decomposition –
factval(number, factorid)
factor value at position
between 1 … nfact(n) –

738

Hydro GeoAnalyst 11.0

Key word
factexp

GammaL
GammaU
GammaP
GammaRegL
GammaQ
GammaRegU
nPk
Beta
logBeta

chi
BetaInc

BetaI

BetaReg

Description
Example
ascending order by factor
value
Prime decomposition –
factexp(number, factorid)
factor exponent / multiplicity
at position between 1 …
nfact(n) – ascending order
by factor value
Lower incomplete gamma GammaL(s, x)
special function, γ(s,x)
Upper incomplete Gamma GammaU(s, x)
special function, Γ(s,x)
Lower regularized P
GammaP(s, x)
gamma special function,
P(s,x)
Lower regularized P
GammaRegL(s, x)
gamma special function,
P(s,x)
Upper regularized Q
GammaQ(s, x)
Gamma special function,
Q(s,x)
Upper regularized Q
GammaRegU(s, x)
Gamma special function,
Q(s,x)
Number of k-permutations nPk(n, k)
that can be drawn from nelements set
The Beta special function Beta(x, y)
B(x,y), also called the Euler
integral of the first kind
The Log Beta special
logBeta(x, y)
function ln B(x,y), also
called the Log Euler integral
of the first kind, ln B(x,y)
Characteristic function for x chi(x, a, b)
in (a,b)
The incomplete beta specialBetaInc(x, a, b)
function B(x; a, b), also
called the incomplete Euler
integral of the first kind
The regularized incomplete BetaI(x, a, b)
beta (or regularized beta)
special function I(x; a, b),
also called the regularized
incomplete Euler integral of
the first kind
The regularized incomplete BetaReg(x, a, b)
beta (or regularized beta)
special function I(x; a, b),
also called the regularized
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Key word
ConFrac
ConPol
gcd
lcm
coalesce

Description
incomplete Euler integral of
the first kind
Continued fraction
Continued polynomial
Greatest common divisor
Least common multiple
Returns the first non-NaN
value

Example
ConFrac(a1, …, an)
ConPol(a1, …, an)
gcd(a1, …, an)
lcm(a1, …, an)
coalesce(a1, …, an)

Constants and Variables
Expressions support mathematical constants and random variables:

Mathematical Constants
The following mathematical constants are supported:
Key word
pi
e
[gam]
[phi]
[F’d]
[F’a]
[Dz3]
[true]
[false]
[NaN]

Description
Pi, Archimedes’ constant
Euler’s number, base of
Natural logarithm
Euler-Mascheroni constant
Golden ratio
Feigenbaum constant alfa
Feigenbaum constant delta
Apery’s constant
Boolean True represented as
double, [true] = 1
Boolean False represented as
double, [false] = 0
Not-a-Number

Example
pi
e
[gam]
[phi]
[F’d]
[F’a]
[Dz3]
[true]
[false]
[NaN]

Random Variables
The following random variables are supported:
Key word
[Uni]
[Int]
[Int1]
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Description
Example
Random variable – Uniform [Uni]
continuous distribution
U(0,1)
Random variable – random [Int]
integer
Random variable – random [Int1]
integer – Uniform discrete
distribution U{-10^1, 10^1}
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Key word
[Int2]
[Int3]
[Int4]
[Int5]
[Int6]
[Int7]
[Int8]
[Int9]
[nat]
[nat1]

[nat2]

[nat3]

[nat4]

[nat5]

[nat6]

Description
Random variable – random
integer – Uniform discrete
distribution U{-10^2, 10^2}
Random variable – random
integer – Uniform discrete
distribution U{-10^3, 10^3}
Random variable – random
integer – Uniform discrete
distribution U{-10^4, 10^4}
Random variable – random
integer – Uniform discrete
distribution U{-10^5, 10^5}
Random variable – random
integer – Uniform discrete
distribution U{-10^6, 10^6}
Random variable – random
integer – Uniform discrete
distribution U{-10^7, 10^7}
Random variable – random
integer – Uniform discrete
distribution U{-10^8, 10^8}
Random variable – random
integer – Uniform discrete
distribution U{-10^9, 10^9}
Random variable – random
natural number including 0
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^1}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^2}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^3}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^4}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^5}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^6}

Example
[Int2]
[Int3]
[Int4]
[Int5]
[Int6]
[Int7]
[Int8]
[Int9]
[nat]
[nat1]

[nat2]

[nat3]

[nat4]

[nat5]

[nat6]
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Key word
[nat7]

[nat8]

[nat9]

[Nat]
[Nat1]

[Nat2]

[Nat3]

[Nat4]

[Nat5]

[Nat6]

[Nat7]

[Nat8]

[Nat9]
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Description
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^7}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^8}
Random variable – random
natural number including 0
– Uniform discrete
distribution U{0, 10^9}
Random variable – random
natural number
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^1}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^2}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^3}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^4}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^5}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^6}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^7}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^8}
Random variable – random
natural number – Uniform
discrete distribution U{1,
10^9}

Example
[nat7]

[nat8]

[nat9]

[Nat]
[Nat1]

[Nat2]

[Nat3]

[Nat4]

[Nat5]

[Nat6]

[Nat7]

[Nat8]

[Nat9]
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Key word
[Nor]
rUni

rUnid

rNor

rStud
rChi2

Description
Example
Random variable – Normal [Nor]
distribution N(0,1)
Random variable – Uniform rUni(a, b)
continuous distribution
U(a,b), usage example:
2*rUni(2,10)
Random variable – Uniform rUnid(a, b)
discrete distribution U{a,b},
usage example:
2*rUnid(2,100)
Random variable – Normal rNor(mean, stdv)
distribution N(m,s) m –
mean, s – stddev, usage
example: 3*rNor(0,1)
Random variable –
rStud(v)
Student’s t-distribution
Random variable – ChirChi2(k)
squared distribution
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Lab Quality Control
When collecting, analyzing, and interpreting environmental data, Quality Control (QC) can
come in many forms and fashions. Hydro GeoAnalyst includes a Lab Quality Control
component that analyses selected data for adherence to specified quality objectives
commonly required for working with analytical/laboratory data.
As part of a data collection process, duplicate samples, blank (control) samples, and spiked
samples are collected as part of the sampling process; these samples are sent to a
laboratory, along with the original field samples, to be analyzed by qualified in a controlled
environment, using approved procedures and instrumentation. The objective this additional
effort is to identify sources of error that may be associated with sample collection through to
analysis and provide some assurance to the stakeholders that the data is valid and
representative of site conditions.
Hydro GeoAnalyst has integrated a Lab Quality Analysis component that allows users to:
· Define one or more lab quality assessment templates
· Analyze Duplicate, Spiked and Blank samples
· Compare Relative Percent Difference and Coefficient of Variation for Duplicate

samples (for more details, see Check Duplicates Settings ).
· Analyze Percent Recovery for Spiked samples (for more details, see Check Spiked

Settings ).
· Compare Blank samples to method detection limits (for more details, see Check

Blanks Settings ).
· Analyze Dilution Factor, Detection Limit, and Holding Time
· Compare the dilution factor in your results with the maximum allowed dilution factor
·
·
·
·
·

23.1

that you set in your template (for more details, see Check Dilution Factor Settings ).
Compare the detection limit in your results with the standard detection limit (for more
details, see Check Detection Limit Settings ).
Compare the holding time in your results with the standard holding time (for more
details, see Check Holding Time Settings ).
Execute a Quality analysis on a selected dataset
Display and retrieve assessment results; records not meeting assessment criteria will
be highlighted
Save assessment results to an Excel spreadsheet

Preparing Your Data for QC Analysis
Your QC Blank, duplicate, and spiked samples should be entered in the same table and
fields as your original samples.
If a Duplicate sample was collected at an existing station, then create a new sample ID, and
assign the appropriate Quality Code (D). You must also define a common batch ID for
duplicates to indicate that they belong together. If you want to compare the duplicate to its
original sample, you must add the appropriate Original Sample Quality Code (O), to each
original sample.

©2022 by Waterloo Hydrogeologic

744

Hydro GeoAnalyst 11.0

If a Blank sample was collected, it can be added as a new station and sample, or as a new
sample, to an existing station. Create a new sample ID, and assign the appropriate Quality
Code (B).
For Spiked samples, you must add two types of samples codes and results:
The first will be a sample that contains the known spiked concentration, for each parameter.
Create a new sample ID, and assign the appropriate Quality Code, ST (for Theoretical
Spiked concentration). Create a new sample for every spiked sample and enter the amount
of constituent that has been added for every spiked parameter.
Next, add the analyzed spiked sample as a new sample. Create a new sample ID, and
assign the appropriate Quality Code, SM (for Measured Spiked concentration). Create a new
sample for every spiked sample and enter the measure amount of constituent that was
recovered, for every spiked parameter.
Both the measured sample and the sample holding the theoretical concentrations should be
assigned a common batch # (Batch ID), which relates the samples to each other.

Defining Quality Codes for Data
When importing/adding sample data, quality codes need to be added to indicate the type of
sample, in order to be used in a Lab Quality Analysis. The following are the codes required
by HGA:

Sample Type

Quality Code

Duplicate Original O
Duplicate
Measured

D

Spiked Theoretical ST
Spiked Measured

SM

Blank measured

B

Using the Template Manager, you can create a field that will store the quality codes. This
field may be added to any table, but typically it is found in the Parameter Sample table, with
the Sample ID.
These quality codes are saved in the file: ...\Program
Files\HGAnalyst\Whi.QualityAC.dll.config
If necessary, the codes may be changed to reflect the codes used in your data. Simply use a
text editor to open the .config file, and modify the quality codes under the section:
<QualityCodes>.
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Data Requirements
Quality Control starts with a data set; before you can apply a quality control template, you
must generate a data set, by building and executing a data query with the Query Builder.
The data query should contain the data set your are interested in analyzing, along with the
fields required by the Quality Control component.
The following are required fields for the Lab Quality validation, and as such, must be fields
that are present in your data query:
· Station ID: located in the Station table
· Sample ID: this is typically found in the Monitoring Event > Parameter Sample table, or

the Soil Sampling > Soil Sample table.
· Batch Identifiers: Samples that are prepared and/or analyzed together with the same

·
·
·
·
·

process and personnel, using the same lot(s) of reagents, within a specified time
period, should be assigned the same Batch ID. Both the measured sample and the
sample holding the theoretical concentrations should be assigned a common batch
number, which relates the samples to each other.
Detection Limit: Method detection limit, typically found in the Chemistry_Results or
Soil_Chemistry table.
Parameter Name: contains the parameter being analyzed; typically found in the
Chemistry_Results or Soil_Chemistry table with the results
Parameter Identification Information: contains meta data about the parameter;
typically found in the same table as the parameter name
Parameter Values: The measured or observed value for the selected chemical or
parameter. Typically found in the Chemistry_Results or Soil_Chemistry table
Quality Code Identifiers: Used to identify the sample type. Typically found with the
Sample ID, in the Monitoring Event > Chem Sample table, or the Soil Sampling > Soil
Sample table.

The following fields are not required, but are helpful for easily identifying samples in the
results page:
· Station Name: located in the Station table
· Sample Name: this is typically found in the Monitoring Event > Chem Sample table, or

the Soil Sampling > Soil Sample table.
· Sample Date
· Units
· Unit conversion factors

23.2

Define A New Lab Quality Template
To create a new lab quality analysis template, click Module > Quality Control > Manage
Lab QC Templates from the Main Menu bar. The Lab Quality window will open, as shown in
the following figure:
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To create a new template, click the [Add] button, and enter a name for the template. The
newly created template will then appear in the Lab Quality Templates list. To configure your
template, click on the [+] to expand the template tree. As shown in the following example
screenshot, the three Check types (Duplicate, Spikes, and Blanks) will be listed. To activate
a Check type, click in the checkbox beside it.
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The Template Description field is filled in by default with a verbal description of the Settings
used for the template. You can modify the Template Description with any text you would like
to use by simply typing over the existing text.
Each Check type has its own Settings, which can be adjusted by clicking on the Check type
to highlight it. The Settings will then appear to the right. Settings for each Check type are
described in the following sections.

23.2.1

Check Duplicates Settings
A field duplicate is a QC sample which is used to determine the precision associated with all
or part of the sample collection and measurement process. Field duplicates are two
independent samples which are collected, as nearly as possible, from the same point in
space and time. The two field duplicate samples are collected from the same source, using
the same type of sampling equipment. Ideally, analyte concentrations in the duplicate
sample should be identical, or very close, to the original sample to which it is being
compared. The following settings are available:
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Relative percent difference less than: This criteria is used to compare how close the result
from a duplicate sample (D) is to the true, original field sample (O). It is expressed as either
a positive difference (the sample result is higher than the true value) or negative difference
(the sample result is lower than the true value). When used with duplicate samples, the
Relative Percent Difference measures precision - the lower the value, the more precise the
results must be to be considered acceptable. It can also measure accuracy, when one of
your results is the true value (such as the quality control lab results for a split sample), or the
actual concentration of a known or unknown sample.
Coefficient of Variation (CV) less than: The standard deviation as a percentage of the
average. The CV is a unitless quantity indicating the variability around the mean, in relation
to the size of the mean. When used with duplicate samples, the CV measures precision - the
lower the value, the more precise the results.
Highlighting: If a record is identified as not meeting the Template criteria specified above, it
will be highlighted according to the settings entered in this frame. By default, the record's
Background Color will be changed to yellow. However, the user has the option to modify the
Font, the Background Color, and the Border Color of the record by clicking on the
appropriate button(s).

23.2.2

Check Spiked Settings
A matrix spike is an aliquot of sample that is spiked with a known concentration of target
analyte(s) prior to sample preparation. Ideally, there should be 100% recovery of the spiked
concentration (or very close to this). The following settings are available.
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Minimal Percent Recovery:You can find this option by selecting Project / Export. In this first
step of the workflow you can create a template (which can be opened in Excel) for others to
use to validate their data. In the EDD Template Designer you select which fields you wish to
have in your template by simply dragging and dropping them onto the Template Format.

Please Note: This analysis assumes that the sample that is
being spiked is a blank, and does not contain any detectable
concentrations of any of the contaminants. You may not use
a field original sample for a spiked sample analysis.

Highlighting: If a record is identified as not meeting the Template criteria specified above, it
will be highlighted according to the settings entered in this frame. By default, the record's
Background Color will be changed to yellow. However, the user has the option to modify the
Font, the Background Color, and the Border Color of the record by clicking on the
appropriate button(s).

23.2.3

Check Blanks Settings
A blank is a quality control sample used to detect and identify contaminants introduced to
samples during the measurement process. A laboratory blank is an analyte-free matrix that
is carried through all or part of the analytical process for identifying contamination introduced
during analysis. Types of laboratory blanks include method blanks (carried through the entire
preparation and analysis sequence), calibration blanks (matrix-matched reagent water used
for calibration), and storage blanks (placed in sample storage areas). In the field, an analytefree matrix is carried through a portion of the field process to identify contamination
introduced during field or transportation operations. Types of blanks associated with the field
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are trip blanks (these accompany samples through the transportation process), equipment
rinsates (collected after decontamination), and field blanks (collected on-site during the
sampling event).
Ideally, analysis of the blank samples should return no detectable concentrations of any of
the analytes; i.e. concentrations are below the method detection limit (MDL).

The detection limit for contaminants can be specified in HGA, and must be added to your
data query.

Highlighting: If a record is identified as not meeting the Template criteria specified above, it
will be highlighted according to the settings entered in this frame. By default, the record's
Background Color will be changed to yellow. However, the user has the option to modify the
Font, the Background Color, and the Border Color of the record by clicking on the
appropriate button(s).

23.2.4

Check Dilution Factor Settings

Please Note: An example of a Lab Quality Data query is
available in the Demo project; select the QC_Lab_Analysis
query in the Queries node, and feel free to follow along with
the instructions below.

To apply a Lab Quality Template, follow the instructions below:
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· Select and highlight the appropriate Data Query from the Queries node in the HGA

Browser.
· From the main menu, click Tools > Quality Control and select the Perform Lab QC

Assessment option; the following dialog will appear:

From the Select and configure a template window select from the list of Lab Quality
Templates.
Once a template has been selected, the Template Description field will be completed with
the description entered when the template was created. The next step is to map the fields in
your data query, to the fields required by the QC component.

Mapping Fields
In the Mapping frame, the Field must be matched to the Query Alias for all required fields;
required fields are marked with a "*", and are also listed in previous section. In most cases,
HGA will be able to automatically detect and map the fields, however if you have created
custom fields, or renamed existing fields in your database structure, you may need to browse
through the list and select the appropriate Query Alias in your project (using the pull-down
menus) that corresponds with a Field.
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Please Note: A field in your query must be mapped to each
of the required fields, as listed above..

Generate QC Results

The results for an example analysis including all six checks is displayed in the screenshot
below:

Indicates that all records have passed this check.
Indicates that one or more record(s) has failed this check.
If any records failed the check you will also find the record is highlighted as per your settings
from your template.
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You will also find an option to
indicating the results of the Validation.
You must select which field in the database to write the Results Flag, which should be in the
analytical results table.
You must also select which field in the database to write the Sample Flag (should be in the
sample table). The name of the Template that was run on the sample will be appended to
the field you select.

Export Quality Control Analysis Results
To export the results of your Lab Quality Analysis to a MS Excel spreadsheet, click the
[Export Results] button, select the check results you wish to export and provide a name for
your spreadsheet.

If more than one check result is selected you will find multiple worksheets within your
spreadsheet (one for each check) see below for an example.
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Check Method Detection Limit Settings
This QA/QC check will compare the Standard Detection Limit in the QA/QC reference table
with your detection limits reported within your results. If your reported detection limits are
greater than the Standard Detection Limit in the reference table they will fail this check and
samples will be formatted according to the Highlighting options.

You can enter your QAQC references (Standards) by selecting Modules > Quality Control
> QAQC References from the Menu bar:
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Here you can manually enter or import the reference values used for running the associated
checks.You will notice that the Method Name and Chemical Name have drop down lists you
can pick from - this is based on your selections from the Settings:

23.2.6

Check Holding Time Settings
Holding time is the length of time a sample can be stored after collection and prior to
analysis without significantly affecting the analytical results. This QA/QC check will compare
the Standard holding time with the holding times of your results. The holding time of your
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results will be calculated by comparing the difference between the Sample Date and the
Analysis date. Any results that have a holding time greater than what is specified in the
QAQC Reference table will fail this check.

You can enter your QAQC references (Standards) by selecting Project/Properties/QAQC
References
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Here you can manually enter or import the reference values used for running the associated
checks.You will notice that the Method Name and Chemical Name have drop down lists you
can pick from - this is based on your selections from the Settings:

Once you have defined the settings for your Template, you can create another template by
clicking the [Add] button, delete an existing template by clicking the [Remove] button, or
accept/reject your changes and return to the HGA main program window.
You are now ready to apply the lab quality template to your data.

23.3

Perform Lab Quality Assessment

Please Note: An example of a Lab Quality Data query is
available in the Demo project; select the QC_Lab_Analysis
queries node, and feel free to follow along with the
instructions below.

To apply a Lab Quality Template, follow the instructions below:
· Select and highlight the appropriate Data Query from the Queries node in the HGA

Browser.
· From the main menu, click Tools > Quality Control and select the Perform Lab QC

Assessment option; the following dialog will appear:
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From the Select and configure a template window select from the list of Lab Quality
Templates.
Once a template has been selected, the Template Description field will be completed with
the description entered when the template was created. The next step is to map the fields in
your data query, to the fields required by the QC component.

Mapping Fields
In the Mapping frame, the Field must be matched to the Query Alias for all required fields;
required fields are marked with a "*", and are also listed in previous section. In most cases,
HGA will be able to automatically detect and map the fields, however if you have created
custom fields, or renamed existing fields in your database structure, you may need to browse
through the list and select the appropriate Query Alias in your project (using the pull-down
menus) that corresponds with a Field.
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Please Note: A field in your query must be mapped to each
of the required fields, as listed above..

Generate QC Results

The results for an example analysis including all six checks is displayed in the screenshot
below:

Indicates that all records have passed this check.
Indicates that one or more record(s) has failed this check.
If any records failed the check you will also find the record is highlighted as per your settings
from your template.
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You will also find an option to
indicating the results of the Validation.
You must select which field in the database to write the Results Flag, which should be in the
analytical results table.
You must also select which field in the database to write the Sample Flag (should be in the
sample table). The name of the Template that was run on the sample will be appended to
the field you select.

Export Quality Control Analysis Results
To export the results of your Lab Quality Analysis to a MS Excel spreadsheet, click the
[Export Results] button, select the check results you wish to export and provide a name for
your spreadsheet.

If more than one check result is selected you will find multiple worksheets within your
spreadsheet (one for each check) see below for an example.
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Plot Module
In Hydro GeoAnalyst, you can easily create collections of plots to visualize, analyze,
summarize, and report on your data. Plot collections consist of one or more plots. There are
nineteen different plot types available. When you select Plots from the main menu and then
New Plot Collection, a new plot collection will be created and you can add ( ) any of the
available plot types:

General and Statistical Plots
· Box and Whisker
· Histogram
· Pie Chart
· Probability Plot
· Quantile Plot
· Radial Plot
· Scatter Plot
· Stacked Bars Plot
· Time Series

Geochemical Plots [HGA+ only]
· Detection Summary
· Durov Plot
· Giggenbach Triangle
· Ludwig-Langelier Plot
· Meteoric Water Line (MWL)
Plot
· Piper Diagram
· Schoeller Plot
· Stiff Plot
· Ternary Plot
· Wilcox Plot

Please Note: The Geochemical plot types and a significant
portion of the functionality of the Plot module are only
available in HGA+.

Hydro GeoAnalyst allows you to create multiple plots for the same data set and view these
plots simultaneously within the Windows environment. Each of these plots is explained in
greater detail later in this chapter. The following sections also describe some of the features
that are common to all plots and how to organize your plots into plot collections.

24.1

Plot Collections
Plots in Hydro GeoAnalyst are organized into plot collections, which consist of one or more
individual plots. The layout of a plot collection can be adjusted using the main toolbar of the
Plot Collection view, reordered using the table of contents, and previewed or exported using
the export pane.
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Toolbar
The Plot Collection toolbar is contains the following controls:

Add a new plot at the end of the Plot Collection
Delete the currently selected plot
Open the plot settings dialog for the currently active plot
Clone the current plot
Save the plot collection configuration
Rename the plot collection
Add a row to the page layout of the plot collection
Remove a row from the page layout of the plot collection
Add a column to the page layout of the plot collection
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Remove a column from the page layout of the plot collection
Refresh plots
Open the plot settings dialog
Page Navigation controls
Open/close the plot collection Table of Contents
Open/close the export pane

Table of Contents
The table of contents in the plot collection displays a list of the plots that belong to the
collection. If the plot layout includes multiple plots per page (using the add rows
or
columns ), then the table of contents is displayed as a tree with a node for each page and
subnodes for each plot on a given page - plots will be drawn in order from left to right and
then top to bottom. For example, the radial plot that is selected in the table of contents below
and shown in the image above is the third item on the page and is located in first column of
the second row.
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You can navigate to any plot in the collection by clicking on its title. You can also
reorganize/reorder plots using the toolbar.

The tool bar buttons move the selected plot within the plot collection as follows:
top/beginning of the collection
up/backward one position
down/forward one position
bottom/end
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Export Pane
The export pane provides a set of options for exporting the plot collection to either a series of
images or to a PowerPoint file based on a template.

Export Type
The Export type provides two options:
· Images: the plot(s) in the current plot collection will be exported as one or more

images
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· Presentation: the plot(s) in the current plot collection will be exported to a PowerPoint

report.

Layout Settings
The Layout settings provide the following settings:
· Layout: the layout dropdown allows you to select the size of the export including the

following standard page sizes:
o
o
o
o
o
o

Letter: 8.5 x 11 inches
Legal: 8.5 x 14 inches
Tabloid: 11 x 17 inches
A4: 21 x 29.27 cm
Custom: a custom width and height
None: no layout is selected and the plot collection will be stretched to fill the
workspace.

Please Note: If an option other than "None" is selected then
the dynamic selection/identify of plot data will be disabled.
However, all options other than "None" will display the plot
collection as it will appear in the exported image or
presentation..

· Width: the width of the exported image or of the plot image(s) in the exported

presentation
· Height: the height of the exported image or of the plot image(s) in the exported

presentation
· Margins: the size of the margins around the image. The width and height of the image

will be reduced proportionally to include the margin
· Unit: the measurement unit for the width, height, and margin of the export (select

inches, centimeters, or pixels)
· Orientation: the orientation of the export

o Portrait: the width and height will be used as-is
o Landscape: the width and height will be switched
· Export with Margins: if selected, the export will include the margin space. If not

selected, the export will not include the margin but the image will be scaled (and
placed in the presentation) to include the margin space
· DPI: the dots-per-inch setting sets the scale of the plot components (e.g. the fonts and

plot symbols) relative to the size of the export. The following settings are available:
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o
o
o
o

Low: 72 dpi
Medium: 150 dpi
High: 300 dpi
Custom: enter a custom dpi

Low DPI values will result in larger fonts and higher DPI values will result in smaller
fonts. Exported raster images (PNGs, BMPs, and JPEGs) with low DPI values will be
appear somewhat pixelated. However, exported EMF images and Presentations, which
are vector-based formats, and the resolution of the images will not be affected.

Please Note: A plot collection with:
§ a width and height matching the dimensions of the image

placeholder in the PowerPoint template
§ margins = 0.00
§ DPI = 96

will result in an exported presentation where the fonts of the plot(s)
will match fonts in the presentation of the same size.

Image Settings
The following settings are available if the export type is images:
· Output Path: clicking the browse button allows you to select a folder where the

resulting image(s) will be exported
· File Type: the image format (PNG, BMP, JPEG, EMF)
· Plots to Export: the scope of the export

o Current page: only the current page will be exported
o Whole plot collection: one image will be exported per page in the plot collection
· Export Button: one or more images will be generated based on the Layout and Image

settings
Report Settings
The following settings are available if the export type is images:
· Report Path: clicking the browse button allows you to define the output presentation

filename for the exported plot collection
· Select a Template: a dropdown that includes the templates in the Project Tree (under

in the Office reports > PPT Plots folder). Select Browse to find alternative templates
· Plots to Export: the scope of the export
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o Current page: only the current page will be exported
o Whole plot collection: one image will be exported per page in the plot collection
· Export Button: the plot collection will be exported to the selected PowerPoint

template based on the Layout and Report settings

24.2

Common Plot Features
Although each of the available plot types have unique characteristics, there are also many
graphical features and options that they have in common. When you select any of the graph
types to plot, a Plot Options dialogue will appear with default settings for data sources,
parameters and other plot settings. Settings common to all plots include:
·
·
·
·
·

Source Data
General
Axis
Legend
Themes

Some of the plot types include plot-specific settings, which are described in the discussion of
each individual plot type, where applicable. Plots with rectangular (Cartesian) axes also
support the addition of custom Lines.

Source Data
The source data selection will determine which sample/station data are included in the plot:
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Data Sources
While the parameter data to be plotted in each of the plots can vary significantly between
plot types, the source of the data can be based on dynamic data:
· Active Sample Set: the sample set that is currently active in the station picker
· Active Samples: the sample(s) currently selected in the sample picker/sample list
· Active Station: the sample(s) associated with the active station (in the Station Picker)

or specified/static data:
·
·
·
·
·

Sample Set: a specific sample set or station group
Station: a specific station
Sample: a specific sample
Symbol: a specific symbol
Query: a specified query.

Please Note: the Query data source is only available for the
General/Statistical plot types as the geochemical plots
require the use of the parameter data structure in HGA+.
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Similarly, the Query data source is the only option available
in the standard version of HGA.

Query-based Data Source
If a query is selected as the data source for a given plot, some additional options will be
displayed:

· Select (first): allows you to select a source query
· Select (second): allows you to select a field that will be used to define the data series
· Symbols: allows you to pick a generic symbol group defined in the Symbol Editor.

Parameters
Once you have selected a data source, you can select parameters to be plotted. The plot
type will determine which parameters (and sometimes how many) are to be plotted. Clicking
a value within the Parameter column will open the parameter selection window.
Many of the plot types (e.g. Piper plot and Stiff diagrams) have specific parameters that are
most commonly used with them. These are described in each of the individual Plot Type
sections.
If your plot data is based on a query, the parameter(s) will be selected by picking one or
more fields from the query results.
Multiparameter Plots
Some of the plot types (i.e. Box and Whisker, Scatter, and Time Series) support multiparameter plots. For more information, please refer the specific settings for each of these
plots.
Generate multiple plots [HGA+ only]
You can generate multiple plots based on a common set of parameters and style settings
using the Generate button, which when clicked opens the following dialog:
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·
·
·
·

Symbol: generates one plot for each symbol in the active symbol group
Station Group: generates one plot for each station group listed in the project tree
Sample Set: generates one plot for each sample set listed in the project tree
Sample in the following set: generates one plot for each sample in a sample set
selected using the sample set picker
· Station in the following group: generates one plot for each station in a station group
selected using the station group picker
Once the multiple plots have been generated each plot will have distinct plot settings, so it is
generally easier to set up the plot style prior to generating multiple plots to minimize having
to make adjustments to each plot individually.
Default
The following options are available for working with default plot settings:
· Set as default: sets the current source, parameters, and style settings as the default

for the current plot type in the current project. All plots of the same type created after
clicking this button will share these settings. This allows you to quickly generate a
number of plots with the same formats, particularly in combination with the generate
multiple plots functionality described above.

General
The General tab provides options for setting the title of the plot and formatting for the
general style of the plot:
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· Title: a text input form for the Title of the plot; disabled if Auto is checked on
· Show title: if checked will display the title above the plot
· Auto: if checked will automatically generate a plot-specific title based on the plot type,

data source, and/or input parameters
· Font: sets the font, size, and style of the plot title
· Color: sets the color of the plot title font
· Alignment: specifies the alignment of the plot title relative to the plot: left, center, or

right
· Background: specifies the background color of the entire plot
· Line Color: specifies the color of the plot frame. Note that axes are drawn on top of

the plot outline
· Size Mode: specifies how the plot will be sized within the row/column of the plot layout

o Stretch: the plot axes will be independently stretched to fit the plot space
o Square: the plot axes will have equal length and the square plot will be scaled to fit
the plot space
Note that the size mode is only available for rectangular plots (such as box and
whisker, scatter plots, etc.).
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Axes
The Axes tab provides options for formatting the plot axes. All axis settings are described
below; however not all axis settings are available/applicable for axes in each of the plot types
(for example the concentration axis on Stiff diagrams does not have a Units setting as units
are fixed to meq/L). Similarly, in some case, multiple axes will share settings; for example,
ternary plots and plots that contain one or more ternary plots (i.e. Durov, Piper, and
Giggenbach) have one ternary axis with common settings.
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A drop down menu is available at the top of the Axes tab which allows you select the axis to
review and specify the following settings:
General
· Show: if checked, shows the axes and related settings will be shown on the plot
· Color: specifies the color of the axes

Title
· Show: if checked, shows the axis title
· Automatically generate title based on parameters: if checked, the text of the axis
·
·
·
·
·
·
·
·
·
·

title will be generated by Hydro GeoAnalyst based on the current set of parameters
Title Input: a text input box for the title; disabled if the title is set to auto-generate
Font: specifies the font, size, and style of the axis title
Color: specifies the color of the axis title
Append unit to title: if checked, the parameter measurement unit will be appended to
the axis title
Unit: if clicked you will be prompted to select a measurement unit from the same
measurement category as the parameter.
Logarithmic: if checked, the axis scale will be transformed to a base-10 logarithm
scale
Min: the minimum value of the axis
Max: the maximum value of the axis
Major Tick Interval: the spacing between major tick marks, gridlines, and tick labels
for the axis
Minor Tick Interval: the spacing between minor tick marks and gridlines for the axis

Please Note: unit conversion is only available in plots using
the parameter-based data sources available in HGA+. Plots
based on query data will not convert data values, only the
unit labels in the selected axis will be affected.

Tick Labels
·
·
·
·

Show: if checked, shows value labels at the major tick marks
Font: specifies the font, size, and style of the axis tick labels
Color: specifies the color of the axis tick labels
Format: allows you to specify the numerical format of the axis tick labels. If the
dropdown is selected, you may choose from standard formats numeric or date/time
formats, based on the axis value type. You also have the option of clearing the format
to use a general/automatic format and Hydro GeoAnalyst will automatically format
each label for you based on the type and magnitude of the number or date.
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Grid lines
The following options are available for the major and minor gridlines:
· Show: if checked, axis major/minor gridlines will be shown on the plot
· Type: specifies the line type in a dropdown menu: solid, dot, dash, dash dot, dash dot

dot
· Color: specifies the color of the axis major/minor gridlines
· Thickness: specifies the thickness of the major/minor gridlines in point units

Tick Marks
The following options are available for the major and minor tick marks:
·
·
·
·

Show: if checked, axis major/minor tick marks will be shown along the axis
Length: specifies the length of the tick mark perpendicular to the axis
Thickness: specifies the thickness of the major/minor gridlines in point units
Location: a dropdown with the following options: In, Out, and Cross

Legend
The Legend tab provides options for setting the format and style of the legend:

· Show legend: if checked, the legend will be displayed on plot
©2022 by Waterloo Hydrogeologic

778

Hydro GeoAnalyst 11.0

· Number of columns: an integer, the legend will be divided into this many columns
· Use actual symbol size: if checked, symbols in the legend will be the same size as
·
·
·
·
·

on the plot, otherwise they will be the same size as the legend font
Font: specifies the font, size, and style of the legend item labels
Color: sets the color of the text in the legend
Background Color: sets the color of behind the text in the legend
Outline Color: sets the color of the bounding box around the text in the legend
Outline Thickness: sets the thickness of the line around the text in the legend

Themes
The Themes tab provides options for managing plot themes. Plot themes are style settings
that can be shared across plot types and collections within a given project, including axis and
plot title fonts, line colors and styles. Plot themes allow you to develop a common style for
plots so that you can quickly generate plots that have a common design style to help you
develop professional looking plots.

· Saved Themes (dropdown): allows you to select one of the plot themes saved in the

current project
· Apply: formats the current plot using the selected plot theme
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· Delete: deletes the selected plot theme from the project. Note: the default plot theme

cannot be deleted
· Replace: replaces/updates the settings of the selected plot theme with those of the

current plot
· Save: saves the settings of the current plot as a new theme

Note that certain plot elements including data formats, number ranges and tick mark
intervals are not included in plot themes as these rely on the data sources which can vary
widely across various plot types; however, these settings can be saved using the plot
defaults.

Lines
The Lines tab is available for many plot types and provides options for adding and formatting
custom lines to the current plot.

Support for Custom Lines in each type of plot
General and
Statistical Plots

Support
for
Custom Lines

Geochemical Plots

· Box and

· Detection

Whisker

Summary

· Histogram

· Durov Plot

· Pie Chart

· Giggenbach

· Probability Plot
· Quantile Plot
· Radial Plot
· Scatter Plot
· Stacked Bars

Plot
· Time Series

Support
for
Custom Lines

Triangle
· Ludwig-

Langelier Plot
· Meteoric Water

Line (MWL) Plot
· Piper Diagram
· Schoeller Plot
· Stiff Plot
· Ternary Plot
· Wilcox Plot

The line settings tab provides a list of custom lines that have been added to the plot on the
left hand side of the tab. You can manage custom lines on a given plot as follows:
· add: click the add button [
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· remove: click the button [ ] to remove the currently selected line
· show/hide: select/deselect the checkbox [ ] next to a custom line to toggle its

visibility.

Common Line Settings
Settings for the custom line selected from the list of custom lines are displayed on the right
side of the tab. Each custom line will include the following general settings:
· Line Name: a text input to provide a name for the line that is used for the legend
· Line Type: a dropdown to select the line type: Linear, Horizontal, Vertical, Time
·
·
·
·
·

Series, Standard
Line Style: specifies the line type in a dropdown menu: solid, dot, dash, dash dot,
dash dot dot
Color: sets the color of the line
Thickness: sets the weight of the line in font points
X-Axis lower cutoff: optional settings to limit the minimum horizontal extent of the line
(not available for Vertical lines)
X-Axis upper cutoff: optional settings to limit the maximum horizontal extent of the
line (not available for Vertical lines)
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The following settings are specific to the line type. Note that if an axis has a category-based
data source (e.g. station names in a box and whisker plot, bins in a histogram, or the species
names in a detection summary plot), then for the purposes of the plotting and defining
custom lines, the category axis will be scaled such that each category has an incremental
value of one unit.

Horizontal
The following settings are available to define horizontal lines:

· Y-Value: constant Y-value for the horizontal line

Vertical
The following settings are available to define vertical lines:

· X-Value: constant x-value for the vertical line

Linear
The following settings are available to define vertical lines:

· Slope: the slope of the linear line
· Y-intercept: y-intercept of the linear line

Time Series
The following settings are available to define vertical lines:
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· Slope: the change in Y-value over a given period of time (as defined by the "Every"

settings described below)
· Every: the period of time for the slope, including a dropdown for time units from
seconds up to years
· X-intercept: x-intercept of the time series line (i.e. the date/time when the Y-value of
the line is 0)
Standard
The following settings are available to define vertical lines:

· Water quality standard: a dropdown that allows you to select an active water quality

standard
· Parameter: the dropdown that allows you to select one of the parameters with a
standard for the selected water quality standard
· Color: pressing the color button will set the color of the custom line to the
exceendance color of the selected water quality standard
· Title: pressing the title button will set the title for the line to the name of the selected
water quality standard and append the name of the selected parameter
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Plot Types
This section describes each of the plots and their relevant options:

General and Statistical Plots
The following general and statistical plot types are available in HGA:

Box and Whisker

Histogram

Pie Chart

Probability Plot

Quantile Plot

Radial Plot

Scatter Plot

Stacked Bars

Time Series
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Geochemical Plots [HGA+ only]
The Plot module in HGA+ includes all of the plots listed above as well as the following:

Detection Summary

Durov Plot

Giggenbach Triangle

Ludwig-Langelier Plot

Meteoric Water Line
(MWL) Plot

Piper Diagram

Schoeller Plot

Stiff Plot

Ternary Plot
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Wilcox Plot

24.3.1

Box and Whisker
The Box and Whisker plot displays a statistical summary of any measured database
parameter(s). It is composed of a central box, showing the spread of the bulk of the data
(typically the 25th-75th quantile range), and a pair of whiskers, showing the range of the tails
(typically the 5th-95th quantile range). Hydro GeoAnalyst supplements this chart type by
allowing you to add the min, max, median, and average values to the plot:
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Source Data Tab
Data are specified in a Box and Whisker Plot as follows:

Source
See common plot settings.

Parameters
The parameters dropdown menu allows you to select if the plot will include:
· single parameter versus a specified (station or sample) parameter (such as Station

Name)
· multiple parameters for a specified set of samples

Axis/Parameter Settings (Single Parameter)
A parameter in the Box and Whisker plot is specified for the category (X) axis and for the
value (Y) axis. The X-axis (category) data source is used to group the data and value
statistics are calculated for each category and plotted along the Y-axis.
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Axis/Parameter Settings (Multiple Parameters)
Multiple parameters in the Box and Whisker plot are specified. Each parameter is assigned a
category along the X-axis and value statistics are calculated and plotted for each parameter
along the Y-axis. Note that all parameters in a multi-parameter plot must share a unit
measurement category (e.g. concentration) and are plotted with the same units:

Box and Whisker Settings
The following settings can be applied to the Box and Whisker plot:
· Box width: width of the box and whisker relative to each x-axis category
· Box color: fill color of each box
· Box percentiles: quantile range for each box (defaults in bold): 25/75, 10/90, 5/95,
·
·
·
·
·

1/99
Whisker percentiles: quantile range for each set of whiskers (defaults in bold): 25/75,
10/90, 5/95, 1/99
Show Maximum: toggles the visibility of the maximum data point of each category
Symbol (Maximum): style controls for the maximum symbol of each category
Show Minimum: toggles the visibility of the minimum data point of each category
Symbol (Minimum): style controls for the minimum symbol of each category
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· Show Average: toggles the visibility of the average of the values data for each

category
· Symbol (average): style controls for the average of the values for each category

The symbol picker allows you to customize the shape and color of the select symbol type
(min, max, average) as well as the color and thickness of its outline:
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Detection Summary
The Detection Summary plot is used to visualize the relative proportions of samples above
the active Water Quality Standards. The plot shows a summary bar for every parameter with
the percentage of values where the constituent concentration is:
· below the detection limit,
· between the detection limit and an active water quality standard, and
· exceeds an active water quality standard

An example the Detection Summary plot based on the demo project is shown below:
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The X-axis of the Detection Summary plot spans from 0 to 100 percent of samples. The
name of each parameter is listed on the left side of the plot for the applicable detection
summary bar. The number of samples for each parameter is also (optionally) displayed.
Source Data Tab
Data are specified in a Detection Summary Plot as follows:
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Source
See common plot settings.

Parameter
In a Detection Summary plot, you may add one or more parameters, which are plotted in the
order listed along the Y-axis.

Detection Summary Tab
The following settings can be applied to the Detection Summary plot:
· Bar Width: allows you to set the width of each bar as a percentage of the category; a

value of 100% will leave no gap between categories
· Color: three color boxes allow you to specify the fill color of the bars for data based on
values:
o Below Detection Limit
o Below standard (but above detection limit)
o Above standard
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Durov Plot
The trilinear Durov plot is a composite plot based on the percentage of major ion
milliequivalents and two (optional) additional water quality parameters (Durov, 1948). Major
cation and anion values are plotted on two separate triangular plots and the data points are
projected onto a shared rectangular grid at the base of each triangle. The Durov plot also
allows for the direct comparison of two other groundwater parameters, typically pH and the
total dissolved solids (TDS) or electrical conductivity. The Durov plot is an alternative to the
Piper Diagram which is described later in this chapter.
Since the data points are projected along the base of the triangle, which lies perpendicular to
the third axis in each triangle, information about the concentration of the vertex element (the
third element) is lost in the square grid. Changing the orientation of parameters in both
triangles may improve your ability to detect distinct groups.
An example Durov Plot Options based on the Demo project is shown in the figure below:
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Source Data Tab
Data are specified in a Durov Plot as follows:
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Source
See common plot settings.

Parameters
Durov Plots have a total of eight required parameters:
· three major anions, typically: chloride (Cl), bicarbonate (HCO3) and carbonate (CO3),

and sulfate (SO4);
· three major cations, typically: sodium (Na) and potassium (K), magnesium (Mg), and

calcium (Ca);
· right frame parameter, typically: conductance or total dissolved solids; and
· bottom frame parameter, typically: pH

The cations specify the parameters that are presented in the left triangle. Default settings
are the major cations Na+K, Ca, and Mg; however the parameters can be reordered or any
other parameter can be selected (e.g. gas composition, trace elements etc.). The anions
generally specify the parameters for the upper triangle. Default settings are the major anions
Cl, SO4, and HCO3+CO3 and, as with cations, anions can be reordered or substituted with
other suitable parameters. Note that measured or calculated Alkalinity may be a valid anion
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parameter. If using the alkalinity in the anion triangle, you would typically change the
respective displayed label field to HCO3+CO3.
Each of the parameters also contain a matching Label field. This allows customization of the
parameter labels on the plot diagram. For example the parameter `Ca' can be edited in the
Label field to displayed as `Calcium'.

Durov Settings Tab
The Durov tab contains options to show/hide and scale the right (conductance/TSS) and/or
lower (pH) plot.

24.3.4

Giggenbach Triangle
The Giggenbach triangle (1988) provides a visual aid to determine the water-rock
equilibrium. An example of the Giggenbach Triangle plot and the corresponding Giggenbach
Triangle Options dialogue is shown in the figure below.
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The Giggenbach Triangle (K-Mg-Na Triangle) representation allows you to verify the extent
to which water-rock equilibrium has been attained. The triangle is comprised of three zones:
· Immature waters (at the base);
· Partially equilibrated waters (in the middle); and
· Fully equilibrated waters (along the curve).

Depending on where the composition of a given sample lies within this triangle, you can
estimate the extent of rock-water equilibrium. For mature waters falling near the upper curve,
you can estimate the temperature as well.
Source Data Tab
Data are specified in a Giggenbach plot as follows:
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Source
See common plot settings.

Parameters
Giggenbach plots have a total of three required parameters:
· Potassium (K);
· Sodium (Na); and
· Magnesium (Mg)

Giggenbach Triangle Settings Tab
The Giggenbach triangle tab contains options to enter division factors for K (left
denominator) and Na (right denominator) in the fields provided. The default values for the
plot are K/100 and Na/1000. There also options to show/hide and format the full equilibrium
line, the partial equilibrium line, and the temperature markers for the full equilibrium line.
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Histogram
One of the oldest methods for summarizing data distributions is the histogram. A histogram
is constructed by dividing the data range into bins, which consist of ranges of values,
counting the number of samples within the bins, and displaying the counts in each bin using
a bar graph. An example of a Histogram plot is shown in the figure below.
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Source Data Tab
Data are specified in a Histogram plot as follows:
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Source
See common plot settings.

Parameters
Histogram plots have a single parameter which must contain numeric values.
Histogram Settings Tab
The Histogram tab contains options to set the width of the bar as a percentage of their
category (i.e. a value of 100 will produce bars with no gaps). There also options to format the
bar color/outline and whether to show the distribution as a percentage or as a count.
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Ludwig-Langelier Plot
The Ludwig-Langelier plot allows you to quickly see patterns and correlations between the
major cations and anions for multiple samples. An example of the Ludwig-Langelier plot and
the corresponding Ludwig-Langelier Plot Options dialogue is shown in the figure below.
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The Ludwig-Langelier square plot is similar to the (central) projection areas of the Piper and
Durov plots. By convention, the sums of selected cations are plotted on the X-Axis and the
sums of selected anions are plotted on the Y-Axis. Each axis typically ranges from 0 to 50
meq%. Suitable groupings of cations and anions are selected and plotted as percentages.
Generally, this type of graph is used to plot %(Cl+SO4) versus %(Na+K). Sample points are
calculated (by default) on a forced ion balance basis as follows:

where:

= percent sodium and potassium in %meq
= concentration of sodium in meq/L
= concentration of potassium in meq/L
= sum of cations (see functions)
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= percent sodium and potassium in %meq
= concentration of sodium in meq/L
= concentration of potassium in meq/L
= sum of anions (see functions)

Sample points may alternatively be calculated without a forced ion balance:

Major ions can be displayed in one plot with the Ludwig-Langelier plot; however, like the
Piper and Durov plots, the Ludwig-Langelier plot displays relative ratios rather than absolute
concentrations.
Source Data Tab
Data are specified in a Ludwig-Langelier plot as follows:
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Source
See common plot settings.

Parameters
Ludwig-Langelier Plots two input parameters:
· Cation: one or more cations, typically: Na+K;
· Anion: one or more anions, typically: Cl+SO4

Note: that multiple parameters can be selected by holding the <CTRL> key while left-clicking
to add/remove parameters from the parameter picker.

24.3.7

Meteoric Water Line (MWL) Plot
The Meteoric Water Line plot is the standard way to portray measurements of stable
isotopes in water, oxygen-18 (
) and deuterium ( ). It consists of a scatter plot showing
on the X-axis and
on the y-axis and compared to the global meteoric water line
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developed by Craig (1961). The global meteoric water line defines the ratio of the stable
isotopes in natural meteoric waters (i.e. water derived from snow, rain, and other forms of
precipitation) and is typically defined by the following equation:

Most groundwater and precipitation samples plot close to the line. In cases where the
measured values are shifted from this line, the type of shifting provides important information
regarding the process leading to the observed shift (e.g. rock-water interaction, evaporation,
mixing with seawater, etc.).

Source Data Tab
Data are specified in a Meteoric Water Line plot as follows:
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Source
See common plot settings.

Parameters
Meteoric Water Line Plots have a total of two required parameters:
· X-Axis: typically the Oxygen-18 (
· Y-Axis: typically the Deuterium (

) parameter
) parameter

Note: the Meteoric Water Line is added as a custom line and the default values of the slope
(8.2) and intercept (10.8) in the Meteoric Water Line fitting equation can be changed to
match regional variations in the line. You can change the default values in the regional
chemistry tab of the project settings or you can add a custom regional line in the plot
settings.
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Pie Chart
Pie charts are simple plots for showing parameter portions in a sample. An example of the
Pie chart is shown in the figure below.

When a Pie chart is based on multiple samples, the average parameter values of the
applicable samples will be plotted. If one or more of the parameters in a given sample are
missing, that particular sample will not be included in the average. If you want to create a
series of individual plots for samples in a particular sample set or station group, you can use
the generate multiple plots option.

Source Data Tab
Data are specified in a Pie chart as follows:
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Source
See common plot settings.

Parameters
Pie charts can have any number of numeric parameters as input.

Pie Chart Settings Tab
The Pie tab contains the following options:
· Slice Option: defines which labels will be shown for each slice:

·
·
·
·

o None: no labels will be shown
o Series: parameter labels
o Value: parameter values
o Percentage: slice percentage
Show leader lines: shows/hides the leader lines between slices and their labels
Color: color of the leader lines
Thickness: thickness of the leader lines
Style: style of the leader lines (solid, dashes, dots, dash-dot, dash-dot-dot)
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Show Outline: shows/hides the outline of the pie and category slices
Color: color of the outline
Thickness: thickness of the outline
Slice Colors: color picker for each parameter in the pie

Piper Diagram
The Piper plot is useful for showing multiple samples and trends in major ions. An example
of the Piper plot and the corresponding Piper Plot Options dialogue is shown in the figure
below.
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In a Piper plot, the major ions are plotted on separate cation (typically: Na+K, Ca, and Mg)
and anion (typically: Cl, HCO3+CO3, and SO4) ternary diagrams in terms of percent
milliequivalents in two triangles along the base. The total cations in meq/l, and the total
anions in meq/l, are set equal to 100%. The data points in the two triangles are then
projected onto the diamond grid. The projection reveals certain useful properties of the total
ion relationships. Every sample is represented by three data points; one in each triangle and
one in the projection diamond grid.
The Piper plot allows comparisons of 6 parameters between a large number of samples.
Like all trilinear plots, it does not portray absolute ion concentrations; however, you can
indirectly add this information by using symbol sizes (in the central rectangular plot) that are
sized proportionally to a measure of the total ionic concentration (typically, the measured
TDS or conductance). The main purpose of Piper plots is to show clustering of samples and
infer hydrochemical facies of samples or clusters of samples.

Source Data Tab
Data are specified in a Piper plot as follows:
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Source
See common plot settings.

Parameters
Piper Plots have a total of six required parameters:
· three major cations, typically: sodium (Na) and potassium (K), magnesium (Mg), and

calcium (Ca); and
· three major anions, typically: chloride (Cl), bicarbonate (HCO3) and carbonate (CO3),

and sulfate (SO4)
The cations specify the parameters that are presented in the lower left triangle. Default
settings are the major cations Na+K, Ca, and Mg; however the parameters can be reordered
or any other parameter can be selected (e.g. gas composition, trace elements etc.). The
anions generally specify the parameters for the lower right triangle. Default settings are the
major anions Cl, SO4, and HCO3+CO3 and, as with cations, anions can be reordered or
substituted with other suitable parameters.
Each of the parameters also contain a matching Label field. This allows customization of the
parameter labels on the plot diagram. For example, if you used Alkalinity as one of the input
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(anion) parameters, you may wish to edit the label so that the parameter is displayed as
`HCO3+CO3'.

Piper Plot Settings Tab
The Piper tab contains options to scale the size of the data point symbols in the
central/diamond portion of the Piper plot proportional to the value of a specified parameter:

24.3.10 Probability Plot
Probability plots involve plotting ranked data against quantiles of the normal distribution.
They are particularly useful for spotting irregularities within the data when compared to a
specific distribution model, particularly the Normal distribution, which plots as a straight-line
on a Probability plot (where the slope is the standard deviation and the Y-intercept is the
mean). An example based on the value of field-measured pH of samples in the Demo project
is shown below:
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To create a probability plot, the data are ranked in order of lowest value (1) to highest value (
, where is the number of values). The y-coordinate of the probability plot is the value of the
data. The x-coordinate is based on the Normal Score ( ), which Hydro GeoAnalyst
automatically determines using the uniform order statistic ( ), as follows:

where:

= Normal Score
= inverse function of the normal distribution
= uniform order statistic given by:
for

where:

= rank of ith smallest value for the plot dataset
= count of all values for the plot dataset
= 0.3175
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Using this plot, it is possible to observe whether and where departures from normality are
occurring - in the middle ranges of the data or in the extreme tails. Probability plots can also
indicate:
· the presence of possible outlier values
· different subsets of the data that do not follow the basic pattern of the data, and
· the presence of significant positive or negative skewness.

A log-scale transformation on the y-axis may be used to test whether a dataset that shows
non-normal behavior is log-normally distributed.

Source Data Tab
Data are specified in a Probability plot as follows:

Source
See common plot settings.
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Parameters
Probability plots are limited to a single selectable parameter, plotted on the Y-axis. The xaxis data are plotted based on the Normal score ( ), as defined above.

24.3.11 Quantile Plot
The Quantile chart (sometimes known as the cumulative frequency chart) plots the values of
the ranked data from lowest to highest on the Y-axis and the cumulative frequency on the Xaxis. The estimated cumulative frequency (X-coordinate) of the data is given by:
for

where:

is the cumulative frequency/quantile of the ranked dataset, 0 <

<1

is the rank of the ith sample
is the number of samples

An example based on the sodium concentration of samples in the Demo project is shown
below:

©2022 by Waterloo Hydrogeologic

816

Hydro GeoAnalyst 11.0

Using this plot, it is possible to observe the distribution of the data and estimate quantile
values and ranges.

Source Data Tab
Data are specified in a Quantile plot as follows:
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Source
See common plot settings.

Parameters
Quantile plots are limited to a single selectable parameter, plotted on the Y-axis. The x-axis
data are plotted based on the estimated cumulative frequency, as defined above.

24.3.12 Radial Plot
Radial plots (also known as radar plots) are used to compare multiple parameter values for a
single sample and to compare the ratios of these values for many different samples. An
example of the Radial plot is shown in the figure below.
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Radial plots can be used to evaluate the change in water quality at a single location over a
period of time, or they can be used to evaluate the change in water quality as the water
passes through different geologic formations or different subsurface conditions.

When a radial plot is based on multiple samples, the average parameter values of the
applicable samples will be plotted. If one or more of the parameters in a given sample are
missing, that particular sample will not be included in the average. If you want to create a
series of individual plots for samples in a particular sample set or station group, you can use
the generate multiple plots option.

Source Data Tab
Data are specified in a Radial plot as follows:
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Source
See common plot settings.

Parameters
Radial plots can have any number of numeric parameters as input.

Radial Plot Settings Tab
The Radial tab contains the following options:
·
·
·
·
·

Show fill: if selected, the radial plot will include a fill color as defined below
Color: color of the radial plot fill
Show outline: if selected, the radial plot will include a line color as defined below
Color: color of the outline
Thickness: thickness of the outline
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24.3.13 Scatter Plot
Scatter plots are the most simple and popular approach to interpreting hydrochemical data.
Scatter plots can show effects such as correlation of parameters or clustering of samples in
a very intuitive manner. An example of the Scatter plot and the corresponding Scatter Plot
Options dialogue is shown in the figure below. Note a custom (1:1) line has be added to the
plot.
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Source Data Tab
Data are specified in a Scatter plot plot as follows:
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Source
See common plot settings.

Parameters
The parameters dropdown menu allows you to select if the plot will include:
· single parameter versus another categorized by the active symbol set specified in the

Symbol Editor
· multiple parameters for a specified set of samples

Symbols (Multiple Parameters only)
The symbols dropdown is shown only for multiple parameter scatter plots and alllows you to
select a set of symbols defined in the Symbol Editor. Symbols from the specified symbol
group will be associated with the added parameters in the order listed.
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Axis/Parameter Settings
Single Parameter Plots
Scatter plots consist of two input parameters, an X-axis parameter and Y-axis parameter.
Both X- and Y-axis parameters must contain numerical inputs.

Multiple Parameters Plots
When the Multiple parameters option is selected, you can add a single numeric parameter to
the X-axis and two or more numeric parameters to the Y-axis and/or Y2-axis. The Y-axis is
the primary vertical axis and is located on the left side of the plot, while the (optional) Y2-axis
is the secondary vertical axis and is located on the right side of the plot. All parameters on
the same axis (the Y-axis or the Y2-axis) must share the same unit category.

24.3.14 Schoeller Plot
Schoeller (1962) developed semi-logarithmic plots to represent major ion analyses in
milliequivalents per liter (meq/L) and to demonstrate different hydrochemical water types on
the same plot. Altough multiple analyses (i.e. samples) can be plotted on a Schoeller plot,
the number is practically limited to a small number as the graph can be difficult to interpret
as more data series will increase clutter on the plot. However, the plot has the advantage
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that, unlike trilinear plots, actual parameter concentrations are displayed. An example of the
Schoeller plot is shown in the figure below.

Source Data Tab
Data are specified in a Schoeller plot as follows:
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Source
See common plot settings.

Parameters
Schoeller plots consist of two input parameters, an X-axis parameter and Y-axis parameter.
Both X- and Y-axis parameters must contain numerical inputs.

24.3.15 Stacked Bars Plot
The Stacked Bars plot allows you to select multiple numerical parameters of a similar
category (e.g. cations) to plot for a specified category (e.g. Station, Sample ID, Sample
Date, Site, etc.). Each parameter is represented by a bars that are stacked and scaled
proportionately to their value.separately. The height of the resulting bar shows the combined
result of the groups. However, stacked bar charts are not suited to data sets where some
groups have negative values.
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Source Data Tab
Data are specified in a Stacked Bar plot as follows:
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Source
See common plot settings.

Parameters
Stacked Bar plots consist of the following input parameters:
· X-axis: one category parameter
· Y-axis: one or more numerical parameter values.

Stacked Bar Settings Tab
The Stacked Bar tab contains the following options:
· Bar width: width of the bar as a percentage of the category (i.e. a value of 100 will
·
·
·
·

produce bars with no gaps)
Show Outline: if selected, the bars will include an outline
Color: color of the radial plot fill
Thickness: thickness of the outline
Bar Colors: color picker for each stacked bar parameter in the plot
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24.3.16 Stiff Plot
The Stiff plot belongs to the group of pattern plots (see Hem 1985, p. 175). It is constructed
by plotting the milliequivalents per liter of (typically three) matched pairs of cations and
anions. Stiff plots can be used to evaluate the change in water quality at a single location
over a period of time, or they can be used to evaluate the change in water quality as the
water passes through different geologic formations or different subsurface conditions. An
example of the Stiff plot is shown in the figure below.
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If multiple samples are selected, the Stiff plot will be based on the average concentrations of
parameters specified in the source data. If you want to generate individual plots for many
samples or stations, you can use the generate multiple plot options.

Source Data Tab
Data are specified in a Stiff plot as follows:
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Source
See common plot settings.

Parameters
Stiff Plots have cations and anions as required parameters:
· Cations, typically: sodium (Na) and potassium (K), magnesium (Mg), and calcium

(Ca); and
· Anions, typically: chloride (Cl), bicarbonate (HCO3) and carbonate (CO3), and sulfate

(SO4)
The number of cations must match the number of anions (typically three of each), noting that
cations/anions may be composed of more than one parameter (e.g. Na+K or HCO3+CO3).
Multiple parameters can be selected by holding the <CRTL> key when selecting parameters
in the parameter picker.

Stiff Plot Settings Tab
The Stiff Plot tab contains the following options:
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Show Fill: if selected, the Stiff plot will be filled
Color: color of the Stiff plot fill
Show Outline: if selected, the Stiff plot will include an outline
Color: color of the outline
Thickness: thickness of the outline

24.3.17 Ternary Plot
Ternary plots are used to determine the relationship between the concentrations of three
different parameters in multiple samples. An example of the Ternary plot is shown in the
figure below.
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Like Piper and Durov plots, the Ternary plot displays relative concentrations of each
parameter with respect to the sum of the concentrations of each parameter. Each vertex of
the Ternary plot represents a relative concentration of 100% for the parameter at the
respective vertex, while the base represents a relative concentration of 0% for the parameter
plotted at the opposite vertex.

Source Data Tab
Data are specified in a Ternary plot as follows:
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Source
See common plot settings.

Parameters
Ternary plots have three required parameters.

24.3.18 Time Series Plot
The Time Series plot shows the evolution of a chemical or physical parameter for a given
sampling point as a function of time. This plot is a standard technique for interpreting
hydrochemical and hydrogeological processes and in particular temporal trends in natural
waters.
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Source Data Tab
Data are specified in a Time Series plot plot as follows:
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Source
See common plot settings.

Parameters
The parameters dropdown menu allows you to select if the plot will include:
· single value parameter versus a specified date/time field categorized by the active

symbol set specified in the Symbol Editor
· multiple parameters for a specified set of samples versus a specified date/time field

Symbols (Multiple Parameters only)
The symbols dropdown is shown only for multiple parameter time series plots and alllows
you to select a set of symbols defined in the Symbol Editor. Symbols from the specified
symbol group will be associated with the added parameters in the order listed.
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Axis/Parameter Settings
Single Parameter Plots
Single parameter time series plots consist of two input parameters:
· X-axis parameter: a time/date data source, typically the sample date from the Sample

List table
· Y-axis parameter: a numerical input, typically a concentration

Multiple Parameters Plots
When the Multiple parameters option is selected, time series plots consist of the following
parameters:
· X-axis parameter: a time/date data source, typically the same date from the Sample

List table
· Y-axis parameters: two or more numerical input parameters

Parameters can be added to the (primary) Y-axis which is located on the left side of the plot,
or to the (optional, secondary) Y2-axis which is located on the right side of the plot. All
parameters on the same axis (the Y-axis or the Y2-axis) must share the same unit category.
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] using the appropriate

24.3.19 Wilcox Plot
A Wilcox plot can be used to quickly determine the viability of water for irrigation purposes
(Wilcox, 1955). The Wilcox plot is also known as the U.S. Department of Agriculture diagram
(Richards, 1954). An example of the Wilcox plot is shown in the figure below.

The Wilcox plot is a semi-log scatter plot of the "sodium hazard" (sodium adsorption ration
[SAR]) on the Y-axis versus the "salinity hazard" (electrical conductivity) on the X-axis. The
conductivity is plotted by default in a log scale. The Wilcox plot contains the following zones:
Salinity Hazard Zones: based on electrical conductivity (us/cm)
· C1: Low (0-249)
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· C2: Medium (250-749)
· C3: High (750-2249)
· C4: Very High (2250-5000)

Sodium Hazard Zones: based on Sodium Adsorption Ratio lines:
·
·
·
·

S1: Low
S2: Medium
S3: High
S4: Very High

The locations of the SAR lines are determined by the following equations:
· S1/2: Line equation: y= -1.5816E-3 x + 10.15816
· S2/3: Line equation: y= -2.2959E-3 x + 18.22959
· S3/4: Line equation: y= -3.0102E-3 x + 26.30102

Source Data Tab
Data are specified in a Wilcox plot as follows:
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Parameters
Wilcox plots have a total of two required parameters:
· X-Axis: typically the Electrical Conductivity parameter
· Y-Axis: typically the calculated Sodium Adsorption Ratio (SAR)

Note: the Sodium Hazard lines are added as custom lines and the default values of the
slope and intercept of each line may be customized as desired.

24.4

Symbol Editor

The Symbol Editor allows you to define the symbols assigned to the Sample List and used in
Plots. There are two different kinds of symbols available:
·

Symbol Groups: the (generic) symbol groups are simple lists of specified symbols
that are not tied to a data source. Symbols will be assigned to data categories based
on the sort order of the data source.

·

Parameter-based Symbol Groups [HGA+ only]: parameter-based symbol groups
are tied to the values associated with a given station, sample, or analytical parameter.
If the symbol group is based on a non-numeric parameter, a separate symbol will be
generated for each value unique value; whereas numeric parameters will be based on
rages of values.

The symbol editor module is shown below:
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Toolbars
The Symbol Editor includes two toolbars:

Symbol Group Toolbar
The symbol group toolbar provides tools to manage symbol groups in the project:

New Parameter-Based Symbol Group [HGA+ only]: Creates a new parameterbased symbol group
New Symbol Group: Creates a new symbol group
Group Selection Dropdown: a dropdown selection list of symbol groups in the project
Delete: deletes the current symbol group
Rename: rename the current symbol group
Apply: applies the currently selected symbol group to the project and updates
symbols in the sample list and active plot collections
Symbol Toolbar
The symbol toolbar provides tools to work with individual symbols:

Add Symbol: Adds a new symbol to the group
Delete Symbol: deletes the currently selected symbol(s)
Save Changes: saves changes to the active symbol group
Refresh: reloads the symbols in the active symbol group from the database
Group Colors: loads the group settings window

Creating a New Parameter-Based Symbol Group
When you create a new parameter based symbol group, the Parameter Selector will be
displayed allowing you to define the symbol categories:
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To generate new symbols, simply select a parameter using the parameter selection. You
may filter the parameters using the dropdown list. In the example shown above, the Station
parameters will be based on unique values of the "Geology" Station parameter. You can also
choose parameters with numeric values. In this case, you will have the option to generate
symbols based on unique values or classified values with a specified number of categories.
For example, using the Demo Project, the Chloride (Cl) parameter with 4 categories would
be classified as follows:
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The options for numeric symbols include:
· Distinct Values: categories will be generated with one symbol for each distinct value
· Use Categories: a specified number of categories will be automatically generated

based on the magnitude of the values (typically between 2 and 10 categories).
o Category type: the method used to define category breaks
§ # of categories: categories will be broken down into the specified number of

linearly divided breaks
§ Quantile: categories will be broken down into the specified number of quantile

breaks (each category will have an equal number of data points)
§ Log: one category will be generated for each order of magnitude between the

specified data range
o Manually specify range: allows you to specify the data range for the generated
symbols
o Prepend parameter name to symbol labels: allows you to include the name of the
parameter in the symbol labels
o Reset: allows you to reset the settings above to the default values.

Creating a New Symbol Group
When you create a new symbol group, the "New symbol group" window be displayed:
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To generate new symbols, simply provide a name and a number of symbols. Any plots that
use this symbol group will assign the symbols based on the order in which they appear in the
plot data source settings. If the number of data series exceeds the number of symbols in the
specified symbol group, the symbols will be assigned by cycling through the list, repeatedly,
if necessary.

Editing Individual Symbols
The following settings are available for individual symbols.

Connecting Line
The following settings are available for formatting individual symbols:
· Color: the color of the line connecting symbols for the same series
· Style: the connecting line style (Solid, Dash, Dot, DashDot, DashDotDot)
· Thickness: the thickness of the connecting line

Label
The following settings are available for formatting individual symbols:
· Label: the text to be displayed in the legend

Range
The following settings are available for formatting individual symbols:
· From: the value used to define the symbol; the lower bound if the source field is

numeric and ranges of values are used
· To: the upper bound value used to define the symbol
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Shape
The following settings are available for formatting individual symbols:
·
·
·
·

Color: the fill color of the symbol (shown in grey below)
Outline color: the color of the outline of the symbol (shown in black below)
Outline thickness: thickness of the symbol outline
Shape: one of the following 16 symbol shapes:
A

E

B

C

D

F

G

H

J

K

L

N

O

P

I

M

· Size: the size of the symbol

Symbol Group Settings
The symbol group settings controls allow you to edit symbol colors for all symbols in the
active symbol group.
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The following settings are available for editing all of the symbols in the current group. For
each of the following settings:
· Symbol fill color: the fill color of symbols in the group
· Outline color: the symbol outline color
· Connection line color: the color of the connection line

You can select either a single color or a two-color ramp. Other settings are available for line
thickness:
· Thickness: symbol outline thickness
· Connecting Line: the symbol outline color

You can select whether the symbol size ramps proportionally to the parameter value,
including the range of symbol sizes and whether or not to set the symbol to a specific
symbol.
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Identify Data in Dynamic Plots
For plots using one of the parameter-based data sources available in HGA+ (i.e. not a
query), the plots will be interactive. This means that if you click on a unique data point in a
given plot, then the corresponding sample will be selected in both the Sample Picker and
Sample List. Similarly, if you select one or more samples in the Sample List, any
corresponding (distinct) data point(s) will be highlighted in applicable plots. This functionality
is made even more useful, when combined with a dynamic data source, such as Active
Sample Set or Active Station.
You can specify how to differentially display highlighted symbols on the plot using the Plots
options by selecting Project > Preferences from the main menu. To maximize the
usefulness of this functionality, it is recommended that you take advantage of the adjustable
windows options available with Hydro GeoAnalyst so that you can view multiple types of
information update simultaneously as you interact with them.

Limitations
The dynamic highlighting linking selections described above does not apply under the
following conditions:
· Plots based on a query-based data source and plots based on displaying aggregated

data (e.g. Box and Whisker, Probability Plot, Pie Chart, Stiff Plot, etc.) will not be
interactive
· Selecting data points on a plot collection using an export layout other than "None" will

not update selections in Hydro GeoAnalyst. However, you can update selections
(including in the plot collection with a layout other than "None" using the sample picker,
sample list, station list, or a different plot collection using the "None" layout.
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R-Console
R is a freely available scripting language and environment for statistical computing
developed by the R Foundation and supplemented by an active user community which
provides a vast variety of statistical and graphical procedures. The R-Console has been built
into Hydro GeoAnalyst to leverage the extensive data science libraries available in R.

Please Note: The R-Console is meant to be a light-weight
utility that provides a direct connection to your project data
rather than a replacement for more comprehensive
integrated development environments (IDE) for R such as
RStudio. As the R programming language is well
documented at the R-Project website and other sites, the
documentation provided in this section is limited to
descriptions of the functionality of the R-Console and a few
distinct differences between the version of R used in the RConsole module of Hydro GeoAnalyst and standard R.

The R-Console module is divided into four separate panes:
1. Input pane: a workspace to develop and input R scripts,
2. Output pane: outputs from scripts will appear here,
3. Project Data pane: allows you to easily add list variables containing values from a
project database field from a given station group, and
4. Parameters pane: allows you to easily add list variables containing parameter values
from a given sample set.
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Input Pane
The Input pane provides a workspace to develop R scripts. The Input pane includes the tools
described above as well as a status bar that provides a line and column counter for the
location of the cursor.

R-Console Toolbar
The R-Console contains the following controls:

·

New Script: creates a new empty script.

·

Rename: allows you to rename the current script.

·

Save: saves changes to the current script.

·

Save As: saves changes as a new script.
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·

Export to File: saves the script as an external file.

·

Run: runs the entire script.

·

Parse: parses Hydro GeoAnalyst-specific commands (e.g. the list constructors
built using the interface) into the raw data that can be run in native R interfaces such
as RGui or RStudio.

·

Stop: stops a running script.

·

Clear: clears variables in active memory from previous script runs

Differences between R-Console scripts and standard R scripts
There are several differences between the R scripts available in the Hydro GeoAnalyst RConsole and standard R-scripts:

· Multi-line commands: multi-line commands in many implementations of R do not

require a line-continuation character. In the case of R-Console, a '+' must be placed in
the first column of each continued line. To facilitate this, you can press
<SHIFT>+<ENTER> to continue a line and a '+' will be added for you. An example of a
continued line from the third script in the HGA+ Demo Project Tutorial tutorial is shown
below:
chart1 <- ggplot(df, aes(x=X, y=Y)) +
+
geom_point() +
+
ggtitle("Monitoring Well Coordinates") +
+
labs(x = "Easting (m)", y = "Northing (m)")
· Comments: similar to standard R, the '#' symbol defines a code comment and text

following this character will not be interpreted as part of the script. furthermore,
comments in the R-Console can also be in any column of the script; however, unlike
other implementations of R they cannot interrupt multi-line commands without causing
an error.
· Output: by default, most implementations of R echo commands from the script. Given

the potential for large datasets in Hydro GeoAnalyst, the echo has been disabled in RConsole so that script performance is not degraded. The output pane only displays
information that is passed through the print() command.
· Project Data variables: R-Console includes custom commands that allow Hydro

GeoAnalyst to inject project data into R. In this process, each script is interpreted in
two passes, the first by Hydro GeoAnalyst to convert these custom commands (this is
equivalent to the parse
button), the second pass is the interpretation of the R script
itself. An example from the second script in the HGA+ Demo Project Tutorial tutorial is
shown below:
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R-Console script with project data
Sample = c(SAMPLE[Name,SampleSet(5)])
Equivalent Parsed R-script with project data
Sample = c("1-2004-1", "1-2004-31", "1-2005-2", "1-2006-3",
"1-2007-4", "1-2008-5", "1-2009-6", "1-2010-7", "MW-1-92",
"MW-1-94", "3-2004-75", "3-2004-8", "3-2005-9", "3-2006-10",
"3-2007-11", "3-2008-12", "3-2009-13", "3-2010-14", "3-201081", "MW-3-92", "MW-3-94", "MW-3-98", "2-2004-15", "2-200516", "2-2007-18", "2-2008-19", "2-2009-20", "2-2009-80", "22010-21", "2-2010-51", "OW-2-92", "OW-2-95", "OW-2-97", "42004-22", "4-2004-52", "4-2005-23", "4-2006-24", "4-2007-25",
"4-2008-26", "4-2009-27", "4-2009-57", "4-2010-28", "4-201029", "4-2010-30", "4-2010-58", "OW-4-93", "OW-4-94", "OW-497")
For more information, see the sections on the Project Data pane and the Parameter
Pane.

Output Pane
The Output pane displays output from R scripts that have run. The Output pane contains one
button, (the
Clear button), which clears any output from the pane, and a status bar at the
bottom of the pane which provides information (e.g. whether a script is running or how long
scripts have taken to run). As described above, in order to improve the performance and
runtimes of scripts, the Output pane only broadcasts information from print() commands.

Project Data Pane: Adding a Project Data Variable
The Project data pane includes a hierarchical tree of the database structure organized by
data categories > tables > fields. The pane also includes controls:
·
·
·
·

Collapse tree: collapses the Project data tree
Search: searches the project database using the search term in the input box to
the left
Clear Search: clears the search bar
Show Tooltips: toggles whether tooltips are shown when hovering the mouse
pointer over a given entry in the tree
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Double-clicking a field in the project tree opens the New field variable window:

The following inputs are included in the window:
· Variable name: the name that will be used in the script, by default, this will be the

name of the selected field
· Fields: allows you to select a field that will be
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· Filter: allows you to constrain the data using one of the following options:

o Get all data: returns all data in the table from the selected field
o Active Station Group: data will be limited to the active station group
o Specific Station Group: data will be limited to the selected station group in the
Project Explorer using the accompanying dropdown menu
o Specific station: data will be limited to the selected station; the browse button will
invoke a Station picker
Click the

button to add the new list variable subject to the constraints listed above.

Parameter Pane: Adding a parameter variable
A parameter picker is included in the R-Console module to facilitate adding a list variable to
your script that includes the values of the selected parameter for a specified sample set.

The parameter picker includes a parameter group dropdown menu containing:
· Automatic parameter groups: station parameters, sample parameters, analyzed

parameters, cations, anions, ions, calculated parameters, and parameters used in a
standard; and
· Custom parameter groups: parameter groups created in the Parameter Group Editor
If you wish to add a parameter variable, use the parameter group dropdown menu and/or the
filter bar to find the desired parameter. Once you've located the parameter, you can select it
by double-clicking it and the new parameter variable window will appear:
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The following inputs are included in the window:
· Variable name: the name that will be used in the script, by default, this will be the

name of the selected parameter
· Parameter: the parameter that you selected; you can change the parameter if you

need to by selecting the

button

· Unit: the unit that will be used for the parameter (from the same unit category as the

parameter)
· Sample Set: allows you to select the sample set for which the variable applies

Click the
button to add the new parameter list variable to your script at the current
cursor location in the Input window.
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Online Sharing
This module allows you to share your HGA project with others who do not have the program
by creating a configurable webpage to share with project team members and/or
stakeholders. You can find this option by selecting Modules > Online Sharing

.

Project Tree Options
You can also load an existing Online Sharing configuration in the Project Tree by doubleclicking on it. Right-clicking on an existing Online Sharing item in the Project Tree will
provide the following options:

· New: creates a new empty Online Sharing configuration
· Open: opens the selected Online Sharing configuration
· Show in browser: provides a list of link(s) to recently published configurations.
·
·
·
·
·

Selecting a link will open the published Online Sharing configuration in your default
browser.
Rename: allows you to rename the Online Sharing configuration
Delete: deletes the selected Online Sharing configuration
New Folder: creates a new folder on the Online Sharing node of the Project Tree
Expand: expands the selected node of the Project Tree
Collapse: collapses the selected node of the Project Tree

Toolbar
The Online Sharing module contains several options for working with Online Sharing
configurations:

· Save: creates a new empty Online Sharing configuration
· Save as: opens the selected Online Sharing configuration
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· Launch browser: launches the most recently published version of the current Online

Sharing configuration in your default browser.
· Name: allows you edit the name of the Online Sharing configuration

Project Tab
On the first tab you can provide some general information regarding the project, including
the project name, a description, contact information and a project/corporate logo.

Please Note: although the supplied logo will be stretched to
fit the html container, the optimal dimensions are based on
an aspect ratio of 3:2 (e.g. 150 pixels wide by 100 pixel
high).
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Queries Tab
The Queries tab allows you to select one or more queries to display data that is important for
your project (for example chemical concentration information).

Charts Tab
The Charts tab allows you to create and organize charts based on data from one or more
queries using the Charts tree, as shown below.
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You can add, remove, edit, and organize charts to the Charts tree using the toolbar:

·
·
·
·
·
·

Add a chart page: creates a new empty chart configuration
Add a folder: opens the selected Online Sharing configuration
Delete: deletes the selected chart or folder
Move Up: moves the selected item up in the folder Chart tree
Move Down: moves the selected item down in the folder Chart tree
Rename Folder: allows you to rename the selected folder

Configuring the Chart
You can configure a chart selected in the Charts tree on the right side of the tab. The first
step is to select a Source query that contains the data to be plotted. Other options are
described below:

· Chart Title: allows you to create a title for the chart. This will be the label in the Charts

tree as well as the title displayed on the chart itself.
· Chart Type: allows you to choose what type of plot will be shown on the chart;

currently, you can choose from Line or Scatter.
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· X-axis: allows you to select the source data for the X-axis - this is commonly a

date/time field.
· X-axis label: the label for the X-axis that will appear on the chart
· Y-axis label: the label for the Y-axis that will appear on the chart
· Plot options: a set of options to add Y-value source data and configure the

appearance of the data series:

Please Note: the query should be set up to sort the data according to the source data
field for the X-axis otherwise the data plot may not appear correctly.

Plot Options
The following options are available to configure the series plotted on the Chart:

· Add Series: adds a new data series for plotting
· Add Line: adds a new line with a specified constant Y-value. This is particularly useful

if you want to add a threshold/criteria value to compare against the data (e.g. a
regulatory limit concentration).
· Remove series: removes the currently selected data series.
Series Options
· Group-by-Field: the field by which data series should be grouped into distinct series
(e.g. Station name or Station ID) (for Series only)
· Constant: a constant value to plot (for Lines only)
· Name: the name of the data series to be added.
· Source Field: the field in the data query which contains the y-values of the series (for
Series only)
Style Options
· Line Color: sets the color of the lines for the data series
· Line Style: allows you to select the line type. Options include: Solid, Dash, or Dot
· Line Thickness: allows you to select the width of the line
· Point Color: sets the color of the data points for the data series
· Point Size: sets the size of the data point for the data series

Maps Tab
The Maps tab allows you to select layers from any of the maps in your project that you wish
to share. Additionally, any water level information for the points layers you select from the
map will be included in the Online Share. You have an option to specify if you want a specific
date range for the water levels or simply include all water levels. This will be displayed as
water level elevations in the Online Share when you select a station on the Map.
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Publish
Once you have setup the Online Sharing Configuration, you can select the publish button at
the bottom of the dialog. This allows you to configure where the Online Sharing webpage
will be published to. Options include:

When publishling a configuration, you may select the option to launch your default browser
at the Project page of the published Online Sharing Configuration.
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Custom Web Server
If you select the custom web server option, the Online Sharing Configuration will be
published directly to the webserver you specify via FTP. You must have the proper
credentials to access and modify files in the location you specify.

Local File Folder
If you select the Local file folder option, the Online Sharing Configuration will be published to
a local folder that you specify. You have the option to clear out the contents of this folder
before publishing so that you only have the latest information present in the folder you
specify.

Please Note: most browsers will not correctly display files
loaded from a local or network drive. In order to view the
Online Share correctly, they must be viewed via a web
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server. You may be able to preview files stored locally by
using a local web server such as IISExpress.

Water Hydrogeologic (Demo) Web Server
If you select the Waterloo Hydrogeologic (Demo) Web Server, the Online Sharing
Configuration will be published to the Waterloo Hydrogeologic Demo (Demo) server. This
server is available as a courtesy for demonstration/preview purposes only.

Please Note: In order to ensure that you do not overwrite
an existing Online Sharing configuration of another user,
each time you publish to the Demo server, the resulting
webpage address will include a unique 16-digit key. You can
access the publication history and the resulting unique
address of a given configuration publication event by rightclicking on that configuration and selecting the show in
browser option.

Caution: The Waterloo Hydrogeologic (Demo) Web server
option should not be used to publish private or confidential
information or be used for long-term data sharing as the data
are publicly visible and may be deleted at any time as part of
maintaining the server. All information published to the
demo web server is subject to the software Terms and
Conditions associated with your license of Hydro
GeoAnalyst. See Section 11 for more details.

Example
The following images are screenshots of an example project Online Share:
Project Tab Example

Queries Tab Example
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Charts Tab Example

Maps Tab Example

If you select one of the stations on the map you will find a pop up with some additional
information.

©2022 by Waterloo Hydrogeologic

863

864

Hydro GeoAnalyst 11.0

Also, the pop up will provide a link to visualize the water levels (in another window)
associated with that stations if the water level data options were set up on the Maps tab.
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Quick Checker
The Quick Checker is a tool to help you organize your data from spreadsheets into a format
ideal for importing into your database and then validate it before importing it into the
database.
The Quick Checker module is an important part of the overall EDD workflow, which includes
four simple steps:
· Create a new Electronic Data Deliverable (EDD) template using the EDD Template

Designer
· Open the EDD template and the source data file within the Quick Checker
· Use the Quick Checker to validate your data against the EDD template and generate a
*.zip_hga import file
· Import the *.zip_hga directly into Hydro GeoAnalyst; data mapping and validation has
already been completed by the Quick Checker
The Quick Checker can launch as a module from the main toolbar by selecting the
button on the main Hydro GeoAnalyst toolbar.

Standalone Version
You can install the Quick Checker as a stand alone application for use on computers that do
not have Hydro GeoAnalyst installed or licensed, including external project stakeholders
such as subcontractors, analytical labs, or support teams. The standalone installation can be
downloaded from the Waterloo Hydrogeologic website at
https://www.waterloohydrogeologic.com/support/getting-started/ and finding the
Hydro GeoAnalyst Quick Checker link:
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The standalone version allows project partners (i.e. field personnel, analytical laboratories,
and subcontractors) to use the Quick Checker without requiring a full license of Hydro
GeoAnalyst. This allows them to provide you with a single data file (i.e. the *.zip_hga import
file) which is pre-validated and pre-mapped, making it extremely simple for Hydro
GeoAnalyst database managers to import that data.

Opening Quick Checker
When the Quick Checker module is first launched, the window below will open:

You can select the new button
by selecting the

to create a new quick checker file or open an existing one

button and browsing to your saved *.qck file.

The Quick Checker method is based on the following components:
· An EDD template file (*.tmpl), which contains data validation criteria
· A Microsoft Excel data file (*.xls, *.xlsx), which contains the data to be imported
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· A Quick Checker file (*.qck), which represents the combination of the EDD template

and Excel data files (i.e. intermediate file type, after import but before validation)
· A validated Quick Checker import file (*.zip_hga), which can be imported directly

into HGA
When creating a new file you will be prompted to select the EDD template file you wish to
use and then you are given the option to either enter data manually or import data from a
selected excel file.

When choosing to import data from an excel file you will need to map your spreadsheet to
the fields in the EDD similar to the way you map in the General import routine. If your
spreadsheet does not contain one of the fields you have the option to Add empty column so
you can manually enter this data for validation.
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This quickly brings your data into the Quick Checker for validation. You should see a data
tab associated with data table that was included in the EDD template file. You still have the
option to add or edit data after importing the data in. This can be done manually by simply
selecting the desired data field and typing the required values. If the EDD template includes
a 'pick list' for any particular field then the pick list will be displayed when entering values into
that field (e.g. see the 'Color' field in the image below). It's also possible to manually add or
remove rows from the Quick Checker using the 'Add New Row' ( ) and 'Delete Selected
Row(s)' ( ) buttons.
In the following example you can see there are some problems with the data. The tab where
errors occur are flagged (red) and the errors are displayed on the right hand side Error
section. If you double click on an error it will take you to the row containing the error so you
can correct it. Once all errors are corrected the flag will disappear, and the data will then be
ready for validation.
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Under the Quick Checker toolbar you will be able to save the existing Quick Checker file
(*.qck) for future use by clicking the Save button ( ). If you have additional Excel
spreadsheets with further data to be imported you can click the 'Import MS Excel File' button
( ). This allows you to incorporate data from multiple spreadsheets into the Quick Checker
file. It's also possible to export the data contained within the Quick Checker at anytime by
clicking 'Tools' > 'Export to Excel..' from the main toolbar. This will open a Windows Explorer
window, allowing you to select a location and file name for the exported data.
It's also possible to perform data corrections using the 'Find and Replace' tool, which can be
accessed by clicking 'Tools' > 'Find and Replace...' from the main toolbar. This will open the
'Find and Replace' window, as shown below.
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Finally, it's possible to clear all the data currently loaded into the Quick Checker using the
'Clear Data' tool the main toolbar. Selecting the 'Clear Data' tool will open a warning
message, asking if you would really like to clean the grid data. Selecting Yes will clear all
data from the Quick Checker.

Once all of the required data has been loaded, and all data errors have been resolved, you
can then click the 'Validate and Submit' button (
). You will then be
prompted to save your file as a *.zip_hga file which can be easily imported through the
Import Data module. See the EDD Import section for more information about importing the
validated data file.
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Link to AquiferTest
In order to use the AquiferTest analysis feature, you must first have AquiferTest 2011.1 or
later installed on the local machine, and specify where the program is installed in the HGA
Settings on the External Programs tab.
Use this feature to analyze pumping test data in AquiferTest. For this feature, you must have
one or more data queries that contains the required fields for a pumping test analysis,
namely:
·
·
·
·
·
·
·
·

Well Name
X Co-ordinate (for both Pumping Wells and Observation Wells)
Y Co-ordinate (for both Pumping Wells and Observation Wells)
Pumping Start
Pumping End
Pumping Rate
Observed time
Observed depth to water level

Additional fields may also be mapped and the data sent to AquiferTest; these include:
· Well Elevation
· Screen Diameter
· Borehole Diameter

For your convenience, these fields are included in the Environmental templates, in the Well
History tables.
The following section describes these settings:

Settings Tab
In the first tab, define the project units you would like to use for AquiferTest, and populate
the Pumping Test information.
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Pumping Wells Tab
In the Pumping Wells tab, select the data query that contains the required fields for this
module, for your pumping test analysis. Then, in the grid below, map the appropriate field to
each required field. If the unit for the field is defined in the database template, then the unit
will be automatically populated. Otherwise, this will be left blank. If needed, you can manually
enter a conversion factor, to convert the data from the HGA source, to the AquiferTest
project target units.
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Please Note: the AquiferTest project units for the station X
and Y co-ordinates must be the same as the unit system
used for the HGA project (for example, if your HGA project is
using UTM, set the AquiferTest units as meters; for State
Plane, set the AquiferTest units as feet). Currently, there is
no conversion for these units when sending Hydro
GeoAnalyst data to AquiferTest.
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Pumping Rate Tab
In the Pumping Rate tab, the workflow is the same as earlier mentioned. In this tab, you
must map the well name, pumping rate, and the start and end interval.

Observation Wells Tab
In the Observation Wells tab, the workflow is the same as earlier mentioned. In this tab, you
must map the well name, X,Y coordinate, and the observation date/time and observed depth
to water level.
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Once all the required fields are defined, click the Analyze button to send the data to
AquiferTest. For more details on how to use AquiferTest, please refer to the AquiferTest
help.
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Report Editor
The Report Editor included with Hydro GeoAnalyst is used to create professional reports
containing data, and 2D and 3D-views you have generated for your projects. This chapter
presents information on how to transfer stations, grids, query results, maps, cross sections,
borehole log plots, and 3D views into a printable report format, which can be printed or
exported for convenient transfer to your colleagues and/or clients.
The Report Editor provides the following features:
·
·
·
·
·
·
·
·
·
·

Create and save Report Layout Templates
Create and Manage Reports
Import Reports
Design and Preview Reports
Save, Export, and Print Reports
In addition the report editor:
Provides an easy-to-use Office-like designer environment
Supports VBScript and JScript events and expressions
Provides Barcode control
Allows report bookmarks and internet hyperlinks

Please Note: This chapter provides a brief overview of the features that the Report
Editor offers. For more details, refer to the Active Reports compiled help file. This file is
named AR2Std.CHM, and is found in the report folder of the HGA installation folder - the
default location is C:\Program Files (x86)\Common Files\Data Dynamics\Active
Reports\AR2Std.chm. Simply double-click on the .CHM file to load the help file.

Legacy Module
The Report Editor is a Legacy Module that is only accessible in
older projects with existing Reports for compatibility. The
Report Editor function has largely been replaced with the Printto-Office functionality. It is recommended that you migrate your
reports to the Print-to-Office templates.

29.1

About the Interface
The Report Designer allows you to design the contents, as well as looks, of your
reports. All report designs can be saved and opened for editing and/or generating
the final report. A sample of the designer view is shown below (with a report
template loaded for demonstration purposes).
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The designer window contains the following items:
Property Toolbox: provides the tools that can be used to edit properties of the
report and all its sections including any controls that the report may contain.
Toolbar: provides multiple buttons for functions in the designer
Explorer: allows you to browse through the controls that are placed on the
currently opened report. It facilitates selecting a control for further editing.
Layout window: provides the interface for designing the report
Fields: allows you to select one or more data fields, for displaying data. Simply
drag and drop the selected field into the desired section of the report.

29.2

Report Designer Window
This section is designed to help familiarize you with the different options available
in the toolbox for various tools. The Toolbox is dynamic, and changes depending
on the object currently active in the Report Designer. The vital options of select
tools are described in this section, however if you require further information,
please refer to the ActiveReport help file included with the installation in the
Reports folder.
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Report Designer Toolbars
Custom
Allows you to change the object output format to General, Number, Currency,
Date, Time, Percentage, and Custom. It also allows you to specify the line/border
style.
CanGrow
Allows you to set whether you want the text field to become larger if the entered
text does not fit within the allotted frame.
CanShrink
Allows you to set whether you want the text field to become smaller if the text does
not fill up the allotted frame.
DataField
Allows you to attach the field to a datafield in a project through a DataControl (e.g.
ADO). If the field is linked to a DataControl, select the desired data field from the
drop-down menu. All fields linked to a DataControl in a current report are listed in
the Fields window under the Report Navigator tree.
SummaryDistinctField
Specify the field name of the field used in a distinct summary function.
SummaryFunction
Set the function to be used for aggregating data.
SummaryGroup
Set the name of group section for summarization.
SummaryRunning
Determines whether the summary is a running value or not.
SummaryType
Determines the type of summary to be used.

29.2.2

Toolbox options for General Tools
LineColor/Style/Weight
Set the properties of the lines/borders for the object.
Picture
Select the picture you wish to display in the frame. Supported graphics formats are
*.bmp, *.ico, *.cur, *.jpg, *.gif, and *.wmf.
SizeMode
Specify how the picture will be displayed in the frame. "Clip" will display the picture
at original size and if the frame is larger than the frame, it will be cut off. "Stretch"
will adjust the image proportions to fit the frame (even if it means distorting the
picture. "Zoom" will adjust the size of the picture until the entire image is visible in
the frame and there is the least amount of unfilled space possible.
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Label

Shape
Specify which shape you wish to display - rectangle, ellipse, or rounded rectangle.
29.2.2.2

Field

CloseBorder
Specify whether or not the bottom border line will be displayed if the frame spans
across multiple pages.
29.2.2.3

Check Mark

Enabled
Allows you to enable or disable the page-break.
29.2.2.4

Image

BarWidth
Set the width of the thinnest line in the code.
Caption
In barcode, the caption is the set of symbols (alphanumeric) you want to code.
Direction
Set the direction in which the code will be written.
EnableCheckSum
Set whether the checksum is used when the code is rendered.
29.2.2.5

Line

Report Explorer
The Report Explorer (as shown in the figure below) allows you to browse through
the controls of the active report and facilitates selecting controls for further editing.
The Report Explorer windows can be accessed by clicking on the Explorer icon
on the toolbar.
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The explorer provides quick access for selection of controls on the report.
Selecting a control in the Report Explorer activates the corresponding control on
the report. This makes the control ready to be formatted or moved to another
location.
The explorer lists at least three nodes under the "MainReport" node, namely:
· PageHeader: refers to the page header for the current report
· Detail: refers to the section that hosts the details of the report
· PageFooter: refers to the page footer for the current report
Any item placed on the page header and footer of your report will be displayed on
all pages of the report. In addition to these sections, one or more sections named
Group Headers and a corresponding Group Footer sections, can be added to the
report. In the figure depicted above the data on the report is grouped by stations.
That is, the data for each station is displayed together. Group Headers can have
their own header and footer that will be displayed above and below each group's
data respectively.

Data Fields Explorer
For most report types, the Report Editor takes data directly from the database,
based on the design, and generates the desired report. Access to the data in the
database is provided through the connection string and SQL Statement. These
inputs result in a list of fields that are available for the current report. These fields
are listed in the Fields Explorer (as shown below) that can be displayed by clicking
on the Fields icon
on the toolbar.
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One or more fields in the fields explorer can be selected and dragged and dropped
into the desired section of the report if displaying data from these fields is desired.

Report Properties Toolbox
The Report Properties toolbox (as shown in the figure below) provides the tools
that can be used to edit properties of the report and all its sections including any
controls that the report may contain. This window can be accessed by clicking on
the Properties icon
on the toolbar.
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This window serves to access the properties of the controls that are present on the
report, and it contains an orderly list with the names and values of the properties of
the objects in the report, presented in the first and second column respectively.
A combo box with the list of objects whose properties can be edited is provided in
the upper part of the window. Additional information for the selected property is
provided at the bottom of this window.

Designer: Advanced Controls and Settings
Types of Controls
The runtime Report Designer allows you to add several types of controls to your
reports. These controls range from those that are currently shown on the toolbar to
all controls that are present on your computer. The types of controls that are
provided on the toolbar can be grouped as follows:
Data Access Controls: ADO data control: Provides access to the database using
information provided to it. Only one ADO control can be added to a given report.
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This control can be added to the report by clicking on the "Insert ADO Data control
icon (

) on the toolbar

Data Display Controls: Controls that can be used to display information that is
either coming from the data source (database) or provided on the Report
Designer. The controls that fall into this category include:
· Label
· Check box
· RTF Text
· Graphics (Image, Line, Forms, OLE objects, Barcodes, etc.)
· Page break
· Sub reports
Adding Controls
Except for ADO data control, all controls can be added to the report in the desired
section. To add a control to a report:
select the desired control by clicking on the icon on the toolbar
position the cursor at the desired location and click-and-drag to define the size of
the control
Depending on the selected control, specific dialog boxes may be displayed
requesting information. Once the control is placed on the report, its properties
could be altered by activating the [Properties Explorer] window and modifying the
desired property.
The position of the controls can be changed by selecting and moving the selection
to the desired location. Controls can be moved this way only within a given section.
Cut and paste can be used to move controls to another section.
Some controls have special properties that require the user's attention; these
controls are described below.
Altering Borders of Controls
Border properties of one or more controls can be modified by selecting the controls
first and either clicking on the
option from the pop-up menu.

(Borders) button on the toolbar or selecting the

Modifying Data Source information of the ADO data control
The ADO data control mainly uses the connection string and SQL statement as its
input to provide access to the data stored in your project's database. Currently
HGA provides basic inputs for this control.
However, advanced users may want to modify these inputs in order to produce
advanced reports that are supported by the Report Editor. One interesting feature
provided by the Report Editor is that of generating a report based on specific
values. For example, a report that displays chemical data for all stations can be
modified to only generate reports for a given station and/or chemical.
The SQL statement is usually composed of the following four parts:
SELECT Field1 [, Field2, Field3,...]
FROM Table Name
WHERE Condition1 [AND/OR Condition2]
ORDER BY Field1 [, Field2, Field3,...]
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where the highlighted words are internal to the SQL language, and the terms in the
brackets ([]) are optional.
To modify the data source information of the ADO control in your report:
· Select the ADO control by clicking on the appropriate icon on the toolbar
· Display the Properties explorer window if it is not already visible
· Select the Custom properties option by clicking on the button next to this item
· A dialog will appear. Provide or modify the desired options
29.2.2.6

Shape

The Report Editor Viewer offers an extensive list of navigation tools; the figure
below shows the toolbars used in the Viewer window.
The following describes the toolbar buttons of the viewer window.
Open Static Report: Opens a previously saved static report
Save Static Report: Saves the current report in the Report Editor's native
format
Export Report: Exports the current report to the desired format
Report Designer: Displays the Report Designer window
Print Report: Sends the current report to printer
Show TOC: Displays the table of contents for the current report
Show Ruler: Displays a ruler
Search Text: Allows you to provide text to search for
Find Text: Searches for text provided in the "Search Text" text box
Copy Page: Copies the current page to windows clipboard
Show Single Page: Displays report one page at a time
Show Multiple Pages: Displays multiple pages of the report at once
Zoom in: Zooms in to a selected area of the report
Zoom in percent: Sets the zoom level to that selected in here
Zoom out: Zooms out the report
First Page: Moves to the first page of the report
Previous Page: Moves to the previous page in the report
Page: Moves to the page specified in this text box
Next Page: Moves to the next page in the report
Last Page: Moves to the last page in the document
Back: Moves back to the previous page in a list of recently accessed pages
Forward: Moves forward to the next page in a list of recently accessed pages
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Rich Text

The Report Settings dialog can be accessed by clicking the Page Report button
from the Main Toolbar. This dialog consists of four sections: Page Setup,
Printer Settings, Grid Settings and Styles. Each section is described below.

The Page Setup section allows you to set the page margins of your report page.
Set the Top, Bottom, Left, Right and Gutter margins by using the appropriate
vertical scroll bars. Margin values can be set in quarter increments (1440 = 1 inch).
You may also choose to mirror the margins of facing pages by selecting the Mirror
Margins check box.
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The Printer Settings section allows you modify the printing options. Here you can
select the paper size from the Paper Size dropdown list box. You can manually
specify the paper size by using the Width and Height vertical scroll bars.
The Orientation frame allows you to specify the paper orientation.
You may also choose to set the options for Collate, Duplex and PaperBin by using
the appropriate dropdown list box.
Selecting Printer Default for any of the printing options will assign the default
setting of the selected printer, for that particular print option.
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The Grid Settings section allows you to modify the grid appearance of the designer
window. You can set the visibility of the grid by enabling/disabling the Show Grid
checkbox. Selecting the Align Controls to Grid checkbox will automatically snap
controls to the nearest grid column. Set the number of Grid columns and Grid rows
by using the appropriate vertical scroll boxes.
You can change the units of the ruler that appears above the designer window by
clicking on either the Inches or Centimeters radio button.
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The Styles section allows you to create, remove and modify text styles, which can
then be selected from the Text Style dropdown box, and applied to your text
controls. Text styles are useful for applying many text characteristics (font, size,
bold, italic, underline etc) to your text, in just one simple task.
Click the New and Delete button to create a new style and delete a current style,
respectively. The Font, Color and Misc settings in the right frame allow you to set
and modify the text characteristics of the selected style.
Using non-default page dimensions
If you wish to print to any non-default paper size (e.g plotter paper), you must first
specify the page dimensions in three different areas within the Report Designer.
To do so, follow the steps below:
1. In the Report Designer, select the Page Setup button from the main toolbar.
Select the Printer Settings button.
Specify the page size from the PaperSize dropdown box. Alternatively, define the
page dimensions by selecting Custom Paper Size from the PaperSize dropdown
box, and then entering the Width and Length values below.
Click [Ok]
2. Select the Printer Settings button from the main toolbar.
Select the desired plotter from the Name dropdown box.
Again, specify the paper size.
Click [Ok].
3. Manually define the page size within the Report Designer, by
increasing/decreasing the page extents with the mouse cursor.
Now you are ready to print your report.
Limitations
Although the Report Designer provides a detailed interface for customizing reports
and templates, it is limited in the following ways:
· You cannot print multiple copies within one print event
· You cannot select specific pages to print
· You cannot select a page range to print
If you wish to print your reports using these settings, you can always export the
report as a PDF and print the report(s) from a PDF Reader.
29.2.2.8

Frame

The main interface of HGA allows you to create reports in one of the following two
ways:
· From a Grid: create a report with the data in the selected grid
· From a Data Query: create a report using the results of a query

Creating Reports from a Data Grid
Follow the directions below to create a report containing a data grid.
Select the desired grid in HGA (for example, select the Stations List grid, or select
the desired table)
Press the Print button

from the toolbar.
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The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
The fields in the selected grid will be added to the report designer; and the ADO
data control is automatically created. An example is shown below for the Lithology
table:

The layout of the report can then be modified, and unwanted fields can be
removed from the design. If the fields do not immediately show up in the Design
window, press the Refresh button in the Fields frame, as circled above. To see the
ADO Data control for the report, click on the button
(ADO button) in the
Detail section of the Report body design (also circled above). Then, right click, and
select Properties. A dialog similar to the one shown below will appear.
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In the ADO properties, under Source SQL, you can see that the SQL string has
been automatically created for you, based on the table selected in HGA. In this
example, the SQL string basically states: Select all fields from the Lithology table,
where the Station ID is 27, and order by Station. If you are familiar with the format,
you may modify the SQL string here, and update the report design.
After the report is saved, a node will be created in the Project Tree, under the
Reports node with the appropriate report file name. Currently HGA requires that all
reports be saved under the "Reports" folder, which in turn is created within the
project folder. Although the Report Manager allows you to open reports from any
folder, only those saved under the "Reports" folder of your project will be displayed
in the Project Tree.

Creating Reports based on a Data Query
Follow the directions below to create a report containing a Data Query.
Select the desired Data Query from the Queries node in the Project Tree (if no
queries are available, create a Query using the Query Manager).
Execute the Query in order to see the results.
Press the Print button
from the main toolbar, or select Project / Report. (This
item is enabled only if a grid is visible and active and has at least one row of data.)
The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
As in the previous type of report, the report will appear in the Project Tree once it
is saved.
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Sub Report

Follow the directions below to create a report containing one or more map layers
from the Map Manager.
Start the Map Manager, and open a Map Project
Show/hide the desired layers in the map project (all visible layers will appear in the
report)
Press the Print button
from the toolbar, or select Project / Print from the main
menu of the Map Manager.
The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
The Report Editor allows you to either create a new report for the current map
project or add it to an existing one. If you choose to add to an existing report, the
report editor adds the new map to the report. As such, multiple views of your map
project(s) can be sent to a report one by one.
Each view of your map project is created with its associated scale bar. The map
project can be resized and repositioned as desired on the runtime Report
Designer. Note that resizing a map project on the runtime Report Designer adjusts
the scale that is associated with that specific view of your map project.
The report will appear in the project tree once it is saved.
29.2.2.10 Page Break

A report for your fence diagrams and 3D views can be created by following the
directions below:
· Start the 3D Explorer and open a 3D project file (.3XS), or load a 3D project from

the Project Tree in HGA
· Create the desired 3D view (adjust the view to your liking
· Press the Print button

from the toolbar, or select File / Print from the main
menu.
The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
Each view of your Fence Diagram is created with its associated legends.
The report will appear in the project tree once it is saved.
29.2.2.11 OLE

The Report Editor contains pre-defined templates which allow users to quickly and
easily create professional reports. Report templates can be edited, saved, and
managed in the Report Editor, and new templates may be created and saved for
future use.
This feature allows users to have different report layout options for headers and
footers and to share them between two or more reports. This allows users to have
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as many report designs as desired. For example, one or more report templates
can be prepared for each client with the specific header and footer. Another
advantage of having a report template is that if the header information using a
certain template changes, the change will automatically be applied to all reports
that use the template without the need to reopen the report. For example, if the
client company's telephone number changes, the user needs to change only the
template instead of changing each report.
Each time a new report is created, previewed, or printed it will use the active
report's layout unless a template is specified.
Creating A Report Template
The Report Editor allows you to save the active report's design as a report
template for future use. Once you are satisfied with the design of the currently
opened report's layout, click
(Save-As button) to save it as a report template.
In the dialog that is displayed, provide the name for the template, check the box
beside "Save as template" and click on "Save".
The template saves the header, the footer as well as the background for the detail
section of the current report. The detail section may have background watermarks
such as "DRAFT", "CONFIDENTIAL", etc. at desired angles and locations. The
header and footer may contain: relevant information for your company and/or client
including logo, name, Address, Telephone, Fax, e-mail, and web site address. The
user can also configure properties such as: font, alignment, etc. for the template.
Once a report template is created, it will be listed under the "Reports" node in the
Project Tree of HGA.
Opening a Report Template
Report templates can be opened by double clicking on them in the Project Tree of
HGA. A template can also be opened using the report editor directly by selecting
the Open button
from the Designer window's toolbar and setting the file filter to
"*.WTP". Once a report template is opened, it can be edited and saved.
Deleting a Report Template
In HGA, right-click on a report template in the Project Tree, and select the Delete
option from the menu, to delete the template. The selected template will be deleted
both from the Project Tree as well as from storage.
Setting a Report Template as Default Template
To set a selected template as the default template, right click on the template and
select the "Set as default" option from the pop-up menu in HGA. The selected
template will be set as the default template.
Every time a new report is created, the default template will be used to furnish the
header and footer sections.
29.2.2.12 Barcode

BarWidth
Set the width of the thinnest line in the code.

©2022 by Waterloo Hydrogeologic

Report Editor

893

Caption
In barcode, the caption is the set of symbols (alphanumeric) you want to code.
Direction
Set the direction in which the code will be written.
EnableCheckSum
Set whether the checksum is used when the code is rendered.
29.2.2.13 ActiveReport

The Report Editor included with Hydro GeoAnalyst is used to create professional reports
containing data, and 2D and 3D-views you have generated for your projects. This chapter
presents information on how to transfer stations, grids, query results, maps, cross sections,
borehole log plots, and 3D views into a printable report format, which can be printed or
exported for convenient transfer to your colleagues and/or clients.
The Report Editor provides the following features:
·
·
·
·
·
·
·
·
·
·

Create and save Report Layout Templates
Create and Manage Reports
Import Reports
Design and Preview Reports
Save, Export, and Print Reports
In addition the report editor:
Provides an easy-to-use Office-like designer environment
Supports VBScript and JScript events and expressions
Provides Barcode control
Allows report bookmarks and internet hyperlinks

Please Note: This chapter provides a brief overview of the features that the Report
Editor offers. For more details, refer to the Active Reports compiled help file. This file is
named AR2Std.CHM, and is found in the report folder of the HGA installation folder - the
default location is C:\Program Files (x86)\Common Files\Data Dynamics\Active
Reports\AR2Std.chm. Simply double-click on the .CHM file to load the help file.

29.2.3

Using the Report Designer
This section is designed to help familiarize you with the different options available
in the toolbox for various tools. The Toolbox is dynamic, and changes depending
on the object currently active in the Report Designer. The vital options of select
tools are described in this section, however if you require further information,
please refer to the ActiveReport help file included with the installation in the
Reports folder.
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Report Viewer Window
LineColor/Style/Weight
Set the properties of the lines/borders for the object.
Picture
Select the picture you wish to display in the frame. Supported graphics formats are
*.bmp, *.ico, *.cur, *.jpg, *.gif, and *.wmf.
SizeMode
Specify how the picture will be displayed in the frame. "Clip" will display the picture
at original size and if the frame is larger than the frame, it will be cut off. "Stretch"
will adjust the image proportions to fit the frame (even if it means distorting the
picture. "Zoom" will adjust the size of the picture until the entire image is visible in
the frame and there is the least amount of unfilled space possible.

29.3.1

Report Viewer Toolbars
CloseBorder
Specify whether or not the bottom border line will be displayed if the frame spans
across multiple pages.

29.3.2

Using the Report Viewer
BarWidth
Set the width of the thinnest line in the code.
Caption
In barcode, the caption is the set of symbols (alphanumeric) you want to code.
Direction
Set the direction in which the code will be written.
EnableCheckSum
Set whether the checksum is used when the code is rendered.

29.4

Report Settings
The Report Editor Viewer offers an extensive list of navigation tools; the figure
below shows the toolbars used in the Viewer window.
The following describes the toolbar buttons of the viewer window.
Open Static Report: Opens a previously saved static report
Save Static Report: Saves the current report in the Report Editor's native
format
Export Report: Exports the current report to the desired format
Report Designer: Displays the Report Designer window
Print Report: Sends the current report to printer
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Show TOC: Displays the table of contents for the current report
Show Ruler: Displays a ruler
Search Text: Allows you to provide text to search for
Find Text: Searches for text provided in the "Search Text" text box
Copy Page: Copies the current page to windows clipboard
Show Single Page: Displays report one page at a time
Show Multiple Pages: Displays multiple pages of the report at once
Zoom in: Zooms in to a selected area of the report
Zoom in percent: Sets the zoom level to that selected in here
Zoom out: Zooms out the report
First Page: Moves to the first page of the report
Previous Page: Moves to the previous page in the report
Page: Moves to the page specified in this text box
Next Page: Moves to the next page in the report
Last Page: Moves to the last page in the document
Back: Moves back to the previous page in a list of recently accessed pages
Forward: Moves forward to the next page in a list of recently accessed pages

29.5

Creating Reports
The main interface of HGA allows you to create reports in one of the following two
ways:
· From a Grid: create a report with the data in the selected grid
· From a Data Query: create a report using the results of a query

Creating Reports from a Data Grid
Follow the directions below to create a report containing a data grid.
Select the desired grid in HGA (for example, select the Stations List grid, or select
the desired table)
Press the Print button
from the toolbar.
The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
The fields in the selected grid will be added to the report designer; and the ADO
data control is automatically created. An example is shown below for the Lithology
table:
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The layout of the report can then be modified, and unwanted fields can be
removed from the design. If the fields do not immediately show up in the Design
window, press the Refresh button in the Fields frame, as circled above. To see the
ADO Data control for the report, click on the button
(ADO button) in the
Detail section of the Report body design (also circled above). Then, right click, and
select Properties. A dialog similar to the one shown below will appear.
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In the ADO properties, under Source SQL, you can see that the SQL string has
been automatically created for you, based on the table selected in HGA. In this
example, the SQL string basically states: Select all fields from the Lithology table,
where the Station ID is 27, and order by Station. If you are familiar with the format,
you may modify the SQL string here, and update the report design.
After the report is saved, a node will be created in the Project Tree, under the
Reports node with the appropriate report file name. Currently HGA requires that all
reports be saved under the "Reports" folder, which in turn is created within the
project folder. Although the Report Manager allows you to open reports from any
folder, only those saved under the "Reports" folder of your project will be displayed
in the Project Tree.

Creating Reports based on a Data Query
Follow the directions below to create a report containing a Data Query.
Select the desired Data Query from the Queries node in the Project Tree (if no
queries are available, create a Query using the Query Manager).
Execute the Query in order to see the results.
Press the Print button
from the main toolbar, or select Project / Report. (This
item is enabled only if a grid is visible and active and has at least one row of data.)
The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
As in the previous type of report, the report will appear in the Project Tree once it
is saved.
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Creating Reports in HGA-Main Window
A report for your fence diagrams and 3D views can be created by following the
directions below:
· Start the 3D Explorer and open a 3D project file (.3XS), or load a 3D project from

the Project Tree in HGA
· Create the desired 3D view (adjust the view to your liking
· Press the Print button

from the toolbar, or select File / Print from the main
menu.
The report will be displayed in the Preview (Viewer) window, by default. To change
to the Designer Window, press the
(Designer) button from the toolbar. This will
allow you to make any desired modifications.
Each view of your Fence Diagram is created with its associated legends.
The report will appear in the project tree once it is saved.

29.5.2

Creating a Report Containing a Map Project
LineColor/Style/Weight
Set the properties of the lines/borders for the object.
Picture
Select the picture you wish to display in the frame. Supported graphics formats are
*.bmp, *.ico, *.cur, *.jpg, *.gif, and *.wmf.
SizeMode
Specify how the picture will be displayed in the frame. "Clip" will display the picture
at original size and if the frame is larger than the frame, it will be cut off. "Stretch"
will adjust the image proportions to fit the frame (even if it means distorting the
picture. "Zoom" will adjust the size of the picture until the entire image is visible in
the frame and there is the least amount of unfilled space possible.

29.5.3

Creating a Report Containing a Cross Section
BarWidth
Set the width of the thinnest line in the code.
Caption
In barcode, the caption is the set of symbols (alphanumeric) you want to code.
Direction
Set the direction in which the code will be written.
EnableCheckSum
Set whether the checksum is used when the code is rendered.
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Managing Reports
The Report Editor included with Hydro GeoAnalyst is used to create professional reports
containing data, and 2D and 3D-views you have generated for your projects. This chapter
presents information on how to transfer stations, grids, query results, maps, cross sections,
borehole log plots, and 3D views into a printable report format, which can be printed or
exported for convenient transfer to your colleagues and/or clients.
The Report Editor provides the following features:
·
·
·
·
·
·
·
·
·
·

Create and save Report Layout Templates
Create and Manage Reports
Import Reports
Design and Preview Reports
Save, Export, and Print Reports
In addition the report editor:
Provides an easy-to-use Office-like designer environment
Supports VBScript and JScript events and expressions
Provides Barcode control
Allows report bookmarks and internet hyperlinks

Please Note: This chapter provides a brief overview of the features that the Report
Editor offers. For more details, refer to the Active Reports compiled help file. This file is
named AR2Std.CHM, and is found in the report folder of the HGA installation folder - the
default location is C:\Program Files (x86)\Common Files\Data Dynamics\Active
Reports\AR2Std.chm. Simply double-click on the .CHM file to load the help file.

29.7

Creating and Managing Report Templates
BarWidth
Set the width of the thinnest line in the code.
Caption
In barcode, the caption is the set of symbols (alphanumeric) you want to code.
Direction
Set the direction in which the code will be written.
EnableCheckSum
Set whether the checksum is used when the code is rendered.

29.8

Import Reports from MS Access
The Report Editor included with Hydro GeoAnalyst is used to create professional reports
containing data, and 2D and 3D-views you have generated for your projects. This chapter
presents information on how to transfer stations, grids, query results, maps, cross sections,
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borehole log plots, and 3D views into a printable report format, which can be printed or
exported for convenient transfer to your colleagues and/or clients.
The Report Editor provides the following features:
·
·
·
·
·
·
·
·
·
·

Create and save Report Layout Templates
Create and Manage Reports
Import Reports
Design and Preview Reports
Save, Export, and Print Reports
In addition the report editor:
Provides an easy-to-use Office-like designer environment
Supports VBScript and JScript events and expressions
Provides Barcode control
Allows report bookmarks and internet hyperlinks

Please Note: This chapter provides a brief overview of the features that the Report
Editor offers. For more details, refer to the Active Reports compiled help file. This file is
named AR2Std.CHM, and is found in the report folder of the HGA installation folder - the
default location is C:\Program Files (x86)\Common Files\Data Dynamics\Active
Reports\AR2Std.chm. Simply double-click on the .CHM file to load the help file.
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Time Series Plotting
The plotting component in Hydro GeoAnalyst allows users to create time series plots of data
stored in the HGA database. The plotting provides the following features:
·
·
·
·
·
·
·
·
·
·
·
·
·

Create Time Series X-Y plots using data from data queries.
Display X-Y plots as a line or bar chart.
Add legends and data marker labels to plots
Add best fit, trend, formula, or statistical lines to the plot
Interact with plots, and display multiple plot windows in the viewer window
simultaneously
Display non-detect, uncertainty, or detection limits on the plot, as lines or symbols
Define data series ranges, and modify display properties for different data ranges (e.g.
define a data range where the data exceeds the water quality standard values, and
assign unique symbol, line, and display properties for this data)
Select fields for plot grouping or data series grouping
Modify display properties, including axis, labels, symbols, legends, and intervals
Print plots to a single or multiple pages
Save plot settings as templates for re-use
Export plots to graphics format
Copy plots to Windows clipboard

Legacy Module
The Time Series Module is a Legacy 32-bit Module that is only
accessible in older projects with existing time series plots using
32-bit editions of HGA to maintain compatibility. The Time
Series module functionality has largely been replaced by the
Plot Module. It is recommended that you migrate your Time
Series plots to the plot module.

30.1

About the Interface
Once you have created and selected a data query, you may create a plot with the data set.
The plot component may be launched from HGA in several ways:
To create a new Plot Page Design, right-click on the Plots node (on the Project Tree) and
select New from the pop-up menu
Existing plots can be opened from the Plots node in the Project Tree by either doubleclicking on the desired plot in the available list, or by right-clicking and selecting the Open
pop-up menu option.
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Please Note: A data query containing the required fields (see below) must be selected
in order to launch the plots mode from the HGA main interface.

A typical plot window is shown in the following figure.

The plot window contains the following items:

Plot Page Design Tree: A list of all available plot page designs, plots, and series such
as Lines and Standards
Designer Toolbar: Toolbar buttons used for modifying the plot design
Plot Settings and Data Source: Contains the settings for the selected entity, and data
mappings
Viewer Window: Contains a real time view of the plot page design
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Description of Designer Toolbar Items

The plot designer toolbar provides the controls for designing the plot page. The following
buttons are available.
Save button saves the current plot design
Save As button saves the current plot design as a new name
Add button provides two options: Add Plot will prompt you to select a template to be
used; Add Default Plot will create a new plot using the default plot template
Delete button deletes the selected plot or line series
Refresh button refreshes the design with new settings or data
Zoom in button allows you to zoom into the selected plot page; to zoom in on
selected plot data within an individual plot
Zoom out button returns to the original zoom view
Fit to Page button fits all plots to the current viewer window size

At the bottom of the window, you will find the following buttons:
these buttons, from left to right, is:

. The function of

Previous Page: scroll to the previous page in the plot design
Next Page: scroll to the next page in the plot design
Zoom
To zoom in on plot data in an individual plot, use the mouse cursor to draw box around the
desired data; a sample is shown in the screen shot below:
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To zoom out to the original extents, right-mouse click on the plot area, and select Zoom Out
from the menu.

Viewer Window Settings
Under the Settings tab, you can define the settings for the plot page design:
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Name controls the name of the selected plot series; this is read-only, and cannot be
modified.
The plotting component supports display and manipulation of multiple plot windows in the
viewer window.
Number of columns controls how many columns will be displayed in the viewing window for
displaying plots.
Number of rows controls how many rows will be displayed in the viewing window for
displaying plots.
For example, 2 columns X 2 rows means that 4 plots may be displayed simultaneously in the
viewer window.
Spacing width controls the amount of space between each plot, in the horizontal direction.
Spacing height controls the amount of space between each plot, in the vertical direction.

30.2

Adding Plots
The data source for the plots must originate from a Data Query; before you create a plot,
you must build and execute a data query using the Query Builder. The data query should
contain the data set you are interested in analyzing, along with the fields for a time series
plot.

Please Note: If you are plotting a large water level dataset which was logged using a
small time interval, e.g., 1 sample per hour over many days, use the average aggregate
function in the query builder to query the daily average water level. By doing this, you will
lower the number of data points in your query and thus lower the drawing time when
displaying the time series plot.

The following are required fields for the Time Series plots, and as such, must be present in
your data query:
· Sample Date or Time
· Value for the parameter of interest (e.g. water level, chemical concentrations,

temperature, pH, conductivity, etc.)
The following fields are not required, but are available for plot and series grouping, and to
take advantage of additional plot options:
·
·
·
·
·
·

Station ID
Station Name
Chemical (Parameter) name
Measured parameter units
Non detect (ND) factor
Method detection limit (MDL)
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· Uncertainly factor

30.2.1

Add Plot
To add a new plot to the design, click the
(Add) button in the toolbar, or right-click on the
Plot Page Design node in the tree view, and select the Add plot menu option. The following
Add plot dialog will appear:

In the Name field enter the name of the plot.
The Type combo box contains the supported plot type; currently only Time-Series scatter
plots are supported.
In the Template combo box, select the desired plot template that should be applied to the
new plot. The plot template contains numerous pre-defined settings for axis, data series,
style settings, etc. If you want to re-use the same template again in the future, select the Set
as the default template check box. For details on creating plot templates, see Managing Plot
Templates section.
Click [OK] when you are finished, to display the new plot in the viewer window. The next step
is to map the fields.

30.2.2

Field Mappings
Under the Data Source tab, you can define the field mappings for the plot, as shown in the
screenshot below:
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Query: select the data source for the plot from the combo box; currently the data must
come from data queries.
Plot Grouping: specify a field to be used for grouping plots
Series Grouping: specify a field to be used for grouping series; at least one field must
be selected for grouping the plot series.
Time Axis: specify a field to be used for the Time (X) axis. This should be the date field
from your query.
Value Axis: specify a field to be used for the Value (Y) axis. This will be observed result
value for the parameter(s) of interest.
Units: loads the following dialog, allowing you to make unit conversions:
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Select the unit category, then the units from this category. If the units' categories are not
compatible (for instance Time and Length) then the buttons are disabled.
You may also select a field to be used for the unit conversion, or create constant conversion
factor; in this case, enter the factor, and an appropriate field.
The units conversion component implements full SI units including temperature, electric
current and luminous intensity.

Label: select a field to be used for the symbol label.
The next two fields are used to control non-detect results. When the query returns null
records for the result value, the method detection limit (if available and if selected) can be
displayed on the plot. Optionally, the method detection limit multiplied by the non-detect
factor (ND_Factor) can be used instead of the method detection limit. For example if an
ND_Factor of 0.5 is provided, and a column containing method detection limit values is
provided, then the plot will display the method Detection Limit (DL) value multiplied by 0.5
(the ND_Factor). If ND_Factor is left empty, then the DL will be displayed.

ND_Factor: specify a field that contains the factor for non-detects.
Detection Limit: select a field that contains the detection limit value
Uncertainty: select a field that contains a value for the uncertainty for the plotted series.
This will plot uncertainty bars directly on the plot
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Standard: This option allows you to display water quality standards as a plot series on
the plot. This is useful for quickly identifying which values exceed the standard. When
you load the options for standards, the following dialog will appear:

Click on the [Add] button to add a standard value and select a field that contains the
standard value
Click on the [Delete] button to remove existing list items from the list.
When you are finished, click on the [Close] button.
The new standards will appear as a plot series, under the Plots node in the tree. You can
then modify the line, symbol and label properties, as shown below:
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Line
Visible: show/hide the line
Width: set the line width
Color: specify the line color
Style: specify the line style (Solid, Dashed, etc.)

Marker
Visible: show/hide the markers
Font: Set the font for labels for the line markers
Color: specify the color
Size: Set the size of the markers along the line
Multiplier: select a field that contains a multiplier value; use this to apply a multiplier
factor to all result values on the plot
Bar Color Schema: This option allows you to define advanced bar color settings for bar
chart plots. When this option is loaded, the Bar Chart Color Settings dialog will display
(shown below).

Please Note: This dialog will only be available after you have specified Bar as the
Series Type in the Settings tab.
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In this dialog you may define the color scheme by selecting the Graduated Color radio button
or the Classification radio button. These options are most useful when displaying the charts
on a map, in order to see both the trends in the data over time at a single sample location,
and the spatial distribution/trends of all sample locations.
Graduated Color: This option allows for coloring bars from the same sample date, the
same color on all bar charts. For example, if your plot data contains sample data from
three seasonal sampling rounds (spring, summer, fall), you will see 3 instances in the
grid at the bottom. A different color can be assigned to each sample date. Upon
clicking [OK], each bar in the bar chart will be colored with the specified color, and all
bar charts in the series will share the same color (where the sample date exists).
Classification: This option allows for coloring the entire bar chart a certain color, based
on where it lies within a specified criteria. For this, you must provide a query that
contains a field that will be used for the criteria identification. When you select this
option, you must map to this field, and you will then see the min and max available for
this field (as shown below). You can then define the number of classifications (default
is 3), and the data range will be separated into equal number of parts. At this point,
you can specify the color and the label.
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Upon clicking [OK], the entire bar chart will be colored with the appropriate color, based on
where it lies in this criteria

30.3

Plot Settings
Once a plot is selected and visible, there are several settings that can be modified. These
settings are sorted into several groups explained below.

General Series Settings
Some of the most-frequently used, general plot settings are available when you right-mouse
click on a plot window (that contains a data series), and select Edit General Settings. The
following dialog will appear for line chart:
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The following settings are available:
·
·
·
·
·

Line Width: specify the line width
Line Style: select the line style
Labels Visible: show/hide the data marker labels
Markers Visible: show/hide the data markers
Color: specify the color for the line

As you define the series options, the Preview frame at the bottom of the dialog provides a
live-update preview of how the data series will appear using the selected settings. If you
have selected Bar as the series type, the following dialog will appear:
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In this dialog, you can modify the following settings:
·
·
·
·

30.3.1

Font: Specify the label font style, size and effects
Visible: Show/Hide labels
Font Color: Specify the color of the label text
Bar Color: Specify the color of the bars

Style and Display Settings
Settings such as Axis, Line, and Legend can be modified in the Settings tab as shown below:
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The following settings are available:

Common
The following common settings are available:
· Name: Enter the Plot name, and optionally specify a Background color
· Size: Specify the Height and Width for the plot
· Location (Origin): Specify the X, Y origin for the plot. The origin (0,0) is located in the

upper left corner of the plot window.
· Data Filter: Set a data filter for the plot data; this is useful when the plot contains a

large number of data points, and you want to filter out repetitive or unnecessary data,
or values where this is no significant change.
· Active: Use this option to enable/disable the filter
· Value: Set the filter value. Any consecutive plotted data points with a value less than
this specified filter value will be hidden from the plots, when the filter is active.
· Title: Enter a Title for the plot.

Legend
The following Legend settings are available:
· Visible: Show/hide the legend
· Alignment: Set the Legend position; choose from the following options: Top, Bottom,
·
·
·
·
·

Left, Right
Style: Controls what data elements or series appear in the Legend; choose from the
following options: Automatic, Series Names, Series Values, Last Values, Palette
Vertical space: Controls the amount of vertical space between each data element in
the legend; higher values will result in more space between each item in the legend.
Inverted Legend: Use this property to reverse the order of items in the legend. For
example, items in the order A, B, C, will be inverted to the order C, B, A, when this
property is selected.
Check boxes visible: Use this property to display a check-box beside each item in the
legend; when active, you can then use the Legend check boxes to show/hide which
data series are visible on the plot.
Font series color visible: Controls the font color for the text in the legend.

Vertical (Y) Axis
The following settings are available for the Vertical (Y) axis:
·
·
·
·

Pen width: Controls the thickness of the axis line
Visible: Shows/hides the axis on the plot
Log scale: Plots the axis values using a logarithmic scale
Max value: Controls the maximum value for the axis. By default, this value will be
calculated from the selected data set
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· Min value: Controls the minimum value for the axis. By default, this value will be

calculated from the selected data set
· Auto max value: Restores the default automatic maximum value, which is calculated

from the selected data set.
· Auto min value: Restores the default automatic minimum value, which is calculated

from the selected data set
Grid
· Visible: Shows/hides gridlines on the plot
· Style: Controls the grid line style; select from Solid, Dash, Dot, DashDot, or
DashDotDot
Title
· Text: Sets the title for the axis
· Visible: Shows/hides the axis title
· Angle: Controls the angle for the axis title; for the Y axis, it may be useful to have the
angle set at 90 degrees.
· Font: Controls the font for the axis title
Tick Label
· Format: Controls the decimal format for the labeled tics; enter #.00 to display 2
decimal places, to display no decimal places, simply enter 0
· Angle: Controls the angle for the tick labels; for date labels, it may be useful to select
an angle of 45 or 90 degrees for improved display
· Font: Controls the font for the tick labels

Horizontal (X) Axis
The Settings for the X Axis are identical to the Y axis, with the following exceptions:
· Log Scale is not available
· Min and Max values: when you define the min and max format, you must select these

values from a calendar
· You can specify a Date/Time format from the following options:
§ m/d/yyyy
§ MMM/yyyy
§ MM/yyyy
§ yyyy
§ MMM
§ hh:mm:ss tt (tt = AM/PM)
§ hh:mm:ss
· You can set the Tick Interval by selecting one of the following options: Min, Hour, Day,
Month, Year
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Series Type
The following settings are available for the Series Type:
· Line: displays the plot as a line chart.
· Bar: displays the plot as a bar chart.

Please Note: You can also change the Series Type by right-clicking on any data point
on and plot, and selecting Change Series Type.

30.3.2

Data Series Settings
Data Series (Range) settings can be accessed by right-mouse clicking on any data point on
the plot, and selecting Edit Range Settings from the pop-up menu. The following Series
Settings dialog will appear:

On the left side of this dialog, there is a list of available data series for the selected plot. You
may also Add Data Range series, and specify Data Series options for this Series. This is
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useful if you want to identify data on the plot that exceeds a guideline or standard value, and
assign unique symbol or label properties to this data set only.
· Click on the

(Add) button to add a new range

· Click on the

(Delete) button to delete the selected range

When you add a new Range, enter the Breaking Value; this is the upper limit for the range.
For the example shown in the screenshot above, there will be two ranges:
· Within guidelines: Values 0 - 100 (inclusive) will have unique symbol and label

properties
· Exceedences: Values greater than 100 to 120 (inclusive) will have a different set of

symbol and label properties, so they can easily be distinguished on the plot
The Labels provides options for the data series labels:
· Text: Select the Font, Color and Alignment options for the text.
· Custom: There are several options available for defining custom label.

Use different label source allows you to select a field from the list, for the labels from a list.
· Include pre-fix provides the option to attach a text string in front of each label
· Include post-fix provides the option to attach a text string at the end of each label

Please Note: If the Label options are inactive, you must set the Labels to Visible; load
the General Series Settings, and enable the Labels Visible option.

As you define the label options, the Preview frame at the bottom of the dialog provides a liveupdate preview of how the data series labels will appear using the selected settings.
When you are finished with the Label options, you can click on the Symbol tab to modify the
symbol options as shown in the screenshot below:
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The following settings are available:
· Symbol marker: select the symbol marker type from the combo box

Marker Size
· Height: specify the symbol height
· Width: specify the symbol width
· Proportional: use this option to create proportionally sized symbols, dependent upon
the result value
· Min value: specify the min value for the smallest symbol size; then specify the marker
size (Height and Width) that should correspond to this value
· Max value: specify the max value for the largest symbol size; then specify the marker
size (Height and Width) that should correspond to this value
As you define the label options, the Preview frame at the bottom of the dialog provides a liveupdate preview of how the data series symbols will appear using the selected settings.

30.4

Adding Lines to a Plot
Best fit lines, or lines calculated with user-defined formulas, can be displayed on any plot; to
do so, right-mouse clicking on any data point on the plot, and selecting Add Line from the
pop-up menu. The following Add Line dialog will appear:
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Enter a line Name at the top of the dialog; this name will appear on the plot.

The following Line Types are available:
· Formula
· Best Fit

Best Fit is the default line type; when selected, the following settings are available:
· Best Fit type: select from Std Deviation, Moving Average, or Exponential Moving

Average
· Source Series: select the data source series to which the line should be applied
· Period: enter a period value

When the Formula line type is selected, the following settings will be available:
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· Formula type: select from Constant, Exponential, Logarithmic, or Inverse
· Source Series: select the data source series to which the line should be applied
· Constant Value: When a Constant Formula Type is selected, enter a constant value

for the location of the line. This will result in a straight line drawn on the plot.
Click [OK] when you are finished, to draw the new line on the plot. The line series will appear
in the tree under the selected plot. The line settings can be modified as described below.

Line Settings
When a line is selected for a plot, the Settings tab will display the appropriate Line Settings
as shown below:

· Name: set the line name
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Line
·
·
·
·

Visible: show/hide the line
Width: set the line width
Color: specify the line color
Style: specify the line style (Solid, Dashed, etc.)

Marker
·
·
·
·

30.5

Visible: Show / hide markers on the line using the Visible option
Font: Set the font for labels for the line markers
Color: specify the color
Size: Set the size of the markers along the line

Saving, Exporting, and Printing
There are several options available for saving, exporting, and printing your plot page design.

Saving
Once you are satisfied with the current plot page design, click on the
(Save) button on
the toolbar. The new plot will appear under the Plots node in the HGA tree.

Exporting
To export the current plot page design, right-mouse click on the plot page design node in the
tree, and select Export Plot Page to Image from the pop-up menu. The image can be saved
to the following graphics file formats: .BMP, .JPG, .TIF, .EMF, .GIF, .PNG. Enter a filename,
and choose the file format, and click Save.

Copy Plot to Clipboard
This option is available for individual plots in the design. To copy the selected plot, to the
windows clipboard, right-mouse click on the plot name in the tree, or right-mouse click on the
plot in the viewer, and select Copy to Windows Clipboard from the pop-up menu. You can
then insert the plot into a graphics or word processing application for further modifications.
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Printing
A plot report may be generated from within the Plot Designer, and either printed or saved to
an external file.
With the Plot Designer window open, click on the Print button at the bottom of the Plot
Designer window, and select from one of the print options, as shown in the following screen
shots.

Please Note: If you select Send all plots to report, a report will be generated for each
station in the current selection; please be aware that this may take some time. If you want to
print a plot for just the selected station, use the Send current plot to report option.

You will be prompted to Select a Template for generating your report, as shown in the
following screenshot. You can either select from the existing templates, or leave the
selection blank and create a new report template for yourself.

Click the [OK] button to load the plot(s) in the Report viewer.
The Report may be printed directly by clicking on the
archive file by clicking on the

(Print) button, saved to a report

(Save) button, or exported to one of several file formats,

including .RTF, .PDF, .HTML, .XLS, and .TIF, by clicking the

(Export) button.

If you would like to modify an existing report template, or if you did not select an existing
template and are creating your own report, you can modify the report design to suit your
needs.
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Managing Plot Templates
Saving Plot as Template
Once you have designed the current plot to your style and data needs, you can save the
design as a template for re-use in future plots. To do so:
· Right-mouse click on Plots, and select Save as a plot template from the menu
· Enter a name for the plot template and [OK]

The template will be available next time you create a new plot, in the Add Plot dialog under
the Templates combo box.

Deleting Plot Templates
Plot templates can be deleted from the main HGA window.
Right-mouse click on Plots in the HGA Project Tree and select Plot Templates. The following
dialog will appear:

©2022 by Waterloo Hydrogeologic
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Select the template you want to remove, then click on the
the window.
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Appendices
The following Appendices provide additional information and resources for working with
Hydro GeoAnalyst:

· Appendix A: Project Files and Directory Structure
· Appendix B: Advanced Interpolation Settings
· Appendix C: Map Manager: ISO Codes
· Appendix D: Frequently Asked Questions (FAQ's)
· Appendix E: Configuring Geotransformation Settings

32.1

Appendix A: Project Files and Directory Structure
An HGA project consists of many different files and folders related to the different
components within HGA. Please refer to the information below to determine what data is
stored in which folder:

Project Folder:
Project.hga is a text file and contains the information on the connection string to the HGA
project, such as SQL server name, database catalog name, etc.
Project.vbx is a text file and contains the geotransformation settings of the project.

Map Subfolder:
The map folder contains all of the shapefiles associated with the map project. In the root,
you will find MapProjectName.VMP. This is an XML file that contains details on the map
project, such as the projection system, renderers, settings, cross-section lines, intersections,
etc. Each map project has a unique .VMP file.

Selection
When you create a new map layer from an HGA station group (or selected stations), a
new points shapefile is created and saved in this directory (i.e. boreholes.shp,
boreholes.shx, boreholes.dbf).
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Data
When you create a new map layer from an HGA data query, or a map project, a new
points shapefile is created and saved in this directory. (e.g. Chem_Exceedences.shp,
Chem_Exceedences.shx, Chem_Exceedences.dbf)

Plumes Subfolder:
The plumes folder contains all of the files associated with the plume data once the 3D
interpolation has been conducted on a query. The created .nc files are used when viewing
the plumes in the Scene Viewer.

Surfaces Subfolder:
The surfaces folder contains all of the gridded surfaces (.GRD files) created in the map
project by interpolating the current layer. The gridded surfaces can also be used in the
Scene Viewer.

XSection Subfolder:
The xsection folder contains all of the cross-section information from your project. In the
xsection folder there is a subfolder for each cross section created in the project (i.e. AA, BB,
etc.). The subfolders contain all the shapefiles associated with the cross section.

XInter
The XInter subfolder contains the shapefiles from the map project for the crosssection line.

BHLP
The BHLP subfolder contains image files for any well profiles drawn on the cross
section. The images are saved as .EMF format.

32.2

Appendix B: Advanced Interpolation Settings
INVERSE DISTANCE
The Inverse Distance Squared method is a very fast and efficient, weighted
average interpolation method. The weighting factor applied to the data depends on
the distance of the point from the grid cell, and is inversely proportional to the
distance squared. Consequently, the greater the distance the data point is from
the grid node, the smaller the influence it has on the calculated value.
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The Inverse Distance Squared method for interpolation may generate patterns
similar to a "bull's-eye" surrounding points of observations. Selecting a larger
number of nearest neighboring data points may smooth this effect, but if the bull's
eye pattern is undesirable, then other methods of interpolation, like Natural
Neighbor and Kriging, are recommended.
The Interpolator Options for the Inverse Distance Squared method is described
below.
Start X Minimum X co-ordinate for the interpolation grid.
End X Maximum X co-ordinate for the interpolation grid.
X_Nodes Number of grid nodes in the X-direction.
Start Y Minimum Y co-ordinate for the interpolation grid.
End Y Maximum Y co-ordinate for the interpolation grid.
Y-Nodes Number of grid nodes in the Y-direction.
Use Log Interpolation Flag to interpolate the log values of the data. This setting
is useful for where some measured values are many orders of magnitude higher
than the majority of the other values. In such cases, the large values dominate the
interpolation process and details in the low concentration zones are removed. If
this setting is selected, the log of each data value is taken prior to performing
interpolation. By interpolating the log of the data set, small values are given more
weight than otherwise.
Restrict Min Value Flag to restrict the minimum value of the interpolated data.
Restrict Max Value Flag to restrict the maximum value of the interpolation data.
Value Min Minimum value of the interpolated data. Any interpolated data less than
Value Min will be assigned a value of Value Min.
Value Max Maximum value of the interpolated data. Any interpolated data greater
than Value Max will be assigned a value of Value Max.
Real Min Real minimum value of interpolated data.
Real Max Real maximum value of interpolated data.
Num_Neighbors Number of nearest data points to use when calculating
interpolated value for each grid node.
Z_Only Allows the user to select between outputting the original X and Y values,
plus the interpolated value (x,y,f(x,y)), or the interpolated value only (f(x,y)). Note:
This has no effect on the actual contour output, and can be ignored.
NATURAL NEIGHBOR
The Natural Neighbor method (Watson, 1994) is based on the Thiessen polygon
method used for interpolating rainfall data. The grid node for interpolation is
considered a new point, or target, for the existing data set. With the addition of this
point, the Thiessen polygons based on the existing points are modified to include
the new point. The polygons reduce in area to include the new points, and the area
that is taken out from the existing polygons is called the "borrowed area". The
interpolation algorithm calculates the interpolated value as the weighted average of
the neighboring observations where the weights are proportional to the borrowed
areas. The Natural Neighbor method is valid only with the convex hull of the
Thiessen polygon formed by the data points, and values outside the hull
extrapolation should be used with caution.
The Natural Neighbor interpolation scheme may be visualized as a taut rubber
sheet stretched to satisfy all the data points. The interpolated value at any location
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is a linear combination of all Natural Neighbors of that location, and the resulting
surface is continuous with a slope that is also continuous. Combining the gradients
or slopes with the linear interpolation provides results that are more smooth, and
may anticipate the peaks and valleys between data. Singularities and other
undesirable effects may be lessened by incorporating the gradient factor.
The gradient influence on the results can be manipulated by two tautness
parameters that the user can enter. These parameters allow the interpolated
surface to vary from purely linear interpolation to one which is well rounded and
has the gradient factor. In all cases the slope discontinuities are removed and the
resulting surface has slope continuity everywhere.
The advanced settings parameters for the Natural Neighbor method are described
below:
Start X: Minimum X co-ordinate for the interpolation grid.
End X: Maximum X co-ordinate for the interpolation grid.
X_Nodes: Number of grid nodes in the X-direction.
Start Y: Minimum Y co-ordinate for the interpolation grid.
End Y: Maximum Y co-ordinate for the interpolation grid.
Y-Nodes: Number of grid nodes in the Y-direction.
Use Log Interpolation: Flag to interpolate the log values of the data. This setting
is useful for where some measured values are many orders of magnitude higher
than the majority of the other values. In such cases, the large values dominate the
interpolation process and details in the low concentration zones are removed. If
this setting is selected, the log of each data value is taken prior to performing
interpolation. By interpolating the log of the data set, small values are given more
weight than otherwise.
Restrict Min Value: Flag to restrict the minimum value of the interpolated data.
Restrict Max Value: Flag to restrict the maximum value of the interpolation data.
Value Min: Minimum value of the interpolated data. Any interpolated data less
than Value Min will be assigned a value of Value Min.
Value Max: Maximum value of the interpolated data. Any interpolated data greater
than Value Max will be assigned a value of Value Max.
Real Min: Real minimum value of interpolated data.
Real Max: Real maximum value of interpolated data.
Mag_X: X co-ordinate magnification factor
Mag_Y: Y co-ordinate magnification factor
Mag_Z: Z co-ordinate magnification factor
No_Value: Value assigned to nodes located outside the convex hull of the data
points (where interpolation is not performed)
Allow_Extrapolation: Is a flag to use extrapolation for nodes outside the convex
hull of the polygon formed by the data points. In this case linear regression is used
to fit a plane through the data set and calculate the interpolated value. This should
be used with caution since extrapolation is less reliable than interpolation.
Sdip: Calculate the aspect and slope at each grid node. This can be used to
augment the elevation information. The aspect is measured in degrees or radians
clockwise from north, and the slope is measured positively below the horizontal
plane in degrees or radians.
Tautness_1: Controls the influence of the gradient on the results and may be
used to smooth the interpolated surface.
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Tautness_2: Controls the influence of the gradient on the results and may be
used to smooth the interpolated surface.
Use_Gradient: Blends the gradient calculation and the linear interpolation
calculation to produce a smoother surface.
KRIGING
Kriging is a geostatistical method that produces visually appealing maps from
irregularly spaced data. Anisotropy and underlying trends suggested in raw data
can be incorporated in an efficient manner through Kriging. The program used,
called kt3d, is available in the public domain from the Geostatistical Software
Library (GSLIB), distributed by Stanford University, and is well-documented by
Deustch and Journel (1998). The program kt3d from GSLIB performs simple
Kriging, ordinary Kriging, or Kriging with a polynomial trend, and uses the standard
parameter file used by GSLIB. If the semi-variogram components have already
been modeled by the user, they can be incorporated into the program by choosing
the appropriate set of parameters in the parameter file. The semi-variograms
available include Spherical, Exponential, Gaussian, Power, and the Hole effect
models. If the variogram information is not available, the default linear variogram
with no nugget effect should be used. This option is a special case of the Power
model with the exponent equal to 1.
The Interpolator Options window for the Kriging method is shown in the following
figure, while each of the settings parameters is described below
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Start X Minimum X co-ordinate for the interpolation grid.
End X Maximum X co-ordinate for the interpolation grid.
X_Nodes Number of grid nodes in the X-direction.
Start Y Minimum Y co-ordinate for the interpolation grid.
End Y Maximum Y co-ordinate for the interpolation grid.
Y-Nodes Number of grid nodes in the Y-direction.
Use Log Interpolation Flag to interpolate the log values of the data. This setting
is useful for where some measured values are many orders of magnitude higher
than the majority of the other values. In such cases, the large values dominate the
interpolation process and details in the low concentration zones are removed. If
this setting is selected, the log of each data value is taken prior to performing
interpolation. By interpolating the log of the data set, small values are given more
weight than otherwise.
Restrict Min. Value Flag to restrict the minimum value of the interpolated data.
Restrict Max. Value Flag to restrict the maximum value of the interpolation data.
Value Min. Minimum value of the interpolated data. Any interpolated data less
than Value Min. will be assigned a value of Value Min.
Value Max. Maximum value of the interpolated data. Any interpolated data greater
than Value Max. will be assigned a value of Value Max.
Real Min. Real minimum value of interpolated data.
Real Max. Real maximum value of interpolated data.
Min. Trimming Limit Minimum bound for the interpolated data if the Restrict Min.
Value option is not selected by the user.
Max. Trimming Limit Maximum bound for the interpolated data if the Restrict
Max. Value option is not selected by the user.
The Points per block along X, Points per block along Y, and Points per block along
Z values allow the user to choose Block Kriging used for interpolation, as
compared to Point Kriging. Block Kriging is based on the premise that since
Kriging is a linear algorithm, direct estimation of the block average is possible for
user-defined blocks. The default values for these parameters are 1, and in this
case the default method is Point Kriging. If Block Kriging is being used, the user
needs to enter the Min. points for block Kriging and Max. points for block Kriging.
The Octant Search option is an exhaustive search option available to make sure
that data are taken on all sides of the point being estimated, and is especially
recommended for 3D data. If the user specifies Max. points per octant to be
greater than 0, an Octant Search is employed to find the neighborhood of points
for interpolation.
The Max. radius and Min. radius defines the search distances, in user specified
units, in the maximum horizontal direction and the minimum horizontal direction for
determining the neighborhood of points for interpolation. For isotropic data, the two
radii are the same. Enter the Vertical Radius value if 3D Kriging is to be performed.
If the total number of points in the data is large (>200), computation time for
Kriging may be reduced by specifying a smaller radius for the search.
The Angle1, Angle2, and Angle3 parameters define the search ellipsoid for
situations in which anisotropy is present in the data.
The Kriging type options are:
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·
·
·
·

Stationary simple Kriging with SK mean
Ordinary Kriging
Nonstationary simple Kriging with means from an external file
Kriging with external drift

The following guidelines are recommended for selecting the type of Kriging.
Choose Stationary simple Kriging with SK mean, if the mean value is known and is
constant throughout the area.
Select Ordinary Kriging if the mean is not constant everywhere, and needs to be
recalculated dependent on the location of the neighborhood.
Choose Nonstationary simple Kriging with means from an external file if the mean
is not constant and has to be read from an external file.
Select Kriging with an external drift when only the trend component needs to be
estimated, and not the residual component, where the variable is assumed to be
the sum of the trend and the residual component. This option is also referred to as
Universal Kriging.
For most situations, Ordinary Kriging is recommended and is the default option.
The SK Mean defines the global mean of the data if Stationary simple Kriging is
performed.
The Drift term defines the drift components if Kriging with external drift is
performed. Nine drift components are possible:
· X = linear drift in x
· Y = linear drift in y
· Z = linear drift in z
· Xq = quadratic drift in x
· Yq = quadratic drift in y
· Zq = quadratic drift in z
· XY = cross quadratic drift in xy
· XZ = cross quadratic drift in xz
· YZ = cross quadratic drift in yz
The Variable/Trend Estimate allows the user to choose between estimating the
variable or the trend. The default is Estimate variable.
The Nugget constant quantifies the sampling and assaying errors in the data. In a
Variogram plot the nugget constant is the y-intercept value.
The Use variograms option allows the user to select the type of variogram to be
used. The Variogram models available include:
· Spherical
· Exponential
· Gaussian
· Power
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· Hole Effect

If the variogram information is not available, the default linear variogram with no
nugget effect should be used. This option is a special case of the Power model
with the exponent equal to 1.

32.3

Appendix C: Map Manager: ISO Codes
None
1250: ANSI Central Europe, Latin 2
1251: ANSI Cyrillic, Slavic
1252: ANSI Latin 1
1253: ANSI Greek
1254: ANSI Latin 5, Turkish
1255: ANSI Hebrew
1256: ANSI Arabic
1257: ANSI Baltic Rim
1258: ANSI Vietnamese
437: OEM US, Latin
708: OEM Arabic, ASMO 708
720: OEM Arabic, Transparent ASMO
737: OEM Greek, formerly 437 G
775: OEM Baltic
850: OEM Western Europe, Latin 1
852: OEM Central Europe, Latin 2
855: OEM Russian, IBM; Cyrillic
857: OEM Turkish, IBM
860: OEM Portuguese, MS-DOS
861: OEM Icelandic, MS-DOS
862: OEM Hebrew
863: OEM Canadian Frech, MS-DOS
864: OEM Arabic
865: OEM Nordic, MS-DOS
866: OEM Russian, MS-DOS; Cyrillic II
869: OEM Greek 2, IBM Modern Greek
8859-1: ISO Latin 1; West European-Danish, Dutch, English, Faeroes, Finnish,
French, German, Icelandic, Irish, Italian, Norwegian, Portuguese, Spanish,
Swedish
8859-2: ISO Latin 2; East European-Albanian, Czech, English, German,
Hungarian, Polish, Rumanian, Serbo-Croatian, Slovak, Slovene
8859-3: ISO Latin 3; Southeastern European-Afrikaans, Catalan, Dutch, English,
Esperanto, German, Italian, Maltese, Spanish, Turkish
8859-4: ISO Latin 4; North European
8859-5: ISO English & Cyrillic-Based; Bulgarian, Byelorussian, English,
Macedonian, Russian, Serbo-Croatian, Ukrainian
8859-6: ISO Arabic
8859-7: ISO English & Greek
8859-8: ISO Hebrew
8859-9: ISO Latin 5; Western European & Turkish
8859-13: ISO Latin 6; Lativan and Lithuanian
ANSI: Uses the system code page
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OEM: Uses the OEM equivalent of the system code page
ISO: Uses the ISO equivalent of the system code page
BIG5: Uses the ANSI 950 code page, also known as Big5; Chinese Taiwan,
HongKong SAR, PRC
SJIS: Uses the ANSI 932 code page, also known as Shift-JIS; Japanese
EUC: Uses the EUC(ISO) equivalent of the system code page

32.4

Appendix D: Frequently Asked Questions (FAQ's)
Waterloo Hydrogeologic maintains an online Hydro GeoAnalyst FAQ:
https://www.waterloohydrogeologic.com/support/software-faq/
If you cannot find the answer, please contact our technical support
support@waterloohydrogeologic.com and they will be happy to assist you.

32.5

Appendix E: Configuring Geotransformation Settings
Introduction
A Geotransformation is a mathematical operation that takes the coordinates of a
point in one geographic coordinate system and returns the same point in
coordinates of another geographic coordinate system.
Hydro GeoAnalyst supports one stage horizontal geotransformations between
different geographic coordinate systems. This is required for the following two
reasons:
Hydro GeoAnalyst stores all spatial data, i.e., station x-y coordinates, in the GCS
WGS 1984 projection system (lat and long coordinates). When data is imported,
Hydro GeoAnalyst converts the spatial data into GCS WGS 1984 coordinates.
Likewise, when data is displayed in HGA, it converts the data from GCS WGS
1984 to the original projection system defined in the project settings. In order for
HGA to store and display your data correctly, an appropriate geotransformation
has to be defined.
In some cases, it may not be possible to obtain certain geographic data in a
coordinate system that is consistent with the rest of your project data. In this case,
a geotransformation can be applied to express the data according to your project's
coordinate system.
Note: Currently, Hydro GeoAnalyst does not support vertical (elevation) datum
shifting. Please ensure that your elevation data is consistent before importing into
HGA.
Geotransformations can potentially occur in Hydro GeoAnalyst in any of the
following scenarios:
· When station data is displayed in the main Hydro GeoAnalyst window
· When data is imported into Hydro GeoAnalyst
· When data is displayed in Map Manager
· When data is imported in Map Manager
· When a projection system is defined in the new project wizard
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As such, you may be prompted to specify geotransformation settings in any of the
aforementioned scenarios. Configuring a geotransformation is very simple and is
described in the following section.

Configuring Geotransformations
When Hydro GeoAnalyst detects that a geotransformation is required, it will check
the internal geotransformation settings to determine if the geotransformation has
already been defined. If not, it will prompt you with the following dialog:

From the Please Select Area dialog, choose the geographic area which best
describes the data extent.
Click [Ok] to save the settings. In subsequent scenarios when this
geotransformation is required, Hydro GeoAnalyst will automatically perform the
geotransformation on-the-fly. In other words, geotransformations only need to be
specified once for the Hydro GeoAnalyst project.
In some cases, such as importing data into HGA or loading a shapefile in Map
Manager, if the geotranformation has already been defined, you may be prompted
to confirm the default geotranformation (shown below).
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When presented with this dialog, select [Yes] to accept the default
geotranformation. Otherwise, select [No] to return to the Please Select Area dialog
(shown at top of page) to select a new geographic area.
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Troubleshooting
When encountering difficulties with Hydro GeoAnalyst you may try reviewing the following
pages to try and resolve the issue:
· Connection Problems

33.1

Connection Problems
There can be several different reasons for having difficulties connecting to a SQL Server
database.

Problem 1: Server not Running
You need to ensure that the SQL server is in face running or you will not be able to connect
to it. You can do this by typing services in the start menu. If you see the prompt to Start the
service that means it is not yet running.

Problem 2: Permissions
You need to ensure that you have permission to the SQL Server and the database you are
trying to connect to. You may require your IT professional or Database Admin to give you
permission to a database if you are trying to connect to a Network SQL server.
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Problem 3: Local Database
If you are trying g to connect to your local database that is installed with HGA, you can do
this in Management Studio just like you connect to other SQL Servers. The naming
convention is : (localdb)\instance name

Please Note: You need to ensure that the localdb is within brackets.
If you are getting a message indicating your SQL Server does not have permission to restore
database from specified location it may be due to your SQL Server Properties (found in your
local services). Consider changing the Log On properties to Local System account and
ensure Allow service to interact with desktop is checked on.
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